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Introduction

Welcome to Macromedia Director—the world’s foremost 
authoring tool for multimedia productions.

If you’re a multimedia artist or producer, an educator, engineer, 
or multimedia consultant, you’ll find Director is the ideal tool for 
creating kiosks, entertainment and educational CD-ROM titles, 
simulations and visualizations, interactive presentations, and 
demo disks.

This introduction contains a list of what’s in the package, a 
description of how the rest of this guide is organized, and 
information about the hardware and system software that you 
need to run Director. It provides instructions for installing 
Director and using Director’s on-line help system. It also contains 
a summary of the features that are new in this version of Director 
and provides a quick overview of the basic steps involved in 
creating a Director movie.
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What’s in this package

The Director package contains the application software and five 
guides. In addition to this guide, Using Director, the package includes:

◆ Learning Director, a collection of step-by-step examples that lead 
you through the process of creating animations, working with 
sounds, creating special effects, adding interactivity to a movie, 
and creating hypertext. If you’re new to Director, Learning 
Director is the ideal place to start. If you’re an experienced user, 
you may want to try out some techniques you haven’t used 
before.

◆ Using Lingo, an introduction to Director’s scripting language, that 
provides hands-on experience using Lingo to control a movie in 
ways not possible in the score. Find out about interactivity: learn 
how to evaluate and respond to user input and how to give users 
the freedom to travel through and explore a movie. Many of the 
examples are based on the sample movies included in the 
package.

◆ Lingo Dictionary, a listing of every Lingo command. The 
dictionary contains the syntax for each command, a description of 
how it works, and examples of how the command might be used 
in a real script.

◆ Tips & Tricks, a short guide that includes tips on performance, 
synchronization, debugging strategies, and cross-platform 
development.
Introduction 2



     
What’s in this guide

This guide has six chapters, one appendix, a glossary, and an index.

Chapter 1, “Working with Cast Members,” covers the basic 
procedures you’ll find most useful when you’re working with cast 
members—the procedures you’ll find yourself using most of the time. 
It contains techniques for creating and making changes to cast 
members, ways to work with and organize cast members in the cast 
window, and procedures for handling cast members once you’ve 
placed them on the stage.

Chapter 2, “Creating Animations,” demonstrates all the techniques 
for creating animation: in-betweening, frame-by-frame animation, 
auto animation, and real-time recording. It also describes techniques 
for handling film loops and QuickTime movies.

Chapter 3, “Working Behind the Scenes,” shows how to add sound 
effects and music to a movie, how to set up visual transitions, and 
how to control the playback speed of a movie. It also explains how 
color palettes work, how to create and edit them, and how to create 
palette effects. 

Chapter 4, “Making a Movie Interactive,” shows how to put control 
of a movie into the hands of the users. It provides procedures you can 
follow to create buttons, hypertext links, and simple Lingo scripts.

Chapter 5, “Window Reference,” details how every window in 
Director works. It includes information on the cast window, the 
score, the control panel, and the paint window.

Chapter 6, “Menu Reference,” describes all the menu commands—
and their associated dialog boxes—in Director in the order in which 
they appear.

Appendix A, “Director Shortcuts,” lists the keyboard and mouse 
shortcuts available in Director. 

Terms that look like this appear in the glossary at the end of the 
guide. 
3



    
Hardware and software requirements

To create movies with Director, you need a 68030 Macintosh 
computer with a 640 x 480 (13-inch) monitor. You can run Director 
on a less powerful computer, but you probably won’t find its 
performance acceptable. If you plan things right, you can create 
movies that will run on a less powerful computer without any 
problems.

A color monitor isn’t absolutely essential, but you’ll find yourself 
greatly limited without one. (The sample movies that come with 
Director require a color monitor.) A second large monitor makes 
developing movies infinitely easier.

To play digital video movies, you need the latest QuickTime 
extension.
Introduction 4



                                  
Installing Director

The CD-ROM version of Director does not require an installer. 
Simply drag any folders you want plus all the files in the Director 
folder to the desired location on your hard drive. The Director 
application will not run off a CD-ROM. Help files, the EHelp 
engine, and projector resources files must be located in the same 
folder as the Director application.

The disk-based version of Director, available from Macromedia, 
requires an installer. Default installation includes all files, which 
decompress to approximately 30 megabytes. 

The files provided include:

◆ Program. Installs the Director application, resources file, on-line 
help, and help settings.

◆ Sample Movies. Installs Guided Tour and Lingo Expo. Guided 
Tour: Behind the Scenes is a quick introduction to Director’s 
features and interface. Lingo Expo showcases three Director 
movies that were designed to show what you can do with Lingo: 
Noh Tale to Tell, a storybook, demonstrates basic Lingo; Furniture 
+ Philanthropy, a kiosk, covers intermediate Lingo; and MECH, a 
simulation, focuses on advanced Lingo.

◆ Tutorial Movies. Installs the sample files you need for the step-
by-step examples in Learning Director and Using Lingo.

◆ Extras. Installs Clipmedia, utilities from Apple and Macromedia, 
and a variety of XObjects.

You don’t have to install everything all at once. If you’re not sure 
you are going to use a set of files, you can skip them, and then install 
the files later if you decide you need them.
5



          
Using the installer

To install Director:

1. Put the Director Program diskette in the disk drive.

2. Double-click the icon that appears on the screen to open it.

3. Double-click the installer icon.

4. Follow the instructions that appear on the screen.

Starting Director

To start Director:

1. Go to the Macromedia Director 4.0 folder, and double-click 
the Macromedia Director 4.0 icon.
After a moment, Director prompts you to enter your name, 
organization, and serial number. The serial number is located on 
the user registration card.

2. Fill in the information, and click Done.
Introduction 6



            
Getting help

Director has an extensive on-line help system:

◆ To display the help window’s table of contents, choose Help 
from the Apple menu.

◆ To get help about something that’s on the screen, choose 
Help Pointer from the Apple menu (or press Command-?), and 
then click the item you want information about.

◆ To get information about a dialog box, click the Help button 
that appears in the dialog box.
7



        
What’s new in Director

The development of Director 4.0 included both major enhancements 
to provide new functionality and small changes to make the software 
easier to learn and use. 

Some of the changes are obvious, such as the color buttons in the cast 
and score windows. Other changes are less apparent, such as the new 
keyboard shortcuts, which are detailed in Appendix A, “Director 
Shortcuts.”

Here’s an overview of everything that’s new in Director:

Opening existing movies

You can open and use movies created with previous versions of 
Director. The first time you save a movie created with a previous 
version of Director, Director converts the movie to Director’s new 
format. The new format provides compatibility with Director 4.0 for 
Windows.

The Update Movies command on the File menu converts an entire 
folder of movies into Director’s new format. You can also use it to 
“protect” a movie: to modify the movie so someone can play it in a 
projector but not reopen it in Director.

Compatibility with Windows

You don’t have to convert a movie you’ve created on the Macintosh 
with Director 4.0 before you open it with Director 4.0 for Windows. 
Any movie you create with Director 4.0 for Macintosh is completely 
compatible with Director 4.0 for Windows—and vice versa. (You 
can’t, however, use earlier versions of Director—including Director 
3.1 or Director 3.1 Player for Windows—to play Director 4.0 
movies.)
Introduction 8



              
Shared casts

To make shared casts compatible on Macintosh and Windows 
computers, a movie containing a shared cast must now be named 
SHARED.DIR.

Adding sounds to the score

Adding sounds to the score is much more straightforward than it was 
before. The Sounds utility, Sound menu, and Sounds file have been 
removed. To add a sound to the score, import it into the cast, and 
then either drag it to the score or use the Set Sound command on the 
Score menu.

User interface improvements

◆ Previous versions of Director had 13 menus, 4 of which were 
always present. Director now has ten menus, six of which are 
always present.

◆ The keyboard shortcuts are more convenient and are more 
consistent with the keyboard shortcuts commonly used in other 
Macintosh applications.

◆ A standard button bar appears at the top of the cast, paint, text, 
script, and digital video windows. The buttons provide 
convenient access to common operations.

◆ The layout and organization of both the score and the control 
panel have been improved.
9



                     
◆ The layout and wording of the dialog boxes have been improved.

◆ You can add a cast member to a movie by dragging it from the 
cast window to the stage or the score. You can move a cast 
member within the cast window by dragging it from one slot to 
another. You can move information in the score by selecting it 
and dragging it.

◆ You can select a color for a range of cells in the score to make the 
information in the cells stand out. To display the cell color 
selector in the score, choose Score Window Options from the 
Score menu and select Colored Cells in the dialog box.

Cast window improvements

◆ You can identify three applications you want to use to edit cast 
members—one for bitmaps, one for sounds, and one for digital 
video—and launch the applications from the cast window.

◆ You can create up to 32,000 cast members—instead of just 512—
for each movie.

◆ Cast window scrolling is much faster, especially for linked cast 
members.

◆ You can select cast members in the cast window by type.

◆ You can assign names to cast members and search for them by 
type, name, or a variety of other options.

◆ Cast members are numbered in decimal rather than octal format.
Introduction 10



                    
General enhancements

◆ The score provides 48 channels, twice as many as earlier versions 
of Director.

◆ There’s no longer a 16-megabyte limit on the size of a Director 
movie.

◆ The way that Director organizes the information that makes up a 
movie has been improved. The change makes it possible to play 
movies back at the best possible rate and to reduce hard disk and 
CD-ROM access times.

◆ Overall memory management has been improved. You can 
assign levels of priority to cast members that determine which cast 
members are removed from memory first when memory is low.

◆ Sound channel management has been improved so that playback 
performance is better and causes fewer pauses in animation.

◆ The way Director looks for linked cast members has been 
improved. Director is more likely to be able to find a linked cast 
member that has been moved to another drive or folder.

◆ You can use Director to create projectors (play-only versions of 
movies). Unlike movies, projectors created with Director 4.0 for 
Macintosh can be played only on Macintosh computers, and 
projectors created with Director 4.0 for Windows can be played 
only on Windows computers.

◆ The Save and Compact command organizes the information in a 
movie in the best possible way for playing it back from a 
CD-ROM.

◆ The digital video features for QuickTime cast members have 
been enhanced.
11



          
General Lingo enhancements

◆ You can play one movie inside of a window within another 
movie. All of the Lingo scripts within the movie in the window 
remain in effect.

◆ Director compiles Lingo scripts automatically. You can check to 
see if a script’s syntax is correct before you play the movie it’s part 
of, and you can protect a movie’s scripts when you create a 
projector.

◆ Creating many related objects from the same script is simpler.

◆ There’s an improved, more consistent approach to handling 
messages and defining event handlers

◆ Scripts are easier to create, edit, and find. Movie, frame, and 
sprite scripts are cast members and appear in the cast window. A 
script in the cast info dialog box lets you display a script attached 
to a cast member.

◆ Lingo has additional cast and file management tools. You can use 
the new tools to find or change a cast member’s type, color 
depth, palette, or other attributes, to copy and paste cast members 
to and from the Clipboard, and to move cast members within the 
cast window.

◆ Searching in script windows has been improved. A new Find 
Handler command locates handlers in either the current script 
or in all scripts in the movie.

◆ Handlers no longer appear on the Lingo menu. They’re now 
listed in the Find Handler dialog box.
Introduction 12



New Lingo language elements

◆ Lingo has new elements you can use to test and set a variety of 
cast member properties such as type, registration points, and color 
depth.

◆ Elements have been added that you can use to control the size, 
location, and appearance of windows and to identify the movie 
you want to play in the window.

◆ New elements make it possible to manage and check files and 
frames.

◆ A number of mathematical functions (such as sine, cosine, and arc 
tangent) are now available.

Outdated features that have been removed

◆ Overview has been removed from Director. The Auto Animate 
command has been retained; it now appears on the Score menu.

◆ Macromedia Accelerator is no longer necessary. To accelerate a 
movie, you export it as a QuickTime movie, and then import the 
QuickTime movie into Director to play it back. The Digital 
Video Cast Info dialog box provides enhanced support for 
controlling QuickTime movies in a Director movie.

◆ The Gaffer and MacroMind Player have been replaced by the 
Create Projector command.
13



Commands whose names have changed

Name in Director 3.1 Name in Director 4.0 Notes

Auto Transform Auto Distort

Burn Scene removed Instead, make the score active, 
choose Select All (Command–A) 
from the Edit menu, and then press 
Delete

Clean Up Selection Sort Cast Members

Clone Duplicate Cast Members, 
Duplicate Palette

Color Depth removed Moved to Transform Bitmap dialog 
box

Comment window Marker window

Delete Unused Cast removed Instead, choose Find Cast Members 
from the Cast menu, select the 
unused cast members in the cast 
window, and then press Delete

Easy Select removed Replaced by Playback Head Follows 
Selection in the Score Window 
Options dialog box (choose Score 
Window Options from the Score 
menu)

Extended Display Options Score Window Options

Magnify removed Replaced by Magnified Cells in the 
Score Window Options dialog box 
(choose Score Window Options from 
the Score menu)

Normal Size removed Replaced by restore to size of cast 
member in Sprite Info dialog box 
(choose Sprite Info from the Score 
menu)

Obey Scripts Disable Lingo Disable Lingo does the opposite of 
what Obey Scripts did

Place on Stage removed Instead, drag a cast member to stage 
or press Command-Shift-L
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QuickTime window digital video window Director is compatible with Windows 
and can run both AVI and QuickTime 
movies

real-time indicator in score actual tempo in control panel

Repeat Selection Selected Frames Only

Select Cast Find Cast Members

Set Blend Value Set Sprite Blend

Shuffle Backward removed Replaced by this button at the 
bottom of the score window:

Shuffle Forward removed Replaced by this button at the 
bottom of the score window: 

Transform Sprite Sprite Info

Commands whose names have changed

Name in Director 3.1 Name in Director 4.0 Notes
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Creating a movie

For a quick introduction to Director, run the guided tour: Go to the 
Macromedia Director 4.0 folder, open the Sample Movies folder, and 
then the Guided Tour folder. Double-click the Behind the Scenes 
icon.

When you use Director to create a movie, the essential elements you 
work with are the stage, the score, the cast window, and cast 
members:

Stage

Score Cast member

Cast memberCast window
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To create a movie:

1. Import or create the cast members you want to use in the 
movie.

Cast members include not just the graphics you want to display and 
animate on the screen, but text, sound effects and music, color 
palettes, buttons, digital movies (such as QuickTime movies), and the 
Lingo scripts that provide interactivity and control of a Director 
movie.

Every cast member you import or create appears in the cast window.

The cast window

2. Make changes to the cast members.

For example, you might colorize black-and-white images you’ve 
imported. Or you might create several different versions of a cast 
member in slightly different positions to create the illusion of realistic 
movement when you animate it.

Script

Bitmap

Shape

Text

Sound
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You can make changes to bitmapped graphics and text in the paint 
window and to QuickDraw objects and text with the tools in the 
tools window.

The paint and tools windows

You can also make changes to bitmapped graphics and text in 
applications such as Photoshop and Canvas. To make changes to 
other types of cast members, such as sound files and QuickTime 
movies, use an appropriate application such as SoundEdit Pro or 
Adobe Premiere. For cast members you’ve linked rather than 
imported into a movie, you can launch the application you used to 
create the original file directly from Director using the Launch 
External Editor command. 

3. Place cast members either on the stage or in the score.

Moving a cast member to the stage not only displays the cast member 
on the stage but automatically inserts information about it into the 
score. Likewise, moving a text or graphic cast member to the score 
automatically places it on the stage.
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Positioning a cast member on the stage determines where it appears on 
the screen. Positioning it in the score determines when it appears on 
the screen.

4. Create animation.

Director offers many ways to create animation:

◆ Auto Animate. For text and graphs. Provides predefined 
routines for creating common effects such as a text crawl or 
animated bars in a bar graph.

◆ Auto Distort. Automatically creates cast members in the 
intermediate positions in an animated sequence that starts with 
the cast member as it originally looks and ends as it looks after 
you’ve reshaped or rotated it.

This cast member
appears…

…before this one.
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◆ Real-Time Recording. Records a cast member’s position as you 
move it around the stage.

◆ Step Recording. Records the position of the cast members on 
the stage one frame at a time.

◆ In-Betweening. Automatically creates the intermediate stages 
between starting and ending points when you’re moving a cast 
member, changing its size, blending it with the background, or 
changing a foreground or background color.

◆ Color Cycling. Cycles through a range of colors selected in the 
color palette. Use to create effects such as a setting sun, a spinning 
ball, or a waterfall.

◆ Palette Transition. Gradually switches from the colors in one 
palette to those in another. Use to create effects such as the 
change from night to dawn to daylight.

5. Add transitions.

Transitions are preset options you can use to change from one image 
to another on the screen. For example, you can wipe text onto a 
background or dissolve from one screen to the next. 

6. Add sound effects and music.

7. Make the movie interactive.

You can add buttons and hypertext links to a movie to make it 
interactive. Basic interactivity, such as branching from one part of a 
movie to another, is easy to accomplish with simple statements in 
Lingo, Director’s scripting language. With more sophisticated Lingo 
scripts, you can create just about any kind of interactivity you can 
imagine.
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Chapter 1

Working with Cast Members

A cast member is any element you can make part of a movie. Cast 
members include not just the images you move around the stage, 
but text, sound effects and music, buttons, color palettes, digital 
video (such as QuickTime movies), and the Lingo scripts that 
provide interactivity and control of a Director movie.

This chapter covers the basic procedures you’ll find most useful 
when you’re working with cast members—the procedures you’ll 
find yourself using most of the time. It contains techniques for 
creating and making changes to cast members, ways to work with 
and organize cast members in the cast window, and procedures 
for handling cast members once you’ve placed them on the stage.

You’ll find many other useful techniques in the last two chapters 
of this guide, Chapter 5, “Window Reference,” and Chapter 6, 
“Menu Reference,” and in two of the other guides that come 
packaged with Director, Learning Director and Tips & Tricks.
21



Creating cast members

Once you’ve planned a movie, assembling the cast is the first major 
task in creating it. You can create cast members either by using the 
tools that Director provides or by importing the cast members into 
Director from other applications.

Director provides a good, solid set of tools you can use to produce 
excellent, high-quality cast members of every type. You’ll no doubt 
want to augment Director’s tools with other applications such as 
Canvas, Photoshop, MacDraw Pro, Premiere, and SoundEdit Pro. 
Because these applications are dedicated to creating specific media 
types, they provide refinements and power that only dedicated 
applications can accommodate. Director doesn’t duplicate all the 
features of dedicated applications; instead, it provides an efficient way 
to import cast members you create in other applications. Once 
you’ve imported those cast members, Director gives you the means to 
turn them into the best movies you can imagine: movies that are 
graphically appealing, filled with movement and sound, and rich in 
interactivity.

The following table provides a brief overview of how you go about 
creating cast members both inside and outside Director.

Ways to create cast members

Cast member Outside Director Inside Director

bitmap Create the image in an application such as 
Photoshop, save it in PICT format, and then 
import it. (Director automatically converts 
PICT images to bitmaps when it imports 
them unless you use Paste as PICT.)

Use any of the paint tools in the 
paint window. (See “The paint 
window” in Chapter 5.)

button Create the button in an application such as 
Photoshop, save it in PICT format, and then 
import it. (In Director, you can assign any 
bitmap, PICT, or shape cast member a 
script, making it a button.)

Use the button tool in the tools 
window. (See “Creating 
buttons” in Chapter 4.)
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digital video Use an application such as Premiere. Create an animation, export it as 
a QuickTime movie, and then 
import the QuickTime movie. 
(See “QuickTime Movies” in 
Chapter 2.)

film loop None. Create an animation, copy the 
animation from the score, and 
paste it in the cast window; or 
create a movie and then import 
it into another movie. (See “Film 
loops” in Chapter 2.)

PICT Create a QuickDraw object in another 
application, copy it to the Clipboard, and 
then use the Paste as PICT command on 
the Cast menu to paste it in the cast 
window. (See “Cast menu” in Chapter 6.)

None. (You can export an image 
from Director in PICT format or 
paste an image you’ve created 
outside Director into the cast 
window in PICT format, but you 
can’t create an image inside 
Director in PICT format.)

shape None. (A shape cast member is a single 
QuickDraw object you create with the 
shape tools in the tools window. A 
QuickDraw object you create outside 
Director becomes a bitmap or PICT cast 
member.)

Use any of the shape tools in 
the tools window. (See “The 
tools window” in Chapter 5.)

script Use a word processor to create the script, 
copy it to the Clipboard, and then paste the 
script into a script window; or copy and 
paste a set of scripts to the Scrapbook, and 
then import the Scrapbook.

Use a script window. (See “The 
script window” in Chapter 5.)

sound Digitize the sound using an application such 
as SoundEdit Pro, and then save the sound 
in AIFF format.

Use the Record Sound 
command on the Cast menu. 
(See Chapter 6.)

text If the content of the text is your concern, 
use a word processor, and then copy and 
paste the text to a text window; or copy and 
paste blocks of text to the Scrapbook, and 
then import the Scrapbook.

If the look of the text is your concern, use 
the text tool in an application such as 
Photoshop, save the image of the text in 
PICT format, then import it.

Use the text tool in the paint 
window to create bitmapped 
text; use a text window or the 
text tool in the tools window to 
create QuickDraw text. (See 
“Creating text,” later in this 
chapter.)

Ways to create cast members

Cast member Outside Director Inside Director
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Creating cast members in the paint window

The paint window offers not just a drawing area and a set of standard 
paint tools, but also a set of commands you can use to change how 
the tools work and a menu of ink effects.

Director’s paint tools work the same as paint tools in applications such 
as Photoshop. If you’re familiar with paint tools from another 
application, you can use them without any further introduction. If 
you’re unfamiliar with how paint tools work, see “The paint 
window” in Chapter 5, “Window Reference.” Procedures for 
creating text with the paint window’s text tool are covered in 
“Creating text,” later in this chapter. You can also practice using the 
paint tools in the examples in Learning Director.

Drawing area

Paint tools

Ink effects Paint menu
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Before you create a cast member in the paint window, make sure you 
have the color depth set to the appropriate setting. For more 
information, see “Changing color depth,” later in this chapter.

Ink effects

Ink effects extend the results you can achieve with the paint tools. 
They modify either how a tool behaves, how colors are displayed, 
or—in the case of the Reveal ink effect—how two cast members 
interact graphically.

Other things you can do in the paint window

What you can do Where to find out how

Change the size and shape of 
the paintbrush

“Brush Shapes” in the Paint menu 
section in Chapter 6

Select the paintbrush sizes and 
shapes you want to appear on 
the paintbrush pop-up menu

“Paintbrush” in the paint window 
section in Chapter 5

Change the size and density of 
the air brush

“Air brush” in the Paint menu section in 
Chapter 6

Select the air brush sizes and 
densities you want to appear on 
the air brush pop-up menu

“Air brush” in the paint window section 
in Chapter 5

Paint with two-color patterns “Pattern selector” in the paint window 
section in Chapter 5

Create new two-color patterns “Patterns” in the Paint menu section in 
Chapter 6

Paint with multicolor patterns “Pattern selector” in the paint window 
section in Chapter 5

Create new multicolor patterns “Tiles” in the Paint menu section in 
Chapter 6
Working with Cast Members 25



The best way to find out what you can do with ink effects is to 
experiment with them.

Things you can do with ink effects

What you can do Where to find out how

Make the background color 
transparent

Transparent under “Ink pop-up 
menu” in the paint window section in 
Chapter 5

Make overlapping colors reverse Reverse under “Ink pop-up menu” in 
the paint window section in Chapter 5

Create an image that can be seen 
only over a black background 
(when you’re working in black and 
white)

Ghost under “Ink pop-up menu” in 
the paint window section in Chapter 5

Paint with the background color Ghost under “Ink pop-up menu” in 
the paint window section in Chapter 5

Cycle through the colors in the 
palette automatically as you paint

Cycle under “Ink pop-up menu” in the 
paint window section in Chapter 5

Paint with translucent colors Blend under “Ink pop-up menu” in 
the paint window section in Chapter 5

Paint over colors that are darker or 
lighter than the color you’ve 
selected

Darkest and Lightest under “Ink pop-
up menu” in the paint window section 
in Chapter 5

Darken or lighten colors Darken and Lighten under “Ink pop-
up menu” in the paint window section 
in Chapter 5

Smooth edges Smooth under “Ink pop-up menu” in 
the paint window section in Chapter 5

Smear a color into an adjacent 
area

Smear and Smudge under “Ink pop-
up menu” in the paint window section 
in Chapter 5

Spread a color already on the 
screen into an adjacent area

Spread under “Ink pop-up menu” in 
the paint window section in Chapter 5
Chapter 126



Choosing ink effects

The ink effects available in the paint window affect art only when 
you’re in the process of creating it. Another set of ink effects is 
available in the score. You can use the score’s ink effects to change 
the way cast members appear on the stage. (For more information 
about the score’s ink effects, see “Ink pop-up menu” under “The 
score window” in Chapter 5, “Window Reference.”)

Many ink effects are available only when the color depth of both the 
monitor and the movie are set to 8-bit (256 colors). For information 
about which ink effects the limitation applies to, see the lists of ink 
effects in the paint window and score sections of Chapter 5.

One of the options in the Paint Window Options dialog box has an 
important effect on ink effects and how they work with the tools in 
the paint window. If Ink Effect Sticks to Tool is selected (which it is 
by default), when you select a tool, Director automatically selects the 
ink effect you were using the last time you used the tool. If you don’t 
want Director to automatically select the ink effect you used last time, 
choose Paint Window Options from the Paint menu and deselect the 
option.

Replace one color with another “Switching colors using the Switch 
ink effect” later in this chapter

Paint with the contents of the 
Clipboard

Clipboard under “Ink pop-up menu” 
in the paint window section in 
Chapter 5

Things you can do with ink effects

What you can do Where to find out how
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To choose an ink effect:

1. Select the tool you want to use.

2. Choose an effect from the Ink pop-up menu.

3. Use the tool you’ve selected to create a cast member.
Director applies the ink effect to whatever you create with the 
tool.

Creating a gradient

A gradient is a blend of colors that varies gradually from the current 
foreground color at one extreme to the gradient destination color at 
the other.

A gradient

Ink pop-up menu
Chapter 128



You can use the Gradient ink effect with the filled-shape tools, the 
paint bucket, and the paintbrush.

To create a gradient:

1. Select a filled shape tool, the paintbrush, or the paint 
bucket.

2. Choose a foreground color.

3. Choose a destination color for the gradient from the 
destination color chip.

4. Choose Gradient from the ink effects pop-up menu.

Ink pop-up menu

Destination color chipForeground color chip

Foreground color chip
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5. Choose Gradients from the Paint menu.
The Gradients dialog box appears.

6. Select the options you want to use, and then click OK.
The options in the Gradients dialog box are described in 
“Gradients” in “Paint menu” in Chapter 6, “Menu Reference.”

7. Use the tool you’ve selected.
The color that appears on the screen as you paint is not a single 
color, but the gradient you’ve selected.
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Using the Reveal ink effect

You can use the Reveal ink effect to create a cast member through 
which you can see another.

Imagine a cast member and the background behind it painted on a 
pane of glass covering another cast member. As you use the Reveal 
ink to paint over the cast member in front, you remove part of the 
cast member, revealing the other cast member underneath.

Cast member
that’s covered

Cast member in front

Area painted with 
Reveal ink
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To use the Reveal ink effect:

1. Create both the cast members.
You can also reveal a cast member through a blank background.

2. Make sure that the two cast members are next to each 
other in the cast window.
Put the cast member you want to reveal before the cast member 
you want it to show through.

If you want to reveal a cast member through a blank background, 
make sure the cast member position after the cast member you 
want to reveal is empty. (For information about rearranging cast 
members in the cast window, see “Moving cast members within 
the cast window” under “The cast window” in Chapter 5, 
“Window Reference.”)

3. In the cast window, double-click the cast member that you 
want the revealed cast member to show through.
The cast member appears in the paint window.

Cast member you
want to reveal

Cast member where you’re 
using the Reveal ink

Cast member you
want to reveal

Double-click this 
cast member
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4. Select the tool you want to use.
The Reveal ink effect works with the paintbrush, the paint 
bucket, the air brush, and the filled-shape tools.

5. Choose Reveal from the ink effects pop-up menu.

6. Use the tool you’ve selected to paint the area where you 
want the other cast member to show through.

Creating text

Director has two text tools: one in the paint window and one in the 
tools window. You can use either to create text, or you can create 
text by typing it in a text window.

Text you create in the paint window is bitmapped (bitmapped text is 
stored as a graphic image of the text). Text you create with the tools 
window or in a text window is QuickDraw text (QuickDraw text is 
stored as the information that defines the text—the letters you’ve 
typed, the font, size, and style you’ve chosen, and so on). 

Text tool
Text tool

Paint window 
tools

Tools window Text window
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Paint window text

Because the text you create in the paint window is bitmapped, 
Director can animate it faster than text you create in a text window 
or with the text tool in the tools window. You can also use the paint 
window’s ink effects on bitmapped text, and you don’t have to worry 
about whether users have the fonts you’re using installed on their 
systems. The disadvantage of bitmapped text is that once you’ve 
created it, you can’t edit it: if you want to change what you’ve typed, 
you have to erase it and type it again.

Tools window and text window text

Any text that you create with the text tool in the tools window, you 
can also display in a text window. And any text that you create in a 
text window, you can edit with the tool window’s text tool once 
you’ve placed the text on the stage. The link between the two is the 
cast window: text created with either the tools window or in a text 
window becomes a text cast member in the cast window.

QuickDraw text takes less space than bitmapped text because 
Director saves only the information that defines the text, not every 
pixel that makes up the image of the text. QuickDraw text also looks 
much better when it’s printed (so it’s the better choice when you plan 
to print frames of a movie, say, for handouts). Perhaps most 
important, you can edit QuickDraw text after you’ve created it.

If you prefer working with QuickDraw text but you want to take 
advantage of Director’s ability to animate bitmapped text faster, you 
can create and edit the text with the tools window or in a text 
window, and then use the Convert to Bitmap command on the Cast 
menu to change the text into bitmapped text. (See Chapter 6, “Menu 
Reference,” for more information.)

˛ Tip If you want to kern text, create it in an application such as Photoshop, adjust 
the spacing between letters there, and then import the text into Director. If you 
use Photoshop, you can also take advantage of its anti-aliasing capabilities.
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Creating text in the paint window

When you create text in the paint window, the text appears in the 
cast window as a bitmap cast member, not a text cast member.

To create text with the paint window’s text tool:

1. Select the text tool.
The pointer changes to an I-beam.

2. Click at the spot in the paint window where you want to 
start typing.
A cursor appears inside a box that marks the text block.

3. Choose the font, size, style, and alignment you want from 
the Text menu.
You can choose an ink effect or change the foreground color, 
background color, and pattern. You can also add a drop shadow 
to the text by choosing one of the options from the Text Shadow 
submenu on the Text menu.

4. Type the text.
Before you set another insertion point, you can edit the text or 
drag the text box around the paint window. You can’t choose a 
new font, size, or style for bitmapped text once you’ve typed it as 
you can with QuickDraw text. If you want to change any of 
those attributes, you have to erase the text, choose the new 
attributes from the Text menu, and then type the text again. 
Once you set another insertion point, you can’t make any further 
changes to the text.

Creating text with the tools window

When you use the text tool in the tools window to create text on the 
stage, the text also appears as a text cast member in the cast window. 
You can edit the text directly on the stage or in the text window. 
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To create text with the tools window’s text tool:

1. Choose Tools from the Window menu.
The tools window appears.

2. Select the text tool.
The pointer changes to a crosshair with an A attached to it.

3. Position the pointer at the place on the stage where you 
want the text to start, and then drag the text tool to draw a 
box.
The text you type appears inside the box. If you want to make 
the box wider, drag the handle on the right edge of the box. If 
you want to move the box, drag it by one of its edges.

4. Type the text.
QuickDraw text always appears in the default font, size, and style 
(Geneva, 12 point, plain). You can apply the font, size, and style 
you want after you’ve typed the text. As you type, the text 
automatically wraps to the next line and the text box expands 
vertically to accommodate the new line.

5. Select the text, and then choose a font, size, and style from 
the Text menu.
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Choosing a font is an important decision if you plan to distribute a 
movie. Remember that a computer can display only the fonts that are 
installed on it, and someone running the movie you’re creating may 
not have the same fonts you have. If the font you choose isn’t 
available, the system will replace it with a different font—and the 
results may not be what you want. If you can’t be sure which fonts 
will be available when someone else runs your movie, either use the 
System fonts (Chicago, Geneva, and Monaco) or convert the text to a 
bitmap.

You can change the color of the text and its background with the 
foreground and background color chips in the tools window. You 
can use the options on the Text menu to set the alignment of the text 
and to place a border, gutter, box shadow, and text shadow around it.

There are a number of other aspects of a block of QuickDraw text 
that you can control using the options in the Cast Member Info 
dialog box. For information about the other options, see “Cast 
Member Info” under “Cast menu” in Chapter 6, “Menu 
Reference.”

Note Although you can’t use paint window ink effects with QuickDraw text, you 
can use the score window ink effects. For information about the score window 
ink effects, see “Ink pop-up menu” under “The score” in Chapter 5, 
“Window Reference.”
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Creating QuickDraw text in the text window

You can type text directly in the text window rather than using the 
text tool on the stage. 

To create text in the text window:

1. Choose Text from the Window menu.
A text window appears.

You can change the size of the text block by dragging the handle 
at the right edge of the text area.

2. Choose a font, size, and style from the Text menu.
You can change the color of the text and its background with the 
foreground and background color chips in the tools window. 
You can also choose to place a border, gutter, box shadow, or 
text shadow around the text you type. The border, gutter, box 
shadow, and text shadow you set appears only on the stage, not in 
the text window.

3. Type the text.
The text you type becomes a cast member in the cast window. 
You can enter up to 32,000 characters, including spaces.

If you want to change the text attributes, select the text in the text 
window and choose new attributes from the Text menu.

Drag to resize 
the text block
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Editing QuickDraw text

You can edit QuickDraw text either on the stage or in the text 
window.

To edit QuickDraw text:

1. Select the text if it’s on the stage, or double-click the cast 
member that corresponds to the text to open the text 
window.
If the text is on the stage, a box appears around it.

2. Select the part of the text you want to change.
You can double-click a word to select the entire word, or triple-
click anywhere in the text to select the entire block.

3. Make whatever changes you want.
Changes to the font, size, style, and text color affect only the text 
that’s selected. Changes to the alignment, margins, border, box or 
text shadow, and background color affect the entire block of text. 
(To change the color of the text and background behind it, use 
the foreground and background color chips in the tools window.)
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Making changes to cast members

Once you’ve assembled the cast of a movie, you may find that you 
need to make changes to some of the cast members. Three of the 
most common reasons for making changes to cast members are to 
produce animation, to change a cast member’s color depth, and to 
change a cast member’s color.

◆ Producing animation. A quick way to animate a cast member is 
first to duplicate it to produce a series of identical cast members, 
and then to make the appropriate change to each cast member in 
the series to create each stage in an animated sequence. You can 
also change the position, orientation, or shape of a cast member, 
and then have Director automatically generate a cast member for 
each intermediate stage between the cast member’s original 
appearance and its appearance after the change.

◆ Changing a cast member’s color depth. A good way to save 
memory and to improve a movie’s performance is to reduce cast 
members to the lowest color depth they need to accommodate 
the number of colors they use. For example, if you’ve created a 
block of text that’s all the same color against a one-color 
background, you can change it from an 8-bit cast member to a 
1-bit cast member and save eight times the memory you were 
using before.

◆ Changing a cast member’s color. If you import a black-and-
white cast member into a color movie, the cast member doesn’t 
have to stay black and white: you can increase the color depth of 
the cast member and then colorize it. If you import a color cast 
member that doesn’t match the color scheme of the screen where 
you want to use it, you can replace its current colors with colors 
that look better.
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The procedures in this section show how to create a sequence of cast 
members, how to change the color depth of a cast member and a 
movie, how to colorize a black-and-white cast member, how to use 
the Switch Colors command and Switch ink effect to replace one 
color with another, and how to combine several separate cast 
members into a single background.

Other things you can do with cast members

What you can do Where to find out how

Scale the size of a cast member “Transform Bitmap” in the Cast menu 
section in Chapter 6

Scale the size of a sprite “Sprite Info” in the Score menu 
section in Chapter 6

Change the size, pattern, and 
color of a QuickDraw shape

“The tools window” in Chapter 5

Invert the colors in a cast member “Invert Colors” in the Effects menu 
section in Chapter 6

Flip a cast member horizontally or 
vertically

“Flip Horizontal” and “Flip Vertical” in 
the Effects menu section in Chapter 6

Rotate a cast member “Rotate Left,” “Rotate Right,” and 
“Free Rotate” in the Effects menu 
section in Chapter 6

Create an outline of a cast 
member

“Trace Edges” in the Effects menu 
section in Chapter 6

Darken or lighten a cast member “Darken” and “Lighten” in the 
Effects menu section in Chapter 6

Smooth the edges of a cast 
member

“Smooth” in the Effects menu 
section in Chapter 6

Give a cast member the illusion of 
linear perspective

“Perspective” in the Effects menu 
section in Chapter 6

Slant a cast member as if it were 
bounded by a parallelogram rather 
than a rectangle

“Slant” in the Effects menu section in 
Chapter 6

Distort the shape of a cast 
member

“Distort” in the Effects menu section 
in Chapter 6
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Convert a QuickDraw text cast 
member to a bitmapped cast 
member

“Convert to Bitmap” in the Cast menu 
section in Chapter 6

Change the type of field Director 
displays a text cast member in

“Cast Member Info” in the Cast menu 
section in Chapter 6

Change the style of a button cast 
member

“Cast Member Info” in the Cast menu 
section in Chapter 6

Change the shape of a shape cast 
member

“Cast Member Info” in the Cast menu 
section in Chapter 6

Crop a film loop, linked Director 
movie, or digital video movie

“Cast Member Info” in the Cast menu 
section in Chapter 6

Open the application you used to 
create a cast member outside 
Director and edit the cast member

“Launch Editor” in the Cast menu 
section in Chapter 6

Other things you can do with cast members

What you can do Where to find out how
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Creating a sequence of cast members

There are times when you’ll need to make minor changes to a single 
cast member to create a sequence of cast members for frame-by-frame 
animation. For example, if you want to create an animation of a bird 
flying, you don’t have to redraw the entire bird for each stage of the 
sequence. You can duplicate the bird’s body, and then add a different 
set of wings to each copy to create each stage in the sequence.

To create a sequence of artwork:

1. Go to the cast window and select the cast member you 
want to base the sequence on.

2. Choose Duplicate Cast Member from the Cast menu (or 
press Command-D).
A copy of the cast member is placed in the next available cast 
member position.

Note It’s a good idea to give a duplicate cast member a new name. To rename a cast 
member, select it in the cast window, and then choose Cast Member Info from 
the Cast menu. When the Cast Member Info dialog box appears, type a 
name for the cast member, and then click OK.

3. Double-click the new cast member to display it in the paint 
window.

4. Use the paint tools to change the cast member.

5. Choose Duplicate Cast Member from the Cast menu again.
A copy of the cast member you just modified appears in the paint 
window (the copy is also added to the cast window). By starting 
with a copy of the cast member you just changed, rather than the 
first cast member in the sequence, you can pick up exactly where 
the last frame left off.
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6. Repeat the process until you’ve completed the sequence.

For information about adding a sequence of cast members to a movie, 
see “Recording with Cast to Time” in Chapter 2, “Creating 
Animations.” For information about turning a sequence of cast 
members into a film loop, see “Film loops,” also in Chapter 2.

Automatically creating in-between cast members

You can use the Rotate Left, Rotate Right, Free Rotate, Perspective, 
Slant, and Distort commands on the Effects menu to change a cast 
member’s shape or orientation.

Original cast member

After using Rotate
Left

After using
Perspective

After using Free 
Rotate

After using 
Distort

After using Rotate 
Right

After using Slant
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You can also stretch or squeeze a cast member in the paint window 
by selecting it and then holding down the Command key as you 
drag it.

After you’ve changed a cast member in any of those ways, you can 
use the Auto Distort command on the Effects menu. Auto Distort 
automatically generates the in-between positions in an animated 
sequence that starts with the cast member as it originally looks and 
ends as it looks after you’ve changed it. For example, you can use 
Auto Distort to create all the cast members you need to animate a 
wheel rotating.

Original cast member

After stretching After squeezing
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You can also use Auto Distort to generate the cast members that 
show a picture postcard fluttering to the bottom of the stage.

To create in-between cast members automatically:

1. Use the selection rectangle tool to select the cast member 
you want to start with.

2. Change the cast member’s orientation or shape.

p If you choose the Rotate Left or Rotate Right commands, 
Director rotates the cast member 90 degrees in the 
corresponding direction. You can drag any of the handles 
that appear at the four corners of the selection rectangle to 
adjust its orientation further.

p If you choose Free Rotate, Perspective, Slant, or Distort, 
drag any of the handles that appear at the four corners of the 
selection rectangle to adjust the cast member’s orientation.

p If you want to stretch or squeeze the cast member, hold 
down the Command key and then drag the cast member in 
the appropriate direction.
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3. While the selection rectangle is still visible, choose Auto 
Distort from the Effects menu.

The Auto Distort dialog box appears.

4. Type the number of in-between cast members you want, 
and click Create.
Director creates the new cast members and displays them in the 
cast window.

˛ Tip To add the entire sequence to the score in a single step, use the Cast to Time 
command. For information, see “Recording with Cast to Time” in Chapter 
2, “Creating Animations.”

Changing color depth

The most important thing to remember when you’re dealing with 
cast members and their color depth is this: The monitor you’re using, 
the movie you’re working on, and every cast member in the movie 
has its own color depth setting.

Changing a cast member’s color depth has an irreversible effect on 
the cast member, so it’s not a change you should make without 
advance planning. But it’s a valuable—and in some cases, an 
invaluable—tool: Changing a cast member’s color depth can save 
memory and improve performance, it can be one step in the process 
of creating cast members that look good on both Macintosh and 
Windows computers, and it’s essential when you want to colorize a 
black-and-white cast member.
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Choosing color depth

Color depth is, most simply, the number of colors you can use at any 
one time. The color depth of the monitor you’re using, the movie 
you’re working on, and every cast member in the movie can range 
from black and white to millions of colors.

A cast member’s color depth setting determines both the number of 
colors you can choose from when you’re creating a cast member and 
the colors that are displayed when the cast member appears on the 
screen. But it isn’t the only determining factor. Three interrelated 
factors are at work:

◆ The color depth of the cast member you’re working on

◆ The graphics display card and monitor you’re using

◆ The monitor settings that are in effect.

For example, if your graphics display card can’t display millions of 
colors, it doesn’t matter if you set the color depth of a cast member to 
allow you to use millions of colors. And it doesn’t matter if your 
graphics display card can display millions of colors and you’ve set the 
color depth of a cast member to allow you to use millions of colors if 
your monitor is set to display only black and white.

A monitor—depending on its type and the graphics display card that’s 
installed—can display 1-bit color (black and white), 2-bit color (4 
colors), 4-bit color (16 colors), 8-bit color (256 colors), 16-bit color 
(32,768 colors), 24-bit color (16.7 million colors), and 32-bit color 
(16.7 million colors and 8 bits of special effects). When you create a 
new movie or a new cast member, Director gives it the same color 
depth that the monitor is currently using. For example, if you have 
the monitor set to black and white, any new movie or cast member 
you create has a color depth of 1 bit. If you have the monitor set to 
millions of colors, any new movie or cast member you create has a 
color depth of 32 bits.
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Changing a movie’s color depth

A movie’s color depth is important only if you select Switch 
Monitor’s Color Depth to Match Movie’s (in the Preferences dialog 
box) before you save the movie. When that option is selected, 
Director automatically changes the monitor’s color depth setting to 
the color depth of the movie whenever you open the movie.

To select the option:

1. Choose Preferences from the File menu.
The Preferences dialog box appears.

2. Click the checkbox next to Switch Monitor’s Color Depth to 
Match Movie’s.

3. Click OK.
The new setting is saved when you save the movie.
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To change the color depth of a movie:

1. Go to the System’s Control Panel folder, and open the 
Monitor control panel.

2. Choose the color setting you want.
The colors displayed on the screen change as soon as you choose 
a new setting.

3. Go back to Director, and save the movie.
From now on, whenever you open the movie, the monitor will 
change to the current settings.
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Changing a cast member’s color depth

A cast member’s current color depth is displayed in the Cast Member 
Info dialog box. You can display the dialog box by selecting the cast 
member in the cast window and then choosing Cast Member Info 
from the Cast menu.

A bitmapped cast member’s color depth is also displayed in the paint 
window.

Changing a cast member’s color depth can save memory and improve 
performance. For example, it takes eight times as much memory to 
define the color of an 8-bit cast member as it does to define a 1-bit 
cast member, and it takes longer to animate an 8-bit cast member as 
well. Surprisingly, that’s true of an 8-bit cast member even when the 
only colors it uses are black and white. So, you can change the color 
depth of an 8-bit cast member that’s black and white to 1 bit without 
changing its appearance—and both save space and improve 
performance.

Color depth

Color depth
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˛ Tip A 1-bit cast member doesn’t have to be black and white. You can select a 
foreground and a background color for a 1-bit cast member when it’s on the 
stage (when the cast member is on the stage, it’s called a sprite). To select a 
foreground and a background color for a sprite, first select the cells in the score 
connected with the sprite (don’t select the cast member in the cast window). 
Then choose a foreground and a background color from the foreground and 
background color pop-up palettes in the tools window (don’t use the palettes in 
the paint window).

You can also improve performance by reducing the color depth of a 
cast member to the color depth of the monitor. For example, if 
you’re running a movie with 32-bit cast members on a monitor set to 
256 colors, change the color depth of the cast members to 8 bits. 
Performance slows down when the color depth of the cast members 
is higher than that of the monitor because every time Director 
displays a cast member, it needs to remap the colors from a 32-bit 
scheme to a 256-color palette.

You may also want to increase the color depth of a cast member. For 
example, if you import a black-and-white cast member into a color 
movie, you can change its color depth and then colorize it.
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To change a cast member’s color depth:

1. Go to the cast window, and select the cast member.
If you want to change the color depth of more than one cast 
member, select them all. Use Shift-click to select a range or 
Command-click to select cast members that aren’t next to each 
other.

2. Choose Transform Bitmap from the Cast menu.
The Transform Bitmap dialog box appears.

3. Choose the color depth setting you want from the Color 
Depth pop-up menu in the lower half of the dialog box.
For information about the other settings, see “Transform 
Bitmap” under “Cast menu” in Chapter 6, “Menu Reference.”
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4. If you’re changing the cast member to a lower color depth, 
select either Dither or Remap to Closest Colors.
The appearance of a cast member doesn’t change when you 
switch from a lower color depth to a higher one. A black-and-
white image remains black and white; changing its color depth 
just gives you the opportunity to add color to it. The appearance 
of a cast member may change when you switch from a higher 
color depth to a lower one. If you change the color depth of a 
black-and-white cast member from 8 bit to 1 bit, it won’t look 
any different. But if you change the color depth of a cast member 
with colors other than black and white from 8 bit to 1 bit, 
Director changes all the colors to either black or white. The 
Dither and Remap to Closest Colors options let you decide how 
you want Director to handle the change.

Dither tries to match the cast member’s original colors or shading 
by creating a blend of the colors available in the new color depth.

256 grays Dithered in black and white
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Remap to Closest Colors selects the colors available in the new 
color depth that are the closest to the cast member’s original 
colors or shading.

5. Click OK.
An alert appears, warning you that you can’t undo a change to a 
cast member’s color depth.

6. Click OK.
Director changes the cast member’s color depth.

Colorizing black-and-white bitmaps

You can colorize 1-bit cast members by increasing their color depth 
and then using the paint tools and ink effects to add color to them.

To colorize a 1-bit cast member:

1. Select the cast member in the cast window.

2. Choose Transform Bitmap from the Cast menu.
The Transform Bitmap dialog box appears.

3. Choose the color depth setting you want from the Color 
Depth pop-up menu in the lower half of the dialog box.
For information about each of the settings, see “Transform 
Bitmap” under “Cast menu” in Chapter 6, “Menu Reference.”

4. Click OK.
An alert appears warning you that you can’t undo a change to a 
cast member’s color depth.

256 grays Remapped to closest colors in 
black and white
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5. Click OK.
Director changes the cast member’s color depth.

6. Display the cast member in the paint window, and use any 
of the following techniques to colorize it:

p Use the paint bucket to fill solid areas with color.

p Use the Switch Colors command on the Effects menu to 
replace the foreground or background color with another 
color. For more information, see the next heading, 
“Switching colors in a cast member.”

p Use the Switch ink effect to paint over the foreground or 
background color with another color.

p Use the Lightest ink effect to paint over any color that’s 
darker than the color you’ve selected.

p Use the Darkest ink effect to paint over any color that’s 
lighter than the color you’ve selected.

p Use the Blend ink effect to create a translucent object 
superimposed over the object you’re colorizing. The color of 
the translucent object (which is the current foreground color) 
is blended with the foreground and background color of the 
object you’re colorizing.

Switching colors in a cast member

Switching colors in a cast member is a quick way to colorize a black-
and-white image. It’s also an invaluable technique for changing a 
color that’s scattered through an image to a different color.

The two methods for switching colors—the Switch Colors command 
on the Effects menu and the Switch ink effect—work essentially the 
same way. They change any pixel that matches the color you’ve 
selected in the paint window’s foreground color chip to the color 
you’ve selected in the destination color chip.
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When you switch colors, you change any pixel that is the current 
foreground color to the destination color.

You can use the Switch Colors command to switch colors 
throughout an entire cast member or in just an area you’ve selected. 
You can use the Switch ink effect to paint over an existing color with 
a new one.

Before the color has
been switched

After the color has 
been switched
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Switching colors using the Switch Colors command

To switch colors with the Switch Colors command:

1. Display the cast member in the paint window.

2. Select the eyedropper.

3. Use the eyedropper to click the part of the cast member 
that contains the color you want to change.
The color in the foreground color chip changes to the color you 
click.

4. Use the destination color chip to select the color that you 
want to change the current color to.

5. Use the selection rectangle or lasso to select the entire cast 
member or the area where you want the change to take 
effect.

6. Choose Switch Colors from the Effects menu.
The parts of the selected area that match the current foreground 
color change to the destination color.

Eyedropper

Destination color chipForeground color chip

Foreground color chip
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Switching colors using the Switch ink effect

To switch colors with the Switch ink effect:

1. Display the cast member in the paint window.

2. Select the eyedropper.

3. Use the eyedropper to click the part of the cast member 
that contains the color you want to change.
The color in the foreground color chip changes to the color you 
click.

4. Use the destination color chip to select the color that you 
want to change the current color to.

5. Select the paintbrush, and then choose Switch from the ink 
effects pop-up menu.

6. Paint the area you want to change.
The parts of the area that match the current foreground color 
change to the destination color.

Eyedropper

Destination color chipForeground color chip

Foreground color chip

Ink pop-up menu
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Combining several pieces of art into one full-screen 
background

On occasion you may find that you’re using several cast members to 
create a static background for animation. You can save space, 
improve performance, and use fewer channels in the score if you 
arrange the cast members on the stage, export the frame that contains 
them as a PICT file, and then import the PICT file and use it as the 
background.

To create a full-screen background from several cast members:

1. Arrange the cast members on the stage as you want them 
to appear.

2. Choose Export from the File menu.
The Export dialog box appears.

3. Choose PICT from the File Type pop-up menu (near the 
bottom of the dialog box).
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4. Under Range of Frames, select Current Frame, and then 
click the Export button.
The Save dialog box appears.

5. Type a name for the file, and then click Save.
Director saves the frame as a PICT image.

6. Choose Import from the File menu, and import the file 
you’ve just saved.
Director imports the full-screen image as a cast member. You can 
drag it to the stage to use as a background in channel 1.
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Working with cast members in the cast window

The main function of the cast window is to provide a place where 
you keep the cast members you plan to use in a movie. But it’s more 
than just that. You can also use the cast window to organize and 
arrange the cast—to name cast members, for example, to find and 
group them, and to delete those you aren’t using.

Organizing and arranging the cast members not only makes them 
easier and more efficient to use, it also puts at your disposal 
capabilities that wouldn’t be available otherwise. For example, once 
you’ve arranged a sequence of cast members next to each other in the 
cast window, you can align them and then flip through them in the 
paint window to see how they will look when you animate them.

You can also use the cast window to make movies load more 
efficiently and perform better. If you have two or more movies that 
use some of the same cast members, you can create a separate movie 
that contains nothing more than the cast window filled with the cast 
members the movies share.

The procedures in this section show how to name cast members, how 
to find cast members by name or by the palette they use, how to find 
and delete unused cast members, how to sort the cast, and how to 
create a shared cast.
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Other things you can do in the cast window

What you can do Where to find out how

Drag cast members from one 
position to another

“Moving cast members within the 
cast window” in the Cast window 
section in Chapter 5

Cut, copy, and paste cast 
members in the cast window

“Cut,” Copy,” and “Paste” in the Edit 
menu section in Chapter 6

Duplicate a cast member ”Copy” under “Edit menu” and 
“Duplicate Cast Member” in the Cast 
menu section in Chapter 6

Get information about a cast 
member

“Cast Member Info” in the Cast menu 
section in Chapter 6

Set when a cast member may be 
removed from memory if it’s not 
being used and memory is low

“Cast Member Info” in the Cast menu 
section in Chapter 6

Find cast members in the cast 
window by type

“Find Cast Members” in the Cast 
menu section in Chapter 6

Arrange bitmap cast members so 
they appear aligned in the cast 
window

“Align Bitmaps” in the Cast menu 
section in Chapter 6

Play a sound file “Cast Member Info” in the Cast menu 
section in Chapter 6

Mute the sound in a film loop, 
linked Director movie, or digital 
video movie

“Cast Member Info” in the Cast menu 
section in Chapter 6

Set a linked Director movie so 
Director follows the instructions in 
its Lingo scripts

“Cast Member Info” in the Cast menu 
section in Chapter 6

Set the way Director handles a 
digital video movie

“Cast Member Info” in the Cast menu 
section in Chapter 6

Change the size of the thumbnails 
in the cast window

“Cast Window Options” in the Cast 
menu section in Chapter 6

Change the number of cast 
members displayed in a row in the 
cast window

“Cast Window Options” in the Cast 
menu section in Chapter 6

Change the number of cast 
members that can be displayed in 
the cast window

“Cast Window Options” in the Cast 
menu section in Chapter 6
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Naming a cast member

Giving a cast member a name is a much better way of identifying it 
than using the number of the position in the cast window that it 
occupies. The name you give a cast member remains the same no 
matter where it appears in the cast window. The position that a cast 
member occupies may change if you rearrange cast members in the 
cast window or reorganize them with the Sort Cast Members 
command. Naming cast members also makes it easier to find and 
select cast members with the Find Cast Members command.

Naming cast members can also save you a great deal of work if you’ve 
created Lingo scripts that refer to cast members. If you’ve referred to 
cast members by number and you then rearrange them in the cast 
window, you have to change each script by hand so it refers to the 
number of the cast member’s new position. If you’ve referred to the 
cast members by name in the scripts, you don’t need to make any 
change to the scripts: a cast member’s name isn’t affected by changing 
its position in the cast window.

To name a cast member:

1. Open the cast window and select the cast member you 
want to name.

2. Choose Cast Info from the Cast menu.
The Cast Info dialog box appears.
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3. Enter a name in the Name entry box.
The name can be 31 characters long.

˛ Tip You can also use the cast member name field in any window where it appears 
to name or rename a cast member. (The cast member name field appears at the 
top of the cast window, the paint window, the text window, and so on.)

4. Click OK.
Director assigns the name to the cast member.

Note Director allows you to give two cast members the same name. If a Lingo script 
refers to a name you’ve given to more than one cast member, the script uses the 
cast member that appears first in the cast window.

Finding a cast member by name

If you’ve given a name to a cast member, you can use the name to 
find the cast member in the cast window using the Find Cast 
Members command. If a group of related cast members have a 
common element in their names (such as Bird 1, Bird 2, and so on), 
you can use the common element to find all of them at the same 
time.
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To find a cast member by name:

1. Make the cast window active.

2. Choose Find Cast Members from the Cast menu.
The Find Cast Members dialog box appears.

3. Select the second option, Whose Name Begins with.

4. Enter the name of the cast member you want to find.
You don’t have to type the entire name, just enough to 
distinguish it from other similar names.

5. Click Select.
Director finds the first cast member whose name matches the text 
you’ve entered and selects it in the cast window.

If you want to find and select all the cast members whose names 
match the text, click the Select All button.

Select this option Type the cast 
member’s 
name here
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Finding cast members by their palettes

Although different cast members in the same movie can use different 
color palettes, only one palette can be active at a time. That means 
there may be times when you need to find a group of cast members 
created with one palette and map them to the palette used by a 
different group of cast members so that you can use the two groups 
on the stage at the same time.

You can use the Find Cast Member command to identify which cast 
members use a particular palette. Once you’ve found the cast 
members that use a particular palette, you can then use the Transform 
Bitmap command to map them to a different palette.

To find the cast members that use a specific palette:

1. Make the cast window active.

2. Choose Find Cast Members from the Cast menu.
The Find Cast Members dialog box appears.

The third option has a pop-up menu that lists all the palettes 
currently available.

Select this option Choose a 
palette
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3. Choose the palette used by the cast members you want to 
find.

4. Make sure the button next to the third option is selected.

5. Click Select All.
The cast members that use the palette you chose appear 
highlighted in the cast window.

Note For information about mapping cast members to a different palette, see 
“Working with color palettes” in Chapter 3, “Working Behind the Scenes.”

Deleting unused cast members

When you finish a movie, you may find that you’ve created or 
imported cast members you’ve decided not to use in the movie. 
Deleting the unused cast members reduces both the space it takes to 
save the movie and the amount of memory the movie needs to run.

Note Use the Save and Compact command on the File menu to get rid of the 
unused space a cast member occupied before you deleted it. If you use the Save 
command, Director records that you’ve deleted the cast member, but it doesn’t 
reuse the space the cast member occupied.

You can identify the cast members that aren’t used in the score with 
the Find Cast Members command, and then use the Clear Cast 
Members command on the Edit menu to delete them.
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To delete unused cast members:

1. Make the cast window active.

2. Choose Find Cast Members from the Cast menu.
The Find Cast Members dialog box appears.

3. Select the fourth option, That Are Not Used in the Score.

4. Click Select All.
The thumbnails of the cast members that aren’t used in the 
current movie are highlighted.

Note The Unused in Score option selects all the cast members that aren’t used in the 
score. Just because a cast member isn’t used in the score, however, doesn’t 
mean it isn’t used in the movie. It may be a script that’s attached to a button 
or a graphic or sound that’s referred to only in a script. Before you delete all 
the cast members that are selected, make sure none of them is used in the 
movie somewhere outside the score.

5. Choose Clear Cast Members from the Edit menu.
Director deletes the unused cast members.

Select this option
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Cleaning up the cast

If you’re working with a large cast, after a while you may find gaps in 
the cast window where you’ve cut or cleared cast members. You can 
eliminate the gaps by sorting the cast.

The cast before and after cleaning up

Note When you clean up the cast, the positions many of the cast members occupy in 
the cast window will change—and so will the numbers currently associated 
with them. If you’ve written Lingo scripts that refer to cast members by 
number, it’s best to name those cast members and then change the references in 
the scripts to the cast members’ names. Otherwise, you’ll need to update the 
reference numbers one by one every time you clean up the cast.

To clean up the cast:

1. Make the cast window active.

2. Choose Select All from the Edit menu (or press Command-
A) to select the entire cast.
If you’re working with a movie that includes a shared cast, 
sorting the cast won’t affect the cast members that are part of the 
shared cast. To clean up the shared cast, you need to open the 
shared cast movie.
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3. Choose Sort Cast Members from the Cast menu.
The Sort Cast Members dialog box appears.

4. Choose the final option, By Order in Cast.

5. Click Sort.
Director reorders the cast members and moves all the empty cast 
member positions to the end.

The score automatically adjusts to the new cast member positions so 
the movie doesn’t change.
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Creating a shared cast

If you find that you’re working on two or more related movies that 
share many of the same cast members, you can create a special movie 
that contains just the cast members the movies share. What makes the 
movie special is its name—SHARED.DIR. When you open any 
movie that’s in the same directory as a movie named SHARED.DIR, 
the cast members in SHARED.DIR automatically appear in the 
movie’s cast window. A shared cast is especially useful for storing the 
background graphics, scripts, buttons, sounds, cursors, and fonts that 
several movies all make use of.

Sharing cast members saves disk space because you don’t have to save 
the same cast members in several different movies. Sharing cast 
members can also save time when you’re opening a movie: Once a 
movie has opened the shared cast and loaded it into memory, the 
shared cast remains in memory. If you then open another movie, it 
doesn’t have to load the shared cast into memory a second time. 
(However, if the new movie needs the memory the shared cast is 
using, it will replace the shared cast.)

For more information about shared casts, see “Frequently Asked 
Questions” in Tips & Tricks.
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To create a shared cast:

1. Choose New from the File menu (or press Command-N) to 
create a new movie.

2. Select a slot in the cast window that’s far enough from the 
top that it will appear below any cast members that belong 
to the movies that will use the shared cast.
You need to leave enough room at the top of the cast window to 
accommodate the entire cast of any single movie that uses the 
shared cast.

For example, suppose three movies use the shared cast. One has 
its own cast of 50 cast members (excluding the shared cast), 
another has its own cast of 75 cast members, and a third has its 
own cast of 100 cast members. To accommodate all 3 movies, 
you need to leave room for at least 100 cast members at the top 
of the cast window because that’s the amount of space the largest 
cast occupies.

A shared cast as it appears in the cast window in SHARED.DIR
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The same shared cast as it appears in the cast window of one of the movies that 
shares it

3. Import the cast members that you want the movies to 
share.

4. Save the movie. Name it SHARED.DIR.
Make sure SHARED.DIR is in the same directory as the movies 
that you want to share its contents.

When you open any movie that’s in the same directory as 
SHARED.DIR, the cast members in SHARED.DIR automatically 
appear in the movie’s cast window. The labels of shared cast members 
appear in italics. You can use shared cast members just as you would 
any other cast members in the movie’s cast window. You can also 
edit shared cast members just as you would any other cast member in 
the movie’s cast. When you save the movie, Director saves changes to 
the movie’s own cast as part of the movie and changes to the shared 
cast as part of SHARED.DIR.
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If you open a movie that’s in a directory that has no shared cast, the 
shared cast that’s currently in memory is removed from memory. If 
you open a movie that’s in a directory that has its own shared cast 
movie, the new shared cast is loaded into memory, and the old shared 
cast is removed.

Note If you’ve created a shared cast movie with an old version of Director, before 
you can use it with a movie created with the current version of Director you 
need to open the movie in the current version of Director, rename it 
SHARED.DIR, and save it as a new movie.
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Working with cast members in the score and on the stage

You can make a cast member part of a movie by dragging it either to 
the stage or to a cell in the score. That’s because the score is another 
view of whatever appears on the stage. But remember that cast 
members include not just the images you move around the stage, but 
sound effects and music, color palettes, and the Lingo scripts that 
provide interactivity and control of a Director movie. There’s a place 
for every type of cast member in the score, and as a result, the score 
contains much more than what appears on the stage—it includes 
everything that’s part of a movie.

Some types of changes to a movie—such as adding or deleting a 
sound effect—appear only in the score. Changes that affect the 
appearance of the stage, on the other hand, are always reflected both 
on the stage and in the score. For example, if you make a change 
directly on the stage—say, move a block of text—Director records 
the change in the score automatically. If you make a change in the 
score—say, apply an ink effect to a graphic—Director immediately 
redraws the graphic on the stage to show the new information 
recorded in the score.

Palettes channel
(for color palettes)

Sound channels
(for sound effects

and music)

Sprite channels
(for graphics, text,

buttons, and digital
video)

Script channel 
(for Lingo scripts)

Transition channel 
(for transition settings)

Tempo channel 
(for tempo settings)
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The procedures in this section show how to place a cast member on 
the stage, how to stretch and squeeze a sprite, how to use the score’s 
ink effects, and how to clear a sequence of frames.

Other things you can do in the score and on the stage

What you can do Where to find out how

Select cells “Selecting cells” in the score window 
section in Chapter 5

Select an entire channel “Selecting cells” in the score window 
section in Chapter 5

Extend a selection “Selecting cells” in the score window 
section in Chapter 5

Select all the cells in a frame “Selecting cells” in the score window 
section in Chapter 5

Position an insertion point down 
an entire frame

“Selecting cells” in the score window 
section in Chapter 5

Select discontinuous ranges of 
cells

“Selecting cells” in the score window 
section in Chapter 5

Drag a cast member from the 
paint window to the score or the 
stage

“Place button” in the paint window 
section in Chapter 5

Clear cast members on the stage “Delete Sprites” in the Score menu 
section in Chapter 6

Cut, copy, paste, and clear cells in 
the score

“Cut,” “Copy,” “Paste,” and “Clear” 
in the Edit menu section in Chapter 6

Reposition a cast member with 
the Tweak window

“The tweak window” in Chapter 5

Specify the exact location of a cast 
member on the stage

“Sprite Info” under “Score menu” in 
Chapter 6

Apply ink effects to cast members 
on the stage

“Ink pop-up menu” under “The Score 
window” in Chapter 5
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Placing cast members on the stage

Once you’ve imported or created a cast member, you need to place 
the cast member on the stage or in the score to make it part of the 
movie.

When you place a cast member on the stage, you don’t move the cast 
member bodily from the cast window to the stage as you put a 
chessman on a chessboard. Placing a cast member on the stage creates 
a new element: a sprite. The cast member remains in the cast 
window, and the sprite—an image of the cast member—appears on 
the stage in its stead.

A cast member and a sprite aren’t identical. A cast member is a 
template for a sprite. When you drag a cast member to the stage, it’s 
like making a copy of a form letter: the master letter remains 
unchanged, but the copy gets filled in with specific information. The 
specific information the sprite gets “filled in with” includes such 
things as its location on the stage, any ink you apply to it, any change 
you make to its size, and so on. You can have more than one sprite 
based on the same cast member, each a separate image of the cast 
member with a different location on the stage, a different ink applied 
to it, a different size, and so on.

To place a cast member on the stage:

þ Drag the cast member from the cast window to the stage.
A sprite representing the cast member appears on the stage in the 
current frame of the animation.

˛ Tip To drag a sequence of cast members to the stage and place them in consecutive 
cells in a channel, hold down the Option key as you drag.
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When Director creates the sprite that represents a cast member, it 
simultaneously records information about the sprite in a cell in one of 
the channels of the score. The information that appears in the score 
depends on the display option selected on the Display pop-up menu.

The default display option is Cast. When it’s selected, the number of 
the cast member that the sprite represents appears in the cell.

The cell where Director has recorded the information about the 
sprite corresponds to the single frame of the movie where the sprite 
currently appears. Remember that every frame in the score represents 
a moment in time. For a sprite to appear on the stage during a given 
period of time, information about the sprite has to appear in every 
frame of the score that covers that period. You don’t have to drag the 
cast member to the stage every time you want it to appear in a 
frame—Director has many techniques you can use to fill the frames of 
a movie with the cast members you want to appear on the stage. The 
techniques are covered in Chapter 2, “Creating Animations.”

The channel where Director has recorded the information about the 
sprite has its own importance. A sprite recorded in a channel closer to 
the top of the score than the channel where another sprite is recorded 
appears behind the other sprite. The relative position of one sprite’s 
channel to another sprite’s is called the sprite’s foreground priority. 
For more information, see “Changing layering” in Chapter 2, 
“Creating Animations.”

Information about a sprite

Display pop-up menu
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˛ Tip When the score is active, press the Backspace or Delete key to remove a sprite 
that’s selected from both the stage and the score. The cast member that 
corresponds to the sprite isn’t affected.

To place a cast member in the score:

þ Drag the cast member from the cast window to the channel 
and frame where you want it to appear.
Director places the cast member’s sprite in the center of the stage.

You can also place a cast member on the stage or in the score by 
dragging it from the paint window. Just point to the Place button at 
the top of the paint window, hold down the mouse button, and drag 
to the spot on the stage where you want the cast member to appear. 

Stretching and squeezing a sprite

You can squeeze or stretch a sprite to change its shape. The change 
you make to the sprite has no effect on the cast member the sprite 
represents or on any other sprites based on the same cast member.

Original cast member

After stretching After squeezing
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To stretch or squeeze a sprite:

1. Select the sprite or the cell in the score that corresponds to 
the sprite.
A selection rectangle with handles at the edges and corners 
appears around the sprite.

2. Drag any of the handles.
When you drag the handle, the cast member stretches or squeezes 
in the direction you drag.

◆ Stretching or squeezing a sequence of sprites. The 
preceding technique works only for a single sprite. If you’ve 
already created a sequence of sprites and you want to stretch or 
squeeze them all in the same way, you need to select the entire 
sequence in the score, not just a single sprite on the stage. For 
more information, see “Changing a sequence of sprites.”

◆ Animating a stretch or a squeeze. If you want to animate a 
sprite as it stretches or squeezes, see “Stretching and squeezing a 
sprite with in-betweening” in Chapter 2, “Creating 
Animations.”

◆ Speeding up animation. When you use a cast member that’s 
stretched, your animation may slow down. Try using the Auto 
Distort command to generate a series of stretched cast members.

Changing a sequence of sprites

Occasionally you’ll find that after you created a sequence of sprites in 
a channel, you want to change something about the sequence. If it’s a 
series of different sprites—perhaps a figure walking—you may want 
to change the position of the sprites on the stage; if it’s a single sprite, 
you may want to change its shape or size. You can make the same 
change simultaneously to every sprite in the sequence by treating the 
series of cells in the score as a group.
Working with Cast Members 81



To change a sequence of sprites:

1. Select all the cells that are part of the sequence.
If the sequence is made up of sprites all based on a single cast 
member, you can double-click any cell in the sequence to select 
the entire sequence. You can also double-click the channel 
number at the left edge of the score to select the entire channel.

When you look at the stage, you’ll see one cast member selected 
on the stage.

2. Make whatever change it is you want to make to the sprite.
Although it appears that you’re changing only the sprite in the 
current frame, you’re making the change to the information 
about the sprite in every cell you’ve selected.

You can select more than one channel if the change you want to 
make—for example, repositioning a group of sprites—applies to the 
sprite in each channel. 

˛ Tip When you need to move the sprites precisely, use the Tweak window to move 
them a specific number of pixels. You can also use the arrow keys to move the 
sprites one pixel at a time.

Using inks in the score

The score’s ink effects are similar to the ink effects in the paint 
window but they serve a different purpose. You can apply the paint 
window ink effects to cast members only as you create them in the 
paint window. Once applied, those effects are permanent.

The score’s ink effects determine how a sprite looks when it’s on the 
stage. As a result, the score’s ink effects don’t change the appearance 
of a cast member permanently. For example, you can apply ink effects 
that make a sprite’s background color transparent or that changes any 
black pixels in it to white. But those changes affect the sprite only in 
the specific cells where you’ve applied the ink effect. If you drag the 
same cast member to the stage to create a second sprite and apply a 
different ink effect to the new sprite, it may look completely different 
from the first.
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Whenever you select cells in the score, the Ink pop-up menu changes 
to show the ink currently in effect. If more than one ink is in effect in 
the selection, the menu is blank.

For a quick overview of the effect each ink creates, take a look at the 
sample movie Ink_FX. To play it, go to the Macromedia Director 4.0 
folder, open the Tutorials folder, and then the Learning Director 
folder. When you’re finished watching the movie, press Command-
period to stop it

To apply ink effects to a sprite:

1. Make the score window active.

2. Select the cells that contain the sprite you want to apply 
the ink effect to.

3. Choose an ink effect from the Ink pop-up menu.
Director applies the ink effect to the sprite you’ve selected.

˛ Tip You can apply an ink effect to a sprite on the stage without opening the score. 
Select the sprite on the stage, position the pointer on it, hold down the 
Command key, and then press the mouse button. The Ink pop-up menu 
appears. Choose an ink effect and release the mouse button. If more than one 
sprite is selected, Director applies the ink effect to all of them.

Ink pop-up menu
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Clearing a sequence of frames

To clear a sequence of sprites that occupies more than one frame:

1. Make the score active.

2. Select the cells you want to clear.

˛ Tip If you want to clear an entire channel, select it by double-clicking the channel 
number at the left of the channel.

3. Choose Clear Cells from the Edit menu (or press Backspace 
or Delete).
The entire sequence of sprites is cleared. In the cast window, the 
cast members that correspond to the sprites are unaffected. 
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Chapter 2

Creating Animations

The animation that appears in a Director movie can take many 
forms. No matter how varied the forms seem, however, almost 
all animation can be reduced to a few basic types:

◆ Changing a sprite’s position on the stage (for example, 
making the moon appear to rise)

◆ Alternating a sequence of sprites (for example, making a 
flower appear to open)

◆ Cycling through a sequence of colors (for example, creating 
the illusion of a sunrise by making gradual changes to the 
color of the sky).

You can also combine the basic types of animation to create 
other animation effects. For example, you can create the 
appearance of a bird flying by alternating a sequence of sprites as 
you change the position of each sprite slightly in relation to the 
one before it.
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Director provides you with four basic techniques for creating 
animation:

◆ In-betweening. In-betweening—also called key-frame 
animation—is an ideal technique for moving a single sprite along 
a straight, curved, or circular path. You position the sprite on the 
stage at the key points that define the path you want it to follow, 
and then have Director fill in all the in-between positions. You 
can also use in-betweening to gradually change a sprite’s size, 
shape, or color, or to gradually blend it with the background.

◆ Frame-by-frame animation. Frame-by-frame animation is the 
most time-consuming way to go about creating animation, but 
it’s also the way to get the most refined, precise results. Frame-
by-frame animation is best for animation that involves alternating 
a sequence of sprites as they move across the stage. It’s also ideal 
when you’re animating several sprites at once and you want to 
keep their movements coordinated.

◆ Auto animation. Auto animation is a quick way of creating such 
things as animated bulleted lists and bar charts or “text crawls” 
(text that scrolls up from the bottom of the screen, such as the 
credits at the end of a movie). The effects you can achieve with 
auto animation are limited, but you can customize them—which 
makes them a quick starting point for more elaborate animation 
effects.

◆ Real-time recording. Real-time animation is the quick and dirty 
approach to animation. The process is simple: as you drag a sprite 
around the stage, Director records its motion. When you play the 
animation back, the sprite follows the path you traced for it on 
the stage. Real-time recording doesn’t provide much precision or 
flexibility, but it’s a quick way to get results.

Director’s animation techniques aren’t exclusive. In fact, when you 
use them in conjunction with each other, you can take advantage of 
the strengths each one has and create animation that’s far more 
sophisticated than anything you could produce with any of them 
alone.
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Basic techniques

This section covers the basics of auto animation, real-time recording, 
frame-by-frame animation, and in-betweening.

The section shows how to create animation with the Space to Time 
and Cast to Time commands and how to link one animated sequence 
with another using the Paste Relative command. The section 
demonstrates how to use in-betweening to add a static background to 
animation, to move a sprite across the stage, to accelerate or 
decelerate a sprite, to change two or more aspects of a sprite 
simultaneously, and to move a sprite in a curved line or a circle. The 
section also shows how to add and cut time from a movie, how to 
shift animation in time, and how to change a sprite’s foreground 
priority.

Other things you can do with animation

What you can do Where to find out how

Align cast members in the paint 
window to test animation

“Align Bitmaps” in the Cast menu 
section in Chapter 6

Reverse an animation sequence “Reverse Sequence” in the Score 
menu section in Chapter 6

Move the playback head to any 
frame in the movie

“Moving around the score” in the 
score window section of Chapter 5

Play a portion of a movie 
repeatedly to check the animation

“Selected Frames Only” in the 
section on the control panel in 
Chapter 5

Display the part of the score 
where the playback head is 
currently located

“Moving around the score” in the 
score window section of Chapter 5

Change the way the score 
notation is displayed

“The Display pop-up menu” in the 
score window section in Chapter 5

Select various elements in the 
score in various ways

“Selecting cells” in the score window 
section in Chapter 5
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Selecting where you want to record animation

Before you create animation, you need to select the place in the score 
where you want Director to record the information about the 
animation. You can select the spot in any of the following ways:

◆ Click a frame number at the top of the score to set an insertion 
point. Director records the animation in the first channel that’s 
available, starting at the insertion point.

◆ Select a single cell. Director records the animation in the channel 
where the cell is located, starting at the cell. If any of the cells it 
needs to record the animation already contain information, 
Director replaces the existing information with the animation.

◆ Select a range of cells, Director records only as much animation 
as will fill the number of cells you’ve selected. If any of the cells 
already contain information, Director replaces the existing 
information with the animation.

If you don’t make a selection or set an insertion point, Director 
records the animation in the first channel that’s available, starting with 
the frame where the playback head is located.

Insert and delete frames in a 
movie

“Insert Frame” and “Delete Frame” 
in the Score menu section in 
Chapter 6

Change the stage background 
color

“Stage background” in the section on 
the control panel in Chapter 5

Create transitions between 
frames

“Working with transitions” in 
Chapter 3

Other things you can do with animation

What you can do Where to find out how
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Using auto animate

You use auto animate to create special animated effects for charts and 
text. You can automatically create effects such as animated bar charts, 
bullet charts, and text that zooms in or out. You can use auto animate 
effects alone or in combination with background images. For 
information about how each of the auto animate effects works, see 
“Auto Animate” under “Score menu” in Chapter 6, “Menu 
Reference.”

Customizing an auto animate effect

Since auto animate provides a quick way to generate a path for a 
block of text or a bullet to follow, you can use it as a short cut for 
creating paths for other sprites. For example, you can use the Banner 
effect to create a path across the screen and then replace the text in 
the banner with a different sprite. The new sprite then follows the 
path you created for the text.

To customize an auto animate effect:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Create the effect with the Auto Animate command.
For details about the Auto Animate command, see “Auto 
Animate” under “Score menu” in Chapter 6, “Menu 
Reference.”
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3. Go to the cast window and select the cast member you 
want to use to replace the cast member that’s currently 
part of the animation.

4. Go to the score and select the cells that contain the 
animation.

5. Choose Switch Cast Members from the Score menu (or 
press Command-E).
Director replaces the original cast member with the one you’ve 
selected in the cast window.

When you run the animation, the new cast member follows the path 
you created with auto animate.

Real-time recording

You can create animation by recording the movement of a sprite as 
you drag it across the stage. The real-time recording technique is 
especially good for simulating the movement of a cursor. If you select 
Trails in the score, you can also use real-time recording to simulate 
handwriting. (For more information, see “Trails check box” in the 
score window in Chapter 5, “Window Reference.”)

Trails checkbox
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For better control when you’re recording in real time, use the tempo 
control in the control panel to record at a speed that’s slower than 
normal. (For more information, see “The Control Panel” in Chapter 
5, “Window Reference.”) You can adjust the speed with a different 
tempo setting to make the animation look normal when you play the 
movie back. (See “Adding a tempo setting” in Chapter 3, “Working 
Behind the Scenes.”)

To record in real time:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. In the cast window, select the cast member you want to 
animate.
Make sure you select a cast member in the cast window—don’t 
select a sprite on the stage. And don’t drag the cast member from 
the cast window to the stage—just select it. 

To record in a specific range of frames, select the frames, and 
then click the Selected Frames Only button on the control panel.

Tempo control
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3. Hold down the Control key and the spacebar.
The real-time record indicator appears next to the channel where 
you’re recording.

˛ Tip If you want to record in a different channel, hold down the Control key and 
the spacebar and click another channel indicator.

The recording begins as soon as you click the mouse button in 
the next step, so be prepared to move the mouse.

4. Point to the spot on the stage where you want the 
animation to start, press the mouse button to begin 
recording, and drag the pointer across the stage. 
Director records the path you move the pointer along.

If there are sprites in any of the other channels in the first frame 
of the animation, Director records their positions in each frame 
where it records the position of the sprite you’re moving.

5. Release the mouse button to stop recording.

If you don’t like the animation, you can choose Undo Score from the 
Edit menu (or press Command-Z) and try again. Or you can record 
different “takes” in different channels, and then use the one you like 
best.

Real-time record
indicator
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Step recording

Step recording is the process of animating by taking snapshots of the 
position of a sprite in successive frames of a movie. You record the 
position of a sprite in a frame, step forward to the next frame, move 
the sprite to its new position, record the position, step forward to the 
next frame, and so on until you’ve completed the animation.

It’s important as you create the animation to keep track of which 
sprites Director is recording in each new frame. The easiest way to do 
that is to select every sprite you want to record. When you select a 
sprite under normal conditions, Director displays a thin selection 
rectangle around the sprite. When Director is recording a sprite in 
step-recording mode, it changes the thin selection rectangle around 
the sprite to a thick selection rectangle so you can see what’s being 
recorded and what isn’t.

It’s important to remember, however, that what determines whether 
a sprite is being recorded is not a thick selection rectangle around it, 
but a step record indicator next to the channel the sprite occupies. 

A thick selection rectangle appears around a sprite that Director is 
recording only if the sprite happens to be selected. The step record 
indicator, on the other hand, always appears next to the channel the 
sprite occupies when Director is recording it.

Step record
indicator
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To step-record animation:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag a cast member from the cast window to the stage.
A sprite corresponding to the cast member appears on the stage. 
The thick selection rectangle around the sprite indicates that 
Director is recording the sprite’s position.
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The step record indicator appears next to the channel where 
Director is recording information about the sprite. 

If you want to record a sprite that’s already on the stage, click it 
to select it, and then press the Option key and click the sprite 
again to start recording. If you want to record other sprites 
already on the stage, Shift-click each of them to select them, then 
Option-click each of them to start recording them. Each sprite 
you select is highlighted with a thick selection rectangle and the 
step record indicator appears next to the channel each of the 
sprites occupies.

You can also record a sprite by Option-clicking the number to 
the left of the channel that the sprite occupies. (A thick selection 
rectangle won’t appear around the sprite, however, unless you’ve 
selected the sprite.)

If you want to stop recording a sprite, Option-click it on the 
stage if it’s selected, or Option-click the number to the left of the 
channel the sprite occupies.

Step record indicator
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3. Choose Step Forward from the Edit menu or click the Step 
Forward button on the control panel.
The movie advances to the next frame. The position of any sprite 
highlighted with a thick selection rectangle is recorded in the 
new frame.

If a sprite you’re recording is already present in the next cell of 
the channel where you’re recording its position, Director replaces 
the sprite’s old position with its current position.

Note As soon as you move the animation in any way other than stepping (for 
example, by using Rewind, Play, or Back, or by dragging the playback head), 
recording stops.

4. Drag the sprite to reposition it. 
You can also stretch the sprite or switch it with a sprite that 
corresponds to a different cast member.

5. Choose Step Forward from the Edit menu or click the Step 
Forward button in the control panel again.
The movie advances to the next frame, and any sprite highlighted 
with a thick selection rectangle is recorded again there.

6. Repeat steps 3 and 4 until you’ve completed the sequence 
you want to record.

7. Choose Rewind or Step Forward from the Edit menu (or 
click the Rewind or the Step Forward button in the control 
panel) to stop recording.
Move the playback head to the beginning of the animation and 
run the movie to see how it looks.
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Switching cast members when step recording

You can switch cast members while step recording when you have a 
sequence of cast members—such as a bird flying—that appears in 
successive frames.

A sequence of cast members 

Before you start recording the animation, make sure you have the 
sequence of cast members assembled in the cast window. 

To switch cast members while step-recording:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Make the cast window active, and drag the first cast 
member in the sequence to the stage.

3. Choose Step Forward from the Edit menu or click the Step 
Forward button in the control panel.
Step Forward copies the sprite you just placed on the stage (and 
the information about its position on the stage) to the next frame. 
There are now two frames of animation, and both frames contain 
the first cast member in the sequence.

The sprite in the second frame is still selected. The next step in 
the process is to switch cast members—to replace the sprite that 
corresponds to the first cast member in the sequence with a sprite 
that corresponds to the second cast member in the sequence.
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4. Select the second cast member in the sequence in the cast 
window, and then choose Switch Cast Members from the 
Score menu (or press Command-E). 
Director replaces one sprite with the other. 

5. Drag the second sprite to reposition it.
For example, if you’re working with a sequence of cast members 
that shows a bird flying, you’d move the second sprite in the 
direction the bird is flying to create the illusion of flight.

6. Repeat steps 3, 4, and 5 for the remaining cast members in 
the sequence.

˛ Tip Option–double-clicking a cast member in the cast window switches it with the 
cast member that’s in the cell or cells currently selected in the score.
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Recording with Space to Time

When you have an animated sequence that’s made up of a series of 
cast members, you’ll probably find yourself arranging the 
corresponding sprites on the stage in a single frame so you can see 
their positions in relation to one another. Once you’ve finished 
arranging the sprites, you’ll find the Space to Time command comes 
in handy. You can use the command to move the sprites from several 
channels in one frame to consecutive cells in a single channel.

Space to Time shifts cast members from one frame to one channel
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To use the Space to Time command:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag the cast members from the cast window one by one, 
in the order they appear in the sequence, and place each 
one on the stage at the spot where you want it to appear in 
the animation.
For example, if the animation involves an object moving from 
left to right, place the sprite corresponding to the first cast 
member in the left-most position, the sprite corresponding to the 
next cast member a bit to the right, the sprite corresponding to 
the next cast member farther to the right, and so on.

As you position the sprites on the stage, Director places each one 
in a separate channel in the score.

3. In the score, select all the sprites that are part of the 
sequence.

4. Choose Space to Time from the Score menu.
The Space to Time dialog box appears. It lets you set the number 
of frames you want between each sprite and the one following it.

5. Type the interval you want, and then click OK.
Director rearranges the sprites so that instead of being arranged 
from top to bottom in a single frame, they’re arranged in 
sequence from left to right in a single channel.

If you’ve spaced the cells so that there are blank cells between them, 
you need to use one of the In-Between commands to fill in the blank 
cells. For information, see “In-Between Linear” and “In-Between 
Special” under “Score menu” in Chapter 6, “Menu Reference.”
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˛ Tip Space to Time is a fast way to set up the points you need for a curved in-
between. Arrange the cast members in one frame, choose Space to Time from 
the Score menu, and add 10 to 20 cells between each cast member to produce 
a smooth curve.

Recording with Cast to Time

When you have a series of cast members that are all part of an 
animated sequence—such as a series of cast members that shows a 
bird in flight—you can use the Cast to Time command to move 
them to the score in a single step and have Director automatically 
arrange them in subsequent frames in a single channel. 

A series of cast members selected in the cast window

To add a sequence of cast members to the score:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Make the cast window active.

3. Select the series of cast members to be added to the score.

4. Choose Cast to Time from the Cast menu (or hold down 
Option and drag the cast members to the stage).
The selected series of cast members is added to the score. 
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˛ Tip Sometimes the series of cast members that’s placed in the score jumps about the 
stage when you play the movie. That’s because the registration points of the 
cast members aren’t set properly. For information about aligning registration 
points, see “Registration tool” under “The paint window” in Chapter 5, 
“Window Reference.” 

Linking a sequence with Paste Relative

You’ll often find that a long animated sequence consists of just one 
short animated sequence repeated several times. You can use the 
Paste Relative command to link a series of short sequences together 
into one continuous motion across the stage. The benefit of Paste 
Relative is that it automatically positions the beginning of one 
sequence precisely where the preceding sequence ended.

Use Paste Relative to make a sequence move all the way across the stage
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To paste one sequence relative to another:

1. Make the score active.

2. Select the cells that make up the sequence.

3. Choose Copy Cells from the Edit menu (or press
Command-C).

4. Select the cell immediately after the last cell in the 
sequence.

5. Choose Paste Relative from the Score menu (or press 
Command-Shift-V).
Director positions the beginning of the copy precisely where the 
existing sequence ends.

You can repeat the process as many times as you need to create one 
continuous animation across the stage. 

˛ Tip If you want to eliminate the pause that sometimes happens between copies of a 
sequence that are pasted together, end the original sequence with the same cast 
member it begins with. Then, copy the sequence, select the last cell of the 
sequence in the score, and choose Paste Relative. The first cast member at the 
beginning of the copy replaces the cast member at the end of the original 
sequence, linking the two together seamlessly.
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In-betweening

Director has two commands for in-betweening: In-Between Linear 
and In-Between Special.

◆ In-Between Linear. Once you’ve set the beginning and ending 
positions of a sprite that you want to move in a straight line, use 
the In-Between Linear command to fill in the intermediate 
positions. You can also use In-Between Linear to fill a channel 
with the stationary background for an animation or to fill a sound 
channel with a sound effect or music.

◆ In-Between Special. Use the In-Between Special command to 
create animation that follows a zig-zagging, curved, or circular 
path—or that speeds up at the beginning or slows down at the 
end. You can also use In-Between Special to animate a sprite as 
its size, shape, orientation, color, or blend value changes. If you 
want to change two aspects of a sprite in a single animated 
sequence—for example, its location and its size—use In-Between 
Special to create the intermediate stages that combine both 
changes.

Both commands appear on the Score menu.

Adding stationary cast members to a movie

Even though the important part of most Director movies is the 
animation they contain, most movies also contain backgrounds, text, 
and other cast members that remain static. Use the In-Between 
Linear command to fill a series of frames in a movie with stationary 
cast members. 
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To set a stationary cast member with In-Between Linear:

1. Select the place in the score where you want Director to 
start recording the position of the cast member.
For example, if you’re creating a background, select a cell in 
channel 1. (For more information, see “Selecting where you 
want to record animation” earlier in this chapter.)

2. Drag the cast member from the cast window to the stage.
A sprite corresponding to the cast member appears on the stage.

3. In the score, select the range of cells where you want the 
cast member to appear.
Make sure the first cell in the range is the one where the sprite 
currently appears. The rest of the cells should be empty.

Creating a stationary background with in-betweening

Background
sprite

Sprite
information
in the score
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4. Choose In-Between Linear from the Score menu.
Director fills the cells you’ve selected with copies of the sprite in 
the first cell of the range.

The channel that a sprite occupies in the score determines whether it 
appears in front of or behind other sprites on the stage. If you add a 
background to a movie and it ends up in front of other sprites, the 
background is in the wrong channel. For more information, see 
“Changing layering” later in this chapter.

Moving sprites with in-betweening

You can use In-Between Linear not only to fill a series of frames with 
a stationary image, but to make an object move smoothly across the 
stage in any direction from one point to the next. All you have to do 
is set the starting and ending points of the animation. In-Between 
Linear does the rest. The frames that contain the beginning and 
ending points of the animation are called key frames.

Note Make sure that Playback Head Follows Selection is selected in the Score 
Window Options dialog box before you start the following procedure.

To move a sprite with In-Between Linear:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag a cast member from the cast window to the stage, and 
place it at the point where you want the cast member’s 
movement to start.
A sprite corresponding to the cast member appears on the stage.
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3. Click the score to make it active.
The cell that’s selected in the score contains information about 
the sprite’s position on the stage.

The easiest way to set the end point of the animation is to copy 
the cell containing the sprite’s starting point, paste it in the cell 
that marks the end of the animation, and then move the copy of 
the sprite to its final position.

To set the end point:

1. Select the cell in the score that contains the sprite at the 
beginning of the animation.

2. Choose Copy Cells from the Edit menu (or press
Command-C).

3. Select the cell where you want the animation to end.
Make sure the cell is in the same channel as the cell where the 
animation begins. The stage changes to reflect the way it’s set up 
in the frame where the cell is located.

4. Choose Paste Cells from the Edit menu (or press
Command-V).
The sprite appears on the stage.

5. Drag the sprite across the stage to the point where you 
want the animation to end.

In-Between Linear
creates the

intermediate positions
in these cells
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To in-between the animation:

1. Select the cell where the animation begins.

2. Shift-click the cell that marks the end of the animation 
sequence to select the entire range.

3. Choose In-Between Linear from the Score menu (or press 
Command-B).
The cells fill with the in-between positions of the animation.

When you play the movie, the sprite moves smoothly in a straight 
line between the starting and ending points you set. See “Adjusting 
the path of an in-betweened sprite” later in this chapter for an easy 
way to change the sprite’s path.

In-betweening with acceleration and deceleration

You may find that an animated sequence looks more realistic if it 
gradually comes up to full speed at the beginning or gradually slows 
down at the end. You can use the In-Between Special command to 
ease into or ease out of an animated sequence by accelerating the 
motion at the beginning of the sequence or decelerating the motion 
at the end.

To create an animation that accelerates or decelerates:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag the cast member you want to animate from the cast 
window to the stage.
A sprite corresponding to the cast member appears on the stage.

3. Position the sprite on the stage at the point where you 
want the animation to start.

4. In the score, select the cell where you want the animation 
to end.
Make sure the cell is in the same channel that contains the sprite 
you just placed on the stage.
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5. Drag the same cast member from the cast window to the 
stage and position it on the stage where you want the 
animation to end.

6. Select the cell that contains the sprite that marks the 
beginning of the animation.

7. Shift-click the cell that contains the sprite that marks the 
end of the animation to select the range between them.

To in-between the animation:

1. Choose In-Between Special from the Score menu.
The In-Between Special dialog box appears.

2. Make sure Location is the only In-Between option selected.
You can also ease into and out of any of the other types of 
animation: a change of size, foreground or background color, or 
blend value.

3. Type the number of frames over which you want the 
acceleration and the deceleration to take place.

4. Click OK.

When you play the movie, the sprite gradually speeds up at the 
beginning of the animation and gradually slows down at the end.
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˛ Tip You can apply acceleration or deceleration to an animated sequence even if it’s 
already in the score. Just select the sequence, choose In-Between Special from 
the Score menu, and choose the number of frames to accelerate or decelerate.

Stretching and squeezing a sprite with in-betweening

If you want to animate a sprite stretching or squeezing, you can use 
In-Between Special to generate the in-between positions in the 
animation.

To animate a sprite stretching or squeezing:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag the cast member from the cast window to the stage.
A sprite corresponding to the cast member appears on the stage.

3. Select the cell in the score that contains the sprite, and 
choose Copy Cells from the Edit menu (or press
Command-C).

4. Select the cell where you want the animation to end.
Make sure the cell is in the same channel as the cell you copied.

5. Choose Paste Cells from the Edit menu (or press
Command-V).

6. Drag the handles on the selection rectangle surrounding 
the sprite to stretch or squeeze it.

To in-between the change in the sprite:

1. Select the series of cells beginning with the cell where the 
original sprite is located and ending with the cell where you 
pasted the copy.

2. Choose In-Between Special from the Score menu.
The In-Between Special dialog box appears.

3. Make sure Size is the only In-Between option selected.
Set acceleration and deceleration settings if you want to use them.

4. Click OK.

When you play the movie the sprite stretches or squeezes. 
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˛ Tip Stretching or squeezing large cast members can make the animation choppy 
and slow. If that happens, use the Auto Distort command to generate separate 
cast members for each in-between position, and then use the sequence of cast 
members to create the animation. See “Auto Distort” under “Effects Menu” 
in Chapter 6, “Menu Reference.”

In-betweening two or more aspects at the same time

There may be times when you want to create animation using two or 
more of the In-Between options—location, size, foreground color, 
background color, and blend—at the same time. For example, you 
may want to move an object across the stage and make it grow 
smaller at the same time to create the illusion that the object is 
moving into the distance. When you use the In-Between Special 
command, you can select the In-Between options in any 
combination or all at the same time.

To in-between two or more aspects at a time:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag a cast member from the cast window to the stage.
A sprite corresponding to the cast member appears on the stage.

The sprite in its current form defines the starting point of 
whatever change you want to make to it in the animation 
sequence: its starting location, starting size, starting foreground 
and background colors, and its starting blend value.

You may need to make changes to the sprite to get to the right 
starting point. For example, if you want the sprite to start out 
invisible and fade in as it moves across the screen, you’ll need to 
change its blend value. (For information about setting a sprite’s 
blend value, see “Set Sprite Blend” under “The Score menu” in 
Chapter 6, “Menu Reference.”)
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3. Copy the cell where the information about the sprite 
appears, move a number of frames to the right in the same 
channel, and paste the sprite information there.
You may also want to drag several cast members to the stage, and 
then use Space to Time to transfer them to a single channel.

4. Make the changes to the sprite that define the way you 
want it to be at the end of the animation sequence.
For example, if you want the sprite’s foreground color to change, 
select the color you want the sprite to be at the end of the 
sequence. If you want the sprite to change transparency, set the 
blend value you want it to have at the end of the sequence.

5. Select the series of cells beginning with the cell where the 
original sprite is located and ending with the cell where you 
pasted the copy.

6. Choose In-Between Special from the Score menu.
The In-Between Special dialog box appears.

7. Select the appropriate In-Between options, and then
click OK.
Director in-betweens all the aspects that match the In-Between 
options you’ve chosen.
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In-betweening a sprite in a curved line

Objects in the real world usually follow curved or circular paths 
instead of straight lines. The In-Between Special command makes it 
much easier for you to plot curved or circular paths for sprites than 
would be the case if you had to do it by hand. The process is similar 
to in-betweening a sprite in a straight line except that rather than 
setting two points to in-between, you set several key positions to 
define the sprite’s path.

To set the key positions for the path:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag a cast member from the cast window to the point on 
the stage where you want the animation to begin.
A sprite corresponding to the cast member appears on the stage.

You can set any number of positions to define a curved in-
between. This example uses four key positions. You first set the 
four positions in one frame so you can see them in relation to one 
another. Then, you use the Space to Time command to transfer 
the key positions to subsequent frames in the same channel. 

3. Drag the same cast member from the cast window and 
position it on the stage to set the second key position.
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4. Repeat step 3 two more times to set the third and fourth 
key positions of the path.

Setting four key positions for a curved in-between

5. Click the score to make it active.

The four sprites you positioned on the stage appear in the score in a 
single frame. The Space to Time command transfers the sprites from 
separate channels in a single frame to consecutive frames in a single 
channel.

Position 4

Position 3

Position 1

Position 2
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To transfer the sequence of sprites to a single channel:

1. Select the sprites in the score.

2. Choose Space to Time from the Score menu.
The Space to Time dialog box appears. It lets you set the number 
of frames you want between each sprite and the one following it.

3. Type an appropriate number of frames in the box.
The higher the number, the greater the space between the sprites, 
and the smoother the animation appears. 

4. Click OK.

Once the four sprites are in the same channel, you can use In-
Between Special to generate the intermediate positions between 
them.
Creating Animations 115



To in-between the sprites:

1. Choose In-Between Special from the Score menu.
The In-Between Special dialog box appears.

Dragging the slider changes the curvature of the path. The effect 
of the setting you choose is shown by the way the square above 
the slider changes.

2. Set the slider to the curvature you want.

˛ Tip Click the Preview Path button to preview the path.

3. Click OK.
The selected cells in the score fill with the in-between positions 
along the path. Play the movie to see the results.

˛ Tip Director remembers and applies the settings you last set in the In-Between 
Special dialog box if you hold down the Shift key when you choose In-
Between Special from the Score menu. 

The effect of the
setting is shown here

Drag to set the curvature of the path
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In-betweening a sprite in a circle

Using the In-Between Special command to make a sprite move in a 
circle is much like using the command to animate a sprite along a 
curved path: you set a series of key positions on the stage to define 
the path of the sprite. The main difference is that to create a circular 
path, you make the last sprite position the same as the first position.

To set the key positions for the path:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag a cast member from the cast window to the point on 
the stage where you want the animation to begin.
A sprite corresponding to the cast member appears on the stage.

You can set any number of positions to define a circular in-
between, although the roundest circle is made with five key 
positions (the first and last positions are exactly the same). This 
procedure shows how to set five key positions in one frame so 
you can see them in relation to one another.

Setting five key frames for a circular in-between

The first and last key frames 
are in exactly the same 
location
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3. Drag the same cast member from the cast window, and 
position it on the stage to set the second key position of 
the path.

4. Repeat step 3 two more times to set the third and fourth 
key position.

5. Copy the cell that contains the first sprite, and paste it in 
the channel below the last sprite.
Copying the cell that contains the first sprite guarantees that the 
first and last key positions are exactly the same.

6. Click the score to make it active.

The five sprites you positioned on the stage appear in the score in a 
single frame. The Space to Time command transfers the sprites from 
separate channels in a single frame to consecutive cells in the same 
channel.

To transfer the sequence of cast members to a single channel:

1. Select the sprites in the score.

2. Choose Space to Time from the Score menu.
The Space to Time dialog box appears. It lets you set the number 
of frames you want between each sprite and the one following it.

3. Type an appropriate number of frames in the box.
The higher the number, the greater the space between the sprites, 
and the smoother the animation appears. 

4. Click OK.
Director transfers the sprites to consecutive cells in the same 
channel.
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To in-between the sprites in a circle:

1. Select the cells to be in-betweened.

2. Choose In-Between Special from the Score menu.
The In-Between Special dialog box appears.

Dragging the slider changes the curvature of the path. The effect 
of the setting you choose is shown by the way the square above 
the slider changes.

3. Set the slider to the curvature you want.

4. Select the checkbox next to Circular.

5. Click OK.
The selected cells in the score fill with the in-between positions 
along the path. Play the movie to see the results.

The effect of the
setting is shown here

Drag to set the curvature of the path
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Adjusting the path of an in-betweened sprite

After you in-between a sprite along a path and then play the 
animation that’s the result, you may find that you want to adjust the 
path of the animation. All you need to do is change the position of 
one or more of the key frames and then choose In-Between Linear or 
In-Between Special again. If the animation is a straight line, for 
example, you can move the sprite in the first or last cell of the 
sequence to reset the beginning or end point of the sprite’s 
movement.

Locating key frames in the score isn’t difficult. If you look at the score 
with the Extended, Cast, or Motion display option selected, you can 
see dotted lines at the top of certain cells.

The dotted lines indicate that the information in the cells was 
generated by either the In-Between Linear or the In-Between Special 
command. Cells without dotted lines at the beginning and end of 
such sequences are key frames.

Dotted lines indicate in-betweened positions

Key frames are cells 
without dotted lines
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To adjust the path of a sprite animated with In-Between Linear:

1. In the score, select the cell that represents the key frame 
you want to adjust.
There’s no need to erase the previously in-betweened cells.

2. On the stage, drag the sprite that corresponds to the key 
frame to reposition it.

3. Shift-click the key frame at the other end of the sequence 
of in-betweened cells to select the entire range.

4. Choose In-Between Linear from the Score menu.
Director recalculates the position of the sprite in all the cells 
between the two key frames. When you run the animation, the 
sprite moves in a new path defined by the new beginning or end 
point you set.

To adjust the path of a cast member animated with In-Between 
Special:

1. In the score, select the cell that represents the key frame 
you want to adjust.
You can adjust any key frame in the sequence.

2. On the stage, drag the sprite that corresponds to the key 
frame to reposition it.
If you want to adjust another key frame, repeat steps 1 and 2.

3. Select all the cells in the original sequence you in-
betweened, including the key frames at the beginning and 
end.

4. Choose In-Between Special from the Score menu.
Director recalculates the position of the sprite in all the cells in 
the sequence. When you run the animation, the sprite moves in a 
new path defined by the new key frames you set.
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Cutting frames from a movie

Occasionally you may want to do more than just delete the 
information from a range of cells in the score—you may want to 
remove a range of frames from the score entirely. Deleting entire 
frames from the score has a different effect than just removing 
information from a range of cells. Removing information from a 
range of cells leaves blank space in the score; deleting entire frames 
removes not only the information in the frames, but the blank space 
as well. Since each frame represents a moment in time, the result is 
that the movie is shorter—just as if you’d cut frames from a film.

To delete frames from a movie:

1. Select a number of frames by dragging across the frame 
numbers at the top of the score window.
The frames you’ve selected are highlighted.

2. Choose Cut Cells from the Edit menu (or press
Command-X).
Director removes the frames—not just the information they 
contain—from the movie.

˛ Tip If you want to delete just a single frame, you can use the Delete Frame 
command on the Score menu.

Drag here to select 
entire frames
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Adding frames to a movie

You may sometimes need to add information to a movie in a spot 
where no empty cells are available. If you select just a cell to mark the 
spot where you want Director to insert the information, Director will 
replace the information that’s already there with the new information 
you’re pasting. But if you set an insertion point at the spot where you 
want to insert the new information, Director will add enough new 
frames to accommodate it.

Click here to set an 
insertion point

Insertion point
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To add frames to a movie:

1. Cut or copy the cells you want to add to the movie.
You can cut or copy the frames from the same movie or from a 
different one. If you want to add blank frames, copy any range of 
cells that’s long enough; you can delete the information in the 
cells after you’ve used them to add new frames to the movie.

2. Click the frame number where you want to insert the 
information.
An insertion point appears in the frame you click. Any 
information you paste into the score appears in new frames to the 
right of the insertion point.

3. Choose Paste Cells from the Edit menu (or press
Command-V).
Director inserts enough frames in the movie to accommodate the 
new information you’re adding.

Note For information about the effects of copying and pasting information in a cell or 
a range of cells, see “Edit menu” in Chapter 6, “Menu Reference.”

Shifting a sequence of cells in time

You can reposition an animated sequence in time without necessarily 
adding or subtracting time in a movie by cutting a group of cells in 
one or more channels, and then pasting them in a different location in 
the score. You can also shift an animated sequence in time by 
selecting and dragging it to a different location in the score. The 
technique depends on how far you’re shifting the sequence: if you’re 
shifting it within a section of the score you can display in the score 
window all at one time, you can just select and drag it. If you’re 
shifting the sequence from one part of the score to another part that’s 
rather far away, it’s easier to cut the sequence from its current 
location, go to the new location, and paste the sequence there.
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To shift a sequence of cells by dragging the sequence:

1. Select the cells that contain the sequence.
Select just the cells, not the entire frames where they’re located.

2. Drag the cells toward their new location.
As you start to drag the cells, an outline of the selection appears.

3. Position the outline over the cells where you want to move 
the sequence.
After a moment, Director removes the information from the cells 
in the old location and displays it in the new location.

To shift a sequence of cells by cutting and pasting the sequence:

1. Select the cells that contain the sequence.
Select just the cells, not the entire frames where they’re located.

2. Choose Cut Cells from the Edit menu (or press
Command-C).
Director removes the information from the cells and stores it on 
the Clipboard. The frames that Director removed the 
information from remain in the score.

3. Select a single cell in the new frame where you want the 
sequence to start.

4. Choose Paste Cells from the Edit menu (or press
Command-V).
The sequence is pasted into the new location in the score.

˛ Tip If you select one cell, Director pastes all the information you cut back in the 
score. If you select more than one cell, Director pastes only as much 
information as will fit in the selected cells.
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Changing layering

Director’s 48 sprite channels mean that you can have as many as 48 
sprites on the stage at one time.

The sprite channels are assigned a foreground priority so that a sprite 
in a channel closer to the top of the score always appears behind a 
sprite in a channel closer to the bottom. Another way to think about 
foreground priority is to think of each channel in the score as a layer:

The order of the sprites in the channels determines foreground priority, as if each 
channel were a layer

When you add a sprite to a channel that’s closer to the bottom of the 
score than another channel already occupied by a sprite, it’s like 
placing a new layer on top of the last one. Sprites in channels closer to 
the bottom of the score appear in front of, or take priority over, those 
in channels closer to the top.

Channels for
“behind the scenes”

elements (scripts,
sound, and so on)

Sprite channels
Chapter 2126



You’ll undoubtedly come across situations where you want to switch 
the priority of two sprites. For example, if you wanted to animate a 
moon rising over a Japanese shrine, the best approach would be to set 
up the animation of the moon in front of the shrine scene, and then 
switch the channels the moon and shrine scene occupy so the moon 
appeared to rise behind the shrine.

Before: The moon, in channel 2, appears in front of the shrine scene, which is in 
channel 1

Shrine
Moon
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After: The moon, now in channel 1, appears behind the shrine scene, which is now in 
channel 2

To switch the channels two sprites occupy, use the Shuffle Forward 
and Shuffle Backward buttons at the bottom of the score.

Moon
Shrine
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The Shuffle Forward button switches a range of cells you’ve selected 
in a channel with the cells in the channel below it. The sprite 
associated with the cells you’ve selected moves in front of the sprite in 
the other channel.

The Shuffle Backward button switches a range of cells you’ve selected 
in a channel with the cells in the channel above it. The sprite 
associated with the cells you’ve selected moves behind the sprite in 
the other channel.

Shuffle Forward button

Shuffle Backward button
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To move a sprite from the background to the foreground:

1. In the score, select the cells that contain the sprite.

2. Click the Shuffle Forward button at the bottom of the 
score.
Director switches the cells you’ve selected with the cells in the 
channel immediately below them.

To move a sprite from the foreground to the background:

1. In the score, select the cells that contain the sprite.

2. Click the Shuffle Backward button at the bottom of the 
score.
Director switches the cells you’ve selected with the cells in the 
channel immediately above them.

Moving animations between movies

Copying animation from one movie to another is as easy as cutting 
and pasting graphics. When you copy information from cells in the 
score, Director places the information on the Clipboard. You can 
then paste the information into the score of a different movie. You 
can also paste animation in the Scrapbook if you want to save it for 
future use.

The cells in the score contain information about the cast members, 
but they don’t contain the cast members themselves. When you paste 
information from one movie into another, Director searches for the 
movie the information came from and imports the cast members. If 
you’ve changed the name of the movie or moved it since you copied 
the information, Director asks you to find the movie.
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To move animation from one movie to another:

1. Select the cells (or frames) you want to copy from the 
score.
Selecting a frame will copy all the information in all the cells in 
the frame, including scripts in the script channel, sounds, 
transitions, and so on.

2. Choose Copy Cells from the Edit menu (or press
Command-C).
Director copies the information to the Clipboard.

3. Choose Open from the File menu (or press Command-O).
The Open dialog box appears. (If a dialog box appears first that 
asks if you want to save the movie, click Save.)

4. Select the movie that you want to paste the information 
into, and then click Open.
After a moment, the movie’s score appears in the score window.

5. Select where you want to paste the information you’ve 
copied:

p If you click a frame number at the top of the score, an 
insertion point appears. When Director pastes the 
information you’ve copied, it will add enough new frames to 
the movie to provide room for the information.

p If you select a single cell, Director will paste all the 
information you’ve copied into the movie. If any of the cells 
it needs for the information already contain information, it 
will replace the current information with the information it’s 
pasting into the movie.

p If you select a range of cells, Director will paste only as much 
information as will fill the number of cells you’ve selected. If 
any of the cells already contains information, Director will 
replace it with the information it’s pasting into the movie.

6. Choose Paste Cells from the Edit menu (or press
Command-V).
The information you’ve copied appears in the score. Director 
imports any cast members associated with the information from 
the original movie and displays them in the cast window.
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Film loops

A film loop is an animated sequence that you can treat as if it were a 
single cast member. For example, if you wanted to create an 
animation of a bird flying across the stage, you could create a film 
loop of the sequence of sprites that shows the bird flapping its wings. 
Then, instead of using the frame-by-frame technique where you 
position each sprite in the sequence on the stage one by one, you can 
set the first and last positions of the film loop as if it were a single 
sprite and then use In-Between Linear to create the intermediate 
positions. When you run the animation, the bird flaps its wings and at 
the same time moves across the stage.

A film loop behaves just like any other sprite that’s part of an 
animation, with three exceptions:

◆ When you step through an animation that contains a film loop 
(either by using Step Forward or Step Backward or by dragging 
the playback head in the score), the film loop doesn’t animate. 
Animation occurs only when the movie is running.

◆ You can’t apply ink effects to a film loop. If you want to use ink 
effects with a film loop, you need to apply them to the sprites that 
make up the animation before you turn the animation into a film 
loop.

◆ You can’t attach a cast member or sprite script to a film loop. 
(For a description of cast member and sprite scripts, see “Types of 
scripts” in Chapter 4, “Making a Movie Interactive.”)

A film loop—because of its limitations—may not be the best 
approach to what you’re trying to achieve in a movie. Director 
provides three other ways of incorporating a completed chunk of 
animation into a movie as a discrete element: you can turn it into a 
QuickTime movie, import it as a linked Director movie, or play it in 
a window in another Director movie. For a comparison of all four 
methods, see “Movies within Director movies” at the end of this 
chapter.
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Creating a film loop

Before you can create a film loop, you need to create the animation 
you want the film loop to contain. After you’ve created the film loop, 
you can delete the animation and use the film loop in its place.

To create a film loop:

1. In the score, select the cells that contain the animation you 
want to turn into a film loop.

2. Drag the selection to an empty cast member position in the 
cast window (or copy the selection and paste it into the 
cast window).
A dialog box appears asking you to name the film loop.

3. Type a name for the film loop, and then click OK.
Director creates the film loop and displays the thumbnail that 
corresponds to it in the cast window.

4. Delete the animation you used to create the film loop.
You can’t extract the animation information in the film loop and 
return it to the score. If you want to keep a copy of the 
animation as it appears in the score, save it in the Scrapbook.

Film loop cast member
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For information about using the film loop in a movie, see “Real-time 
recording with a film loop” and “In-betweening a film loop” later in 
this chapter.

Note If you delete any cast member used in the film loop from the cast window, 
Director can’t run the film loop. You can reposition the cast members in the 
cast window or remove them from the score, but the cast members in the film 
loop have to remain in the cast window for the film loop to work.

Creating a multi-channel film loop

A film loop isn’t limited to the information in a single channel in the 
score. For example, if you have a sound effect that’s part of an 
animated sequence, you can make the sound effect part of the film 
loop.

To create a multi-channel film loop:

1. In the score, select the cells that contain all the sequences 
you want to be part of the film loop.

˛ Tip Use Command-click to select sequences that aren’t in adjacent channels.

2. Drag the selection to an empty cast member position in the 
cast window (or copy the selection and paste it into the 
cast window).
A dialog box appears asking you to name the film loop.

3. Type a name for the film loop, and then click OK.
Director creates the film loop and displays the thumbnail that 
corresponds to it in the cast window.

4. Delete the sequences you used to create the film loop.
You can’t extract the animation information in the film loop and 
return it to the score. If you want to keep a copy of the 
animation as it appears in the score, save it in the Scrapbook.
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Real-time recording with a film loop

Animating a normal sprite in real time involves dragging the pointer 
across the stage to record the path you want it to follow and the rate 
at which you want it to move. You can use the same animation 
technique with a film loop. The difference is that you’re setting the 
path and rate not for a simple object, but for one that changes as it 
moves across the stage. For example, if you create a film loop of a 
bird flapping its wings, after you record the path of the film loop and 
rate at which it moves, the bird will appear to flap its wings as it 
moves across the stage.

For better control when you’re recording in real time, use the tempo 
control in the control panel to record at a speed that’s slower than 
normal. (For more information, see “The control panel” in Chapter 
5, “Window Reference.”) You can adjust the speed with a different 
tempo setting to make the animation look normal when you play the 
movie back. (See “Adding a tempo setting” in Chapter 3, “Working 
Behind the Scenes.”)

To real time record a film loop:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Select the film loop in the cast window.
Don’t drag the film loop from the cast window to the stage—just 
select it. 

To record in a specific range of frames, select the frames, and 
then click the Selected Frames Only button on the control panel.

Tempo control
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3. Hold down the Control key and the spacebar.
The record indicator appears next to the channel where you’re 
recording.

˛ Tip If you want to record in a different channel, click another channel indicator 
while you’re holding down the Control key and the spacebar.

The recording begins as soon as you click the mouse button in 
the next step, so be prepared to move the mouse.

4. Point to the spot on the stage where you want the 
animation to start, press the mouse button to begin 
recording, and drag the pointer across the stage. 
Director records the path you move the pointer along.

If there are sprites in any of the other channels in the first frame 
of the animation, Director records their positions in each frame 
where it records the position of the film loop.

5. Release the mouse button to stop recording.

In-betweening a film loop

The power of using a film loop is evident when you use either of the 
In-Between commands to animate the film loop. For example, one 
way to create an animation of a bird flying is to set the position of 
each cast member in the sequence frame by frame across the stage. A 
much easier approach is to create a film loop of a bird flapping its 
wings and then to in-between the film loop along the path you want 
the bird to follow.

Note Make sure that Playback Head Follows Selection is selected in the Score 
Window Options dialog box before you start the following procedure.
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To define the path of a film loop:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag the film loop to the spot on the stage where you want 
the animation to begin.
A sprite corresponding to the first cast member in the film loop 
appears on the stage.

When one of the sprites that’s part of a film loop is selected, 
Director displays a selection rectangle that’s big enough to 
encompass all the sprites that make up the film loop.

3. Go to the score, copy the cell that contains the information 
about the film loop’s sprite.

4. Paste the information in the cell where you want the 
animation to end.

5. Drag the sprite across the stage to the point where you 
want the animation to end.

To in-between the animation:

1. Select the cell where the animation begins.

2. Shift-click the cell that marks the end of the animation 
sequence to select the entire range.

3. Choose In-Between Linear from the Score menu (or press 
Command-B).
The cells fill with the in-between positions of the animation. Play 
the movie to see the results.

You can also use the options in the In-Between Special dialog box to 
accelerate or decelerate a film loop at the beginning or end of its 
movement or to in-between the film loop along a curved or circular 
path. Follow the instructions in “In-betweening with acceleration 
and deceleration,” “In-betweening a sprite in a curved line,” or 
“In-betweening a sprite in a circle” earlier in this chapter.
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Switching film loops

Just as you can replace one sprite with another in an animated 
sequence, you can replace one film loop with another (or a film loop 
with a sprite or a sprite with a film loop). For example, if you wanted 
a bird, a bee, and a bat to follow exactly the same path, you could 
create the path with the film loop of the bird, make two copies of it, 
and replace the film loop of the bird with the film loop of the bee in 
one of the copies and with the film loop of the bat in the other copy.

To replace one film loop with another in an animated sequence:

1. In the score, select the cells that contain the animation.

2. In the cast window, select the film loop you want to replace 
the film loop currently used in the animation. 

3. Choose Switch Cast Members from the Score menu (or 
press Command-E).
The film loop you selected in the cast window replaces the film 
loop you used when you created the animation. 
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QuickTime movies

QuickTime movies and film loops have many things in common. 
They’re both elements that you can manipulate as individual cast 
members, and yet they’re both movies themselves. You can convert 
animation in Director’s score into either a QuickTime movie or a 
film loop, and you can move both QuickTime movies and film loops 
around the stage the same way you move any other graphic cast 
member.

There are, of course, differences. QuickTime movies offer the added 
dimension of digital video—they provide a way to incorporate live 
action into a Director movie. You can also edit a QuickTime 
movie—unlike a film loop—either in Director or in an application 
such as Premiere. When you turn animation in a Director movie into 
a QuickTime movie, you can include transitions, tempo settings, and 
other effects, something that’s not possible when you create a film 
loop.

As mentioned in the section on film loops, Director provides several 
ways of incorporating a completed chunk of animation into a movie 
as a discrete element. In addition to turning an animated sequence 
into a film loop or a QuickTime movie, you can import it as a linked 
Director movie or play it in a window that’s part of another Director 
movie. For a comparison of all four methods, see “Movies within 
Director movies” at the end of the chapter.

This section shows how to turn animation in Director into a 
QuickTime movie, how to import a Quicktime movie into a 
Director movie, and how to edit the QuickTime movie and add it to 
the score.
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QuickTime and digital video 

You’ll come across both the term QuickTime and the term digital 
video in Director. For example, when you import a QuickTime 
movie, the file type you choose is “QuickTime,” but you then 
display the QuickTime movie you’ve imported in a digital video 
window. Director is a cross-platform development tool and tries to 
use general terms whenever possible. The digital video window is so 
named because it accommodates QuickTime movies on the 
Macintosh and both Video for Windows (.AVI) and QuickTime for 
Windows movies on Windows computers. On the other hand, since 
you can import only QuickTime movies into a Macintosh 
application, the option on the Type pop-up menu in the Import 
dialog box is appropriately named QuickTime.

Exporting a Director movie as a QuickTime 
movie

Turning animation you’ve created in Director into a QuickTime 
movie is one way to distribute the animation or use it in other 
applications. For example, many applications, such as Microsoft 
Word, let you attach QuickTime movies to documents.

You can also export animation as a QuickTime movie and then 
import the QuickTime movie into a Director movie. The entire 
animation then becomes a single cast member—which you can then 
move around the stage as the movie plays. Exporting animation as a 
QuickTime movie captures not just the movement of the sprites on 
the stage, but any tempos, palette effects, or transitions you’ve set.
Chapter 2140



How exporting a QuickTime movie works

When Director exports animation as a QuickTime movie, it plays the 
animation, takes snapshots of the stage moment by moment, and 
turns each snapshot into a frame in the QuickTime movie. When 
you play the QuickTime movie, the result looks much the same as 
the Director movie, even though the way the QuickTime movie 
produces the effect might be quite different. For example, if you use a 
palette setting to fade to black in a Director movie, Director actually 
darkens the entire screen little by little. When you export the 
animation as a QuickTime movie, Director takes snapshots of a stage 
that’s progressively darker. When you play the QuickTime movie, 
you see a series of images, each of which is slightly darker than the 
one before it—but the screen as a whole doesn’t change at all.
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Getting the stage ready

When Director exports animation as a QuickTime movie, it always 
takes a snapshot of the entire stage. If you’re using only part of the 
stage for the animation you’re exporting—and the rest of the 
background is empty—you need to move the animation to the upper 
left corner of the stage and reduce the size of the stage to fit the area 
where the animation takes place.

To move the animation:

1. Select the animation in the score, and then choose Sprite 
Info from the Score menu (or press Command-K).
The Sprite Info dialog box appears.
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When you have more than one sprite selected, the size and 
location displayed in the Sprite Info dialog box apply to an 
imaginary rectangle that surrounds all the sprites.

2. Write down the width and height displayed in the dialog 
box.
The width and height tell you how big the stage needs to be to 
accommodate the animation.

3. Change the distance from both the top and left edges of the 
stage to zero, and then click OK.
Director moves the animation to the upper left corner of the 
stage.

Imaginary rectangle 
surrounding the sprites.
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To set up the stage:

1. Choose Preferences from the File menu.
The Preferences dialog box appears.

The size of the stage needs to be as close as possible to the size of 
the area the animation occupies. But both the width and height 
of the stage must be divisible by 16.

2. Set the stage size:

p If the area the animation occupies is smaller than 160 pixels 
wide by 120 pixels high, choose QuickTime 160 x 120 from 
the Stage Size pop-up menu.

p If the area the animation occupies is larger than 160 pixels 
wide by 120 pixels high, round the width and height up to 
the nearest number divisible by 16 and type the numbers in 
the Width and Height fields. (For example, if the area the 
animation occupies is 138 pixels wide by 222 pixels, enter 
144 as the width and 224 as the height.)

3. Click OK.
Director changes the size of the stage.
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Exporting the animation

To turn the animation into a QuickTime movie:

1. Choose Export from the File menu.
The Export dialog box appears.

2. Select the option you want from the Range of Frames 
options at the top of the dialog box.
For specific information about the options, see “Export” in “File 
menu” in Chapter 6, “Menu Reference.”

3. From the File Type pop-up menu in the Destination section 
at the bottom of the dialog box, choose QuickTime Movie.
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4. Click the QuickTime Options button.
The QuickTime Export Options dialog box appears.

5. Select the options you want to use and then click OK.
For specific information about the options, see “Export” in “File 
menu” in Chapter 6, “Menu Reference.”

The Export dialog box reappears when you click OK.

6. Click Export.
The Save dialog box appears.

7. Name the file and then click Save.
An alert appears that tells you to turn off any screen saver you 
have installed. Creating a QuickTime movie can sometimes be 
time consuming, and if your screen saver comes on, Director will 
save it as part of the QuickTime movie.

8. Click OK.
Director saves the animation as a QuickTime movie.

Note If you turn an animated sequence that includes a transition into a QuickTime 
movie, but the transition doesn’t appear when you play the QuickTime 
movie, try increasing the Duration and Chunk Size settings in the Set 
Transition dialog box.
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Importing a QuickTime movie

You import a QuickTime movie the same way you import any other 
type of cast member.

To import a QuickTime movie:

1. Choose Import from the File menu (or press Command-J).
The Import dialog box appears.

2. Choose QuickTime Movie from the Type pop-up menu.
The Link to File checkbox disappears from the dialog box when 
you select QuickTime Movie as the type because the QuickTime 
movies you import always remain linked with the original file on 
the disk.

3. Select the file you want to import, and then click Import.
A thumbnail with the name of the file and identified by the 
digital video cast member icon appears in the cast window.

Type pop-up menu
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Editing a digital video cast member

Once you’ve imported a QuickTime movie into Director, it’s called 
a digital video cast member or a digital video movie.

Editing a digital video movie in Director is limited to cutting, 
copying, and pasting frames. Remember that the QuickTime movies 
you import always remain linked with the original file on the disk. As 
a result, any changes you make to a digital video movie in Director 
become a permanent part of the original QuickTime movie file.

If you want to make changes other than cutting, copying, and pasting 
frames, use an application such as Premiere. Any changes you make 
to a QuickTime movie outside of Director are automatically reflected 
in Director as well.

Opening a digital video window

Just as you make changes to bitmap cast members in the paint 
window and to text cast members in a text window, you make 
changes to a digital video movie in a digital video window.
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To display a digital video movie in a digital video window:

þ Select the digital video cast member in the cast window, 
and then choose Digital Video from the Window menu (or 
press Command-9).
The digital video window appears.

To display a second digital video window:

1. Make sure the digital video window is still selected.

2. Choose Duplicate Window from the Window menu (or press 
Command-Option-Shift-9).
A second digital video window appears.

When you open a second digital video window, it displays the same 
movie that’s in the first window. The movie in the second window 
isn’t a copy of the one in the first window, it’s just a second view of 
the same movie. You can display different parts of the movie at the 
same time in the two different windows, but if you make a change to 
the movie, the change is reflected in both windows.

Volume control Step forward

Play/pause Step backward

Drag to go to a frame
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To display a different movie in the second window:

þ Click the next or previous arrows at the top of the window 
until the movie you want appears.
The next and previous arrows display the next or previous digital 
video movie that’s in the cast window. Director skips over other 
types of cast members.

Cutting, copying, and pasting

You can cut, copy, or paste either individual frames or ranges of 
frames.

To select a single frame in a digital video movie:

þ Use the Play button, the slider, or the Step Forward or Step 
Backward buttons to display the frame in the digital video 
window.

To select a range of frames in a digital video movie:

1. Display the first frame in the range in the digital video 
window.

2. Hold down Shift and drag the slider until the last frame in 
the range appears.
The section of the slider that corresponds to the frames you’ve 
selected turns black.

To cut or copy part of a digital video movie:

1. Select the frame or range of frames you want to cut or 
copy.

2. Choose Cut (or press Command-X) or Copy (or press 
Command-C) from the Edit menu.
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To paste a frame or range of frames into a digital video movie:

1. Display the frame after the spot where you want the new 
frame or frames to appear.
You can paste the new frames either into the same movie that 
you cut or copied them from or into a different movie in a 
different digital video window.

You can also paste the frames in the Scrapbook. Or you can paste 
a single frame into the paint window, where Director converts it 
into a bitmapped graphic (but you can’t paste it back into a digital 
video movie after it’s converted).

2. Choose Paste from the Edit menu (or press Command-V).
Nothing changes in the digital video window because the image 
there occupies the frame just after the spot in the movie where 
you’ve pasted the new segment. To see the new frame or frames, 
click the Step Backward button.

Adding a digital video movie to a Director movie

You add a digital video movie to a Director movie the same way you 
add any other cast member:

þ Drag the digital video cast member from the cast window 
to the place on the stage or the frame in the score where 
you want it to appear.
Information identifying the digital video movie appears in the 
score, and the first frame of the movie appears on the stage.

˛ Tip If there’s a white bounding box around the digital video movie, use the 
Background Transparent ink to get rid of it. (The Matte ink doesn’t work 
with QuickTime movies.)

A digital video movie is, like a sound, a time-based cast member. 
Remember that a single frame in a Director movie represents just a 
moment in time. As a result, when you place a digital video movie in 
just a single frame of the score you get just a snippet of the digital 
video movie. The playback head moves to the next frame before 
Director has time to play more than a little of the digital video movie.
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There are two ways to make sure that Director plays a digital video 
movie until the movie is finished:

◆ Add a tempo setting that keeps the playback head from moving 
to the next frame until the entire digital video movie has finished 
playing. (See “Playing a digital video movie before continuing” 
later in this chapter.)

◆ In-between the digital video movie over enough frames to give it 
time to play all the way through. (See “In-betweening a digital 
video movie” later in this chapter.)

Cropping a digital video movie

Cropping a movie means trimming slices off the top or sides of the 
movie image.

Cropping doesn’t remove the slices you trim permanently, it just 
hides them. It’s like adjusting shutters until just the part of the image 
you want to show is visible.

Cropping trims a slice 
from a movie image
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To crop a digital video movie:

1. Select the digital video movie’s cast member in the cast 
window.

2. Choose Cast Member Info from the Cast menu (or click the 
Info button at the top of the Cast window).
The Cast Member Info dialog box appears.

3. Select Crop.
If you select Center (the option below Crop) as well as Crop, 
Director automatically centers the digital video movie inside the 
rectangular area you set as the size of the movie’s image.

4. Click OK.

5. Select the digital video movie in the score.

6. Go to the stage, and drag any of the handles that appear on 
the selection rectangle that surrounds the digital video 
image.
Director displays only as much of the movie image as will fit in 
the area defined by the selection rectangle.
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Playing a digital video movie before continuing

Tempo settings control how fast the playback head moves from one 
frame to the next. You can use a tempo setting to prevent the 
playback head from moving to the next frame before the digital video 
movie in the current frame has finished.

Tempo settings have a special channel reserved for them in the score.

Tempo channel
Chapter 2154



To add a tempo setting that prevents the playback head from moving 
on until a digital video movie has finished:

1. In the score, select the cell in the Tempo channel where you 
want the playback head to wait.

2. Choose Set Tempo from the Score menu.
The Set Tempo dialog box appears.

˛ Tip You can also display the Set Tempo dialog box by double-clicking the cell in 
the Tempo channel where you want to set the tempo.

3. Select Wait for QuickTime Movie to Finish in Channel 1.

4. Change Channel 1 to the number of the channel where the 
digital video movie appears.

5. Click OK.
Director adds the tempo setting to the score.
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In-betweening a digital video movie

There are two reasons to in-between a digital video movie: 

◆ To fill enough frames with the movie so that it has time to play 
through to the end

◆ To move the movie across the stage as it plays.

If you want to fill enough frames with the movie so it has time to 
play through to the end, the process is essentially the same as adding a 
background to a movie. If you need help, see “Adding stationary cast 
members to a movie” earlier in this chapter. The steps that follow 
show how to move a digital video movie across the stage as it plays.

Note Make sure that Playback Head Follows Selection is selected in the Score 
Window Options dialog box before you start the following procedure.

To define the path of a digital video movie:

1. Select the place in the score where you want Director to 
record the animation.
See “Selecting where you want to record animation” earlier in 
this chapter.

2. Drag the digital video movie to the spot on the stage where 
you want the animation to begin.

3. Copy the cell in the score where the movie’s location on the 
stage is stored.

4. Paste the information in the cell where you want the 
animation to end.

5. Drag the movie across the stage to the point where you 
want the animation to end.
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To in-between the animation:

1. Select the cell where the animation begins.

2. Shift-click the cell that marks the end of the animation 
sequence to select the entire range.

3. Choose In-Between Linear from the Score menu (or press 
Command-B).
The cells fill with the in-between positions of the animation. Play 
the movie to see the results.
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Movies within Director movies

Film loops and QuickTime movies provide two ways to incorporate 
a completed piece of animation in a Director movie as a discrete unit. 
Director provides two other ways of accomplishing the same thing:

◆ Importing one Director movie into another as a linked cast 
member

◆ Playing one Director movie in a window that’s inside another 
Director movie.

Importing a linked movie. One of the advantages of importing one 
Director movie into another as a linked cast member is that the 
movie you’re importing retains any interactivity you’ve built into 
it—something that’s not true of film loops or QuickTime movies. 
Unlike a QuickTime movie, however, the linked Director movie 
doesn’t retain any of the tempo settings, palette settings, or transitions 
it has when you open it and play it as a stand-alone Director movie.

To import a Director movie as a linked cast member, make sure the 
Linked checkbox is checked in the Import dialog box. The entire 
movie appears as a single cast member in the cast window. You can 
animate the cast member just as you would any graphic cast member, 
film loop, or digital video movie. If you want to retain the 
interactivity that’s in the stand-alone version of the movie, select 
Enable Scripts in the Cast Member Info dialog box.

Playing a movie in a window. Playing a Director movie in a 
window has none of the limitations of using a film loop, a 
QuickTime movie, or a linked Director movie. Like a linked 
Director movie, it retains any interactivity you’ve built into it; like a 
QuickTime movie, it retains tempo settings, palette settings, and 
transitions. The movie that’s in a window is, in fact, a complete, self-
contained Director movie that plays inside another Director movie 
just as it does when it stands alone.
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Navigator, one of the sample movies that came packaged with 
Director, shows how a movie within a movie works. To take a look 
at Navigator, go to the Macromedia Director 4.0 folder, open the 
Sample Movies folder, then the Lingo Expo folder, and double-click 
Navigator to start it.

The three movies that play in Navigator’s window—the kiosk, the 
simulation, and the storybook—are complete, self-contained Director 
movies. You can play any of them on their own without Navigator, 
and they play exactly the same way they do within Navigator.

To play a movie in a window, you need to write a short Lingo script 
to set up the window and to identify the movie you want to play. For 
information, see Chapter 9, “Movies in a Window,” in Using Lingo.

A Director movie
playing in a window

within Navigator

Navigator
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The following table shows what you can and can’t do with a film 
loop, a QuickTime movie, a linked Director movie, and a movie in a 
window. This information will help you decide which approach you 
want to use when you need to include a completed piece of 
animation in a Director movie.

* Select Enable Scripts in the Cast Member Info dialog box.

† You can cut, copy, and paste individual frames in Director; to do full editing, you need to use an application such 
as Premiere (changes are reflected in Director automatically).

‡ Close the current movie and open the linked movie in Director.

Choosing an approach

If you want to Use

Film loop QuickTime 
movie

Linked 
Director movie

Movie in a 
window

Include tempo settings no yes no yes

Include palette settings no yes no yes

Include transitions no yes no yes

Include sounds yes yes yes yes

Include interactivity no no yes* yes

Attach a cast member 
script to the movie’s 
cast member

no yes no no

Attach a sprite script to 
the movie’s sprite

no yes yes no

Include sprite channel 
information from the 
original animation

yes yes yes yes

Move the movie across 
the stage

yes yes yes yes (using LIngo)

Edit the movie no partially† yes‡ yes
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Chapter 3

Working Behind the Scenes

Anyone who’s ever seen a big-budget action film knows that 
much of its impact comes from things other than the actors on 
the screen. The same is true of a Director movie. Animation is 
without doubt the heart of any movie, but without music, sound 
effects, transitions, and all the other effects you can create behind 
the scenes, any movie is bound to be a pretty bland experience.
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The elements you can work with behind the scenes fall into these 
categories:

◆ Sound effects and music. You can make any sound or any 
piece of music that’s been digitized and saved in AIFF format part 
of a Director movie.

◆ Transitions. Films use many techniques to shift from one scene 
to another—jump cuts, fades, dissolves, and so on. Director has 
over 50 transitions you can choose from, and you can use many 
of them not just to shift from one scene to the next, but to add or 
remove an element from the stage.

◆ Palette effects. Palette effects let you change the way images 
look by directly manipulating the colors in the palettes. There are 
two types of palette effect; palette transitions and color cycling. A 
palette transition shifts every color in a palette gradually through a 
range of intermediate colors to a corresponding color in a new 
palette. Color cycling affects a range of colors you’ve selected 
from the palette: Director shifts each color in the range to every 
other color in the range in succession.

◆ Tempos. Tempo settings give you control over the speed of 
animation (speed can have a major impact on the realism and 
effectiveness of an animated sequence). You can also use tempo 
settings to control the flow of a movie—for example, by waiting 
until a sound effect is finished or until a user has pressed a key 
before going to the next frame.

While most of the things you do behind the scenes have a direct 
impact on the content of the movies you create, one of the most 
important—creating projectors—affects how you distribute the 
movies after you’ve created them. A projector creates a play-only 
version of a movie. It’s the ideal form for distributing a movie 
because anyone can run a projector—even people who don’t own a 
copy of Director.

The procedures in this chapter show how to set tempos, control the 
playback speed of a movie, and add sound effects, music, and 
transitions to a movie. The chapter explains how color palettes work, 
how to create and edit them, how to set up palette transitions, and 
how to use color cycling. Finally, it describes how to turn a movie 
into a projector.
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Working with tempo settings

Tempo settings control the speed of animation. You can use them to 
vary the pace within a movie. For example, you might want a title to 
move onto the stage slowly and then exit quickly. You can use one 
tempo setting to control the speed at which the title moves onto the 
stage and a different setting to control the speed at which it exits.

Tempo settings don’t affect the duration of any transitions you’ve set 
in the transition channel, and they don’t control the speed at which a 
sound plays. They control only the speed at which the playback head 
moves from frame to frame.

In the real world, the tempo setting in the tempo channel is the speed 
Director tries to achieve. Other factors may—and often do—affect 
the speed of animation. If you’re animating several sprites at the same 
time, the animation runs more slowly than if you’re animating just 
one. If you’re animating a sprite you’ve applied a blend value to, the 
animation runs more slowly than it otherwise would. If you’re 
animating an 8-bit sprite across an 8-bit background, the animation 
runs more slowly than if you’re animating a 1-bit sprite across a 1-bit 
background. The computer you’re using also affects the speed 
Director can achieve: some computers run more slowly than others. 
You can always slow animation down with a tempo setting, but you 
can’t speed it up faster than the computer that’s running the 
animation can manipulate the information it needs to display the 
animation on the screen.

The procedures in this section show how to set tempos, how to 
compare the speed at which a movie is actually running with the 
tempo you’ve set, and how to lock the speed at which a movie plays.
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Adding a tempo setting

A movie usually begins with a tempo setting in the first cell of the 
tempo channel. 

Other things you can do

What you can do Where to find out how

Pause a movie for a given number 
of seconds

“Set Tempo” in the Score menu 
section of Chapter 6

Pause a movie until a user clicks 
the mouse or presses a key

“Set Tempo” in the Score menu 
section of Chapter 6

Wait for a sound to stop playing 
before the movie continues

“Set Tempo” in the Score menu 
section of Chapter 6

Tempo channel
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If you don’t set a tempo until later in the movie, the beginning tempo 
is determined by the setting in the control panel.

Director plays a movie at the tempo you’ve set until it encounters a 
new tempo setting in the tempo channel.

Note It’s a good idea to avoid setting a tempo, a transition, and a palette change all 
in the same frame. It’s also a good idea to avoid using tempo settings that 
make a movie wait for the user to click the mouse or a key or for a sound or 
QuickTime movie to finish in the same frame where you have an interactive 
button. For ways to work around such situations, see Tips & Tricks.

To add a tempo setting:

1. In the score, select the cell in the tempo channel where you 
want the new tempo setting to appear.

2. Choose Set Tempo from the Score menu.
The Set Tempo dialog box appears.

˛ Tip You can also open the Set Tempo dialog box by double-clicking a cell in the 
tempo channel.

Tempo setting
Working Behind the Scenes 163



3. Select the option you want to use.
For information about the options in the dialog box, see “Set 
Tempo” under “Score menu” in Chapter 6, “Menu Reference.”

4. Click OK.
A number that matches the setting you’ve chosen appears in the 
tempo channel.

Comparing actual speed with tempos you’ve set

As mentioned earlier, the tempo setting in the tempo channel is the 
speed Director tries to achieve. Not all computers, however, are 
equally fast, and one of the major reasons Director may fail to keep 
up with the tempo you’ve set is that the computer it’s running on just 
isn’t fast enough.

It’s always a good idea while you’re in the process of creating a movie 
to run the movie on a computer that’s slower than the computer 
you’re using to create it. You can step through the movie frame by 
frame and compare the tempo you’ve set with the actual speed of the 
movie. If the difference is too great and performance on the slower 
computer too poor, you can make changes to the movie to make it 
perform better.

The tempo you’ve set and the actual speed of a movie both appear in 
the control panel.

Tempo setting

Actual speed
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To compare the actual speed of a movie with the tempos you’ve set:

1. Use the Step Forward button to step through the movie 
frame by frame.

2. In each frame, compare the tempo setting shown in the 
control panel with the actual speed shown there.
If you haven’t recorded the actual speed of a movie in a particular 
frame, the control panel displays two dashes (--).

Locking playback speed

Once you have a movie running at the speed you want, you can 
record the duration of each frame and then lock the movie’s speed so 
it can’t play back any faster. For example, you can adjust a movie so it 
runs well on a slow computer and then lock its playback speed so it 
runs the same on all computers regardless of their speed. It’s 
important to remember that even though the movie can’t play back 
any faster after you’ve locked the playback speed, it can still play more 
slowly.

To lock a movie’s playback speed, either choose Lock Frame 
Durations from the Edit menu or click the Lock button on the 
control panel.

To unlock the playback speed, choose Lock Frame Durations or click 
the Lock button again.

Lock button
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To lock an entire movie:

1. Rewind the movie and play it all the way through.
Playing the movie records the actual duration of each frame. If 
you’re working with a movie that has a great deal of interactivity, 
make sure you play through each segment of the movie.

2. Choose Lock Frame Durations from the Edit menu or click 
the Lock button on the control panel.
When you click the Lock button, its appearance changes to show 
that frame durations are now locked.

Once you lock the frame durations, the movie won’t run any 
faster than the durations you’ve set even if the computer it’s 
running on is capable of playing it faster.

To unlock a movie:

þ Click the Lock button.
The appearance of the Lock button changes to show that the 
movie is no longer locked.

Clearing previously recorded frame durations

You may occasionally want to lock the playback speed of only part of 
the movie. To do that, you first need to clear all the frame durations 
you’ve previously recorded for the movie, and then record the actual 
durations in just the parts of the movie where you want to lock the 
playback speed.

To lock part of a movie:

1. Hold down the Option key and choose Lock Frame 
Durations from the Edit menu (or Option-click the Lock 
button on the control panel) to clear any frame durations 
that are set.
The value in the Actual display is replaced with two dashes (--).

2. Select the frames you want to lock and click the Selected 
Frames Only button on the control panel.
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3. Click the Play button to play the frames you’ve selected.
Playing the selection sets the actual duration of each frame that’s 
part of it.

4. Choose Lock Frame Durations from the Edit menu or click 
the Lock button on the control panel.
When you click the Lock button, its appearance changes to show 
that frame durations are now locked.

Once you lock the frame durations, the frames you’ve selected 
won’t run any faster than the durations you’ve set even if the 
computer it’s running on is capable of playing them faster.

To unlock the part of a movie that’s locked:

1. Select the frames that are locked. 

2. Click the Lock button.
The appearance of the Lock button changes to show that the 
frames are no longer locked.
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Adding sounds

Of all the effects you can create in Director, sounds are among the 
most versatile. You can add voice-overs to provide information, 
music to create a mood, atmospheric sounds to set a scene, realistic 
sounds such as footsteps to reinforce animation, fantastic sounds to 
enhance special effects—just about anything you can imagine.

The sound channels in the score and tempo settings you can add to 
the tempo channel provide basic control of sound effects. You can 
create more sophisticated effects using the Lingo commands sound 
fadeIn, sound fadeOut, and the volume of sound. For more 
information, see Using Lingo.

The procedures in this section show how to add a sound to the sound 
channel and how to retrigger a short sound (such as a footstep) that 
you want to use over and over.

Other things you can do

What you can do Where to find out how

Record a sound “Record Sound” in the Cast menu 
section in Chapter 6

Play a sound in the cast window “Cast Member Info” in the Cast menu 
section in Chapter 6

Cut, copy, paste, and clear sounds 
in the sound channels of the score

Edit menu section in Chapter 6

In-between sounds in the sound 
channels of the score

“In-Between Linear” in the Score 
menu section in Chapter 6

Replace one sound in the sound 
channel with another

“Switch Cast Members” in the Score 
menu section in Chapter 6
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Adding sound to a movie

Most sounds require more than one cell for you to hear the whole 
sound. So, when you add a sound to the score, you usually select a 
range of cells rather than just a single cell.

The score has two channels set aside for sounds: 

A sound in sound channel 2 overrides a sound in sound channel 1. A 
sound that’s already playing in either sound channel overrides the 
sound in a digital video movie, and it also prevents the digital video 
movie’s sound from playing even after the sound in the sound 
channel has stopped. Once the sound in a digital video movie has 
started, however, it overrides a sound in either sound channel.

If you’re adding a looped sound—one that plays over and over as 
long as the playback head is in a frame where the sound is set—make 
sure the Looped checkbox in the Cast Member Info dialog box is 
selected for the sound. Otherwise, the sound won’t repeat. (The 
ability to loop is something that’s set when a sound file is created; you 
can’t make a sound repeat by selecting the Looped checkbox if the 
ability to loop hasn’t been built into the sound. )

Sound channels
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To add a sound to a movie:

1. Import the sound.

2. In the score, select the range of cells in the sound channel 
where you want to set the sound.

3. Choose Set Sound from the Score menu.
The Set Sound dialog box appears.

˛ Tip If you want to hear a sound before you add it to the movie, select it and click 
the Play button.

4. Select the sound you want to use, and click OK.
The number that appears in the sound channel corresponds to the 
sound’s number in the cast window.

If the sound cuts off before it’s finished playing when you run the 
movie, use In-Between Linear to fill more cells with the sound. 
Or add a tempo setting to the frame where the sound ends: select 
the option in the Tempo dialog box that makes the movie wait 
for the sound to finish.

˛ Tip Sounds take up considerable disk space. If you know you’re going to use the 
same sounds in several movies, put the sounds in a shared cast. You can then 
use the same sounds in several movies and use much less memory. For 
information about creating a shared cast, see “Creating a shared cast” in 
Chapter 1, “Working with Cast Members.”
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Repeating a sound

You may find that you want to repeat a sound such as a footstep over 
and over to create one continuous sound effect—for example, the 
sound of a person walking.

One way to do that is to use a looped sound. But remember that the 
ability to loop is something that’s set in an AIFF sound file when the 
file is created; you can’t you can’t make an AIFF sound repeat by 
selecting the Looped checkbox in the Cast Member Info dialog box if 
the ability to loop hasn’t been built into the sound.

To repeat a sound that doesn’t have looping built into it, you have to 
retrigger the sound—which means you have to separate each new 
occurrence of the sound in the sound channel with at least one blank 
cell. (Simply filling a continuous range of cells with the sound won’t 
work: Director interprets the entire range as a single instruction to 
play the sound through just once.)

Using a blank cell to retrigger a sound
Working Behind the Scenes 171



To repeat a sound:

1. In the score, go to the sound channel you want to use and 
select the entire range of cells during which you want the 
sound to play.

2. Choose Set Sound from the Score menu.
The Set Sound dialog box appears.

3. Select the sound you want to use, and click OK.
The number that corresponds to the sound’s position in the cast 
window fills the sound channel.

4. Play the section of the movie where you’ve set the sound to 
see how many frames it takes to play the sound once.
The movie may run faster or slower on a computer that runs at a 
different rate from yours, so it may take a different number of 
frames for the sound to play once on a different computer.

5. Select the cell in the frame after the one where the sound 
ended, and choose Clear Cells from the Edit menu.

˛ Tip You can also clear the cell by pressing the Backspace or Delete key.

6. Skip over as many cells as you need to play the sound a 
second time, and clear the cell in the frame following that 
group.

7. Repeat step 6 throughout the entire range you originally 
selected.
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Working with transitions

Without transitions, the only way to get from the end of one scene to 
the beginning of another is with a jump cut: the first scene ends and 
the next abruptly replaces it. Director provides more than 50 
alternatives to the jump cut. For example, you can dissolve from one 
scene to the next, display a new scene strip by strip, or switch to it as 
if revealing it through Venetian blinds. You can wipe across the 
screen revealing the new scene as you go, slide the old scene off the 
stage revealing the new scene underneath, or slide the new scene 
onto the stage covering the old. You can also use many of the 
transitions to make individual elements appear or disappear from the 
screen, and you can even use transitions to create animation—for 
example, you can make bars appear to grow on a bar chart as you 
wipe the new scene over the old.

The procedures in this section show how to select the transitions you 
want to use and where to place them in the score to get the effect you 
want to achieve.

Other things you can do

What you can do Where to find out how

Fade to black or white “Set Palette” in the Score menu section 
in Chapter 6

Gradually shift from one set of 
colors to another

“Extending a palette transition over 
time” later in this chapter
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Adding transitions

Transitions, like tempos, palettes, and sounds, have a channel set aside 
for them in the score.

Before you select the frame where you want to set a transition, it’s 
important to understand how transitions work. A transition always 
takes place between the end of the current frame and the beginning 
of the frame where the transition is set. So, if you want to do a 
dissolve between two scenes, set the transition in the first frame of the 
second scene, not the last frame of the first scene.

Note It’s a good idea to avoid setting a transition, a palette change, and a tempo 
change all in the same frame.

Transition channel
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To add a transition:

1. In the score, go to the transition channel and select the cell 
where you want the transition to occur.

2. Choose Set Transition from the Score menu.
The Set Transition dialog box appears. It lists the transitions you 
can choose from.

˛ Tip You can also open the Set Transition dialog box by double-clicking a cell in 
the transition channel.

3. Select the transition you want.
For many of the transitions, a default setting for Duration and 
Chunk Size appears in the scroll bars at the left of the Transition 
dialog box. You can adjust the scroll bars to make the transition 
faster or slower, smoother or chunkier.

For many of the transitions, you can also select whether the 
transition affects the entire stage or just the area that’s changing 
(the area where any sprites that weren’t on the stage in the 
previous frame appear).

Some transitions look significantly different on Macintosh and 
Windows computers. For more information, see “Set Transition” 
under “Score menu” in Chapter 6, “Menu Reference.”
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˛ Tip You can scroll to the transition you want to select in the transition dialog box 
by typing the first letter of the transition’s name.

4. Click Set.
Director displays the number that corresponds to the transition in 
the transition channel.

If you export a movie that contains transitions as a QuickTime movie 
or PICS file, the transitions may not be preserved.
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Working with color palettes

Note OPEN ISSUE: This information needs to be reviewed.

Director’s palette window provides a place where you can work with 
the color palettes that are part of a movie.

A monitor—depending on its type and the graphics display card that’s 
installed—can display 1-bit color (black and white), 2-bit color (4 
colors), 4-bit color (16 colors), 8-bit color (256 colors), 16-bit color 
(32,768 colors), 24-bit color (16.7 million colors), and 32-bit color 
(16.7 million colors and 8 bits of special effects). Color palettes are 
available only when the monitor’s color depth is set to 2, 4, or 8 bits. 
When you have the monitor set to 1 bit, there’s no color palette 
because the only colors you have to choose from are black and white. 
When you have the monitor set to thousands of colors (16-bit color) 
or millions of colors (24- or 32-bit color), you choose colors not 
from a palette—a collection of 4, 16, or 256 discrete colors—but 
from a continuous spectrum of the thousands or millions of colors 
available.

You can use the palette window to display any existing palette and to 
rearrange or change the colors it contains. You can also make a copy 
of the palette you’ve displayed in the palette window and use the 
copy to create a new palette.

This section explains how cast members are linked to palettes and 
what determines which palette is active. It shows how to make a 
palette active, how to remap the cast to a new palette, and how to 
create a common palette for cast members that don’t share the same 
palette. It also describes how to move colors around in a palette, how 
to make changes to the colors a palette contains, and how to find the 
color chip in the palette that corresponds to a color on the stage.
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Other things you can do

What you can do Where to find out how

Cut, copy, and paste colors in a 
palette

“Cut,” “Copy,” and “Paste” under 
“Edit menu” in Chapter 6

Blend colors in a palette “Blend Colors” under “Palette menu” 
in Chapter 6

Reverse the order of colors in a 
palette

“Reverse Color Order” under 
“Palette menu”

Rotate colors in a palette “Rotate Colors” under 
“Palette menu”

Sort the colors in a palette “Sort Colors” under “Palette menu”

Reserve colors in a palette “Reserve Colors” under 
“Palette menu”

Select all the colors that aren’t 
being used by any of the cast 
members in a movie

“Select Used Colors” under 
“Palette menu”

Import a cast member with its 
palette

“Import” in the File menu section of 
Chapter 6

Remap a cast member to the 
palette that’s active when you 
import it

“Import” in the File menu section of 
Chapter 6

Have Director remap cast 
members automatically

“Movie Info” in the File menu section 
in Chapter 6
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How cast members are linked to palettes

Each cast member that’s set to a color depth of 2, 4, or 8 bits is 
associated with a palette. (Cast members with a color depth of 16 or 
24 bits aren’t associated with palettes because they have the entire 
spectrum of colors the monitor can display associated with them.) A 
palette gets associated with a cast member when you create it. For 
example, if you create a cast member in the paint window, the palette 
that was selected when you created the cast member becomes the 
palette that’s linked to that cast member. If you create a cast member 
by scanning an illustration in a color scanner at a color depth of 2, 4, 
or 8 bits, the scanner’s software creates a palette that’s linked to the 
cast member.

The palette associated with a cast member provides Director with the 
information it needs to display a cast member in the same colors it 
had when you created it. When you import a cast member that was 
created with a palette different from the  palette, Director lets you 
import its palette as well so you can display it exactly as it looked 
when it was created.

A potential problem arises when you want to display a cast member 
associated with a palette that’s different from the palette that’s 
currently active. The computer can display only one palette at a time, 
so you need either to change the palette that’s active to the one the 
cast member uses or to remap the colors in the cast member to the 
colors in the current palette. Director makes it possible to take either 
approach.

A more vexing problem caused by the computer’s inability to display 
more than one palette at a time arises when you want to display two 
(or more) cast members that were created with different palettes. The 
best solution is to create a common palette that contains most of the 
colors in each of the cast members. You can then remap each cast 
member to the common palette. (For more information, see 
“Creating a common palette” and “Remapping the cast to a new 
palette” later in this chapter.)
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What determines which palette is active

The score has a palette channel where you can set which palette you 
want to become active at any given frame in a movie.

While a movie is running, the palette in control of the monitor is 
determined by the position of the playback head in the score. 

When a movie is stopped, the palette associated with the window 
that’s currently active is in control. The most obvious example is the 
palette window: when it’s active, the palette that’s selected is in 
control. If the cast window is active, the palette associated with the 
cast member currently selected is in control. (Since a palette can be a 
cast member, you can switch control from one palette to another just 
by selecting their respective cast members in the cast window.) If the 
paint window is active, the palette associated with the cast member 
displayed there is in control. And so on.

One of the most important things to remember when you’re working 
with palettes is that changing from one palette to another affects 
everything on the screen—not just the stage, but Director’s interface, 
the Finder, and anything else displayed on the monitor.

Palette channel
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Changing palettes in a movie

The palette channel in the score determines which palette is active at 
any point in a movie. The default setting for the palette channel is the 
System-Mac palette. If you place a cast member with a different 
palette on the stage—and it’s the first cast member with a different 
palette in the frame—Director adds the new palette to the palette 
channel automatically. The new palette becomes the active palette 
unless you clear it from the palette channel or replace it with a 
different palette, and it remains in effect until you set a different 
palette in the palette channel.

To switch from one palette to another in a movie:

1. In the score, select the cell in the palette channel where 
you want the palette to take effect.

2. Choose Set Palette from the Score menu.
The Set Palette dialog box appears.

˛ Tip You can also open the Set Palette dialog box by double-clicking a cell in the 
palette channel.
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3. Select a palette from the Palette pop-up menu.
The choices always include System-Mac, System-Win, 
Rainbow, Grayscale, Pastels, Vivid, NTSC, Metallic, and VGA 
palettes. If you’ve added any other palettes to the cast they also 
appear in the Palette pop-up menu.

˛ Tip Since the palette you choose affects everything displayed on the monitor—
including Director’s interface—you may find it difficult to see what you’re 
doing after you select a new palette. If that’s the case, choose Preferences from 
the File menu, and then choose Black and White User Interface from the 
Preferences dialog box. The black-and-white interface looks the same no 
matter which palette is active.(You might also want to deselect the Colored 
Cells checkbox in the Score Windows Options dialog box.)

4. Click Set.
The palette you choose now appears in the cell you selected in 
the palette channel of the score. It remains in effect in the movie 
until you set a different palette in the palette channel.

Hiding a palette change with a transition

When you switch from one palette to another, you’ll notice that 
sprites on the stage in the frame just before the change occurs appear 
briefly in the colors of the new palette. To mask the flash of color, set 
a transition in the same frame where you set the new palette.
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To mask the flash of color with a transition:

1. In the score window, double-click the cell in the transition 
channel that’s in the same frame where the new palette 
appears.
The Set Transition dialog box appears.

2. Select a transition.

The best transitions for hiding the flash of color are ones that happen 
quickly over the entire screen, such as Checkerboard, Boxy Dissolve, 
or Venetian Blinds.

3. Click Set.

When you play the movie, the transition doesn’t completely hide the 
flash of color, but it does distract the eye of the viewer and make the 
flash less obvious.

A more effective way of handling the change from one palette to 
another is with a palette transition. For more information, see 
“Creating color effects” later in this chapter.
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Remapping the cast to a new palette

If cast members you’ve assembled in the cast window use different 
palettes, the task of using them in the same movie—even if cast 
members with different palettes don’t appear on the stage at the same 
time—can be complicated.

You can avoid the problems of switching from one palette to another 
by mapping the entire cast to a single palette. The best approach is to 
find the palette that contains most of the colors most of the cast 
members use (a quicker approach is to use the palette the majority of 
the cast members already use) and then to remap any cast members 
using a different palette to the one you’ve chosen. If you can’t find a 
palette with enough common colors, you can create one (see 
“Creating a common palette” later in this chapter).

When Director remaps a cast member to a new palette, it finds the 
colors in the new palette that most closely match the colors in the 
original palette. The result is usually a close, although not identical, 
match.

You can also have Director remap a cast member when you import it 
(see “Import” under “File menu” in Chapter 6, Menu Reference”) 
or automatically when it’s needed (see “Movie Info,” in Chapter 6).

Note Make a duplicate of a cast member before you remap it to a different palette. 
That lets you preserve the cast member the way it was meant to look in case 
you don’t like the results of the remapping.
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To remap a cast member to a new palette:

1. Go to the cast window and select the cast member you 
want to remap.
If you want to remap more than one cast member, select them 
all.

˛ Tip If you’re working with a large number of cast members, use the Find Cast 
Members command to select all the cast members that use a specific palette.

2. Choose Transform Bitmap from the Cast menu.
The Transform Bitmap dialog box appears.

3. From the Palette pop-up menu, choose the palette that you 
want to remap the cast member to.

4. Select Dither or Remap to Closest Colors.
Dither produces blends of colors that approximate as closely as 
possible the original color. Remap to Closest Colors uses the 
solid color in the new palette that’s closest to the original color.

5. Click OK.
An alert appears. It tells you that you can’t undo the change and 
asks if you want to transform the cast member.

6. Click OK.
Director replaces the colors in the cast member with the colors 
from the new palette that match them most closely. 

Palette pop-up menu
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Creating a common palette

If you can’t find a palette that contains most of the colors used by 
most of the cast members in a movie, you can create one. You can 
then remap all the cast members to the common palette.

Although the process varies depending on the range of colors the cast 
members use and the number of cast members and palettes you’re 
dealing with, it follows the same general steps:

◆ Find the existing palette you want to use as the basis of the 
common palette.

◆ Assemble the common palette.

◆ Remap the cast to the common palette.
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To find the existing palette that you want to use as the basis of the 
common palette:

1. Select the cast member in the cast window with the palette 
that seems like the best candidate.
If you have a cast member that doesn’t use all the colors in its 
palette, try it first.

2. Choose Color Palettes from the Window menu (or press 
Command-8) to open the palette window.

3. Choose Select Used Colors from the Palette menu. 
The Select Colors Used in Bitmap dialog box appears.
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4. Click Select.
Director highlights the colors used by the selected cast member. 

If the cast member uses all or most of the colors, try another 
palette. The goal is to find a palette with as many unused colors as 
possible so you can add colors to it without disturbing the 
original palette or the cast member that the palette is associated 
with. When you find a palette that has a large number of unused 
colors, you can duplicate it and use the copy to build the 
common palette. If all the cast members use most of the colors in 
their respective palettes, you can duplicate any of the palettes.

5. When you find the palette you want to use as the basis for 
the common palette, choose Duplicate Palette from the 
Palette menu.
Director displays a dialog box where you can enter a name for 
the new palette.

6. Name it Common Palette, and then click OK.

The next part of the process is to assemble the common palette. The 
first step is to move the selected colors—the colors used by the cast 
member that’s currently selected—to the top of the palette where you 
won’t disturb them when you add colors used by other cast members.

If the selected cast member uses a large number of the colors in the 
palette, you may want to select just a representative sample of the 
colors it uses. For example, if the cast member has a wide range of 
reds and greens you can probably sacrifice a number of intermediate 
shades without degrading the quality of the image.
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To assemble the common palette:

1. Use the hand tool to drag any color that’s selected to the 
color chip in the upper left corner of the palette.
Director consolidates the colors into a contiguous range. The 
colors on the screen change, reflecting the change in the palette.

2. Choose Invert Selection from the Palette menu.
Invert Selection reverses the selection so all the color chips that 
weren’t selected before are now highlighted. The colors now 
highlighted are the ones you don’t need in the common palette.

3. To make the part of the palette you don’t want to keep 
easier to identify, choose Blend Colors from the Palette 
menu.
Director replaces the unused colors with a smooth blend of 
colors. You can replace the blended colors with the colors the 
other cast members use.

To add colors from another cast member to the common palette:

1. Choose a cast member with a different palette from the 
cast window.

2. Make the palette window active, and then choose Select 
Used Colors from the Palette menu. 
The Select Colors Used in Bitmap dialog box appears.

3. Click Select.
Director highlights the colors used by the selected cast member.

If the selected cast member uses a large number of the colors in 
the palette, select just a representative sample. If several cast 
members use the palette, you may need to repeat the previous 
three steps for all of them to find a sample that’s representative of 
all of them.
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4. Choose Copy Colors from the Edit menu (or press 
Command-C) to copy the selected colors.

5. Choose Common Palette from the pop-up menu in the 
Palette window.
The common palette reappears in the palette window.

6. Select the first color chip in the area that contains the 
blended colors and choose Paste Colors from the Edit menu 
(or press Command-V).
Director pastes the colors you copied into the common palette.

7. Repeat steps 1 though 6 for each cast member with its own 
palette.

Once you’ve created a common palette that contains a representative 
range of colors from all the other palettes, you’re ready for the final 
part of the process: remapping each cast member to the common 
palette.

It’s best to work with a copy of each cast member rather than the 
original. You’ll discover the best palette for all the cast members only 
by experimenting. If you don’t like the results of remapping to one 
palette, you can create a new common palette and try remapping the 
cast members to it. Having the original cast member to go back to 
makes it much easier to experiment until you get the results you 
want.
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To remap the cast to the common palette:

1. Select all the bitmap cast members in the cast window.

2. Choose Duplicate Cast from the Cast menu (or press 
Command-D).
Director makes copies of all the cast members you’ve selected and 
displays them in the next available spots in the cast window.

3. Choose Transform Bitmap from the Cast menu.
The Transform Bitmap dialog box appears.

4. Choose Common Palette from the Palette pop-up menu.

5. Select either Dither or Remap to Closest Color.
Dither produces blends of colors that approximate as closely as 
possible the original color. Remap to Closest Colors uses the 
solid color in the new palette that’s closest to the original color.

6. Click OK.
An alert box appears. It tells you that you can’t undo the change 
and asks if you want to transform the cast member.

7. Click OK.
Director remaps the cast to the new palette. 

You may need to try several times before you create a palette that has 
the right set of colors you need to make all the cast members look 
good. But you’ll find that many cast members look virtually the same 
with fewer than half the colors of their original palettes.
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Editing palettes

You may find that while the palette you’ve chosen has all the colors 
you need for most of the cast members, it needs one or two more 
colors for a particular cast member. It’s easy to add a new color to a 
palette—but because every palette has space for only a finite number 
of colors, adding a new color means replacing a color that’s already 
part of the palette. When you do that, you have to make sure you 
don’t replace a color you’re using for some other cast member.

The Color Picker

The easiest way to choose a new color for a palette is with the Color 
Picker.

The Color Picker is similar to the color wheel artists use to organize 
the spectrum of colors. The Macintosh Color Picker uses two systems 
to measure color: Hue, Saturation, Brightness (HSB) and Red, 
Green, Blue (RGB). Each of the 16 million colors that the Macintosh 
can display has unique values in the HSB and RGB systems. 
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The color currently selected in the palette window appears in the 
color box on the left side of the dialog box; its location on the color 
wheel is marked by a small square. As you change the color, only the 
top half of the color in the box changes so you can compare the 
current color with the original. 

Below the box are the controls to change the Hue, Saturation, and 
Brightness. You can type numbers directly into the boxes for the H, 
S, or B values, or click the up or down arrows. The numbers are a 
useful reference if you’re trying to duplicate a color exactly. As you 
change the hue, you can see the spot in the color wheel move around 
the color wheel in a circle. As you change the saturation, the spot 
moves toward or away from the color wheel’s center. 

You can also click or drag in the color wheel to set the hue and 
saturation. Brightness is controlled with the scroll bar to the right of 
the color wheel.
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Changing a color with the Color Picker

To change a color with the Color Picker:

1. Choose Color Palettes from the Window menu (or press 
Command-8) to display the palette window.

2. Select the name of the palette you want to change from the 
Palette pop-up menu.
The palette you select appears in the palette window.

3. Double-click the color you want to change.
The Color Picker appears.

4. Select the color that you want to replace the current color 
with, and then click OK.
If you’re working with one of the default palettes, a dialog box 
appears so you can name and save the new palette.

5. Type a name and click OK.
The new color replaces the old color in the palette.

Moving colors in a palette

Sometimes you need to shuffle the order of the colors in a palette (for 
example, when you’re drawing a gradient with adjacent colors or 
isolating a range of colors to create a common palette). In either case, 
you can use the hand tool in the palette window to move colors 
around.

To move colors in a palette:

1. Select the hand tool in the palette window.

2. Select the color you want to move.

3. Drag the color to a new position.
If you’re working with one of the default palettes, a dialog box 
appears so you can name and save the new palette.

4. Type a name for the new palette, and then click OK.
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˛ Tip You can drag the hand tool across a number of colors in a palette to select a 
range of colors, or you can press the Command key and click with the hand 
tool to make a discontiguous selection of colors. When you have a 
discontiguous selection, dragging one of the colors to a new position reorganizes 
all the selected colors so they occupy a contiguous range.

Identifying colors on the stage

You may find that you need to identify the specific color chip in the 
palette that matches a color that appears on the stage. For example, 
you may want to create another cast member that uses exactly the 
same color; or you may want to create a color cycling effect that 
includes the color. To identify the color chip in the palette that 
matches any color on the stage, use the eyedropper tool in the palette 
window.

Eyedropper tool
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To use the eyedropper to identify a color:

1. Choose Color Palettes from the Window menu (or press 
Command-8) to display the palettes window.

2. Select the eyedropper tool.

3. Click any spot on the stage.
The color chip that matches the color of the pixel you click is 
selected in the palette.
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Creating color effects

There are two ways you can use palette settings in the palette channel 
of a movie’s score to create effects with color:

◆ Palette transitions. Use palette transitions to control a shift 
from one palette to another. A palette transition can mask a 
change from one palette to another by fading the screen to black 
during the change, or it can animate the change either between 
frames or over a series of frames, shifting every color gradually 
through a range of intermediate colors to its counterpart in the 
new palette.

◆ Cycling through colors. Use a palette setting to cycle through a 
range of colors you’ve selected in a palette. Cycling colors is a 
great way to represent flowing, spinning, or pulsing objects.

The most important thing to remember about effects you create with 
palette settings is that they affect not just the stage, but anything that 
appears on the monitor. For example, if you fade to black to mask a 
palette change, the entire screen fades to black.

Hiding a palette change with a fade

When you switch from one palette to another, you’ll notice that 
sprites on the stage in the frame just before the change occurs appear 
briefly in the colors of the new palette. You can mask the flash of 
color with a transition in the transition channel, but a more effective 
way to handle the change is to fade the screen to black (or white), 
change to the new palette, and then fade up from black with the new 
palette already in effect. Director can handle the entire process with a 
single palette transition.

Remember that when you fade the screen to black or white to switch 
palettes, the entire screen—not just the stage—fades to black or 
white.
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To mask a palette change with a fade:

1. Go to the score, and select the cell in the palette channel 
where you want the new palette to take effect.

2. Choose Set Palette from the Score menu.
The Set Palette dialog box appears.

˛ Tip You can also open the Set Palette dialog box by double-clicking a cell in the 
palette channel.

3. Select Palette Transition near the top of the dialog box.

4. If you haven’t already set the palette that you want to 
change to, choose it from the Palette pop-up menu.

5. Select Fade to Black or Fade to White.

6. Make sure the checkbox next to Over Time isn’t selected.

7. Click Set.
The number of the palette that you’re changing to appears in the 
cell in the palette channel.
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Setting palette transitions between frames

Fading the screen to black or white may not be an appropriate effect 
at the point in the movie where you want to switch from one palette 
to another. Another technique you can use to prevent an abrupt 
switch from one set of colors to another is a gradual change that 
occurs between the last frame where the old palette is in effect and 
the first frame where the new palette assumes control.

Don’t use this technique if an animated sequence spans the frames 
where the palette change occurs. The gradual change from one 
palette to another—because it occurs between two frames—stops any 
animation that’s in progress while the change is occurring. For 
information about creating a palette transition that happens at the 
same time animation is in progress, see the next section, “Extending 
palette transitions over time.”

Remember that the transition from one palette to another affects the 
entire screen, not just the stage.

To create a palette transition between frames:

1. Go to the score, and double-click the cell in the palette 
channel where you want the new palette to take effect.
The Set Palette dialog box appears.

2. Select Palette Transition near the top of the dialog box.
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3. If you haven’t already set the palette that you want to 
change to, choose it from the Palette pop-up menu.

4. Use the Speed slider to set the speed of the transition.
The farther to the right you drag the slider, the faster the 
transition happens.

5. Make sure the check box next to Over Time isn’t selected.

6. Click Set.
The number of the palette that you’re changing to appears in the 
cell in the palette channel.

Run the animation to test the speed you’ve set. If it’s too fast or too 
slow, double-click the cell in the palette channel where the setting 
appears and adjust the Speed slider. 

˛ Tip You can get a better idea of how the palette transition works if you open the 
Palette window and watch the transition there.

Extending a palette transition over time

When Director changes from one palette to another over time, the 
animation continues on the stage as the palettes change.

To extend a palette transition over time:

1. In the score window, select the cells in the palette channel 
during which you want the transition to take place.
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2. Choose Set Palette from the Score menu.
The Set Palette dialog box appears.

3. Select Palette Transition near the top of the dialog box.

4. If you haven’t already set the palette that you want to 
change to, choose it from the Palette pop-up menu.

5. Select the checkbox next to Over Time.

6. Click Set.
The number of the palette that you’re changing to appears in the 
entire range of cells you’ve selected. The change isn’t complete, 
however, until the playback head reaches the last cell in the 
range.

Cycling colors

You can have Director cycle through a range of colors you’ve 
selected in the palette. As Director cycles through the colors, any spot 
on the stage where any of the colors in the range appear changes in 
turn to each of the other colors in the range.

You can use color cycling to create effects such as a sunrise or sunset, 
a ball spinning, or a waterfall.

You can set up color cycling so that it occurs in a single frame or over 
a range of frames.
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˛ Tip Since color cycling affects everything displayed on the monitor—including 
Director’s interface—you may find it difficult to see what you’re doing when 
you’re working with color cycling. If that’s the case, choose Preferences from the 
File menu, and then choose Black and White User Interface from the 
Preferences dialog box. The black-and-white interface looks the same no 
matter which colors are in effect.

To cycle colors:

1. Go to the score window, and in the palette channel select 
the cell or cells where you want the cycling to take place.

2. Choose Set Palette from the Score menu.
The Set Palette dialog box appears.

3. Select Color Cycling.

4. If the palette you want to use isn’t the one that appears in 
the dialog box, choose the palette from the Palette pop-up 
menu.

5. Use the palette in the dialog box to select the range of 
colors you want to cycle.

6. Select the settings you want to use.
For information about the settings, see “Set Palette” under 
“Score menu” in Chapter 6, “Menu Reference.”

7. Click Set.
The number of the palette you’ve selected appears in the cells 
you selected in the score.
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When you play the movie, as the playback head reaches the frames 
where the color cycling is in effect, any sprite that contains a color in 
the range you selected changes in turn to each of the other colors in 
the range.

˛ Tip You can get a better idea of how color cycling works if you open the Palette 
window and watch the cycling there.
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Creating a projector

A projector is a play-only version of a Director movie. Anyone—even 
someone who doesn’t own a copy of Director—can play it. The only 
thing that’s needed is a computer that meets certain basic system 
requirements. (For details, see “Hardware and Software 
Requirements” in the introduction.)

Note OPEN ISSUE: What are the system requirements to play a projector?

A projector is the ideal way to package movies for distribution. 
Anyone can play them, but no one can open them again in Director 
and edit or copy them.

If you’ve created a series of related movies that play one after another 
or a movie that branches to one or more other movies, you can 
include them all as part of the same projector. If the order in which 
the movies play is important, you need to arrange them in the same 
order before you turn them into a projector.

For more information about projectors, see “Create Projector” in 
Chapter 6, “Menu Reference;” also see “Frequently Asked 
Questions” in Tips & Tricks.
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To create a projector:

1. If you have a movie open, save it, and then close it.

2. Choose Create Projector from the File menu.
The Create Projector dialog box appears.

3. From the list of source movies on the left side of the dialog 
box, select the movie you want to turn into a projector, and 
then click the Add button.
Director transfers the name of the movie to the list on the right.

If you want to add more movies to the projector, repeat the step 
for each one. If you want to include all the movies that are in the 
directory that’s open, click the Add All button.
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4. Click the Options button.
The Projector Options dialog box appears.

5. Select the options you want, and then click OK.
For information about the options, see “Create Projector” under 
“File menu” in Chapter 6, “Menu Reference.”

6. Click Create.
The Save dialog box appears.

7. Name the projector, and then click Save.
Director turns the movies you’ve selected into a projector.

If you want to create a projector for a different movie or set of 
movies, repeat the procedure. When you’re finished:

þ Click Done to close the dialog box.

To play a projector, you double-click the icon associated with it. The 
projector starts the play-only version of Director, plays the movies, 
and then quits Director automatically.
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Chapter 4

Making a Movie Interactive

Making a movie interactive means building into it the ability to 
respond to choices that users make. The goal of interactivity is to 
give users some degree of control over a movie. Interactivity can 
sometimes be extraordinarily subtle and difficult to achieve, but 
when your goals are modest you can achieve remarkable results 
with very little effort.

Normally, the only control a user has over a movie you’ve 
created is to start it and let it run until it reaches the end. The 
simplest level of control you can build into the movie itself is to 
give users control over the pace at which they move from one 
part of the movie to the next.
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Director gives you two ways to provide that kind of control. The 
easiest to use is a tempo setting. One of the options you have to 
choose from when you create a tempo setting stops the movie and 
simply waits until the user clicks the mouse button or presses any key 
on the keyboard before it allows the movie to go on to the next 
frame. (For more information, see “Wait for Mouse Click or Key” 
under “Set Tempo” in Chapter 6, “Menu Reference.”) A more 
sophisticated approach is to create “next” and “previous” buttons that 
allow users to move both forward and backward through a movie. 
For an example of “next” and “previous” buttons, see the sample 
movie Noh Tale to Tell (go to the Macromedia Director 4.0 folder, 
open the Sample Movies folder, then the Lingo Expo folder, and 
finally the Storybook folder, and then start Noh_Tale).

A more complex form of interactivity is branching—allowing users to 
choose a path through a movie, rather than limiting them to a single 
path that goes directly from beginning to end. For an example of how 
branching works, see the sample movie Furniture + Philanthropy (go to 
the Macromedia Director 4.0 folder, open the Sample Movies folder, 
then the Lingo Expo folder, and finally the Kiosk folder, and then 
start Begin.Dir). Branching uses buttons to show users what their 
choices are—but as you can see in Furniture + Philanthropy, buttons 
can take many different shapes and forms.

Whenever you create a button—whether to allow users to go from 
one segment to the next or to choose the path they want to follow—
you also need to write a Lingo script that tells Director what to do 
when someone clicks the button. While writing scripts may sound 
like the kind of thing only people with experience in programming 
should try, it’s a lot easier and less intimidating than you may think.

The procedures in this chapter show how to create and use markers, 
how to set up hypertext links, and how to create buttons and write 
scripts for them.
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Using markers

You can write a script that tells a movie to go to a specific frame that 
marks the beginning of a segment. Such a script would say something 
like go to frame 13—which means to go to the frame numbered 
13 in the score.

Frame 13
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The problem with that approach is that if you add or delete a frame 
before frame 13, the script no longer tells the movie to go to the right 
place. A much better practice is to put a marker in the first frame of a 
segment and give the marker a name. 

When there’s a marker, the script can tell the movie to go to the 
marker, and you can add and delete frames without worrying about 
having to rewrite scripts whenever you do so. A script that tells a 
movie to go to a marker looks something like this: 

go to frame "Screen Two"

It’s always accurate as long as you don’t rename the marker that the 
script refers to.

Marker

Marker name
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Creating and labeling a marker

To create a marker:

1. Drag a marker from the marker well and place it above the 
frame where you want the marker to appear. 

2. Type the name you want to give the marker and press 
Return.
The name appears to the right of the marker.

Using the marker window

Once you’ve set a marker, it appears not only in the score, but also in 
the marker window. The marker window has two uses. You can 
select the name of a marker to display the part of the score where the 
marker is located. That can come in handy when you’re working on 
a complex score with lots of frames. You can also use the marker 
window to add comments about each segment of a movie where 
you’ve placed a marker.

Marker positioned above frame 13Marker well
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To use a marker to display the part of the score where it’s located:

1. Choose Markers from the Windows menu.
The Markers window appears.

The names of all the markers are listed on the left side of the 
marker window. Any comments you’ve added about the marker 
that’s currently selected appear on the right side of the window.

2. Select the marker located in the part of the score you want 
to display in the score window.
Director moves to the part of the score where the marker is 
located.

Marker labels

Comments
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Creating buttons

The Tools window provides tools for creating standard buttons, radio 
buttons, and checkboxes.

◆ Standard buttons. Use standard buttons when you want a 
movie to respond to the user immediately. For example, use a 
standard button to allow a user to pause the animation on the 
stage, to branch to a different part of a movie, or to quit a movie.

◆ Radio buttons. Use radio buttons for mutually exclusive 
options. For example, if you’re creating a storybook that displays 
text in more than one language, use radio buttons to let users 
select which language they want to appear on the screen.

◆ Checkboxes. Use checkboxes for options that aren’t mutually 
exclusive. For example, if you’re creating a kiosk with travel 
information, use checkboxes to allow users to select the activities 
they’re interested in.

Each type of control operates just as you’d expect. When you click a 
standard button, it’s highlighted as you press the mouse button down 
and then returns to normal as you release the mouse button. When 
you click a radio button, a dot appears inside the circle; when you 
click it a second time, the dot disappears. When you click a 
checkbox, an X appears in the box and then disappears when you 
click the box a second time. But remember that any control you 
create with any of the tools is just an animated image—it needs a 
Lingo script before it can cause anything to happen.

Standard button

Radio buttons

Checkboxes

Standard button tool
Radio button tool

Checkbox tool
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Simple Lingo scripts are easy to create. The scripts for buttons that 
allow users to choose a path through a movie are about a half dozen 
words long—and Director writes part of the script for you.

To create a button:

1. Choose Tools from the Window menu to open the Tools 
window.

2. Select the tool for the type of button you want to create.

3. Position the pointer on the stage, and drag toward the left 
or right until the box that appears is big enough to 
accommodate the text for the button.
The button appears on the stage. Director also adds it to the cast 
window.

A radio button or checkbox always appears aligned with the left 
edge of the box you’ve drawn—no matter which way you draw 
the box—so you can type the text to the right.

4. Type the text you want to appear on or next to the button.
If you want to change the way the text looks, select it, and then 
choose the appropriate settings from the Text menu.

5. Create a script for the button.
For information about creating a script, see “Writing scripts” later 
in this chapter.

˛ Tip You can edit a button’s text either in a text window or on the stage.

Standard button tool
Radio button tool

Checkbox tool
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Creating a hypertext link

A hypertext link works just like a button: when a user clicks some 
text on the screen—an entire block, just a phrase, or a single word—
a script associated with the text tells Director to go to a different 
segment of the movie.

There are two ways to set up a hypertext link. You can make the 
entire cast member containing the text act as the button, or you can 
make just a word or phrase within the cast member act as the button. 
Making just part of the text in a cast member act as a button is a little 
more difficult than making the entire cast member act as a button.

The two procedures in this section will work for nearly every 
situation in which you want to create a hypertext link. If you want to 
do something more sophisticated than either of the procedures can 
accommodate, you’ll need to rely on what you can accomplish with 
Lingo. For example, if you want to create a hypertext link in a 
scrolling text field, you can use the mouseWord function. For more 
information, see Using Lingo.

Using an entire text block as a button

To make an entire text block act as a button:

1. Create the text.
You can use either the paint text tool or the text tool in the tools 
window. If you use the text tool in the tools window—which 
creates QuickDraw text—it’s best to convert the cast member to 
a bitmap when you’ve finished editing the text. See “Creating 
text with the tools window” in Chapter 1, “Working with Cast 
Members,” for more information.

2. In the cast window, select the cast member that contains 
the text.
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3. Click the Script button at the top of the cast window.
A script window appears.

4. Type the script that creates the hypertext link, and then 
close the Script window.

A typical script for a hypertext link would take the user to a different 
segment of the movie. It might look something like this:

on mouseDown
 go to frame "woodwinds"
end 

“Woodwinds” is the name of the marker that marks the beginning of 
the segment. For more information about writing a script, see 
“Writing scripts” later in this chapter.

You can use the hypertext cast member you’ve created just as you 
would any other block of text. The only difference between it and a 
normal block of text is that when a user clicks it, Director follows the 
instructions in the script you’ve attached to the hypertext cast 
member and goes to the movie segment you’ve indicated in the 
script.
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Using part of a text block as a hypertext link

When you want to use a word or phrase in a block of text as a 
hypertext link, setting up the link involves:

◆ Creating the text

◆ Converting the text to a bitmap

◆ Creating a transparent cast member that first you place over the 
word or phrase and then attach a script to

◆ Writing the script.

The first part of the process is to create the text block:

1. Create the text using the text tool in the Tools window.

2. Select the word or phrase you want to act as a button and 
make it a different color, font, size, or style to make it 
stand out.

3. Arrange the text on the stage exactly as you want it to 
appear.

The text you create with the text tool in the tools window is 
QuickDraw text. Remember that Director can display the font 
you’ve chosen for QuickDraw text only if the font is installed on the 
computer where it’s running—and someone running the movie 
you’ve created may not have the same fonts you have. If the font 
you’ve chosen isn’t available, the system will replace it with a 
different font. The text may end up looking quite different from the 
way you laid it out.

To make sure the text doesn’t change, convert it to a bitmap:

1. In the cast window, select the cast member that contains 
the text.

2. Choose Convert to Bitmap from the Cast menu.
Director turns the text cast member into a bitmap cast member.

The next step is to create a transparent cast member you place over 
the text you want to act as the hypertext link. The transparent cast 
member is actually the button that makes the hypertext link work.
Making a Movie Interactive 217



To create the transparent cast member:

1. Select the filled rectangle tool from the tools window.
Be sure you select the filled side of the rectangle tool. When you 
draw a rectangle with the unfilled rectangle tool, you create 
what’s essentially an empty frame: the inside of the rectangle is 
invisible because there’s nothing there. An empty frame won’t 
work as a button, because when you click inside it you’re 
clicking empty space. On the other hand, when you draw a 
rectangle with the filled rectangle tool and then make it 
transparent, there’s something inside the rectangle—it just 
happens to be invisible because you’ve made it transparent.

2. Select the same color from both the foreground and the 
background color chips in the tools window.

3. Draw a rectangle over the text you want to use as the 
hypertext link.

4. Choose Background Transparent from the Ink pop-up menu 
in the score.
The rectangle becomes invisible.

The final step is to write the script for the invisible button:

1. Go to the cast window, and select the transparent cast 
member.

2. Click the script button at the top of the cast window.
A script window appears.
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3. Type the script, and then close the script window.
A typical script for a word or phrase that’s a hypertext link looks 
the same as the script for an entire block of text that acts as a link. 
For more information about writing a script, see “Writing 
scripts,” next.

When users click the part of the text that’s formatted differently, 
they’re really clicking the transparent cast member you’ve placed over 
the text. Director follows the instructions in the script you’ve 
assigned to the transparent cast member and goes to the movie 
segment you’ve indicated in the script.
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Writing scripts

This section describes four script scenarios that outline the kind of 
navigation techniques you’ll find yourself using again and again.

Writing scripts is a lot easier and less intimidating than you may think. 
None of the scripts in this section is longer than seven words. You 
can master all the Lingo you need to know to use the techniques in 
this section in under an hour.

Note You may notice that after you’ve added buttons to a movie, the cursor seems to 
disappear occasionally. That happens because Director doesn’t display the 
cursor when there’s nothing on the screen to click.

Types of scripts

The script scenarios in this section use three types of scripts:

◆ Cast member scripts

◆ Sprite scripts

◆ Frame scripts.

Sprite scripts and frame scripts are also known as score scripts because 
they appear in the score.

Note Director has a fourth kind of script that you’ll encounter after you’ve mastered 
basic Lingo—movie scripts. For information about them, see Using Lingo.
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Cast member scripts

Every button is a cast member. A cast member script—which you 
attach to a button in the cast window—becomes a permanent part of 
the button. The script goes with the button no matter where you use 
the button in the movie. (You can attach a script not just to a button 
cast member, but to any bitmap, PICT, shape, or text cast member; 
that means you can use any of those cast members as a button.)

A cast member script looks something like this:

on mouseUp
 go to frame "Screen Two"
end 

Director automatically supplies the first and last lines of the script. 
You need to supply only the middle line.

The first line, on mouseUp, means “when a user clicks the mouse on 
this button.” The last line, end, indicates the end of the script. So, if 
you add a middle line that reads

go to frame "Screen Two"

the script means, “When a user clicks the mouse on this button, go to 
the frame that has the marker named Screen Two. That’s the end of the 
script.”

Use a cast member script when you want Director to do exactly the 
same thing whenever anyone clicks the button that the script is 
attached to. But be aware that “do exactly the same thing” means “do 
absolutely exactly the same thing.”

Suppose, for example, you’ve set up a button named Next at the end 
of the first screen of a movie, and you want the button to take the 
user to the second screen. You label the marker in the first frame of 
the second screen Screen Two and attach this cast member script to the 
button:

on mouseUp
 go to frame "Screen Two"
end 
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The button works fine. But if you try to use the same button on the 
third screen, Director will go, not to the fourth screen, but back to 
the second screen. That’s because even though the button says Next, 
the script tells Director to go to the frame labeled Screen Two no 
matter where the button is located in the movie.

When you attach a script to a cast member, an indicator appears in 
the lower left corner of the cast member’s thumbnail in the cast 
window.

Sprite scripts

Remember that when you place a cast member on the stage, what 
Director displays is not the cast member itself, but a sprite associated 
with the cast member. The cast member remains in the cast window, 
and the sprite—an image of the cast member—appears on the stage.

Remember also that a cast member and a sprite aren’t identical. A cast 
member is the template for a sprite, and the sprite has information 
associated with it—such as its position on the stage—that isn’t 
associated with the cast member. Director stores information 
associated with a sprite in a cell in the score, and that information—
like the sprite’s position—can change from cell to cell. Part of the 
information that can be stored in the cell is a script associated with a 
sprite.

Because the information associated with a sprite can change from cell 
to cell, a sprite script—unlike a cast member script—is associated with 
a button in only one cell at a time. You could, for example, have two 
sprites associated with the same button cast member on the stage at 
the same time, and if they had different sprite scripts, something 
different would happen when you clicked each of them. 

Script indicator
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A sprite script for a button looks identical to a cast member script for 
a button, and Director automatically supplies the first and last lines of 
the script. You need to supply only the middle line.

It’s possible for a cast member to have both a cast member script and 
a sprite script associated with it. When that happens, the sprite script 
overrides the cast member script.

Frame script

There’s a third type of script you may use occasionally in conjunction 
with a cast member or sprite script—a frame script. A frame script is 
associated with an entire frame in the score, rather than with a cast 
member or a sprite.

A frame script looks something like this:

on exitFrame
 pause
end 

Director automatically supplies the first and last lines of the script. 
You need to supply only the middle line.

The first line, on exitFrame, means “when everything else in this 
frame has been done.” The last line, end, indicates the end of the 
script. So, if you add a middle line that reads

pause 

the script means, “When everything else in this frame has been done, 
wait for an instruction to continue. That’s the end of the script.”

One of the most common ways you’ll use frame scripts is to pause a 
movie to wait for a user to press a button.
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Script scenarios

The four scenarios in this section cover the four most common 
situations that you’ll want to write scripts for:

◆ Allowing users to go from one segment to the next at their own 
pace

◆ Allowing users to go to a segment that’s not immediately after the 
current segment in the score

◆ Allowing users to go to a segment and returning them 
automatically to the spot they branched from

◆ Allowing users to quit a movie.

Going to the next segment after a pause

If you want to allow users to go from one segment of a movie to the 
next at their own pace, you need to write two scripts: 

◆ The first script pauses the movie at the end of a segment.

◆ The second script resumes the movie when the user clicks a 
button.

Script one: pause 
The script that pauses a segment is a frame script. It looks like this:

on exitFrame
 pause
end 
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To create the script:

1. Go to the score, and in the script channel, select the cell 
where you want the script to appear.

2. Choose New from the script pop-up menu.

A script window appears.

3. On the middle line of the script, type:
pause 

That’s all you need to add.

4. Close the script window.

Add the same script to the final frame of every segment in the movie.

Script two: continue 
The script that goes to the next segment is a cast member script. You 
attach the script to the button you want users to click to continue to 
the next segment. The script looks like this:

on mouseUp
 continue
end 

Script pop-up menu
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To create the script:

1. In the cast window, select the cast member that you want 
to attach the script to.

2. Click the script button in the cast window.
A script window appears.

˛ Tip Control-click the cast member to display a script window.

3. On the middle line of the cast member script, type:
continue 

That’s all you need to add.

4. Close the script window.

Add the button with the script to the final frame of every segment in 
the movie. The script is part of the button, so it goes with the button 
wherever you place the button in the movie.

Note For the final segment of the movie, you probably want to have a Quit button 
instead of a Continue button. See “Leaving a movie” later in this chapter for 
the appropriate script.

About pause and continue 
The pause and continue commands are easy to use, but 
unfortunately that makes them easy to use in the wrong 
circumstances.
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It’s important to understand exactly what pause does: it stops 
Director’s playback head. Using it is just like pressing the pause 
button on a VCR: the picture remains frozen on the screen until you 
press the play button again. The difference between a videotape and a 
Director movie is that more may be going on in a Director movie 
than just the image that appears on the screen. When you use pause 
to stop the movie, you also stop any Lingo scripts that may be 
running unseen in the background.

When you start creating movies where things are happening behind 
the scenes, the appropriate alternative to the pause command is the 
statement go to the frame (the next section describes how to use 
it). When you use go to the frame, the playback head remains in 
the same frame, but it never stops moving—it keeps returning to the 
same frame over and over until you give Director an instruction to go 
to a different frame.

Going to a segment identified by name

If you want to allow users to follow a path of their own choosing 
through a move, you need to write two types of scripts:

◆ The first makes the movie wait at the end of a segment until users 
click a button. 

◆ The second—slightly different for each button—takes the user to 
a different segment.

Script one: go to the frame 
The script that makes a movie wait at the end of a segment for the 
user to click a button is a frame script. It looks like this:

on exitFrame
 go to the frame
end 
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The go to the frame statement, as explained in the previous 
section, is an alternative to pause. Like pause, go to the frame 
keeps the playback head from moving to a different frame. But there’s 
an important difference between the two: pause stops the playback 
head completely; go to the frame keeps the playback head 
returning to the same frame over and over until you give Director an 
instruction to go to a different frame.

To create the first script:

1. Go to the score, and in the script channel, select the cell 
where you want the script to appear.

2. Choose New from the Script pop-up menu.

A script window appears.

3. On the middle line of the script, type:
go to the frame 

That’s all you need to add.

4. Close the script window.

Add the same script to the final frame of every segment where you 
want the movie to wait for the user to click a button.

Script pop-up menu
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Script two: go to frame "name" 
The script that goes to a particular segment when the user presses a 
button can be either a cast member script or a sprite script, depending 
on the nature of the movie you’re creating. For example, if the movie 
is a kiosk providing travel information about different cities, the 
button for each city will have a different name, so you’d use cast 
member scripts for each button. But the information about each city 
is going to fall into the same categories: lodging, restaurants, 
attractions, and so on. You’d create one set of buttons for each 
category, and then use sprite scripts in the appropriate cells to allow 
each category button to branch to the appropriate information for the 
specific city a user has chosen.

The exact text of the script varies, depending on the name of the 
marker that identifies the specific segment of the movie that you’re 
branching to, but the form of the script is the same whether you’re 
creating a cast member script or a sprite script. It looks like this:

on mouseDown
 go to frame "name"
end 
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The script for each button looks slightly different: for each one, in 
place of name, you type the name of the marker that identifies the 
segment that you want the button to go to.

Note You probably want to have a Quit button in various segments. See “Leaving 
a movie” later in this chapter for the appropriate script.

Cast member script Sprite script

To create the script for a cast member:

1. In the cast window, select the cast 
member that you want to assign the 
script to.

2. Click the script button in the cast 
window.

A script window appears.

3. On the middle line of the script, 
type:
go to frame "name" 

In place of name, type the name of the 
marker that identifies the segment that 
you want the button to go to. Make sure 
you enclose the name of the marker in 
quotation marks.

4. Close the script window.

To create the script for a sprite:

1. In the score, select the cell (or cells) 
that contain the information about 
the sprite you want to assign the 
script to.

2. Choose New from the Script pop-up 
menu.

A script window appears.

3. On the middle line of the script, 
type:
go to frame "name" 

In place of name, type the name of the 
marker that identifies the segment that 
you want the button to go to. Make sure 
you enclose the name of the marker in 
quotation marks.

4. Close the script window.

Script pop-up menu
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Going to a segment and returning automatically

You can set up a segment so that users automatically return to it 
when they reach the end of a segment that they’ve branched to. For 
example, if you create a movie that has help screens, you’d want to 
set it up to work like this: when a user clicks a help button, the movie 
branches to the appropriate help screen, which has a return button on 
it. When the user clicks the return button, the movie goes back to the 
screen where the help button appeared.

To set up a segment to branch and return automatically, you need to 
write three types of scripts:

◆ One that waits at the end of the segment for the user to click a 
button

◆ One for each button that takes users to a different segment

◆ One at the end of each of those segments that tells Director the 
segment is done and it’s time to return.

Script one: go to the frame 
The script that waits at the end of a segment for the user to click a 
button is a frame script. It looks like this:

on exitFrame
 go to the frame
end 

To create the script:

1. Go to the score, and in the script channel, select the cell 
where you want the script to appear.

2. Choose New from the Script pop-up menu.

Script pop-up menu
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A script window appears.

3. On the middle line of the script, type:
go to the frame 

That’s all you need to add.

4. Close the script window.

Add the same script to the final frame of every segment where you 
want the movie to wait for the user to click a button.

Script two: play frame "name"
The script that goes to a particular segment when the user presses a 
button can be either a cast member script or a sprite script, depending 
on the nature of the movie you’re creating.

The exact text of the script varies, depending on the name of the 
marker that identifies the specific segment of the movie that you’re 
branching to, but the form of the script is the same whether you’re 
creating a cast member script or a sprite script. It looks like this:

on mouseDown
 play frame "name"
end 
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The script for each button looks slightly different: for each one, in 
place of name, you type the name of the marker that identifies the 
segment you want the button to play.

Note You probably want to have a Quit button in various segments. See “Leaving 
a movie” later in this chapter for the appropriate script.

Cast member script Sprite script

To create the script for a cast member:

1. In the cast window, select the cast 
member that you want to assign the 
script to.

2. Click the script button in the cast 
window.

A script window appears.

3. On the middle line of the script, 
type:
play frame "name" 

In place of name, type the name of the 
marker that identifies the segment that 
you want the button to go to. Make sure 
you enclose the name of the marker in 
quotation marks.

4. Close the script window.

To create the script for a sprite:

1. In the score, select the cell (or cells) 
that contain the information about 
the sprite you want to assign the 
script to.

2. Choose New from the Script pop-up 
menu.

A script window appears.

3. On the middle line of the script, 
type:
play frame "name" 

In place of name, type the name of the 
marker that identifies the segment that 
you want the button to go to. Make sure 
you enclose the name of the marker in 
quotation marks.

4. Close the script window.

Script pop-up menu
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Script three: play done 
The script that tells Director that it’s time to return is a frame script. It 
belongs in the script channel in the last frame of the segment that the 
user has branched to. It looks like this:

on exitFrame
 play done
end 

To create the script:

1. In the script channel, select the cell where you want the 
script to appear.

2. Choose New from the Script pop-up menu.

A script window appears.

3. On the middle line of the script, type:
play done 

That’s all you need to add.

4. Close the script window.

Add the same script to the final frame of every segment where you 
want Director to return to the segment that it came from.

Script pop-up menu
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Leaving a movie

If you create a movie that allows users to follow various paths, they 
may never reach the final segment of the score—so the movie will 
never end. To allow users to leave a movie before they reach the end 
of the score, you need to write a simple script that ends the movie 
when the user clicks the appropriate button. (The button, of course, 
must appear in a frame where there’s a script that waits for the user to 
click a button.)

The script that ends a movie is normally a cast member script assigned 
to a Quit button. It looks like this:

on mouseDown
 quit
end 

The quit command does the same thing as the Quit command on 
Director’s File menu: it exits Director and returns to the Finder.

To create the script:

1. In the cast window, select the cast member that you want 
to assign the script to.

2. Click the script button in the cast window.

A script window appears.
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3. On the middle line of the cast member script, type:
quit 

That’s all you need to add.

4. Close the script window.

Add the button to every frame in the movie where you want to give 
users the option of quitting. The script is part of the button, so it goes 
with the button wherever you place the button in the movie.

Learning more about Lingo

There’s much more that you can do with Lingo than the few scripts 
in this chapter suggest. The table that follows lists the things you may 
want to try next. For a complete introduction to Lingo, work 
through the tutorials in Using Lingo.

Director’s on-line help is another valuable resource when you’re first 
learning Lingo. There’s an entry for every Lingo element in the on-
line help system. Each entry has a sample script that shows how to use 
the element. You can copy the sample script that’s part of an entry, 
paste it in a script window, and then use the sample script as a 
template for the script you want to write.
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Other things you can do with Lingo

What you can do Where to find out how

Go to the next marker no matter 
what its name is

go to, next, and marker in 
Lingo Dictionary; also see Chapter 2, 
“Navigation,” in Using Lingo

Go to the previous marker no 
matter what its name is

Chapter 2, “Navigation,” in 
Using Lingo

Keep the playback head in the 
same frame

Chapter 2, “Navigation,” in 
Using Lingo

Make a sprite highlight when a 
user clicks it

Chapter 4, “Using Puppets,” in 
Using Lingo

Have something happen when 
the user holds the mouse button 
down

on mouseDown in Lingo Dictionary; 
also see Chapter 6, “Using the 
Keyboard and Mouse,” in Using Lingo

Have something happen when the 
user moves the pointer off a 
button without releasing the 
mouse button first

on rollOver in Lingo Dictionary; 
also see Chapter 6, “Using the 
Keyboard and Mouse,” in Using Lingo

Start a different movie, play it, and 
then return automatically to the 
movie where you started

play in Lingo Dictionary; also see 
Chapter 2, “Navigation,” in 
Using Lingo
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Chapter 5

Window Reference

This chapter describes each Macromedia Director window in the 
order in which it appears in the Window menu.

The Director menus and commands are described in Chapter 6, 
“Menu Reference.”

See Appendix A, “Director Shortcuts,” for a complete list of all 
keyboard shortcuts for working with windows.
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The stage

The stage is the backdrop against which all Director animation 
appears. The size of the stage is set with the Preferences command on 
the File menu. In most cases, the edges of the stage window extend to 
the edges of your screen, so you can use all of the monitor for your 
movie. Movies continue to play on the stage when other windows 
are open and active. This permits you to study the movie in the score, 
for example, while keeping an eye on the stage.

The Stage command on the Window menu brings the stage to the 
front of the screen. It temporarily hides open windows and the menu 
bar. Use the keyboard shortcut Command-1 to toggle back and forth 
between seeing the stage with the other open windows and the menu 
bar or just the stage.

The menu bar is invisible but active when only the stage is showing. 
To open a menu just move the pointer to the top of the screen to the 
menu’s position, and hold the mouse button down.

Resizing sprites on the stage

To resize a sprite that’s on the stage:

1. Go to the score and select the cells where the information 
about the sprite is recorded.
On the stage, a selection rectangle with resize handles appears 
around the sprite. 

2. Drag any of the resize handles to change the sprite’s size.

Changing the size of a sprite on the stage doesn’t change the size of 
the cast member that the sprite is based on. 
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The control panel

Open the control panel by choosing Control Panel from the 
Window menu or by pressing Command-2.

The control panel has controls similar to a VCR. Use it to play, stop, 
step forward or backward, or rewind your movie. The control panel 
is also used to loop animation, set tempo, turn sound on and off, lock 
the movie’s playback rate, and change the color of the background. 
The control panel indicates the current frame number, the current 
tempo, and the actual duration of the current frame. 

To move the control panel, drag it by the small title bar or by any 
spot that is not a button.
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Control panel buttons

Note The control panel buttons correspond to commands on the Edit menu.

Rewind

Rewind (Command-R) resets the movie to frame 1. If the movie is 
playing, clicking Rewind stops the movie and rewinds it to the first 
frame.

Selected Frames OnlyRewind

Step Backward

Stop

Step Forward

Disable Sounds

Loop

Play
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Step Backward

Step Backward (Command–left arrow) steps the movie backward one 
frame at a time. Press and hold down this button to step backward 
continuously.

Stop

Stop (Command-.) halts the movie.

Step Forward

Step Forward (Command-right arrow) advances the movie one frame 
at a time. Press and hold down this button to advance continuously.

If a score channel is in step-recording mode, stepping the movie 
forward also copies the contents of the current frame to the next 
frame.

Play

Play (Command-P) starts the current movie. If you press the Shift key 
while clicking Play, the open windows and the menu bar are hidden 
until you stop the movie.

Disable Sounds

Disable Sounds (Command-~) turns your movie’s sound on and off. 
Click the button to alternate turning the sound on or off. When the 
button is pressed, sound is off and when it is not pressed, the sound is 
on.
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Loop

Loop (Command-L) causes the movie to repeat continuously. When 
the movie reaches the last frame, it starts again from frame 1. Loop is 
in effect when its button is pressed. Loop is on by default.

If this button is not pressed, the movie does not loop.

Selected Frames Only

Selected Frames Only (Command-\) lets you play a portion of a 
movie. First, open the score and select the frames to be played. Click 
Selected Frames Only and then click Play.

A green bar at the top of the score window in the area that contains 
the frame numbers indicates which frames have been marked for 
Selected Frames Only. Clicking Selected Frames Only again turns the 
selection off. 

This button is dimmed if you haven’t selected any frames in the score.
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Control panel indicators

Frame counter

The frame counter displays the number of the frame currently on the 
stage. Click the up arrow to advance the movie or click the down 
arrow to rewind the movie, frame by frame. Press and hold down an 
arrow to rapidly advance or rewind the movie. To go to a specific 
frame number, click into the frame counter field, type a frame 
number, and press Return.

Tempo display

The tempo display shows the tempo of the current frame (which may 
be different from the default tempo). The number displayed indicates 
the upper limit of the speed of your movie in frames per second 
(FPS). Click the tempo mode to display the tempo in seconds per 
frame (SPF). Seconds per frame measures the duration, in 
milliseconds, of a frame. The display mode you choose is saved with 
the movie.

To change the tempo, click or press the up or down arrow. To use a 
specific tempo, click into the tempo display area, type a tempo, and 
press Return. If you are entering a tempo in frames per second (FPS), 
you must enter a whole number.

Note It is recommended that you always enter a tempo setting in the first frame in 
the tempo channel.

Stage background

Tempo

Actual

Frame counter

Tempo
display

Tempo mode
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If there are no tempo settings in the tempo channel, the control panel 
displays the default tempo. (If there is a tempo setting in the tempo 
channel, the control panel displays the tempo of the current frame.) 

Director will attempt to play the movie at the specified tempo setting, 
depending on the type of Macintosh you are using. The movie may 
play slower on slower machines.

Actual display

If a movie is playing, the Actual display shows the actual duration of 
the previous frame in frames per second (FPS), including the time 
necessary to execute any Lingo scripts (except Exit Frame scripts). 
If the movie is stopped, the Actual display shows the duration of the 
current frame.  Frames that don’t have a recorded tempo value display 
“--” instead of a value for the actual tempo.

If the movie is locked (using the Lock button in the control panel or 
using the Lock Frame Durations command in the Edit menu), the 
Actual display shows the previously recorded frame durations.

Since not all Macintosh computers are equally fast, you can step 
through the movie frame-by-frame and compare the actual frame 
durations to the tempos you’ve set for the movie. This lets you see 
which frames your computer is not keeping up with. Comparing 
actual frame durations to tempos you’ve set is especially useful if you 
author on a fast computer and want to test playback on a slower 
computer.

Click the Actual mode button to display actual durations in seconds 
per frame (SPF) or frames per second (FPS). The display mode you 
choose is saved with the movie.

The Sum display provides a quick summary of elapsed seconds (the 
default) from the beginning of the movie to the current frame. The 
Est display provides a more accurate but slower calculation of elapsed 
time. It’s useful if you want to include transitions and palette changes 
in determining frame durations. Computing estimated frame 
durations can reduce playback speed, so don’t leave the Actual display 
in Est mode while playing the movie.
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To lock the movie’s playback rate so that it plays using previously 
recorded frame durations, click the Lock button.

Clicking the Lock button is the same as choosing Lock Frame 
Durations in the Edit menu.

Clear all recorded frame durations from the movie if you want to 
record frame durations for a section of the movie and lock them. To 
clear all recorded frame durations, press Option while clicking the 
Lock button. During playback, frames that don’t have a recorded 
duration instead display “--”.

˛ Tip To find frames that have longer durations than the current tempo, set both the 
Tempo and Actual displays to show seconds per frame (SPF); then step 
through the range of frames, and look for any frame whose actual duration is 
longer than the current tempo.

Stage background

The Stage background color chip lets you change the stage’s 
background color. On a color Macintosh you can use the background 
control to change the color of the background to any color in the 
current palette. To display the palette, position the pointer on the 
background control and press the mouse button. Then choose a 
background color from the pop-up palette.

Lock button
(unlocked state)

No recorded
duration
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The cast window

The cast window lets you view the cast members used in a movie. It 
is a database of graphics, sounds, color palettes, Lingo scripts, buttons, 
digital video movies, and text used in a Director movie. 

Open the cast window by choosing Cast from the Window menu, or 
by pressing Command-3.

Each cast member position is identified by a number, and optionally, 
a name.

A movie’s cast can contain up to 32,000 cast members. You control 
the row width and the number of visible rows using the Cast 
Window Options command in the Cast menu.

Clicking any cast member selects it. Select a range of cast members by 
Shift-clicking. Command-click selects multiple non-adjacent cast 
members. Individual cast members can be cut, copied, pasted, or 
cleared from the cast window. 

˛ Tip You can select several text cast members in the cast window and change their 
font, size, and style using the commands on the Text menu. You can change 
the color of a text cast member using the foreground and background color chips 
in the tools window.

Cast member
position number

Cast type icon
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For every occupied position in the cast window, an icon is displayed 
that represents the cast member’s type.

In previous versions of Director, whenever you opened a movie, the 
cast window would recreate every thumbnail image. In Director 4.0, 
thumbnails are only redrawn when you change the thumbnail size in 
the Cast Window Options dialog box. If the cast includes a linked 
file, and you edit the original file, Director does not redraw the 
thumbnail unless you edited it using the Launch External Editor 
command in the Cast menu.

Double-clicking a cast member is a shortcut for opening the paint 
window for a graphic cast member, the text window for a text cast 
member, the color palettes window for a palette cast member, the 
script window for a script cast member, and the digital video window 
for a digital video cast member.

Text Button Shape

Script PICT

Digital 
video Palette

Embedded 
bitmap

Linked 
bitmap

Embedded
sound

Linked 
sound

Film loop or 
embedded 
movie

Linked 
movie

Linked 
PICT
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Identifying cast members with scripts and shared cast members

Cast members with scripts display a script indicator icon in the lower 
left corner. To control whether or not Director displays a script 
indicator icon in the cast, use the Indicate Cast Members with Scripts 
checkbox in the Cast Window Options dialog box.

The names of cast members that are part of a shared cast movie appear 
in italics. Director also italicizes the names of shared cast members in 
the digital video, paint, script, and text windows, and the names of 
thumbnail images in the upper left corner of the score window.

You must name a shared cast movie “SHARED.DIR” to have 
Director recognize it as a movie that contains cast members that can 
be shared by other movies. For information about creating a shared 
cast, see “Creating a shared cast” in Chapter 1, “Working with Cast 
Members.”

Script indicator

Shared cast member
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Cast window features

Place button
Lets you move the selected cast member to the stage or score, or 
move it within the cast. When cast members are moved within the 
cast window, the score window is updated with their new position. 
When you press and hold down this button, the cursor changes to an 
open hand to let you drag one or more selected cast members. Using 
this button is the same as clicking and dragging a selected cast 
member in the cast window. Use this button to move selected cast 
members that may not currently be visible in the cast window, if 
you’ve scrolled to a new location.

To use the Place button to move a cast member to a new location 
within the cast window:

1. Select the cast member you want to move. 
You can select more than one cast member and move them at the 
same time.

2. Scroll to the new location in the cast window where you 
want to insert the selected cast member. 

3. Drag from the Place button to the new location in the cast 
window.
As you drag within the cast window, a blinking insertion bar 
indicates the location where the cast member will be inserted.

4. Release the mouse to insert the selected cast member at 
the new location.

Place

Previous

Next
Info

Script

Cast member number
Cast member name
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Previous, Next arrows
These arrows let you navigate to the previous or next cast member, 
skipping over empty cast members.

˛ Tip The keyboard equivalents for Previous and Next are Command-Shift-left 
arrow and Command-Shift-right arrow.

Info button
Displays the Cast Member Info dialog box for the selected cast 
member. If the selection consists of more than one cast member, the 
dialog box displays the number of cast members selected, and their 
total size and purge priority.

˛ Tip Choosing Cast Member Info from the Cast menu or pressing Command-I are 
the same as clicking this button.

Script button
Opens a new script window or makes an existing script window 
active for the selected cast member, or for the first selected cast 
member if more than one are selected. If the selected cast member has 
no script associated with it, clicking this button opens a new script 
window. This is the same as clicking the Script button in the Cast 
Member Info dialog box.

˛ Tip Choosing Open Script from the Cast menu or pressing Command-' is the 
same as clicking this button.
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Cast member number
Displays the position of the selected cast member in the cast window 
or the position of the first selected cast member in a multiple 
selection.

˛ Tip When the cast window is front-most, typing the number of an existing cast 
member automatically scrolls the cast window to the cast member’s location and 
selects it. After you've stopped typing for 1/2 second, the cast window will 
scroll to show the new selection. Alternatively, you can press Return 
immediately after typing the number to scroll the cast window instantly. (You 
can also press Delete to delete the last digit you typed.)

Cast member name
Displays the name of the selected cast member, or the first selected 
cast member in a multiple selection. Click and type into the name 
area to enter or edit the name of a cast member. Press Return or 
Enter to confirm your changes.
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Moving cast members within the cast window

You can rearrange cast members within the cast window by dragging 
them to a new location.

Note You can’t drag a selection if it includes cast members that are part of a shared 
cast. You must open the shared cast movie to rearrange its cast members.

To move one or more cast members:

1. In the cast window, click to select the first cast member.
The pointer changes to a hand shape. 

2. Shift-click to select additional adjacent cast members; 
Command-click to select additional non-adjacent cast 
members.

3. Drag one of the cast members you just selected.
Dragging any selected cast member drags the entire selection. 

As you drag within the cast window, a blinking insertion bar 
indicates the location where the selection will be inserted.

4. Release the mouse to insert the selected cast members at 
the new location.
The cast members are inserted to the right of the insertion bar. 
Cast members following the insertion bar shift over to make 
room for the inserted cast members.

Dragging a selection within the cast window

Insertion bar
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Placing cast members on the stage

Placing cast members on the stage adds them to the score in the 
available channels in the current frame. If you place more cast 
members than you have available channels in the current frame, 
Director warns you that it will ignore the extra cast members.

When you place cast members on the stage (or in the score), Director 
adds them as sprites. A sprite is an image of the cast member on the 
stage or in the score that contains information about the cast member 
at one point in time.

To place one or more cast members on the stage:

1. In the cast window, click to select the first cast member.
The pointer changes to a hand shape. 

2. Shift-click to select additional adjacent cast members; 
Command-click to select additional non-adjacent cast 
members.
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3. Drag one of the cast members you just selected to the 
stage.
Dragging any selected cast member drags the entire selection.

The keyboard shortcut for placing selected cast members in the 
center of the stage is Command-Shift-L.

As you drag the cast members over the stage, Director displays an 
outline indicating the size of the area enclosing all the cast 
members. (If you drag a sound or a palette, it does not display an 
outline on the stage, since such cast members have no size 
dimensions.)

Drag cast members from the cast to the stage to place them in channels in the score

When you drop the cast members on the stage, Director activates 
step-record mode in the channels where the cast members were 
dropped.
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Placing cast members over time

By default, Director places multiple cast members on the stage so that 
they all occupy the same frame in the score. To place cast members 
on the stage over time instead of in the same frame, press Option 
while dragging the cast members from the cast window to the stage.

Option-drag cast members from the cast to the stage to place them over time in the 
score

As you Option-drag the cast members over the stage, Director 
displays an outline indicating the dimensions of the first visual cast 
member in the selection, which will be placed in the current frame. 
The rest of the cast members in the selection are placed into adjacent 
frames.

If the score is open while you are dragging cast members to the stage, 
Director outlines the cells in the score where the cast member 
selection will be dropped. When you Option-drag cast members to 
the stage, Director prevents you from dropping cast members into 
occupied cells in the score. (If you instead drag the cast members 
directly from the cast window into the score, Director does not 
prevent you from dropping the cast members into occupied cells and 
overwriting existing sprites.)
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Note If you drag a sound cast member to the stage or score, Director places it in 
sound channel 1 of the current frame, or in sound channel 2 if sound channel 
1 is occupied. If both channels are occupied, the sound is not dropped. If you 
drag a palette cast member to the stage or score, Director places it in the palette 
channel of the current frame, and assigns it these default properties: Speed=30 
(instant) and Type=Normal.

When you drag a cast member to the stage, Director uses the first 
empty cell in the current frame that is closest to the current score 
selection. (If you drag the cast member directly into the score, you 
can more precisely specify the cell that will contain the cast member.) 
You can force Director to use a certain set of empty cells by first 
selecting them in the score before dragging in the cast members.

When dragging multiple cast members to the stage, Director places 
each cast member into the score, beginning with the 
lowest-numbered cast member in the selection, as if you had 
individually dragged each cast member into the score.

˛ Tip The keyboard shortcut for placing selected cast members over time in the center 
of the stage is Command-Option-L.

You can also place selected cast members across time in the score by choosing 
Cast to Time in the Cast menu.

Canceling the drag

To cancel the drag, drag the cursor over the menu bar or desktop so 
that the cursor changes to indicate that the location under the cursor 
is an invalid drop location.
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Dragging cast members to the score

Dragging cast members into the score places them into a range of cells 
and activates step-record mode in the channels where the cast 
members are dropped.

 To place one or more cast members into the score:

1. Click to select the first cast member in the cast window.
The pointer changes to a hand shape. 

2. Shift-click to select additional adjacent cast members; 
Command-click to select additional non-adjacent cast 
members.

3. Drag one of the cast members you just selected to the 
score.
Dragging any selected cast member drags the entire selection.

As you drag the cast members over the score, Director outlines 
the range of cells into which the cast members will be dropped.

Placing cast members over time

By default, Director places cast members in channels in the score, so 
that they all occupy the same frame. To place cast members into the 
score across time instead of in the same frame, press and hold down 
Option while dragging the cast members into the score.

Dragging cast members to the score

Placing cast
members in

several channels

Placing cast
members over

time (Option–drag)
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As you drag cast members over the score, Director may restrict you 
to specific regions of the score depending on the type of cast 
members in the selection. For example, if you drag a sound cast 
member into the score, Director restricts you to the two sound 
channels. If you are dragging different types of cast members, 
Director lets you only drop them into cells of the appropriate type.

When you drop cast members into the score, Director fills the 
highlighted cells in sequential order by cast number. The first cast 
member in the selection of a particular type will be dropped into the 
left-most or top-most cell in the channel.

Any occupied cells in the highlighted region are overwritten by the 
cast members you drag in.

You can drag this type of 
cast member

...into this part of 
the score

Bitmap, PICT, Text, Button, Shape, Film loop, 
Movie, Digital Video

Sprite channels 1- 48

Sound Sound channel 1, sound 
channel 2

Palette Palette channel

Script None
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Creating a film loop

When you move selected frames from the score into the cast, 
Director creates a new film loop cast member in the cast window. 
This is a shortcut for copying and pasting a score selection into the 
cast window.

To create a film loop cast member in the cast window:

1. In the score window, select the cells that contain the 
sequence of cast members that you want to use to create 
the film loop.

2. Drag the selection into the cast window.
As you drag within the cast window, a blinking insertion bar 
indicates the location where the selection will be inserted.

3. Release the mouse button to insert the selection to the 
right of the insertion bar.
Director asks you to name the film loop.

4. Enter a name for the film loop and click OK.
The film loop is inserted in the cast to the right of the insertion 
bar. Cast members to the right of the insertion bar will shift over 
to make room.
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The score

The score is the heart and soul of Director. It contains the notation 
that describes your movie and is the primary tool for creating and 
editing animation. The score contains a record of everything that 
happens on the stage.

Open the score by choosing Score from the Window menu, or by 
pressing Command-4.

The smallest unit in the score is a cell. Each cell contains information 
about one cast member at one point in time, called a sprite. When 
you select a cell, a small image of the sprite that occupies that cell 
appears in the upper left corner of the score window. Double-click 
the sprite’s image to open a window in which you can edit the cast 
member.

The first five rows, called channels, keep track of special effects like 
tempos, palettes, transitions, or sounds. By setting effects in those 
channels, you can add sound to your movie, control the tempo, set 
and transition palettes, cycle colors, and add visual effects. The script 
channel is where you store scripts (instructions written in Lingo) that 
are executed when the movie reaches a particular location in the 
score.

Effects channels

Script channel

Sprite
channels
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Note To use sound channel 2 you must be using a Macintosh capable of 
multi-channel sound. If you’re using some other system configuration, sound 
channel 2 appears dimmed in the score. Movies created with versions of 
Director earlier than version 3.0 have their sound information placed into 
sound channel 1.

The order of sprites in the 48 animation channels determines which 
sprites appear in the foreground and which appear in the background. 
Think of the stage as a pile of transparent sheets, 48 sheets thick. The 
sprite that occupies a channel closer to the top of the score is like the 
object drawn on the last sheet of acetate. It appears behind any sprite 
in a channel closer to the bottom of the score.

Foreground and background priority in the score

Sprites in channels closer to the bottom of the score appear in front 
of, or take priority over, those in channels closer to the top of the 
score.

A frame contains information about everything you see on the stage 
when you stop a movie at the moment that corresponds to the frame. 
Like a frame in a movie, a Director frame shows what each sprite is 
doing on the stage at one point in time. Each frame is numbered.

Background

Foreground
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The score also contains small triangular markers to help you 
coordinate the comments in the markers window with specific frames 
of your movie or identify frames of your movie for printing. You can 
drag any number of markers from the left side of the score window 
and position them in any frame. Use this feature to add comments, 
speaker notes, or storyboard notes to specific frames of animation. 

When you position a marker in the score window, an insertion point 
appears to the right of the marker so you can type a short comment 
for that marker. Use the markers window to review and edit marker 
comments.

Marker
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Working with score cells

This section describes the ways in which you can display and work 
with score cells.

The Display pop-up menu

The Display pop-up menu lets you change the type of information 
displayed in each cell of the score. It is located in the lower left corner 
of the score window. Use it to view different types of notation in the 
score. By default, the score displays cast notation.

Display pop-up menu
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Extended display notation

For the animation channels, the Extended display enlarges the score 
and displays all of the sprite information at once.

Use the Score Window Options command to choose what 
information is contained in the Extended display.

If you have chosen to view the cast members by name in the cast 
window (using the Cast Window Options command), the Extended 
display shows the first few letters of the cast member’s name instead of 
the cast member’s cast number, if a name exists for that cast member.

For the tempo channel, the extended notation displays the settings 
specified in the Set Tempo dialog box.

For the palette channel, the extended notation displays the settings 
specified in the Set Palette dialog box.

Cast member type
Anti-alias*
Blend

Cast member number or name (last four digits)
Script number
X and Y coordinates on the stage

Motion relative to previous sprite

Dotted lines indicate sprite
was created by in-betweening

*Anti-aliasing is only enforced if you have enabled it using the 
Movie Info command on the File menu.

Ink effect

Tempo channel

Tempo setting

Speed Delay

Wait for setting

Channel number

Palette channel

Palette Speed
Cycles

Color cycling Auto reverse Palette transition

Fade to black

Fade to white

Over time
Chapter 5268



For the transition channel, the extended notation displays the settings 
specified in the Set Transition dialog box.

For the sound channel, the extended notation displays the cast 
member number.

Ink display notation

The Ink display indicates which ink effect has been applied to each 
sprite.

Transition channel

Transition

Duration

Chunk size

Stage area Changing area

Sound channel
Cast member number

Cast member type

Ink effect

Copy

Matte

Bkgnd
Transparent

Transparent

Reverse

Ghost

Not Copy

Not 
Trans.

Not Reverse

Not 
Ghost

Mask

Blend

Darkest

Lightest

Add

Add Pin

Subtract

Subtract Pin

Dotted line indicates trails
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Blend display notation

The blend notation shows the blend percentage that’s applied to the 
sprite using the Set Sprite Blend command in the Score menu.

Cast display notation

The Cast display depends on how you have chosen to view cast 
members in the cast window using the Cast Window Options 
command. If the cast window displays cast members by octal number, 
decimal number, or by number:name, the Cast display shows the last 
two digits of the cast member’s position number. If  the cast window 
displays cast members by name, the Cast display shows the first two 
letters of the cast member’s name, if a name exists for that cast 
member. Cast display is the default.

Motion display notation

The Motion display shows the direction of the sprite’s movement and 
whether or not a new sprite appears in that cell. It is a useful way to 
view the score if you are tweaking a sprite to line up in a particular 
position relative to the sprite’s previous position. 

Two squares indicate 100 percent

Last two digits of cast member
position number

first two letters of cast member name

Upper symbol denotes cast member type

QuickDraw cast 
member

Bitmap cast member
Text cast member

PICT cast member

Lower symbol denotes motion 
relative to previous sprite

Stop

Film loop, QuickTime, or 
linked movie cast member
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Script display notation

The Script display shows the location and number of the script 
associated with each cell in the score. 

Each script has an identifying number associated with it. Cells 
without scripts display 00. Sprites with cast scripts display a plus (+) 
sign in the cell.

Selecting cells

Drag across cells to select them. If you have the Playback Head 
Follows Selection checked in the Score Window Options dialog box, 
the movie will advance or rewind as you select cells in the score. You 
can see the frames on the stage as you select them in the score.

No script
Sprite script 
number

Cast member script
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To select this: Do this:

Click a single cell

Drag across cells or Shift-click cells

Double-click the channel number

Double-click the channel number and drag 
down

Drag across the frame numbers at the top of 
the score window

Click a frame number at the top of the score 
window

Double-click an occupied cell to select all 
adjacent cells that contain the same cast 
member

Command-click for discontinuous selections

Insertion point
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The consequences of each type of selection are very important. For 
example, if only one cell in the score is selected, only one sprite in 
one frame of the movie is affected by the commands you choose. On 
the other hand, if you select a number of cells in a channel, you can 
select a sequence of sprites over a period of time. Then, any changes 
you make affect that sequence. 

Whenever you select less than all the channels in a frame, from a 
single cell to a range of cells over one or more channels, you are 
editing and affecting space. Cutting, copying, pasting, or clearing 
either adds or removes elements within a time sequence but does not 
affect the length of the sequence.

Moving selections within the score

You can move one or more selected cells to a new location within 
the score or to the cast. (You cannot drag score selections to the 
stage.) 

To move selected cells to a new location within the score:

1. Select the cells.
The cursor changes to a hand.

2. To select additional frames, Shift-click them.

3. Drag the frames to the new location. 
As you drag, an outline of your selection appears under the 
cursor. Dragging to the edge of the window will auto-scroll the 
window.

To instead move a copy of the selection, press the Option key 
while dragging the selection.
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4. Release the cursor to place the selection at the new 
location.
The contents of the frames you move replace the contents of 
existing frames at the new location.

If Playback Head Follows Selection is checked (using the Score 
Window Options command in the Score menu), the selected 
frames will be displayed on the stage as you drag the selection in 
the score.

To cancel the drag, move the cursor over the menu bar or 
desktop or choose Undo.

Moving around the score

The playback head at the top of the score indicates which frame of 
the movie is currently on the stage.

The playback head travels in the scratch bar as the movie plays. You 
can drag the playback head or click to move to a specific frame. If 
Playback Head Follows Selection is checked in the Score Window 
Options dialog box, the playback head travels with any selection you 
make in the score.

Another way to move your view of the score to the current frame of 
your movie is the Jump button, located in the lower left corner of the 
score window.

Whenever you click this button, Director brings the playback head 
into view and your view of the score jumps to the frame that is 
currently on the stage. 

Playback head

Jump button
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The Jump to Top button at the top right side of the score window 
scrolls the score window to the script channel when you click it.

If the score channel is already visible, clicking the Jump to Top 
button scrolls the score window to the top of the effects channels.

An additional aid to navigation is the frame counter that pops up in 
the middle of the horizontal scroll bar when you drag the horizontal 
scroll box. It indicates how far you have advanced or rewound the 
view of the score as you drag the scroll bar.

The Shuffle Forward and Shuffle Backward buttons let you move a 
selection of sprites up or down in the score, to change their 
foreground priority on the stage.

Shuffle Forward switches a range of cells you’ve selected in a channel 
with the cells in the channel below it. The sprites associated with the 
selected cells move in front of the other sprites.

Shuffle Backward switches a range of cells you’ve selected in a 
channel with the cells in the channel above it. The sprites associated 
with the selected cells move behind the other sprites.

˛ Tip The keyboard shortcut for Shuffle Forward is Command-Shift-down arrow; 
the keyboard shortcut for Shuffle Backward is Command-Shift-up arrow.

Jump to Top button

Frame counter

Shuffle Forward

Shuffle Backward
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Applying color to cells

The cell color selector lets you apply color to score cells. The color 
affects only the cells in the score; it doesn’t affect how sprites appear 
on the stage. Applying color to cells can help you identify different 
sections in a large score.

To apply color to cells, select them and click a color from the cell 
color selector. You can apply color to empty or occupied cells. The 
color is carried with the cell if you move it or copy it.

You show or hide cell colors using the Colored Cells option in the 
Score Window Options dialog box. If you’ve already applied color to 
cells, hiding cell colors doesn’t remove their color. Score window 
scrolling performance is faster if you hide cell colors. 

Cell color selector
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The script pop-up menu

The script pop-up menu lists all the score scripts used in the current 
movie. The script pop-up menu displays the script number associated 
with a selected frame in the script channel. If the selected cell has no 
script associated with it, the pop-up menu is blank. You can use this 
pop-up menu to apply existing scripts to areas of the score. Select the 
cells you want to apply the script to; then choose the script you want 
from the script pop-up menu.

Choose the New option in the script pop-up menu to create a new 
score script. Choose the 0 option to remove the script from the 
selected cell.

For a complete description of how to create and use scripts, refer to 
the Using Lingo manual.

Script pop-up menu
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The script preview button

The Script Preview button displays the first two lines of the script 
associated with one or more selected cells in the script channel. If the 
selection has no script associated with it, the Script Preview button is 
blank. Clicking the Script Preview button opens a new script 
window. 

To hide the script pop-up menu and the Script Preview button, click 
the Show/Hide button.

The script window

Click the Script Preview button to open the script window associated 
with the current script. Use the script window to enter and edit the 
script associated with one or more selected cells in the script channel. 
Scripts can contain up to 32,000 characters.

For more information about the script window, see “The script 
window,” later in this chapter.

˛ Tip Double-clicking a cell in the script channel opens a script window. This is the 
same as selecting the cell and clicking the Script Preview button.

Script Preview button

Show/Hide button
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Sprite attributes

This section describes the score’s controls for seeing and changing 
sprite attributes.

Ink pop-up menu

You apply inks to cast members to change the way they appear on 
the stage. Choose an ink from the pop-up menu in the score 
window. The Ink pop-up menu also indicates the current ink applied 
to selected sprites in the score.

The score window inks fall into two categories. The first set of inks 
can be used with black and white or color artwork. They are: Copy, 
Matte, Transparent, Reverse, Ghost, Not Copy, Not Transparent, 
Not Reverse, Not Ghost, and Mask. The second set of inks only 
works with color. They are: Bkgnd Transparent, Blend, Darkest, 
Lightest, Add, Add Pin, Subtract, and Subtract Pin. Copy, Matte, and 
Mask are useful in black and white or color work.

To apply an ink, select the cells in the score, then choose the ink 
from the Ink pop-up menu.

Ink pop-up menu
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When dragging a cast member to the stage, the default ink is the last 
ink you chose in the Ink pop-up menu. 

The initial default ink is Copy. When you use Copy, a bounding box 
appears around the sprite. The bounding box is invisible when 
displayed on a white stage, but when the sprite passes in front of 
another sprite, or the stage is black, you will see the bounding box.

To eliminate the bounding box that appears around a sprite, select the 
sprite in the score and choose the Matte ink. Use it sparingly though, 
because it slows down screen redraw and uses more memory than 
other inks.

To change the ink for a sprite, select the cell or cells, and choose an 
ink from the Ink pop-up menu. Your choice replaces the previous 
ink assigned to the sprite.

Choose an ink carefully, since some inks can result in decreased 
performance when animating a cast member. For example, the 
following inks are listed in order of decreasing performance: Copy, 
Matte, Background Transparent, and Blend.
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Score window inks

Ink What it does

Copy Copy is the default ink. It draws every pixel within the bounding box of the sprite 
and makes the bounding box opaque. If the cast member is not rectangular, a 
white box appears around the sprite when it passes in front of another sprite, or is 
displayed on a black background. Copy is useful for backgrounds and when sprites 
do not appear in front of other artwork. Sprites with the Copy ink animate faster 
than sprites with any of the other ink effects. You can use Matte to hide the white 
box around the sprite while keeping the sprite opaque.

Matte Makes an opaque sprite without a white box around the sprite. Matte does not 
draw any pixels outside the sprite’s boundaries. Artwork within the boundaries, 
however, will be opaque. Matte functions much like the lasso in the paint window, 
in that the artwork is outlined rather than enclosed in a rectangle. Matte, like Mask, 
uses more memory than the other inks, and sprites with this ink animate more 
slowly than other sprites.

Bkgnd Trans. Pixels in the background color of the selected sprite appear transparent and permit 
the background to be seen. As with Matte and Mask, this may make your sprite 
animate more slowly.

Transparent The Transparent ink makes the pixels that are the  background color transparent so 
you can see the artwork underneath the transparent pixels.

Reverse Reverses overlapping colors. A pixel that was originally white becomes transparent 
and lets the background show through unchanged. Reverse is good for making 
custom masks. 

Ghost When Ghost is applied to the foreground sprite, any black pixel turns the pixel 
beneath it white. Anything white becomes transparent. Ghost is useful for 
reversing black and white.

Not Copy,
Not Transp.,
Not Reverse,
Not Ghost

These inks are variations of the previous four inks. The foreground image is first 
reversed, then the Copy, Transparent, Reverse, or Ghost inks are applied. These 
are good for odd effects. 
Like Transparent, the Not Transparent ink is good for reversing black and white. 
Just choose Not Transparent, select a white fill, and then draw a QuickDraw 
rectangle on stage on top of the artwork you want to reverse.

Mask When Mask is applied to the foreground art, you can see the background through 
any holes in the cast member. For example, you can see the background through  a 
car window that has a mask. For this to work properly you must create a duplicate 
of the cast member to be masked and place it in the cast window in the cast 
member position to the immediate right of the cast member being masked. The 
mask must be drawn in 1-bit black and white. The opaque areas of the mask must 
be black.
Mask and Matte use twice the memory of any other ink because Director has to 
internally create a duplicate of the artwork.
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The best way to see how each ink effect works is to play the sample 
movie Ink Effects. To find it, go to the Macromedia Director 4.0 
folder, open the Tutorials folder, and then open the Learning 
Director folder. Double-click the icon labeled Ink_FX. When you’re 
finished watching the movie, press Command-period to stop it.

Note The following inks produce jagged text if you have Adobe Type Manager 
installed: Not Transparent, Not Reverse, Not Ghost, Blend, Darkest, 
Lightest, Add, Add Pin, Subtract, and Subtract Pin.

Blend When Blend is applied to a sprite, the sprite’s color changes to blend with the color 
of the background sprite. Since the Blend value is tweened and changes from 
frame to frame, it can reduce performance when animating a sprite. Applying the 
Blend ink ensures that the sprite uses the blend percentage specified in the Set 
Sprite Blend dialog box.

Darkest Compares pixel colors in the foreground and background, and uses whichever pixel 
color in the foreground or background is darkest.

Lightest Compares pixel colors in the foreground and background, and uses whichever pixel 
color in the foreground or background is lightest.

Add Creates a new color that is the result of adding the color value of the foreground 
sprite with the color value of the background sprite. If the value of the two colors 
exceeds the maximum color value, the addition wraps around the color scale.

Add Pin Similar to Add, the foreground sprite’s color is added to the background sprite’s 
color, but the value of the new color cannot exceed the maximum color value.

Subtract This ink subtracts the value of the foreground sprite’s color from the value of the 
background sprite’s color to arrive at the new color. If the color value of the new 
color is less than the minimum color in the color scale, the new color is determined 
by wrapping around and starting at the top of the color scale.

Subtract Pin The color of the sprite with this ink is determined by subtracting the color value of 
the foreground sprite from the value of the background sprite. The value of the 
new color does not wrap around the color scale.

Score window inks

Ink What it does
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The mathematics of color

The effect of the color ink effects on sprites can be predicted if you 
know a bit about how the Macintosh calculates color. Colors are 
represented by three numbers which represent the proportion of red, 
green, and blue in a color. For example, the value of black, which is a 
complete absence of any color is 0, 0, 0. White, which is a mix of all 
colors, is 100, 100, 100. Grays are produced when all three colors 
have equal percentages less than 100, or more than 0, for example, 
40, 40, 40 is a dark gray, and 80, 80, 80 is a lighter gray. Keep in 
mind that these are percentages of colors, not the absolute values you 
see in the Macintosh Color Picker.

The names of the color ink effects come from the way the new color 
is calculated for each pixel when a foreground sprite crosses paths 
with a background sprite. The color values of the two sprites are 
blended, added, subtracted, or the color with the darkest or lightest 
value is used.

Take the example of mixing a red pixel with a white background. 
The value of the pixels are shown in the following table.

Sprite color % Red % Green % Blue

Red 100 0 0

White 100 100 100
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When the red pixel has various ink effects applied, the resulting color 
can be predicted as shown in the following table.

When an added or subtracted value exceeds the color scale, it wraps 
around the color scale. For example, if 50 is added to 75, the final 
color exceeds 100, so it starts at the beginning of the scale and the 
final color is 25. Add Pin and Subtract Pin mean that those effects do 
not wrap around. They “pin out” at 100 or 0. If Add Pin were used 
in the example, 50 and 75 would pin out at 100.

Ink % Red % Green % Blue Resulting 
color

Darkest 100 0 0 red

Lightest 100 100 100 white

Blend 100 50 50 pink

Add 100 100 100 white

Subtract 0 100 100 aqua blue
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Anti-Alias pop-up menu

This pop-up menu lets you apply an anti-alias modifier to a text or 
bitmap graphic cast member in the score. Anti-aliasing can reduce or 
remove the jagged or stair-step distortions in a graphic image or in 
text. 

Note In order for the anti-alias effect to be visible during playback, anti-aliasing 
must be checked in the Movie Info dialog box.

Using the anti-alias ink modifier is not recommended for 8-bit cast 
members that have a gradient fill, since the anti-alias effect may cause 
the gradient to appear banded.

To apply the anti-alias effect to a text or graphic sprite:

1. Open the score.

2. Select the cells that contain the sprites that will receive the 
anti-alias effect.

3. Choose an anti-alias level from the Anti-Alias pop-up 
menu.
The anti-alias level you choose determines how much the 
distortions are reduced or removed. Choose the level that gives 
you the most desirable result. You may have to experiment with 
different levels to find the most appropriate one.

Anti-Alias pop-up
menu
Window Reference 285



˛ Tip Using the anti-alias effect will cause your animations to play more slowly. 
Anti-aliasing can be disabled for the entire movie using the Movie Info 
command on the File menu. Disabling anti-aliasing while editing the movie 
will improve drawing speed, and you won’t have to disable it for each frame of 
the score.

To improve playback speed, only apply anti-aliasing to the first and last frame 
of an animation sequence (unless you are recording to videotape). 
Alternatively, you may prefer to create anti-aliased text using an application 
such as Adobe Photoshop.
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Trails checkbox

If Trails is checked, the selected sprite remains on the stage, leaving a 
trail of images along its path as the movie plays. If Trails is unchecked, 
the selected sprite is erased from previous frames as the movie plays. 
The checkbox also reflects the current selection. If the current 
selection includes sprites that don’t all have the same setting, the 
Trails checkbox is shaded gray.

A sequence with trails

Trails checkbox

Trails enabled
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˛ Tip The dashed line in the center of the cells that appears when you view the score 
using the Ink or Extended display indicates that those cells have trails applied 
to them. You can also see if a cast member has trails by selecting the cast 
member on the stage or in the score and looking at the Trails checkbox.

Moveable checkbox

This option is only available if you select one or more cells in the 
sprite channels in the score. If Moveable is checked, users can move 
the selected sprite(s) around on the stage during playback. If checked, 
the “Moveable” setting is in effect only when the playback head is 
executing those frames that contain the moveable sprites. The 
checkbox also reflects the current selection. If the current selection 
includes sprites that don’t all have the same setting, the Moveable 
checkbox is shaded gray.

Trails is indicated by a
dotted line

Moveable checkbox
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Editable checkbox

This option is only available if you select one or more text sprites. If 
Editable is checked, users can edit the selected text sprites on the stage 
during playback. This option is convenient for making a text sprite 
editable in some frames, and non-editable in others. You can turn this 
setting off when it is no longer required. If checked, the “Editable” 
setting is in effect only when the playback head is executing those 
frames that contain the editable sprites. The checkbox also reflects the 
current selection. If the current selection includes sprites that don’t all 
have the same setting, the Editable checkbox is shaded gray.

Note You can set a text cast member to always be editable using the Text Cast 
Member Info dialog box. If you set a text cast member to be editable in the 
cast, it is always editable when used in the score. Director ignores the score’s 
Editable checkbox setting for the cast member.

Using the Lingo command set the editableText of sprite to 
true is the same as checking the Editable checkbox in the score.

Editable checkbox
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Recording and playback in the score

This section describes how to step-record, real-time record, and 
suppress a channel during playback.

Step-recording in a channel

Step-recording lets you create frame-by-frame animation in a 
channel. To activate step-recording in a channel, Option-click the 
channel number in the score where you want recording to occur. 
Select additional channels by Option-clicking their channel numbers. 

Note Step-record mode is automatically invoked if you drag cast members from the 
cast window to the score or the stage. 

A step-recording indicator appears in the channels that are in step 
record mode.

When you choose Step Forward from the Edit menu or control 
panel, the sprite in the channel with the step-recording indicator is 
copied into the next frame of your movie. 

Step-recording remains in effect until you Option-click the channel 
number again, click out of the channel, drag the playback head, or 
click Rewind or Step Backward.

Step-recording indicator
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Real-time recording in a channel

Real-time recording lets you move a sprite directly on the stage while 
recording its motion in a score channel. To activate real-time 
recording in a channel, press Control-Spacebar while clicking a cell 
in the desired channel. To activate real-time recording in the first 
empty score channel, just press Control-Spacebar.

An indicator appears next to the channel number to indicate that 
real-time recording will occur in that channel. Only one channel at a 
time can be used for real-time recording.

To record a cast member’s path in the score, first select it in the cast 
window. Then hold down Control-Spacebar and click anywhere on 
the stage to begin recording the sprite’s path. Director records the 
motion of the sprite in the score as you move it across the stage. 
Information in any of the other channels is copied as you record.

To stop real-time recording, release the mouse button.

Turning a channel on and off

Turning a channel off tells Director to ignore the channel during 
playback. By default, no channels are ignored (i.e., all channels are 
active). Clicking the button next to a channel turns the channel off, 
causing Director to ignore that channel when you play the movie. 

If you turn the script channel off, Director ignores all scripts during 
playback. (This is the same as checking the Disable Scripts command 
in the Edit menu.) 

Channel on/off settings are not saved with the movie.

Real-time
recording indicator

This channel is off
This channel is on
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The paint window

The paint window has a complete set of paint tools and inks you can 
use to create cast members for your movies. The paint and cast 
windows share a dynamic link. Anything you draw in the paint 
window becomes a cast member automatically and is displayed in the 
cast window. When you make a change to a cast member in the paint 
window, the image in the cast window is instantly updated—as is the 
cast member wherever it appears on the stage. Conversely, when you 
paste or import a new bitmapped cast member into the cast window, 
it appears in the paint window.

Open the paint window by choosing Paint from the Window menu, 
or by pressing Command-5. When you open the paint window, the 
Paint and the Effects menus appear on the menu bar. 

˛ Tip A shortcut for opening the paint window is to double-click a bitmapped cast 
member on the stage or in the score or cast windows. The paint window opens 
with that cast member showing.
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The paint window contains a complete paint program so you can 
create or edit cast members without leaving Director. The paint tools 
are contained in the tool palette at the left side of the window.

The paint window

Cast member buttons

Tool palette

Ink pop-up menu
Destination color chip

Foreground color chip
Background color chip

Pattern chip

Line width selector

Color resolution indicator
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Working with easels

The easel is the area of the paint window where you draw. Use the 
Paint Window Options command on the Paint menu to choose 
between two types of easel display, One Cast Member or 50 Cast 
Members. If you choose One Cast Member, one cast member at a 
time is visible in the paint window; if you choose 50 Cast Members, 
each cast member occupies a separate easel in the paint window.

The paint window can display one cast member at a time or 50 cast members
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Creating a new bitmap cast member

To create a new cast member:

þ Click the Add button, or press Command-Shift-A.

Director creates a new, empty easel in which you can create the 
cast member. Whatever you draw is placed in the first available 
cast member position.

The Previous and Next buttons control which cast member is 
displayed. For descriptions of the other buttons, see “The cast 
window,” earlier in this chapter.

Using rulers

The paint window has a set of vertical and horizontal rulers to help 
you align and size your artwork.

To use the rulers:

þ Choose Show Rulers from the Paint menu.
The rulers appear at the top and left side of the paint window. 
The default unit of measurement is inches.

Add button
Previous, Next buttons

Click to
change the unit of

measurement
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To change the unit of measurement:

þ Click the corner where the rulers meet.
With each click the unit of measurement changes, first to 
centimeters, then to pixels, then to picas, then back to inches.

To change the location of the zero point:

þ Drag right or left along the ruler at the top of the window 
or up or down along the ruler at the side.

To remove the rulers from the paint window:

þ Choose Hide Rulers from the Paint menu.
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Zooming in and out

The Zoom commands on the Paint menu permit you to zoom in or 
out at four levels of magnification.

To zoom in on the image in the paint window:

þ Choose Zoom In (Command-+) from the Paint menu.
The image size increases to the first level of magnification. To 
increase the magnification, choose Zoom In again. The zoom 
centers on the last part of the image clicked in the paint window. 
To zoom in on a particular feature of the image, Command–click 
the image, or position the pointer over the feature before 
choosing Zoom In.

You can see a normal-size view of the image in the box in the upper 
right corner of the paint window. You can go back to the 
normal-size view any time by clicking inside the box.

Zoom Out reverses the direction of the zoom. To reduce a magnified 
view:

þ Choose Zoom Out (Command–minus) from the Paint menu.

˛ Tip Switch back and forth between normal size and the last level of magnification 
you chose by double-clicking the pencil tool or by pressing the Command key 
and clicking the art with any tool.

Click here to return 
to the normal-size 
view
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Selecting colors and patterns

Colors and patterns are similar in the way you choose them and in the 
way you make use of them. You choose both colors and patterns 
from pop-up palettes (the pop-up colors palette isn’t available if you 
have your monitor set to black and white), and you make use of both 
with the same set of tools.

The colors that appear on the pop-up palette come from a set of 
colors known as a palette. Although the Macintosh is capable of 
displaying over 16 million colors, it can only display a given set of 
colors at any one time, depending on the capabilities of your video 
card. If the Macintosh you’re working with has a 4-bit video card, 
you can work with palettes of 16 colors. If you’re working with an 
8-bit video card, you’ll be able to work with palettes of 256 colors.

Director has nine standard palettes: two System palettes (for 
Macintosh and Windows systems), Rainbow, Grayscale, Pastels, 
Vivid, NTSC, Metallic, and VGA palettes. (The standard palettes 
aren’t all available all the time; which palettes are available depend on 
the number of colors your monitor is set to display.) The System 
palette for your platform is the default palette. You can create as 
many additional palettes as you want.
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There are three types of colors you can choose from the current 
palette: the foreground color is the color that you paint with when 
the pattern is solid and the ink is Normal. The background color is 
the secondary color in a pattern. The destination color is the color 
you want to replace the foreground color with when you use the 
Switch ink or the Switch Colors command; when you use the Cycle 
ink, the destination color is the end of the range of colors (beginning 
with the foreground color) that you want to cycle through; and when 
you use the Gradient ink, the destination color and the foreground 
color define the two extremes of the range that make up the color 
gradient.

Director has three standard palettes of patterns—Grays, Standard, and 
QuickDraw—as well as a custom palette. The custom palette contains 
a set of default patterns; you can create new patterns by editing the 
default patterns in the Patterns dialog box. You can also create a 
tile—a multicolored pattern that’s a duplicate of a small rectangular 
section of an existing cast member.

See “Working with color palettes” in Chapter 3 for more 
information.

Foreground color
Background color

Destination color
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Paint window buttons

Place button
Lets you drag the selected bitmap cast member to the stage, score, or 
cast window. Press and hold down this button to drag the selected 
cast member.

Add button
The Add button creates a new bitmap cast member. Director creates 
the new cast member in the first empty slot in the cast window that 
follows the location of the current cast member. If there are no empty 
slots following the current cast member, Director continues searching 
for an empty slot from the beginning of the cast. The new cast 
member inherits the stage monitor’s color depth.

˛ Tip The keyboard shortcut for Add is Command-Shift-A.

The other buttons work the same as they do in the cast window. See 
“The cast window” earlier in this chapter.

Place button
Add button
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Paint window tools

The paint window has a set of paint tools for creating or modifying 
cast members. If you’re familiar with Macintosh paint applications, 
you’ll feel right at home with the way the tools work.

In most cases, pressing the Shift key while dragging a tool constrains 
it to horizontal or vertical. The ellipse and rectangle tools are 
constrained to a perfect circle or square when Shift-dragging.

If you press the Command key and click the image in the paint 
window, your view of the artwork will zoom in to a magnified view.

Selection rectangle

Text

Airbrush
Pencil
Eraser
Polygon

Arc
Eyedropper

Lasso

Hand

Paint bucket
Paintbrush
Rectangle

Ellipse

Line
Registration
Window Reference 301



The following table shows whether clicking and/or dragging makes 
the tool work.

Tool Click Drag Result

Lasso • Selects irregular shapes

Selection rectangle • Selects rectangular areas

Hand • Moves artwork within easel

Paint bucket • Fills with foreground color or 
current pattern

Air brush • • Sprays foreground color or 
current pattern

Paintbrush • • Paints foreground color or 
current pattern

Pencil • • Toggles pixels between 
foreground and background 
color

Rectangle • Draws hollow or filled 
rectangles and squares 

Eraser • • Erases artwork

Ellipse • Draws hollow or filled ellipses 
and circles

Polygon • Draws hollow or filled 
polygons

Line • Draws straight lines

Arc • Draws arcs (one quarter of an 
ellipse or circle)

Registration • Sets registration point

Eyedropper • Picks foreground color
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Drawing with the shape tools

The shape tools are the line, rectangle, ellipse, and polygon tools. The 
rectangle, ellipse, and polygon tools have a left, or hollow side, and a 
right, or shaded side. When you click the hollow side, the shape you 
draw is only an outline; it is not filled with a pattern or color. When 
you click the filled side, the shape you draw is filled with the 
currently selected foreground and background colors and patterns.

˛ Tip If you press the Option key while drawing with one of the shape tools, the 
border of the shape is drawn with the current pattern.

If you press the Shift key while drawing with the line tool, the line is 
constrained to horizontal, vertical, or 45–degree angles.

Double-clicking the shaded side of the rectangle, ellipse, or polygon tool opens 
the Gradients dialog box.

Lasso

The lasso can be used to select an area. Once selected, drag the 
artwork, cut, copy, or clear it. You can also use the following 
commands from the Effects menu: Invert Colors, Trace Edges, Fill, 
Darken, Lighten, Smooth, and Switch Colors.

˛ Tip If you press the Option key while dragging the lasso, the lasso draws straight 
lines to select a polygon shape. Click the lasso to anchor a point and draw 
another straight line. Double-click when you reach the end of your selection.

Once an object is selected with the Lasso, pressing the Option key while 
dragging the object makes a copy of your selection.

Pressing the Shift key while dragging the object constrains its movement to a 
horizontal or vertical line. To move the cast member in one-pixel increments, 
select it on the stage and use the arrow keys on your keyboard.
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Note Use the lasso to select everything but the pixels of a certain color. The color of 
the pixels not selected is determined by where you begin to drag the lasso. For 
example, if you’re selecting an object that is red, white, and blue, and you 
only want to select the red and white pixels in the object, begin your drag on a 
blue pixel. Then, only the red and white pixels will be selected. If you want to 
avoid this effect, use the No Shrink option in the Lasso pop-up menu.

Lasso pop-up menu
Pressing and holding the mouse button while the pointer is on the 
lasso tool causes the lasso pop-up menu to appear.

Choosing a command from the lasso pop-up menu modifies how the 
lasso works. 

◆ Shrink causes the lasso to tighten around the selected object so 
that only the object is selected.

◆ No Shrink permits you to select the entire area you drag around. 
The lasso selects whatever is inside the selected area.

◆ See Thru causes your selection to become transparent, as if the 
Transparent ink effect were applied.
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Selection rectangle

The selection rectangle can be used to select artwork in the paint 
window. When selected with the selection rectangle, artwork can be 
dragged, cut, copied, and cleared. It can also be modified with the 
commands in the Effects menu.

Select the contents of the visible part of the paint window by 
double-clicking the selection rectangle.

˛ Tip Stretch and compress art that is selected with the rectangle by holding down the 
Command key while dragging the art.

When artwork is selected with the selection rectangle, hold down the Option 
key while dragging the artwork to make a copy of it.

Selection rectangle pop-up menu
If you press and hold the mouse button when the pointer is 
positioned on the selection rectangle tool, the selection rectangle 
pop-up menu appears with commands to modify the action of the 
tool. 

◆ Shrink causes the rectangle to shrink around the selected artwork. 

◆ No Shrink permits you to select everything within the selection 
rectangle.

◆ Lasso makes the selection rectangle tighten around your selection 
like the lasso tool. The selection tightens around the object and 
selectively selects the pixels according to the color of the pixel 
beneath the crosshair when you started your drag.

◆ See Thru Lasso makes the selection rectangle tighten around your 
selection like the lasso and applies the Transparent ink.

Double-clicking the selection rectangle tool selects the entire paint 
window or active cast member.
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As with the lasso, you can reposition the selected cast member. Move 
the crosshair inside the selected area until the crosshair turns into an 
arrow pointer and drag the selected area to reposition it. Several key 
combinations affect the selected area when you drag it.

You can also use the arrow keys to move the selected area one pixel 
at a time.

Hand tool

The hand tool moves the image within the paint window, changing 
your position in the window relative to the artwork. Click the hand 
tool to select it, then drag the artwork to pan the view. If you press 
the Option key while using the hand tool, its effect is the same as 
scrolling the view with the horizontal and vertical scroll bars. 

˛ Tip A shortcut for using the hand is pressing the Spacebar. This turns any tool 
(except the text tool) into the hand tool when the mouse button is pressed.

Effect Mouse or key combination

Copy Option-drag

Stretch Command-drag

Stretch proportionally Command-Shift-drag

Copy and stretch Command-Option-drag

Constrain to horizontal 
or vertical

Shift-drag

Clear Backspace or Delete
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Text tool

The text tool lets you type in any font, size, or style in the paint 
window. Use it to set the font, size, and style of the text.

The text you create in the paint window is bitmapped. It can be 
dragged around the paint window before you deselect the text. 
However, once you click outside the text box after creating the text, 
you cannot edit its font, size, or style. To change the font, size, or 
style after clicking, you must erase the text and replace it with new 
bitmapped text with the attributes you prefer. However, you can 
modify selected text with ink effects from the Ink pop-up menu, 
patterns from the patterns pop-up palette, or foreground and 
background colors with the foreground and background color chips 
in the paint window.

Paint bucket

The paint bucket fills any enclosed area with the currently selected 
color and pattern. The fill can be further modified with the ink effects 
in the Ink pop-up menu in the paint window. If there is a break in 
the outlined area you are filling, the paint will leak out and fill the 
surrounding area. If this happens, immediately choose Undo Bitmap 
from the Edit menu. Then choose Zoom In from the Paint menu to 
get a magnified view and inspect the outline for breaks. 

˛ Tip Double-clicking the paint bucket tool opens the Gradients dialog box.

Air brush

The air brush sprays the currently selected color and pattern. The 
spray can be further modified by choosing the ink effects from the 
Ink pop-up menu in the paint window. The longer you hold the 
airbrush in one spot, the darker it fills in the area. 

˛ Tip Double-clicking the air brush in the tool palette opens the Air Brushes dialog 
box. Use this dialog box to set the size of the air brush’s spray, the size of the 
dots of paint it sprays, and how fast it sprays paint.
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Air brush pop-up menu
If you press and hold the mouse button when the pointer is 
positioned on the air brush, the air brush pop-up menu appears. Each 
of the five settings in the pop-up menu can be defined so you can 
have several types of spray available without opening the Air Brushes 
dialog box.

To define a setting:

1. Choose the menu item you want to define from the Air 
Brush pop-up menu.

2. Choose Air Brushes from the Paint menu.

3. Select the type of spray you want in the Air Brushes dialog 
box. 

4. Click Set.
The choices you make in the Air Brushes dialog box are assigned 
to the menu item and remain until you change them.

Paintbrush

The paintbrush draws with the currently selected colors, ink effect, or 
fill pattern. Double-click the paintbrush to change the size and shape 
of the brush. When the Brush Shapes dialog box appears, click the 
brush shape you need, and then click Set.

Paintbrush pop-up menu
The paintbrush pop-up menu is similar to the air brush pop-up 
menu. Press and hold the mouse button while the pointer is 
positioned on the paintbrush tool to open the pop-up menu. 

Each of the five settings in the pop-up menu can be defined so you 
can have several brush shapes available without opening the Brush 
Shapes dialog box. 
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To define a setting:

1. Choose the menu item you want to define from the 
Paintbrush pop-up menu.

2. Choose Brush Shapes from the Paint menu.

3. Select the brush shape you want in the Brush Shapes dialog 
box. 

4. Click Set.
The choices you make in the Brush Shapes dialog box are 
assigned to the menu item in the pop-up menu and remain until 
you change them. 

Pencil

The pencil creates a one-pixel-wide line. On a black and white 
monitor, the pencil draws black pixels on a white background and 
white pixels on a black background. On a color monitor, the pencil 
draws with the currently selected foreground color unless you are 
drawing on pixels that are the foreground color. In that case, the 
pencil draws in the background color.

Double-clicking the pencil tool magnifies your view of the artwork 
in the paint window. It magnifies the current easel at the point last 
clicked with any of the paint tools. You can also zoom in while using 
the pencil or any other tool by pressing the Command key and 
clicking.

Once you are in a magnified view you can edit the cast member pixel 
by pixel. You can use any of the paint tools while in a magnified 
view. Clicking the reduced view in the upper right corner of the 
paint window returns you to a 100% view. Double-clicking the 
pencil in the tool palette while in magnified view also returns you to 
a 100% view.

Move around the magnified view using the paint window’s scroll bars 
or by using the hand tool.
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Rectangle tool

The rectangle tool draws rectangles of any shape and size. When you 
click the left or hollow side of the rectangle tool, it draws an outline 
in the current foreground color as you drag the crosshair diagonally. 
When you click the right or shaded side of the rectangle tool, the 
rectangle you draw is filled with the current foreground and 
background colors in the current ink and pattern. The thickness of 
the rectangle’s border is controlled with the line width selector at the 
bottom of the tool palette. 

To constrain the rectangle to a square, press the Shift key as you drag 
with the crosshair pointer. If you press the Option key while drawing 
a rectangle, the border is drawn with the current pattern.

˛ Tip Double-clicking the shaded side of the rectangle tool opens the Gradients 
dialog box.

Eraser

The eraser clears the portion of the cast member you drag across. The 
eraser always clears to white. Double-clicking the eraser tool erases 
everything in the paint window’s visible area.

Ellipse tool

The ellipse tool creates circles and ovals. Like the rectangle tool, the 
ellipse is an outline if you click the tool on the left or hollow side, and 
is filled with the current foreground and background colors, ink, and 
pattern when you click the tool on the right or shaded side. The 
thickness of the line is controlled by clicking the line width selector at 
the bottom of the tool palette. 

When you hold down the Shift key as you draw, the ellipse tool 
draws perfect circles. If you use the ellipse tool while pressing the 
Option key, the border of the circle is drawn with the currently 
selected pattern.

˛ Tip Double-clicking the shaded side of the ellipse tool opens the Gradients dialog 
box.
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Polygon tool

The polygon tool draws polygons with as many sides as you want. As 
with the rest of the shape tools, the left or hollow side of the tool 
creates an outline, and the right or shaded side of the tool draws an 
area filled with the current foreground and background colors, ink, 
and pattern. When you click the tool, the pointer becomes a 
crosshair. Click in the paint window to start drawing the side of a 
polygon. Each time you click, a line is drawn from the spot you 
clicked previously. When you are ready to finish off your shape, 
double-click and a line is drawn connecting the spot you just clicked 
and the point of your first click.

The thickness of the lines drawn with the polygon tool is controlled 
with the line width selector at the bottom of the tool palette. If you 
press the Option key while drawing a polygon, the border is drawn 
with the currently selected pattern. 

˛ Tip Double-clicking the shaded side of the polygon tool opens the Gradients dialog 
box.

Line tool

The line tool draws straight lines at any angle. When you hold down 
the Shift key, the line tool draws vertical, horizontal, or 45–degree 
lines, depending upon the direction you begin to drag. Change the 
line width by clicking the line width selector in the tool palette. 

The line is drawn with the currently selected foreground color and 
ink effect.

˛ Tip Pressing the Option key while drawing a line causes the line to be drawn in 
the currently selected pattern.
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Arc tool

The arc tool draws one quarter of an ellipse or circle. When the tool 
is active, the pointer becomes a crosshair. Drag the crosshair from the 
starting point of the line and move the pointer to see the curve. 
Experiment with dragging the tool until it produces the line you 
need. The thickness of the arc is controlled with the line width 
selector at the bottom of the tool palette. 

The line is drawn with the currently selected foreground color and 
ink unless you press the Option key while dragging, in which case the 
arc is drawn with the current pattern.

Registration tool

When you create a cast member in the paint window, it is 
automatically assigned a registration point that centers on the artwork. 
You can see this by creating a simple cast member and clicking the 
registration tool. When you click the tool, dotted lines appear in the 
paint window. The intersection of these dotted lines is the 
registration point of the cast member. Using registration points speeds 
your ability to quickly and accurately put cast members on the stage 
and have them all line up with the same point. 

The registration tool is used to line up cast members for 
frame-by-frame animation. When you have a series of cast members, 
you can align their registration points so you have a fixed reference 
point for animation. A simple example might be the hands of a clock. 
The hands are made up of different cast members at various positions 
around the face of the clock, but they must be anchored to the center 
of the clock. Setting a registration point on the hands at the point 
about which they rotate enables them to line up in the proper 
position on the stage.

Another example of using registration points is a running figure. You 
can set a registration point at the same spot on the ground so when 
the series of running figures is animated, they bounce up and down 
relative to the same point on the ground.
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Registration points are most useful when animating with the Switch 
Cast Members command in the Score menu, with film loops, and 
when previewing a sequence of cast members in the paint window 
with the Align Bitmaps command in the Cast menu. When you use 
the Align Bitmaps command, the cast members in the paint window 
are all lined up on each other’s registration points, permitting you to 
preview the animation by quickly flipping through the cast members 
using the left and right arrows at the top of the paint window.

The default registration point for a bitmap image is the center of the 
cast member in the paint window. However, the registration point 
for shapes, buttons, or text is always the upper left corner of the 
image. Clicking a point in the paint window sets the registration 
point at that location. 

To set a registration point:

1. In the paint window, select the cast member that you want 
to register.

2. Click the registration tool.
The dotted lines in the paint window intersect at the registration 
point. The default registration point is the center of the cast 
member. 

The pointer changes to a crosshair when you move it to the paint 
window.

3. Click a location in the paint window to set the registration 
point.
You can also drag the dotted lines around the window to 
reposition the registration point. 

˛ Tip To reset the default registration point at the center of the cast member, 
double-click the registration tool.

Eyedropper

The eyedropper is used to match colors. When you select the 
eyedropper, any color you click in the paint window becomes the 
foreground color. Use it to match colors without opening the color 
palette. Pressing the Control key turns any tool into the eyedropper.
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Ink pop-up menu

Below the tool palette is a pop-up menu with a number of inks that 
modify the way each tool is used. The result of the ink you choose 
depends on whether you are working in color or black and white. 
Another factor to keep in mind is the pattern the ink is used with. 
Some inks work better when painting with patterns and others work 
better when painting with solid colors. 

Ink B&W Color Works with

Normal √ √ Solids and patterns

Transparent √ √ Patterns

Reverse √ √ Solids and patterns

Ghost √ √ Solids (b&w) and patterns (color)

Gradient √ √ Paintbrush, paint bucket, shape 
tools

Reveal √ √ Paintbrush, shape tools

Cycle √ Solids and patterns

Switch √ Paintbrush

Blend √ Solids and patterns

Darkest √ Patterns

Lightest √ Patterns

Darken √ Paintbrush

Lighten √ Paintbrush

Smooth √ Paintbrush

Smear √ Paintbrush

Smudge √ Paintbrush

Spread √ √ Paintbrush

Clipboard √ √ Paintbrush
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Normal
Normal is the default ink. It is opaque and maintains the color of the 
current foreground color and pattern. 

Transparent
Transparent ink makes the background color of patterns transparent 
so you can see artwork drawn previously in the current cast member 
through the pattern.  

Reverse
Reverse ink makes overlapping colors reverse. Any pixel in the 
foreground art that was originally white becomes transparent. Any 
pixel that was black reverses the color of the background art.

Ghost
Ghost in black and white creates an image than can only be seen 
when placed over a black background. In color, Ghost draws with 
the current background color.

Gradient
Gradient lets you paint with the gradient fill selected in the Gradients 
dialog box. A gradient fill is one that progresses from one color, the 
foreground, to another color called the destination color. You can 
paint with Gradient ink with the paintbrush, paint bucket, or shape 
tools.

Reveal
Reveal works indirectly with the art in the previous cast slot. Imagine 
the previous cast member’s artwork covered with a white area. 
Reveal erases the white area to show the artwork in the previous 
easel. Reveal can be used to create specific shapes from shades created 
with the air brush. Since it is impossible to mask certain shapes for the 
air brush, spray an area with the air brush first; then in the next cast 
member, paint the shapes you need with a Reveal ink. As you paint 
your object, you will expose the air brush pattern in the previous 
easel.
Window Reference 315



Cycle
Cycle is a color ink. As you draw with a cycling ink, the colors 
change as the ink progresses through the palette. The beginning and 
ending points of the color cycle are determined by the foreground 
and destination colors. If you want to cycle through the whole 
palette, choose white as the foreground color and black as the 
destination color.

Switch
Switch changes any pixel that is the current foreground color to the 
current gradient destination color as you paint over that color. 

Blend
Blend creates a translucent color ink. You can see the background 
object, but its color is blended with the foreground object’s color. 
You can choose the percentage of blend in the Paint Options dialog 
box.

Darkest
Darkest is a useful ink for colorizing black and white artwork. For 
example, if you are painting yellow over black and white, black will 
remain black since it is darker than yellow, and white will become 
yellow because yellow is darker than white. 

Lightest
Lightest is another useful ink for colorizing black and white artwork. 
For example, if you are painting yellow over black and white, black 
objects become yellow when painted with the Lightest ink effect, and 
white remains white because it is lighter than yellow. 

Note In very rare instances you may experience bugs in the Macintosh QuickDraw 
routines. These occur when you use the Darkest or Lightest inks. For 
example, mixing colors with Darkest or Lightest ink will not work well if one 
of the colors is a gray pattern. Use a solid gray rather than a pattern to mix 
colors. Another anomaly crops up when you use the air brush’s speckled paint 
option to spray with the Darkest or Lightest ink. The size of the large drops of 
speckled paint will not be as large as they are with the other inks.
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Darken
Darken makes colors darker. The more the paintbrush passes over an 
area, the darker it becomes. The color of the foreground, 
background, or destination inks has no effect on Darken. Darken 
creates an effect that is the same as reducing a color’s brightness with 
the controls in the color palettes window. You can vary the rate of 
this ink effect in the Paint Options dialog box.

Lighten
Lighten makes existing artwork lighter. The more times you pass 
over the artwork with the paintbrush, the lighter it becomes. The 
color of the foreground, background, or destination inks has no effect 
on Lighten. Lighten creates an effect that is the same as increasing a 
color’s brightness with the controls in the color palettes window. 
You can vary the lightness of this ink in the Paint Options dialog box.

Smooth
Smooth blurs existing artwork when painted with the paintbrush. It is 
not directional as are Smear and Smudge. The color of the 
foreground, background, or destination inks has no effect on Smooth. 
Smooth only works with art already in the paint window. Use it to 
smooth out jagged edges.

Smear
Smear works with the paintbrush. It is similar to mixing paint. Any 
area you drag across with a Smear ink is spread in the direction of the 
brush and fades as it gets farther from its source. The color of the 
foreground, background, or destination inks has no effect on Smear. 
Smear only works with art already in the paint window.

Smudge
Smudge is a color ink for the paintbrush that is similar to Smear. It is 
also like mixing paint. The colors fade faster as they are spread. The 
color of the foreground, background, or destination inks has no effect 
on Smudge. Smudge only works with art already in the paint 
window.
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Spread
Spread works with the paintbrush in color. Whatever is under the 
paintbrush when you start to drag is picked up as the ink for the 
brush. Copies of what is beneath the brush are pushed across the 
window as you draw. 

Clipboard
Clipboard uses the current contents of the Clipboard as a pattern to 
paint with.

Destination color chip

The range of colors between the foreground and destination colors is 
used with the Gradient, Cycle, and Switch inks. You select the 
destination color using the destination color chip.

A gradient is a blend of a range of colors that can be used for shading, 
highlights, backgrounds, and special effects. On a black and white 
monitor, gradients are created with a pattern of black and white pixels 
that fade from black to white or vice versa. With a color monitor, the 
two colors that form the beginning and end of a gradient are the 
foreground color and the destination color.

To set the current foreground color, click the left side of the selector 
and choose a color from the pop-up color palette. To set the 
destination color, click the right side of the selector and choose a 
color from the pop-up palette.

˛ Tip Hold down the Option key while pressing the up or down arrow key to cycle 
through the colors in the destination color chip.

Destination
color chip
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Foreground color chip

The foreground color is the color displayed in the foreground color 
chip. It’s also displayed in the color chip on the left side of the 
gradient color selector. The foreground color is the color you work 
with when you’re using the solid pattern and the Normal ink.

˛ Tip Press the up or down arrow key to cycle through the colors in the color palette 
associated with the Foreground color chip.

Double-click the foreground, background, or destination color chip to open the 
color palettes window.

Background color chip

The background color is the color displayed in the lower right color 
chip. The background color is the secondary color that appears in a 
pattern.When used with the Transparent ink, the background color 
in a pattern is drawn so you can see through the background color to 
artwork beneath. The background becomes transparent.

Foreground color
chip

Gradient color
selector

Background color
chip
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˛ Tip Hold down the Shift key while pressing the up or down arrow keys to cycle 
through the colors in the color palette associated with the Background color 
chip.

Pattern chip

The current pattern is displayed in the pattern chip below the two 
color chips in the tool palette.

Click the pattern chip to select a new pattern from the pop-up 
palette.

˛ Tip Pressing the Option key before displaying the pattern palette permanently 
changes the patterns to shades ranging from the foreground color to the 
background color rather than the set of patterns you see without pressing the 
Option key. Press the Option key again to return to the default set of 
patterns.

Double-click the pattern chip to open the Patterns dialog box. Use the dialog 
box to edit or select new sets of patterns.

Pattern chip
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Line width selector

The line width selector controls the thickness of the line drawn by 
the line or arc tool and the thickness of the borders drawn by the 
shape tools. 

The width of the line drawn by the line, arc, rectangle, ellipse, and 
polygon tools can be changed with the line width palette. The line 
width palette has several settings for line width ranging from no line 
(the dotted line in the line selector) to Other. Use the dotted line 
setting when you want to draw filled shapes without borders. If you 
choose Other, the line width is determined by the Other Line Width 
setting in the paint Window Options dialog box.

˛ Tip Double-click the line width selector to open the Paint Window Options dialog 
box. Use it to set the Other Line Width.

Line width
selector
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Color resolution indicator

The color resolution indicator displays the color resolution of the 
current cast member in the paint window.

Double-clicking the color resolution indicator opens the Transform 
Bitmap dialog box. Use the Transform Bitmap dialog box to change 
the color resolution of the current cast member in the paint window. 
Changing the color resolution from color to black and white saves 
disk space. You can still make a selected 1-bit cast member a color 
other than black by selecting colors with the foreground and 
background color chips in the tools window after it has been reduced 
to 1-bit. (This colorizes the sprite on the stage, but does not affect the 
original cast member, which remains black and white.)

If you import black and white cast members, changing their color 
resolution to multiple colors permits you to colorize them with any 
color in the current palette.

For more information, see “Changing color depths” in Chapter 1.

Color resolution
indicator
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The text window

Use the text window to create and edit a text cast member.

The commands on the Text menu set text attributes and find and 
replace text. You can also use the tools window to set the foreground 
and background colors of the text you create. 

Text created in a text window prints well with a laser printer. When 
printing frames from your movie you can avoid the jagged lines of 
bitmapped text by using the text window rather than the paint 
window to create text.

To open a new text window, choose Text from the Window menu. 
Director adds the name of the text window to the bottom of the 
Window menu. The window’s title displays the position of the first 
empty cast member where the text will be entered in the cast 
window.

Alternatively, double-clicking a text cast member in the cast window 
or on the stage will either open the cast member’s text window or 
bring it to the front if it is already open.

Changes made in the text window are automatically reflected in the 
cast after you stop typing for more than 1/2 second, switch to a 
different window, or if you click outside the text window or close it. 
All other windows displaying the current text cast member are 
automatically updated.

Add button
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Except for the Add button (which the cast window doesn’t have), the 
text window buttons work the same as they do in the cast window. 
For a description of the text window’s other buttons, see “The cast 
window,” earlier in this chapter.

Add button
Creates a new text cast member. Director creates the new text cast 
member in the first empty slot in the cast window that follows the 
location of the current cast member.

˛ Tip The keyboard shortcut for Add is Command-Shift-A. To switch to a new 
empty cast member and open a new window for it, use Option-Command-
Shift-A.
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Selecting and editing text

Click in the text window to set an insertion point. The text you type 
is inserted into the current cast member and automatically appears in 
the cast window. You can enter up to 32,000 characters, including 
spaces.

You select text in the text window or on the stage by dragging across 
the text, or by double-clicking to select a whole word. 
Triple-clicking selects all text in the cast member, which is the same 
as choosing Select All from the Edit menu.

You can cut, copy, and paste text between text windows.

Resizing text width

When text is on the stage, or in the text window, a resize handle at 
the right of the text controls the width of the text and the shape of 
any border set with the Text menu. Drag the resize handle in the text 
window or on the stage to change the text’s width.

Resize handle
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The minimum width of the text window is 16 pixels.

The handle’s thickness in the text window indicates the current 
vertical extent of the text. The handle appears thicker in the area 
occupied by the text, and narrower where there is no text.

˛ Tip To create another view of the same text window, hold down the Option key 
while choosing the name of the active text window from the Window menu. 
This creates a second view of the text window. This is useful if you are editing 
a large text cast member, since you can display different sections of the text in 
each view, and cut and paste between them.
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Formatting text

To apply a format to text, select it and choose a command from the 
Text menu. You can apply a font, size, and style to text on a per-
character basis.

Applying color to text

To apply a color to text:

1. Select the text in the text window.

2. Choose the Tools command from the Window menu.
The tools window appears.

3. In the tools window, choose a text color using the 
foreground color chip.
The color you choose is applied to selected text in the text 
window.

4. Choose a color for the text window’s background using the 
background color chip.
The color you choose is applied to the text window background.
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The tools window

The tools window has tools for creating QuickDraw text and 
graphics directly on the stage. QuickDraw text and graphics make 
excellent backgrounds and print well with a laser printer. They are 
easy to create and are resizable. They also use less memory than 
bitmapped images you create in the paint window. If you are 
producing handouts for a presentation, use text created with the text 
tool to avoid the jagged lines of bitmapped text.

The shapes you create with the QuickDraw shape tools appear as cast 
members in the cast window and the score window. The text you 
create with the QuickDraw text tool appears in the cast, score, and 
text windows. QuickDraw shapes and text do not appear in the paint 
window.

Using QuickDraw text for animation does have a drawback. It tends 
to animate more slowly than bitmapped text, so it’s best to use 
bitmapped text if animation speed is an issue.

Text tool
The text tool is an alternative to the text window for creating text. 
When you create text with the text tool on the stage it can also be 
seen in the text and cast windows. Click the arrow to select text that 
is already on the stage. You can change the color of selected 
QuickDraw text using the foreground and background color chips in 
the tools window.

Text tool

Line tool
Shape tools

Button tools

Background color chip
Pattern chip

Line width selector

Foreground color chip
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Line tool
Click the QuickDraw line tool to select it and drag it across the stage 
to draw. You can choose the color for the line with the foreground 
and background palettes that appear when you press on the color 
chips. The width of the line tool is controlled with the line width 
selector at the bottom of the tools window.

Shape tools
Click the shape tools on the left or hollow side to draw an outline of 
the shape. Click the right or shaded side of the tools to draw with a 
solid color or pattern. You can choose the color for the shape with 
the foreground and background palettes that appear when you press 
on the color chips. Use the pattern chip to select the current pattern. 
The thickness of the borders of the shape tools is controlled with the 
line width selector at the bottom of the tools window. You can 
change the shape using the Shape pop-up menu in the Cast Member 
Info dialog box.

Button tools
Director provides three tools for creating buttons, checkboxes, and 
radio buttons. Click the checkbox tool, button tool, or radio button 
tool and drag a rectangle on the stage to create a button. Then type 
the text that you want to appear on or next to the button. If 
necessary, set the font, style, and size. The button is placed in the cast 
as a button cast member. You can edit the button’s text on the stage 
or in a text window. You can then attach a script to the button so 
that it responds appropriately when clicked.

Foreground, Background color chips
The foreground and background color chips in the tools window can 
be used to set the color of text typed in the text and script windows, 
set the color of QuickDraw text and shapes, and set the color of 
sprites. 

To set the color of text you type in the text or script windows, make 
the text or script window active, and then choose a text color using 
the foreground color chip. The color is subsequently applied to text 
you type, but not to existing text. To set the window’s background 
color, choose a color using the background color chip.
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To set the color for a sprite, select the sprite in the score or on the 
stage and choose a new foreground color using the foreground color 
chip, or a new background color using the background color chip.

If you change the color of a 1-bit cast member, Director changes the 
color of the sprite on the stage but does not change the color of the 
actual cast member, which remains black and white.

Pattern chip
Lets you select the current pattern for a shape tool.

Line width selector
Lets you select the current width of the line tool, or the border for a 
shape tool.

Creating shapes

You create shapes with the line, rectangle, rounded rectangle, and 
ellipse tools. As with the paint tools, clicking the left side of the tool 
produces a hollow shape. Clicking the right side of the tool produces 
a shape filled with the current color or pattern in the pattern chip. 

˛ Tip Pressing the Shift key while dragging the crosshair constrains the tool to 
drawing a perfect square or circle. The line tool is constrained to horizontal, 
vertical, or 45-degree lines with the Shift key. 

To create a shape that is the full size of the screen, draw one as large as you 
can, drag it up and to the left, then extend it by dragging the handle in the 
lower right corner. You can then reposition it slightly lower and to the right to 
hide the edge along the right and the bottom. You can also use the Sprite Info 
command on the Score menu to enter the exact dimensions and position of the 
shape, to make it the same size as the screen.
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Changing a shape

To change a shape:

1. Click the pointer in the tools window.
The pointer allows you to select shapes.

2. Click a shape on the stage to select it.

3. In the tools window, select a new foreground color, 
background color, pattern, or line thickness.
The shape changes to match your selection.
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The color palettes window

The color palettes window lets you determine which palette to use to 
color the cast members on the stage. When you open the color 
palettes window, the Palette menu appears in the menu bar and the 
color palettes window displays the current palette (either 16 or 256 
colors). You can edit colors or switch palettes entirely. To use a 
palette in the score, select a cell in the palette channel and choose Set 
Palette from the Score menu. 

Hue, saturation,
and brightness controls

Palettes

Arrow

Eyedropper tool

Hand tool

Index number

Lets you select 
reserved colors. (This 
button only appears if 
you reserved colors 
using the Reserve 
Colors command in the 
Palette menu.)
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Director has nine built-in palettes:

◆ System – Mac

This is the standard 256-color Macintosh system palette.

◆ System – Win

This is the standard 256-color Windows palette.

◆ Rainbow palette

◆ Grayscale palette

◆ Pastels palette

◆ Vivid palette

◆ NTSC palette

◆ Metallic palette

◆ VGA palette.

The VGA (Video Graphics Array) palette is a special palette for 
VGA 4-bit displays. It provides consistent results when playing 
Director movies under Windows in 4-bit mode.

If you add new palettes to your movie from other graphics 
applications, those palettes also appear in the pop-up menu and in the 
cast window. Duplicated palettes that you modify also appear in the 
color palettes window’s pop-up menu.

When you switch to a new palette, the pixels change color in sprites 
on the stage based on the position number of their colors in the 
original palette.

Sprites always take on the colors of the palette that is currently active. 
The active palette is determined by which cast member is selected in 
the cast, score, or paint windows or which palette is selected in the 
color palettes window.

Use the hand tool to drag a color from one spot in the palette to 
another to reposition the color. 

Use the eyedropper to match the color of any pixel you click with 
the tool. 

Clicking the arrow changes your pointer back to the pointer.
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Editing colors

The easiest way to edit colors is with the Macintosh Color Picker. To 
edit a color using the Color Picker, double-click a color in the color 
palettes window. The Color Picker uses both the HSB (Hue, 
Saturation, Brightness) system and the RGB (Red, Green, Blue) 
system to measure color. The index number of the selected color 
appears in the lower left corner of the color palettes window along 
with a sample of the color.

To edit selected colors in the color palettes window using the HSB 
system, click the arrows at the bottom of the window to increase or 
decrease the value of hue, saturation, or brightness.

Hue is the primary or secondary color created by mixing two 
primaries. There are six hues that blend together as you travel in a 
circle around the Color Picker.

Saturation is a measure of how much white is mixed in with the 
color. A fully saturated color is vivid; a less saturated color is a washed 
out pastel or even a shade of gray.

Brightness controls how much black is mixed in with a color. Colors 
that are very bright have little or no black. As the brightness is 
reduced, the color gets darker as if more black were added. If 
brightness is reduced to 0, then no matter what the values for Hue or 
Saturation, the color will be black.

For information on editing a palette, see “Editing palettes” in 
Chapter 3. 
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The digital video window

Double-clicking a QuickTime cast member in the cast window or on 
the stage displays the cast member’s digital video window.

The digital video window lets you play a digital video movie. Use the 
controls at the bottom of the window to play, stop, advance, or 
rewind the movie. When the movie is stopped, you can cut, copy, 
and paste frames from the movie into another digital video window.

Note On a Macintosh, the term “digital video” refers only to QuickTime 
animations. However, on a PC, Director for Windows supports two digital 
video formats: Microsoft’s Video for Windows (.AVI) and QuickTime for 
Windows.
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Digital video window buttons

The Place, Previous, Next, Info, and Script buttons work the same as 
they do in the cast window. See “The cast window” earlier in this 
chapter for a description of these buttons.

Add button
The Add button creates a new digital video cast member. Director 
creates the new cast member in the first empty slot in the cast 
window that follows the location of the current cast member. If there 
are no empty slots following the current cast member, Director 
continues searching for an empty slot from the beginning of the cast.

Press Option while clicking the Add button to create a new digital 
video cast member in a new window.

˛ Tip The keyboard shortcut for Add is Command-Shift-A. To switch to a new 
empty cast member and open a new window for it, use Command-Option-A.

Add button
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When you paste a QuickTime movie into an empty digital video 
window, Director automatically converts the movie into a linked cast 
member. Director creates a QuickTime movie file in the same folder 
as the Director movie, and links the movie to the cast. The filename 
consists of the movie name, followed by the cast member name and 
number.

Creating a digital video cast member

To add a digital video movie to the cast, you either paste it or import 
it. Director automatically links the movie to the cast and adds it to the 
cast window. If you paste the movie, Director first asks you to name 
the file in which to store the movie.
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Using multiple digital video windows

You can create as many digital video windows as memory allows and 
play them simultaneously. A movie continues playing even if it is not 
the front-most window.

You can also create multiple views of the same digital video window, 
to display the same cast member in separate windows. This is useful 
for editing the movie, since you can play the movie independently in 
each window, and cut and paste between each window.

Changes to the cast member in one window are automatically 
reflected in any other windows that display the cast member.
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The script window

Use the script window to enter and edit Lingo scripts. A script 
window can contain up to 32,000 characters.

For a description of the buttons at the top of the script window, see 
the section called “The cast window,” earlier in this chapter.

˛ Tip In Director’s help window, Lingo commands include examples, attached as 
notes, that you can paste into your scripts and use.

You can have multiple script windows open at the same time. The 
Window menu lists all open script windows. The active script 
window appears underlined.

Director saves changes you make in the script window when you 
close it (by clicking the close box or by pressing Enter on the 
keyboard or Command-W) or if you choose Recompile Script or 
Recompile All Scripts in the Text menu.

˛ Tip Double-clicking a cell in the script channel opens the script window.

See “Writing scripts” in Chapter 4 for information about creating 
scripts. For complete information about using scripts, see Using Lingo.
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The message window

The message window is a convenient place to experiment with and 
test Lingo scripts. Actions occur immediately when you press the 
Return key, so you can see the results before you insert your scripts 
into a movie. This allows you to see the results of any script, 
including whether it is a valid script.

To move around the message window, use the arrow keys or scroll 
the window. Press Command-up arrow to move the insertion point 
to the top of the window. Press Command-down arrow to move the 
insertion point to the bottom of the window.

Use Cut or Clear to remove text from the message window. To clear 
all the text from the insertion point to the bottom of the window, 
press Command–Shift–Delete.

The message window has a Trace feature that can help you find 
problems in scripts. If Trace is checked, you can play a movie and all 
the Lingo commands will appear in the message window as they are 
executed. Using the Trace feature slows down animation, so turn it 
off when you’re not using it.

See Using Lingo for more information about working with the 
message window.
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The tweak window

The tweak window allows you to move one or more selected sprites 
in any direction with precision. Drag the point in the left side of the 
window to set the number of pixels. The value in the boxes will 
continue to increase or decrease as you drag the line beyond the 
boundary of the tweak window.

Tweaking the location of a cast member on the stage

After you set the number of pixels, click the Tweak button to move 
the selected sprites. Continue clicking the Tweak button to 
repeatedly move the selected sprites the same distance.

˛ Tip You can also use the arrow keys on your keyboard to move selected sprites one 
pixel at a time.

Selected sprite
Horizontal number of pixels
Vertical number of pixels
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The markers window

The markers window lets you write comments associated with 
markers you set in the score. For example, a Director animation can 
have staging or acting directions, storyboard scripts, or speaker’s notes 
written in the markers window and tied to specific frames in the 
score. A storyboard, transparencies, or handouts can be printed that 
include pictures of selected frames of your movie along with the 
comments written in the markers window. Double-clicking one of 
the triangular markers in the score window opens the markers 
window to the comment associated with that frame.

Once you’ve marked a frame in the score, you can use the marker 
name in your scripts. This is important because references to frame 
numbers may become invalid if you insert or delete frames in the 
score. Marker names remain constant no matter how much you edit 
the score.

The left column of the markers window displays the marker names 
from the score. Clicking a marker name or clicking the left or right 
arrow in the markers window moves the playback head to the 
selected marker location in the score window, and displays the 
comments associated with the marker in the markers window.

Click a marker
name to scroll the
score window to

the marker’s
location
Chapter 5342



To enter a comment, click a marker name to select it. You can then 
enter your comments beginning at the insertion point that appears in 
the right column of the markers window. By default, the marker 
name appears as the first line of text in the right column. If you edit 
the marker name, your changes are also reflected in the score 
window. If you don’t want to edit the marker name, press the Return 
key to start a new line, and enter your comments on the new line in 
the right column of the markers window.
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Chapter 6

Menu Reference

This chapter is a complete reference to the Director menus and 
commands. The menus are described as you see them in the 
menu bar from left to right. Four Director menus—Paint, Effects, 
Palette, and Lingo—only appear if you open a certain window.

Windows are described in Chapter 5, “Window Reference.”

See Appendix A, “Director Shortcuts,” for a complete list of all 
keyboard shortcuts for working with commands.
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Apple menu

The Apple menu includes three Director commands, followed by all 
currently installed Apple Menu Items files.

About Director...

Choosing About Director displays a dialog box that shows you how 
much memory is available to Director for your movie. It also 
indicates how much memory different parts of the current movie use 
and the total disk space the movie occupies. 

Total Memory 
Shows you the total memory available to Director to run your movie. 
This number depends on the size of the memory partition in the 
Finder, the amount of RAM installed in your computer, and any 
virtual memory.

Total Used
Indicates how much RAM is being used for your movie.
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File Size on Disk
Shows you how much disk space the current animation occupies. 
This number is updated every time you save the file. If you have 
created a new movie and have not saved it yet, this item is not 
displayed.

Free Memory
Indicates how much more memory is currently available to Director. 

Used by Program 
Indicates the amount of memory used by Director. 

Mattes & Thumbs
Shows you how much memory is used by cast members that use the 
Matte ink in the score window, and by thumbnail images in the cast 
window.

Cast & Score
Indicates the amount of memory used by the cast members in the cast 
window and the notation in the score window. Cast members 
include all the artwork in the paint window, all the text in the text 
windows, and any sounds, palettes, buttons, digital video movies, or 
linked files imported into the cast and currently loaded into memory.

Screen Buffer 
Shows how much memory Director reserves for a “working area” 
while animating on the stage.

Click Credits to display the names of the team that brought you 
Director.

Click Purge Memory to remove all purgeable items from RAM, 
including all thumbnail images in the cast window. All cast members 
that have a purge priority greater than zero (as specified in the Cast 
Member Info dialog box) are removed from memory. (Edited cast 
members don’t get purged.) This is useful for gaining as much free 
memory as possible before importing a large file.
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Help...

Displays a help window that gives you access to Director Help. To 
display the help window, do one of the following:

◆ Choose Help from the Apple menu.

◆ Choose Help Pointer from the Apple menu and then choose a 
window or menu to display the appropriate help screen for the 
object you chose.

◆ Click the Help button in any dialog box.

Use the buttons at the top of the Help window to navigate through 
the help system.

Topics
Returns you to the help contents window. This is the first window 
you see when you choose the Help command.

Previous
Returns you to the last window you were looking at before the 
current window.

Notes
Displays a dialog box that lets you enter a note for the current topic. 
The note is automatically attached to the current topic.

Click a topic to display
help on that topic
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Keyword
Displays the keyword window, which you can use like an index. The 
list on the left shows each keyword in the help system. When you 
select a keyword, the list on the right shows each topic where the 
selected keyword is referenced. Click a topic to display its help 
screen.

Back
Returns you to the previous window in the help system.

Forward
Takes you to the next window in the help system.

Search
Displays a window that lets you search for a word or phrase.

Bookmarks
Lets you assign a bookmark to the current window, so that you can 
quickly return to it by choosing the name of the bookmark from the 
pop-up menu.

˛ Tip Lingo commands include examples, attached as notes, that you can paste into 
your scripts and use.

Click to display the note
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Help Pointer

Changes the cursor to a question mark shape, for getting 
context-sensitive help. Choose a command or click a window to 
display the appropriate help screen. To cancel context-sensitive help, 
choose this command again.

˛ Tip Command–? is the keyboard shortcut for this command.

Scrapbook

Scrapbook files are an easy way for you to transfer artwork from 
another application into Director. Use the Import command to bring 
Scrapbook files into Director. When you import a Scrapbook file, 
Director automatically places each item in the Scrapbook in a cast 
member position in the cast window.

You can also use the Scrapbook to transfer the score from movies 
you’ve created to new movies. When you copy parts of a score to the 
Scrapbook, the score notation is stored in the Scrapbook along with 
references to the cast members in the movie.

Storing animation from the score in the Scrapbook
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The Scrapbook FKey

Director includes a Scrapbook FKey that you can use to quickly build 
a Scrapbook file in any application. The Scrapbook FKey lets you 
capture a portion or all of the screen, including any custom palette 
which is currently active. 

Activate the Scrapbook FKey from within any application by pressing 
Command-Shift-8. When the cursor changes to a crosshair, you can 
drag to select a portion of the screen, or click the mouse to save the 
entire screen. Director creates a special file in the System folder called 
“Anim Scrapbook” to store each image you capture.
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File menu

The File menu contains commands for creating Director movies, 
opening and saving movies, importing and exporting files, creating 
projectors, and printing. 

New 

The New command opens a new, untitled movie. Name the untitled 
movie by choosing Save from the File menu.

The color depth of a new movie is determined by the monitor’s color 
depth, as specified in the Monitors control panel. See “Changing 
color depth” in Chapter 1 for more information.

˛ Tip Command-N is the keyboard shortcut for this command.

Open...

The Open command opens an existing Director movie. When you 
choose Open, the directory dialog box appears with a list of movie 
names.

The dialog box only lists movies created by the Macintosh version of 
Director, or movies with a .DIR extension (such as a shared cast 
movie or movies created with the Windows version of Director).

Note If you open a movie created with a previous version of Director, Director 
converts the movie into a Director 4.0 format file when you save the movie. 
Director 4.0 movies cannot be saved as earlier movie format files.

˛ Tip Command-O is the keyboard shortcut for this command.
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Close Window

Closes the current window, but doesn’t close the stage.

˛ Tip Command-W is the keyboard shortcut for this command.

Save 

The Save command saves the current movie to your disk. When you 
choose Save, the current version replaces the previous version with 
the same name. The first time you save a new Director movie or a 
movie created by a previous version of Director, the Save As dialog 
box is displayed so you can name the movie. It’s a good practice to 
save often while you’re working.

The first time you save a movie created with a previous version of 
Director, Director:

◆ converts the movie into a Director 4.0 format file

◆ places the movie script in the cast

◆ converts text macro cast members to movie scripts, which appear 
in the cast window. The “macro” syntax is replaced with the 
“on” syntax.

(These changes make it easier to find and edit Lingo scripts, but they 
do not affect the movie’s behavior.)

In addition:

◆ Director converts any unlinked QuickTime movie cast members 
into linked cast members. 

For each unlinked QuickTime movie cast member, Director 
creates a QuickTime movie file in the same folder as the Director 
movie. The filename consists of the movie name, followed by the 
cast member name and number.

◆ Score scripts appear as cast members.
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◆ Only sounds stored as cast members are converted (Sound file 
sounds are not converted).

◆ Overview documents and movies created with Macromedia 
Accelerator are not converted.

Any movie you save in Director 4 file format is compatible with 
Director 4 for Windows.

˛ Tip To change the movie’s color depth, change the monitor’s color depth (using the 
Monitors control panel) before saving the movie. See “Changing color depth” 
in Chapter 1 for more information.

Command-S is the keyboard shortcut for this command.

Save and Compact

Lets you save a movie under its original name so that it is optimized 
for playback. Since this operation reorders the cast and compacts the 
file, it takes longer than using the Save command, especially if you are 
saving a very large file. However, this command produces smaller and 
more efficient movies.

Use Save and Compact instead of the Save command to:

◆ Reduce a movie to its minimum size

Save and Compact rewrites the file’s entire contents so that any 
wasted space that might have accumulated in the original file is 
eliminated. This command differs from the Save command 
because the Save command only saves the cast members or other 
elements that have actually changed since you last saved the 
movie.

◆ Gain optimum performance for playback on a CD-ROM drive 
or a slow hard disk.

If you are working with a large movie, using the Save command will 
be faster. For a large movie, you might want to use Save and 
Compact when you are done authoring.

˛ Tip Command-Option-S is the keyboard shortcut for this command.
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Save As... 

Use the Save As command to name and save a movie, save the movie 
under a different name, or to save it to a different disk. Type the new 
name of the movie in the text box to name it, or click the Drive 
button to save to a different drive.

˛ Tip To change the movie’s color depth, change the monitor’s color depth using the 
Monitors control panel before saving the movie. See “Changing color depth” 
in Chapter 1 for more information.

Command-Shift-S is the keyboard shortcut for this command.

Revert 

The Revert command opens the last saved version of the current 
movie. This command is dimmed if you have not made any changes 
or if you are working on a new untitled movie that you have not yet 
saved.

Import...

Use the Import command to import PICT files, MacPaint files, 
sounds, Scrapbook files, PICS files, Director movies, or QuickTime 
movies into the cast.

˛ Tip Command-J is the keyboard shortcut for this command.
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When you choose Import, Director opens the cast window and 
displays a dialog box so you can choose the file you want to import.

Import dialog box for a PICT file

The Create button is active for file types that can display a preview 
image. Click it to create a preview image of the selected file in the 
dialog box.

Choosing a file type from the Type pop-up menu only displays the 
files available in the chosen file format. When you select a file and 
click Import, the file is imported and appears in the first available cast 
position in the cast window. Clicking Import All causes all files of the 
selected type in the current folder to be imported into the cast. This 
button is dimmed for PICS and Scrapbook files.
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Linking to a file

When you import a PICT file, AIFF sound file, or a Director movie, 
you have the option of creating a link to the file in the cast rather 
than copying the contents of the file into your movie. This allows 
you to add a PICT, sound, or Director movie to the current movie 
without increasing the size of the movie. It also allows you to share 
the same linked file among several movies. If you change the linked 
file, the changes are automatically reflected in your movie. Director 
looks for any linked cast members when you open the movie. If it 
cannot find a linked file, a dialog box appears so you can locate the 
file.

Linking to a file also allows you to edit the file using the Launch 
External Editor command. 

Director always imports digital video movies by linking to the file.

Note Director cannot keep track of filenames with more than 255 characters. 
Occasionally, files that are nested too many folders away from the movie file 
will fail to link correctly. For this reason, it’s a good idea to keep linked files in 
a folder that’s close to the original movie file.

In previous versions of Director, each time you opened a movie, the cast 
window would recreate every thumbnail image. In Director 4.0, cast window 
thumbnails are only redrawn when you change the size of the thumbnails 
(using the Cast Window Options command) to a larger size. If you have 
linked to a file and edited the original file, it will not redraw the cast member 
unless you edited it using the Launch External Editor command.
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Importing cast members with palettes

If you import a cast member that uses a palette that is different from 
the currently active palette, Director asks you if you want to remap 
the cast member to the currently active palette, or import the cast 
member’s palette as a separate cast member.

The currently active palette is the palette currently in use as set in the 
score. Only one palette can be active at a time. The currently active 
palette may differ from the palette that the movie uses. See “Working 
with color palettes” in Chapter 3 for more information.

Importing the cast member’s palette ensures that the cast member 
looks as it did when it was originally created.

Remapping the colors causes the cast member to appear in the colors 
closest to the colors in the current palette.

Importing PICT files 

If you import a PICT file, Director converts it to a bitmapped cast 
member and adds it to the cast. (To create a PICT cast member, you 
must paste the image into the cast using the Paste as PICT command 
in the Cast menu.)
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The color depth of an imported PICT image depends upon the color 
depth of the monitor on which Director’s stage appears. For example, 
if the stage appears on a second monitor when you import the image, 
the second monitor’s color depth determines the image’s color depth. 
You set the monitor’s color depth using the Monitors control panel. 
For example, if you import a 24-bit PICT image, it will become a 
24-bit cast member only if the stage monitor is set to support millions 
of colors. If the stage monitor is set to 256 colors, the PICT will 
become an 8-bit cast member. Switching to millions of colors after 
you import the PICT image, or using the Transform Bitmap 
command will not change the cast member to a 24-bit image. See 
“Changing color depth” in Chapter 1 for more information.

Link to File 
If this box is checked, Director creates a link to the location of the 
PICT file on disk. This is useful if you want to add large (24–bit) 
images to your movie without increasing the movie’s size.

Note If you edit a linked PICT file, your changes are reflected in the file on disk 
when you save the movie. For example, if you import a 24-bit PICT file by 
linking to the file, and later change its color depth using the Transform Bitmap 
command, when you save the movie, Director alters the bit depth of the PICT 
file on disk.
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Importing MacPaint files

If you import a MacPaint file, Director adds it to the cast window. 

Importing sounds

Imported sounds are added to the cast. You can import SoundEdit 
files, AIFF files, AIFC files, and SND (8-bit) resources.

Import dialog box for sounds

◆ File

Displays sounds stored as Macintosh files.

◆ Resource

Displays sounds stored as resources in applications.

Link to File
If checked, lets you create a link to an AIFF format sound file on disk. 
(You must create a link to an AIFC format sound file.)

Note If you import a stereo sound, Sound Manager 3.0 or later must be installed in 
order for Director to play the left and right channels.
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Importing scrapbooks

If the Scrapbook file contains color graphics created with a palette 
that is not in the cast window, you will have the opportunity to 
import the palette with the Scrapbook file or remap the images in the 
Scrapbook file to the current palette. The sequence of images in an 
imported Scrapbook is added to the cast window and to the score 
window at the insertion point so you can immediately play the 
imported sequence.

Import dialog box for scrapbooks

◆ Original position

Causes the imported artwork to appear in the paint window in its 
original position relative to the other artwork in the series.

◆ Centered

Causes each piece of imported artwork to be centered relative to 
the rest of the artwork in the series when seen in the paint 
window.
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Range
If checked, you can selectively import up to 512 frames from a 
Scrapbook file. Each frame will be imported as a separate cast 
member.

If you select a single cell in the score, the imported frames will be 
added to the score beginning at the selected cell. Any existing score 
data will be replaced by the imported frames. If you set an insertion 
point, the imported frames are inserted in channel 1, beginning at the 
insertion point. If you select a range of cells, the imported frames that 
are inserted will occupy the number of cells in the selection. If you do 
not make a selection or set an insertion point, the imported frames are 
placed at the end of the movie in channel 1.

˛ Tip Sometimes when you import a Scrapbook file, the images jump when you play 
the movie. That’s because the registration points of the cast members aren’t set 
properly. For information about resetting registration points, see “Registration 
tool” in Chapter 5, “Window Reference.”
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Importing PICS files

If the PICS file contains color graphics created with a palette that is 
not in the cast window, you will have the opportunity to import the 
palette with the PICS file or to remap the PICS file to the current 
palette. The sequence of images in an imported PICS file is added to 
the cast window and to the score window so you can immediately 
play the imported sequence. Note that the PICS file is imported into 
the score window beginning at the currently selected frame, and 
overwrites the contents of the frames that follow. 

Import dialog box for PICS files

Contract White Space
If checked, allows you to import only the image, not the surrounding 
white space.

Range
If checked, you can selectively import up to 512 frames in a PICS 
file. If the PICS file was created using a previous version of Director, 
you must enter the number “1” as the starting frame to import. Each 
frame will be imported as a separate cast member.
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˛ Tip Sometimes when you import a PICS file, the images jump when you play the 
movie. That’s because the registration points of the cast members aren’t set 
properly. For information about resetting registration points, see “Registration 
tool” in Chapter 5, “Window Reference.”

Importing Director movies

Importing a Director movie converts the movie into a film loop, 
which Director adds to the cast window. Director imports all the 
movie’s cast members, adds them to the cast window, and updates 
any references to them to reflect their new positions in the cast 
window. Director doesn’t import the movie’s resources, tempos, 
transitions, or markers. Although it imports any scripts that are part of 
the movie, the movie’s score scripts are no longer active. (That’s 
because a score script can’t be made part of a film loop.) If you want 
the movie’s scripts to remain active, link the movie rather than 
importing it.

Link to File
Lets you create a link to a Director movie. Linking doesn’t convert 
the movie into a film loop, nor does it add the movie’s cast members 
to the cast window. Instead, it adds a single cast member—a linked 
movie cast member—to the cast window. One advantage in linking 
to a movie rather than importing it is that a linked movie doesn’t 
increase the file size of the current movie. Another important 
advantage is that any scripts that are part of the linked movie remain 
functional. (To activate the scripts, select Enable Scripts in the linked 
movie’s Cast Member Info dialog box.) Unlike scripts, however, 
tempo settings, palette settings, and transitions that are in a movie 
aren’t functional when the movie is linked. (For a comparison of film 
loops, QuickTime movies, linked Director movies, and movies in a 
window, see “Movies within Director movies” in Chapter 2, 
“Creating Animations.”)

Note You cannot link to a movie created with a previous version of Director. To 
link to the movie, first update it to Director 4.0’s file format using the Update 
Movies command in the File menu.
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Importing digital video movies

Importing a QuickTime movie automatically links the file to the 
current movie and adds it to the cast window.

When you import a QuickTime movie, Director creates a link to the 
digital video movie. Any changes you make to the digital video 
movie inside Director or with a digital video editor outside Director 
are reflected in the linked file.

Note The imported digital video movie’s contents do not become part of the Director 
movie. If you make a copy of the Director movie, be sure to include all digital 
video movies that are part of the movie.
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Export...

Exports frames of Director movies from Director to the Finder so 
you can record frames to videotape, save images as stills, or create 
digital video movies. You can choose to export frames of movies as 
Scrapbook files, PICS files, PICT files, or QuickTime movies.

˛ Tip Command-Shift-E is the keyboard shortcut for this command.

Range of Frames

These options determine which frames to export:

◆ Current Frame

Exports just the current frame on the stage. This is the default.

◆ Selected Frames

Exports the selected frames in the score window.
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◆ All

Exports all frames.

◆ From: To:

Exports only the range of frames that begin and end with the 
frame numbers you enter in the From: and To: boxes.

Within Range of Frames 

Further modifies your selection specified in the range of frames. 

◆ Every Frame

Exports all frames in the selected range.

◆ Every Nth Frame

Exports only the frames at the interval you specify in the “N=” 
box.

◆ Frames With Markers

Exports frames with markers set in the score window.

◆ When Artwork Changes in Channel.

Exports frames only when a cast member changes in the channel 
you specify in the box.

Destination

File Type
Choose the exported file format from the Type pop-up menu. File 
formats you can export are PICT, Scrapbook, PICS, and 
QuickTime.

QuickTime Options
This button is dimmed unless you choose QuickTime from the Type 
pop-up menu. For a description of the options, see “Exporting 
QuickTime movies,” later in this section.
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Frame-Differenced PICS

This option is dimmed unless you choose PICS from the Type 
pop-up menu.

If checked (the default), PICS images are exported as 
frame-differenced images, in which each frame after the first frame 
contains only the pixels which have changed from the previous 
frame. This results in a much smaller file, but the file can only be used 
by an application such as Director that can access the information in 
that format. If not checked, this option lets you export full frame 
PICS images in which each frame is a complete image. This lets you 
export PICS images that can be used by the ImageWorks module in 
Macromedia Three-D, or later be selectively imported back into 
Director.

Export
When you click Export, a directory dialog box appears, allowing you 
to name the file. If you are saving in PICS or Scrapbook format, only 
one file will be created. If you are saving in PICT format, Director 
automatically creates one file for each frame, attaching the 
corresponding frame number to each file. For example, if the name of 
the exported file is “Myfile”, Frame 1 will be exported to a file 
named “Myfile0001”.

Exporting Scrapbooks

If you press the Option key while clicking Export, each cast member 
in a given frame is stored as a separate PICT if you choose the 
scrapbook file type from the Type pop-up menu. Otherwise, the cast 
members in each frame are merged into a single PICT image. 
Exporting cast members as separate PICTs allows you to reposition 
and resize them individually in other drawing programs.

To view the scrapbook file using the Scrapbook, you must name it 
“Scrapbook File” and save it in the System Folder. 

Note To avoid overwriting your existing Scrapbook file, move it out of the System 
folder before exporting a scrapbook file using Director. Alternatively, you can 
use a utility like Now Utilities’ Now Scrapbook to manage mutiple scrapbook 
files.
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Exporting QuickTime movies

To export your Director movie as a QuickTime movie, choose 
QuickTime from the pop-up menu.

See “Exporting a Director movie as a QuickTime movie” in Chapter 
2 for more information.

The QuickTime Options button in the Export dialog box opens the 
QuickTime Export Options dialog box. This dialog box has controls 
for determining the tempo, compression method, quality, color 
depth, size, and audio channels of the QuickTime movie you export.

Frame Rate

◆ Tempo Settings

If you click Tempo Settings, the QuickTime movie uses the 
tempo settings specified in the tempo channel of your Director 
movie’s score. This setting lets you create a QuickTime movie at 
24 or 30 frames per second, even though Director can’t play the 
movie at that speed.
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The size of an exported QuickTime movie is influenced by the 
tempo settings, transitions, and palette transitions in the Director 
movie. Fast tempos, certain transitions, and palette transitions all 
increase the size of the QuickTime movie. The tempo settings 
determine the number of QuickTime frames per second and the 
number of frames per transition. The faster the tempo, the more 
frames per second.

A movie that would work well with this setting is one in which 
the tempo settings have been carefully timed. For instance, some 
frames could be set to a tempo of ten per second and their 
QuickTime frame durations would be exactly one tenth of a 
second; other frames later in the movie could be set to a tempo of 
one frame per second. When the movie is exported, these slower 
frames would each last precisely one second in the QuickTime 
movie.

A movie that would not work well with this setting is one in 
which the tempo is set to 60 throughout but Director typically 
only plays at 5 frames per second because the frames are very 
complex. The movie’s frames would have extremely short 
durations and would play back much too fast (possibly skipping 
many frames).  

◆ Real Time

Lets you export a QuickTime movie that matches the 
performance of the Director movie. (You should always play the 
entire movie with Lingo disabled before using this feature.)

When exporting a movie with Real Time selected, each Director 
frame becomes a QuickTime frame. Each frame in the 
QuickTime movie will match the duration of the same frame in 
the Director movie.

Director will generate as many frames as required to duplicate 
each transition, up to 30 frames per second. To reduce the 
number of frames created for any transition, reduce the chunk 
size of the transition.

This option causes Director to use the actual durations that were 
stored the last time you played the entire movie, regardless of the 
actual tempo settings of the movie.
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Compressor
Compressors reduce the file size of a QuickTime movie at the 
expense of quality:

◆ Use the Animation compressor for simple animations. 

◆ Use the Graphics compressor for exporting single frames of 
computer graphics. 

◆ Use None to export a movie with no compression. 

◆ Use the Photo-JPEG compressor with scanned or digitized 
continuous-tone still images. 

◆ Use the Video compressor when exporting video clips.

Quality
The quality setting you choose determines the compression quality 
and resulting file size when using the chosen compressor. A higher 
quality setting preserves the appearance of the images and motion but 
increases the size of the file. A lower quality setting results in poorer 
image quality but decreases the size of the file.

Colors
Color depth is a measure of the number of colors that artwork can 
display. Artwork with a color depth of one bit can have only two 
colors. Artwork with a color depth of 8 bits can have up to 256 
colors. The compression method you choose determines the range of 
color depth options available to you in this pop-up menu. 

QuickTime is optimized to play movies on a 16-bit monitor 
(thousands of colors). If you have an 8-bit monitor, you can still 
export the movie at a 16-bit depth. The movie will have a 16-bit 
palette with only 256 colors. See “Changing color depth” in Chapter 
1 for more information.

Scale
There are two ways to scale the exported QuickTime movie. You 
can choose a percentage from the Scale pop-up menu, or you can 
type pixel dimensions in the fields. By entering the number of pixels, 
it is possible to stretch a movie so that it plays in a rectangle that does 
not adhere to the original aspect ratio.
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Sound Channel
The Sound Channel checkboxes allow you to choose which sound 
tracks are exported with your movie. A checked box indicates that 
the associated sound channel in the score window is exported with 
your QuickTime file.

External sounds (sounds you imported as linked cast members) don’t 
get exported when you export a digital video movie. To include 
sound when you export a digital video movie, you must import the 
sounds as cast members instead of linking to them.

Looped sounds don’t loop in a movie that you have exported as a 
digital video movie. To loop a sound in a movie that you plan to 
export as a digital video movie, you must trigger the sound by 
alternating it between the two sound channels.

Converting Director animations into QuickTime movies

You can export a Director animation as a QuickTime movie, and 
then import it into Director so that it becomes a single cast member. 
You might want to do this for the following reasons:

◆ Since an imported digital video movie is linked to its source file 
on disk, you can edit the digital video movie in another 
application, and your changes will be automatically reflected in 
the digital video movie inside Director.

◆ Director provides precise control over the digital video movie’s 
playback, using the Digital Video Cast Member Info dialog box.

◆ Other users can use and distribute the QuickTime movie for use 
in any application that supports QuickTime.

You might not want to convert a Director animation into a digital 
video movie if the animation includes interactivity. (Digital video 
movies do not allow interactivity.)

See “Movies within Director movies” in Chapter 2 for more 
information.

˛ Tip If you lose your transitions when you export a Director movie as a digital 
video movie, try increasing the Duration and Chunk Size settings for the 
transitions before you export the movie.
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Update Movies...

Converts a movie or a folder of movies created by a previous version 
of Director into Director 4.0’s file format.

You can also use this command to protect a movie, to prevent others 
from editing it, or to save a movie in optimized format.

Using this command is the same as opening a movie created with a 
previous version of Director and saving it.

Select a movie to update and click Update. To update all the movies 
in the folder, click the Folder button at the bottom of the dialog box. 
Director then displays another dialog box so you can enter a name for 
the updated movie or folder. 

Note Director prevents you from overwriting your existing movie or folder with the 
updated movie or folder.
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When you update a movie, Director:

◆ Converts the movie into a Director 4.0 format file

◆ Places the movie script in the cast

◆ Converts text macro cast members to movie scripts, which appear 
in the cast window. The “macro” syntax is replaced with the 
“on” syntax.

(These changes make it easier to find and edit Lingo scripts, but they 
do not affect the movie’s behavior.)

In addition:

◆ Director converts any unlinked QuickTime movie cast members 
into linked cast members. 

For each unlinked QuickTime movie cast member, Director 
creates a QuickTime movie file in the same folder as the Director 
movie. The filename consists of the movie name, followed by the 
cast member name and number.

◆ Score scripts appear as cast members.

◆ Only sounds stored as cast members are converted (Sound file 
sounds are not converted).

◆ Overview documents and movies created with Macromedia 
Accelerator are not converted.

Protect Movies
If checked, Director removes Lingo source code and cast thumbnail 
images when you update a movie. This prevents the movie from 
being edited, but does not affect the movie’s scripts. A protected 
movie’s icon looks like this:

Protected movies cannot be opened in Director. They can only be 
played from a projector. To play a protected movie from a projector, 
you must use Lingo to “go to” or “play” the protected movie.
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Adjust Pre-4.0 Shared Cast References
If checked, Director opens a dialog box allowing you to shift 
references in the score to shared cast members. This prevents 
converted script cast members from being overwritten by shared cast 
references. This feature is only available for older Director movies.

Create Projector...

Lets you create a play-only version of a Director movie, called a 
projector, that can be played on any Macintosh. 

A projector’s icon looks like this:

To play a projector file, double-click it. See “Creating a projector” in 
Chapter 3 for additional information.

If a movie is open when you choose this command, Director closes 
the current movie (after asking you if you want to save your changes).

Use this dialog box to add one or more movies from the Source 
Folder to the projector’s play list. 
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Note Movies created with previous versions of Director are not listed in the dialog 
box. To include movies that were created with a previous version of Director, 
you must first open the movies in the current version of Director and save 
them, or use the Update Movies command to convert them.

Clicking Add adds the selected source movie to the projector’s play 
list. Clicking Add All adds all movies in the current folder to the play 
list. Clicking Remove removes a selected movie from the projector’s 
play list.

Click Move Up to move a selected movie higher up in the play list. 
Click Move Down to move a selected movie further down in the 
play list.

You can include more than one interactive movie in the projector 
file list. You can also use Lingo to “go to” or “play” files while 
running a projector under Lingo control.

Click Create to create the projector file. Click Done to dismiss the 
dialog box.

Note If your movies include links to external files, you must include the files when 
you distribute the projector.
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Projector Options

The Options button displays a dialog box that specifies additional 
preferences for creating the projector. These settings override the 
movie preferences you set using the Preferences command in the File 
menu.

These settings apply to all movies in the projector. 

Play Every Movie
If checked, the projector plays all movies in the the play list. 
Otherwise, the projector only plays the first movie in the play list 
unless other movies are called by Lingo from the first movie.

Animate in Background
If checked, if a user clicks outside the movie, on the desktop, for 
example, the movie continues playing. This is useful if you are using 
Apple Events. If not checked, the movie stops playing if the user 
clicks outside the movie.

Resize Stage
If checked, the stage size changes when you open a movie that uses a 
stage size that is different from the current stage size. If not checked, 
the stage size remains unchanged.
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Switch Monitor’s Color Depth to Match Movie’s
If checked, Director automatically changes the color depth of your 
monitor to the color depth of each movie in the projector play list. 
For example, if you are working on a color monitor set to 256 colors, 
and a movie in the play list was created in 16 colors, the monitor will 
automatically switch to 16 colors. 

Center Stage on Screen 
If checked, the stage is centered on the screen, which is useful if the 
stage size is smaller than the screen size. Otherwise, the movie plays 
using its original stage position.

Movie Info...

The Movie Info command lets you choose basic settings for the 
current movie.

˛ Tip Command-U is the keyboard shortcut for this command.
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User Info

Specifies the creator and modifier, as entered during installation of the 
Director application.

Settings

Anti-Alias Text and Graphics
Anti-aliasing removes or reduces edge distortions in an image by 
adding and subtracting pixels to enhance the appearance of the image. 
If this box is checked, Director uses anti-aliasing during playback. 
Anti-aliasing will be enabled for any text and bitmap graphic cast 
members on the stage to which you have applied an anti-alias 
modifier using the Anti-alias pop-up menu in the score window. This 
box is checked by default. If this box is not checked, anti-aliasing is 
disabled during playback for any cast members which had an anti-alias 
modifier set. Disabling anti-aliasing during playback can improve 
playback speed. 

Remap Palettes When Needed 
This option only affects the appearance of cast members on the stage. 
If this box is checked, whenever the cast member is displayed on the 
stage and the currently active palette (the palette in effect in a given 
frame of the movie) is different from the palette associated with the 
cast member, Director automatically creates a common palette and 
remaps all images on the stage that have a different palette to the 
common palette. The cast members themselves are not modified. The 
common palette determines how the cast member is remapped. For 
example, if a cast member uses a grayscale palette, it will be drawn on 
the stage using whatever grays are available in the common palette.

Allow Outdated Lingo
Lets you include Lingo commands used by previous versions of 
Director, including references to octal cast members (i.e., A11). This 
option is dimmed unless the movie was created with an earlier 
version of Director.
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Load Cast 
Provides a pop-up menu that lists the options available for 
pre-loading cast members into memory.

◆ When Needed

Load cast members only when they are required and are not 
currently available in memory. Best for interactive movies. Don’t 
use this option for movies that require high-speed animation.

◆ After Frame One

Display the first frame of animation and start playing any sounds 
in the first frame of the sound channels before loading the rest of 
the movie into memory. Best for large movies where you want 
to display an opening screen or play some initial sound while 
waiting for the rest of the movie to get loaded into memory. This 
is the default.

◆ Before Frame One

Load the entire movie into memory before playing the first frame 
of the movie. Best for small movies.

A new movie inherits the Load Cast setting from the movie that was 
previously open, as specified using the Movie Info command.

Default Palette
Lets you specify the movie’s default palette. Director uses the default 
palette until it encounters a different palette setting in the palette 
channel.

Font Mapping Table

Director uses a font map table to determine the appropriate substitute 
Macintosh fonts for text cast members created by Director for 
Windows. The font map table specifies how Director maps fonts 
between the Macintosh and Windows platforms. The font map table 
consists of a text file that contains the font mapping information.

See “Mapping Macintosh fonts to Windows fonts” in Tips & Tricks 
for more information about creating and using a font mapping table.
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Load from File
Click Load from File to have Director load the font mapping 
assignments specified in the chosen font map file.

Save to File
Click Save to File to save the current font map settings in a text file. 
You can then edit this file to include the names of appropriate 
substitute Windows fonts. (This button is dimmed unless the movie 
has a font map associated with it.)

Preferences...

The Preferences command allows you to modify some of Director’s 
default settings.

Director stores the following window settings in the Director 4.0 
Preferences file: cast window options and window positions. Other 
preferences are saved with, and are specific to, your current movie.

˛ Tip Command-Option-U is the keyboard shortcut for this command.
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Stage size
These settings permit you to change the size of the stage window. 
Changing the stage size is useful if you want to display movies on a 
smaller or larger stage, or if you want to change the stage size to 
match the size of a digital video movie.

You can change the size of the stage by choosing a setting from the 
pop-up menu, or by entering the width and height of the stage.

If you choose a setting from the pop-up menu, the values in the 
Width and Height fields automatically update.

Note If you enter a value for Width or Height that is not divisible by 16, Director 
uses the nearest smaller number that is divisible by 16.

Menu selection Example Stage size (pixels)

9-inch monitor Compact Macintosh 512 x 342

12-inch monitor Macintosh LC 512 x 384

13-inch monitor Macintosh II 640 x 480

15-inch monitor Portrait monitor 640 x 870

QuickTime QuickTime movie 160 x 120

Current monitor 13-inch monitor 640 x 480

Multiple monitor two 13-inch monitors 1280 x 480

Custom 15-inch portrait monitor 640 x 870

Screen 2 19-inch monitor 1152 x 882
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Stage Location
Stage Location permits you to change the location of the stage. 

◆ Centered

Places the stage window in the center of your monitor. This 
option is useful if you play a movie that was created for a 12-inch 
screen on a larger screen. You can also use this option if you are 
creating a movie on a larger screen that will be seen on smaller 
screens. 

◆ Left, Top

Alternatively, the values you type in the Left and Top boxes 
represent the number of pixels the stage is moved from the top 
left corner of the screen. These values only apply if the stage is 
smaller than the current monitor’s screen size.

When Opening a Movie

◆ Use Movie’s Size/Location 

If you open a movie that has a stage that is a different size than 
the current stage, the stage size changes to the movie’s stage size 
and location.

◆ Always Center

If you choose this option, the stage is centered on the screen 
when the movie opens.

◆ Don’t Change Size/Location

If you choose this option, your stage size and location remain the 
same as the current movie.

◆ Switch Monitor’s Color Depth to Match Movie’s

If checked, Director automatically changes the color depth of 
your monitor to the color depth of the movie you open. For 
example, if you are working on a color monitor set to 256 colors, 
and you open a movie created in 16 colors, the monitor will 
automatically switch to 16 colors. A movie’s color depth is 
determined by the color depth of the monitor when the movie 
was saved.
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Save Settings

◆ When Quitting 

If chosen, Director saves the settings in the Preferences dialog 
box every time you quit.

◆ Now

If checked, Director saves the settings when you click OK to 
leave the Preferences dialog box.

Black and White User Interface
If checked, Director switches to a black and white user interface. 
Using a black and white user interface improves performance if you 
switch color palettes, since Director doesn’t have to update its color 
user interface to match the colors in the new palette each time you 
switch palettes. In addition, working with a black and white user 
interface may be less distracting as you work with the color palettes in 
your movie. For example, if you are working on an animation that 
uses multiple palettes and/or color cycling, using a black and white 
user interface may be less distracting. 

If not checked, Director uses a color user interface. If you switch to a 
non-system color palette in your movie, Director switches the colors 
it uses in its user interface to match the palette in use. 

Dialogs Appear at Mouse Position 
If checked, dialog boxes are displayed at the mouse position. If this 
option is not checked, dialog boxes are centered on the monitor that 
contains the menu bar.

Animate in Background 
If checked, your animation runs in the background while you are 
working with other applications in the Finder. When you are 
running animation in the background, the stage remains on the 
screen and the active application window appears in front of the 
stage. 

Using Message Window Recompiles Scripts
Checked by default. If deselected, scripts should be manually 
recompiled using the Recompile All Scripts command before 
entering Lingo in the message window.
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Page Setup... 

The Page Setup command offers options for determining how a page 
is to be printed. The dialog box that you see depends on the type of 
printer you use. For more information about Page Setup options see 
your printer manual.

Print... 

The Print command lets you print your movie in a variety of ways.

˛ Tip Command-Option-P is the keyboard shortcut for this command.
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Print
Lets you choose what part of your movie you want to print. You can 
print an image of the stage, the score, the cast member number and 
contents of text cast members in the cast window, all scripts or a 
range of scripts (movie, cast, score, and sprite scripts), the comments 
in the markers window, the cast window artwork, or all of the cast 
window.

If a script window is front-most when you choose the Print 
command, the dialog box displays the cast member ID of the current 
script cast member in the From: and To: boxes, so you can print just 
the current cast member’s script.

When you use the Print command, cast members in each frame are 
merged into a single PICT image. If you press the Option key while 
clicking the Print button, each cast member in a given frame is 
imaged as a separate PICT. If you are printing multiple frames on a 
page, printing with this option causes QuickDraw elements (text, 
rectangles, lines, and circles) to print better. Note, however, that 
printing with this option may take much longer.

If you’re printing the stage, the Options button lets you specify 
additional printing options.

Print Range
Controls which frames of your movie are printed. 

◆ Current Frame

Prints the frame that is currently on the stage. 

◆ Selected Frames

Prints the frames that are selected in the score window. 

◆ All

Prints all the frames in your movie. 

◆ From: To:

Prints a range of frames that you specify. 

◆ Within Range of Frames

Refines your selection within the range specified in Range of 
Frames. 
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◆ Every Frame

This is the default and does not modify the choice in Range of 
Frames. 

◆ Every Nth Frame

Prints frames at the interval you specify in the box. For example, 
if you type 10, Director prints every tenth frame. 

◆ Frames with Markers

Prints only the frames that have markers in the score window. 

◆ When Artwork Changes in Channel

Prints the frames in which cast members move or in which new 
cast members are introduced in the score, in the channel you 
specify in the box.

Stage Options

Displays a dialog box that lets you adjust the layout of the items you 
choose to print. The image at the left of the dialog box previews the 
layout options.
Menu Reference 387



Image Size
You can print your document at full size, or scale the images to 1/2 
or 1/4 size, which is convenient for printing the images in storyboard 
format.

Frame Printing Options
Allows you to print a border around each frame, include the frame 
number, print registration marks, or print in storyboard format and 
include the comments associated with each frame. Storyboard format 
is only available if you are printing 1/2- or 1/4-size images.

Print File Name and Date in Header
If checked, prints a header on each page. The header consists of the 
name of the Director movie and the current date. 

Print Page Footer
If checked, lets you print a footer on each page. Type the footer in 
the field. 

Quit 

The Quit command quits Director.

The Clipboard is saved when you quit, and its contents are available 
for use in another application.

˛ Tip Command-Q is the keyboard shortcut for this command.
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Edit menu

The Edit menu contains standard commands for editing. It also 
includes control panel commands.

A note of caution about Cut, Copy, Clear, and Paste

The Cut, Copy, Clear, and Paste commands operate only on the 
currently active window. To use these commands effectively, you 
must be aware of which window is active, or you may accidentally 
cut a cast member from the cast when you were actually trying to cut 
frames from the score. 

To avoid unintended results, observe this rule: before using Cut, 
Copy, Paste, or Clear, make sure the window you want to work in is 
active.

When you choose one of the commands from the Edit menu, the 
menu changes to indicate the active window. Cut, for example, is 
displayed as Cut Score, Cut Bitmap, Cut Text, or Cut Cast, 
depending on which window is active. 

Note You cannot use Cut, Copy, or Paste directly on the stage. To cut, copy or 
paste cast members from the stage, you must cut, copy, or paste in the score 
rather than directly on the stage. You can clear selected cast members from the 
stage with the Delete Sprites command in the Score menu. 

Undo 

Undo reverses your last action. Since it works only on your last 
action, you must use it before making any other change to the 
animation. Undo works with most commands you use while writing, 
drawing, and animating.

˛ Tip Command-Z is the keyboard shortcut for this command.
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Cut 

The Cut command removes the selected object from its current 
location and places it on the Clipboard. It can then be pasted to 
another location. 

˛ Tip Command-X is the keyboard shortcut for this command.

Copy 

The Copy command makes a copy of the selected colors, text, art, or 
sequence of art and places that copy on the Clipboard.

˛ Tip Command-C is the keyboard shortcut for this command.

Paste 

The Paste command pastes the contents of the Clipboard into a 
selected location. 

Note If you paste a PICT image into the cast using the Paste command, Director 
converts it to a bitmap. If you want the artwork to remain in PICT format 
when you paste it into the cast, use the Paste as PICT command in the Cast 
menu. 

˛ Tip Command-V is the keyboard shortcut for this command.
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Clear

Clear removes the selected item or sequence of items, without saving 
it to the Clipboard. Clear is used when you have no further use for a 
particular piece or sequence of art or text and when you do not want 
to affect what is already in the Clipboard. 

˛ Tip Delete is the keyboard shortcut for this command.

Select All

Select All highlights all the selectable items in the active window.

To create a new animation with the same cast members, choose 
Select All in the score window, and then choose Clear. This clears all 
the score window notation while preserving the cast members. Your 
animation is erased, but the cast window is unchanged.

˛ Tip Command-A is the keyboard shortcut for this command.

Play

The Play command starts the movie. If you press the Shift key while 
choosing Play, the menu bar is hidden and the stage is cleared of all 
open windows as the movie plays.

˛ Tip Command-P or Enter is the keyboard shortcut for this command. The keypad 
plus (+) key toggles between Play and Stop.

Clicking the Play
button in the control

panel also plays
the movie
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Stop

The Stop command halts the movie.

˛ Tip Command-period (.) stops the movie.

Rewind

Rewind moves the playback head back to frame 1. If the movie is 
playing, it also stops.

˛ Tip Command-R or keypad 0 rewinds the movie.

Step Backward

Step Backward steps the movie backward one frame at a time.

˛ Tip Command-left arrow or keypad 1 steps the movie backward.

Clicking the Stop
button in the control

panel also stops
the movie

Clicking the Rewind
 button in the control

panel also rewinds
the movie

Clicking the Step
Backward button in the
control panel also steps

the movie backward
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Step Forward

The Step Forward command advances the movie forward one frame. 
When using the step recording technique it can be used to record cast 
members to the next frame of animation.

˛ Tip Command-right arrow or keypad 3 steps the movie forward.

Disable Sounds

If checked, turns your movie’s sound off. By default, this option is 
off.

˛ Tip Command-~ or keypad 7 disables sounds.

Clicking the Step
Forward button in the

control panel also steps
the movie forward

Clicking the Disable
Sounds button in the

control panel also
disables sounds
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Loop

If checked, causes the movie to repeat continuously when played. 
When the movie reaches the last frame, it automatically starts again 
from frame 1. By default, this option is on.

˛ Tip Command-L or keypad 8 turns looping on or off.

Selected Frames Only

If checked, lets you play a selected portion of a movie. This is 
convenient if you are working on just one part of a movie. 

To play a portion of a movie, open the score and select the frames to 
be played. Choose Selected Frames Only and play the movie.

When a portion of the score has been marked as selected frames, a 
green bar appears at the top of the score over the selected frames.

Turn off Selected Frames Only when you want to return to normal 
play mode.

This command is dimmed if no frames are selected in the score.

˛ Tip Command-\ turns Selected Frames Only on or off.

Clicking the Loop
button in the control

 panel also causes the
movie to loop

Clicking the Selected
Frames Only button
in the control panel

marks selected frames
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Disable Lingo

This command lets you ignore scripts during playback. If this 
command is not selected, Director executes all scripts during 
playback. This is the default. If this command is selected, Director 
ignores all scripts in the movie during playback.

This command is useful whenever you want to control whether 
interactivity is on or off during playback.

Lock Frame Durations

When a movie’s playback rate is locked, Director plays the movie 
using previously recorded frame durations. For frames without 
recorded durations, Director uses the current tempo. If checked, this 
command allows you to lock the movie’s playback speed so that it 
will play back at the same speed on all types of computers. 

Choosing this command is the same as clicking the Lock button in 
the control panel to lock frame durations.

To unlock the playback rate, remove the check from this command, 
click the Lock button in the control panel, or make an editing change 
to your movie, such as adjusting the tempo, or adding or deleting a 
frame in your movie. Unlocking the playback rate lets you record 
frame durations as you play the movie.

See “Locking playback speed” in Chapter 3 for more information.

Note Locked movies will not play faster when played on a faster Macintosh, but 
may still play slower if played on a slower Macintosh.

Lock button
(unlocked state)
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˛ Tip You might want to clear all recorded frame durations from the movie if you 
want to only record frame durations for a section of the movie and lock them. 
To clear all recorded frame durations, press Option while choosing this 
command or while clicking the Lock button. During playback, frames that 
don’t have a recorded duration instead display “--” .
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Window menu

The commands in this menu open and close Director’s authoring 
windows. Open windows have checkmarks next to their names in 
the menu and the currently active window’s name is underlined.

The bottom of the Window menu lists all open text, script, and 
digital video windows, sorted by category, and sub-sorted by cast 
member number. Choosing a window opens it and brings it to the 
front. If the window is open, but not in front, choosing it from the 
Window menu brings it to the front. If the window is already in 
front, Director hides it. 

Director automatically hides any open windows if you choose the 
Stage command from the Window menu.

For a complete description of each command on this menu, see 
Chapter 5, “Window Reference.”

Stage

The stage is the backdrop against which all Director animations 
appear.

See “The stage” in Chapter 5 for more information.

˛ Tip Command-1 is the keyboard shortcut for this command.

Control Panel

Use the control panel to play, stop, step forward or backward, or 
rewind a movie, using controls similar to a video cassette recorder.

See “The control panel” in Chapter 5 for more information.

˛ Tip Command-2 is the keyboard shortcut for this command.
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Cast

The cast window stores a movie’s cast members, including graphics, 
sounds, palettes, scripts, digitial video movies, Director movies, film 
loops, and text.

See “The cast window” in Chapter 5 for more information.

˛ Tip Command-3 is the keyboard shortcut for this command.

Score

The score window contains notation that describes everything that 
occurs on the stage. It is the primary window for creating and editing 
animation.

See “The score” in Chapter 5 for more information.

˛ Tip Command-4 is the keyboard shortcut for this command.

Paint

The paint window provides a complete set of drawing tools for 
creating graphic cast members. The paint window is linked to the cast 
window, so anything you draw in the paint window automatically 
gets added to the cast window.

See “The paint window” in Chapter 5 for more information.

˛ Tip Command-5 is the keyboard shortcut for this command.
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Text

Use a text window to create or edit text cast members. Buttons 
created with the tools window can be edited in a text window.

See “The text window” in Chapter 5 for more information.

˛ Tip Command-6 is the keyboard shortcut for this command.

Tools

Use the tools window to create QuickDraw text and shapes directly 
on the stage. QuickDraw text and shapes use less memory than 
bitmap text and graphics created in the paint window, and also print 
without the jagged lines associated with bitmapped images.

See “The tools window” in Chapter 5 for more information.

˛ Tip Command-7 is the keyboard shortcut for this command.

Color Palettes

The color palettes window lets you choose or edit a palette that can 
be assigned to sprites, cast members, frames, or the movie itself.

See “The color palettes window” in Chapter 5 for more information.

˛ Tip Command-8 is the keyboard shortcut for this command.
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Digital Video

The digital video window displays a QuickTime movie cast member.

Note On a Macintosh, Director’s digital video window only displays QuickTime 
movies. On a PC running Windows, the digital video window supports 
Microsoft Video for Windows (.AVI) in addition to QuickTime for 
Windows.

See “The digital video window” in Chapter 5 for more information.

˛ Tip Command-9 is the keyboard shortcut for this command.

Script

Use the script window to enter and edit the script associated with one 
or more selected cells in the script channel. The script window also 
displays the script associated with a cast member, if the cast member 
has a script attached.

See “The script window” in Chapter 5 for more information.

˛ Tip Command-0 is the keyboard shortcut for this command.

Message

The message window lets you enter and test Lingo scripts. Actions 
execute as soon as you press Return, so you can immediately see the 
results before you insert the script into a movie.

See “The message window” in Chapter 5 for more information.

˛ Tip Command-M is the keyboard shortcut for this command.
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Tweak

The tweak window lets you move a selected sprite in any direction 
by a specific number of pixels.

See “The tweak window” in Chapter 5 for more information.

˛ Tip Command-Shift-T is the keyboard shortcut for this command.

Markers

The markers window lets you write comments for markers you set in 
the score.

See “The markers window” in Chapter 5 for more information.

˛ Tip Command-Shift-M is the keyboard shortcut for this command.

Duplicate Window

This command duplicates the front-most window and its contents, 
creating another view of it. This command only works if a text, 
digital video, or script window is the front-most window.

˛ Tip Pressing Option while choosing a text, digital video, or script window from the 
Window menu is a keyboard shortcut for choosing this command.

Duplicating a window is useful if the window’s contents are large and 
you want to look at or edit different sections of the window 
simultaneously. Changes you make in the window are automatically 
reflected in all other views of the same window.
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Cast menu

The Cast menu contains commands for managing cast members.

Cast Member Info...

Cast Member Info displays a dialog box containing information about 
the selected cast member: its name, cast position, its type, and its size 
in kilobytes. The Cast Member Info dialog box also displays 
additional information and options for each cast member type. Use 
the options in the dialog box to define the behavior and appearance 
of the selected cast members.

In the cast window, select a cast member and click the Info button as 
a shortcut for choosing this command.

If you are editing the cast member in the paint, text, digital video, or 
script window, you can click the window’s Info button as a shortcut 
for choosing this command.

˛ Tip Pressing Command-I or pressing the Control key and clicking a cast member 
in the cast or on the stage is a shortcut for opening the Cast Member Info 
dialog box.

Using the Cast Member Info dialog box is particularly useful when 
switching back and forth between creating new color cast members 
and editing old color cast members. You can reset the palettes of each 
cast member manually to avoid the confusion of working with 
multiple palettes.

Info button
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Note Cast member info appears in the following sections in alphabetical order, by 
cast member type.

Bitmap Cast Member Info

Cast Member
Enter or edit the name in the field. The name remains attached to the 
cast member if it is cut or copied and pasted. Director does not 
prevent you from creating duplicate cast member names, but you 
should avoid using them. If more than one cast member with the 
same name has a script attached to it, Lingo uses the script attached to 
the cast member with the lowest cast number. Use cast names instead 
of cast numbers to address cast members in a Lingo script, so that you 
don’t have to update your scripts if your cast members get 
re-numbered or sorted.

Palette
Lets you temporarily assign a different palette to the cast member, 
while maintaining the cast member’s original palette. You can change 
the palette assignment at any time by choosing another palette from 
the pop-up menu.
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Purge Priority
Controls how Director removes the bitmap cast member from 
memory if memory is low.

Note If you set many cast members to have a purge priority of Last or Never, your 
movie may run out of memory.

Colors
Displays the color depth of the cast member.

Size
Displays the size of the cast member, in Kilobytes.

File Name
If a cast member is an external PICT file that is linked to its source 
file on disk, Director displays the location of the linked file. Clicking 
the file name lets you choose a different file to link to.

Auto Hilite
For cast members that you use as buttons, use the Auto Hilite option 
to have the cast member automatically highlight when the user clicks 
it using the mouse. Even if Auto Hilite is checked, the cast member is 
not affected by clicking the mouse unless it is controlled by a Lingo 
script. 

Purge
priority

Description

3-Normal The selected cast member will be removed from 
memory as necessary. This is the default.

2-Next The selected cast member will be among the next to 
be removed from memory.

1-Last The selected cast member will be among the last to 
be removed from memory.

0-Never The selected cast member remains in memory and is 
never purged.
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Script...
Director opens a script window for the cast member, and displays the 
Lingo menu in the menu bar. For more information on creating and 
using cast member scripts, see the Using Lingo manual. The script 
remains attached to the cast member if the cast member is cut or 
copied and pasted.

Button Cast Member Info

Style
The Style pop-up menu lists the button types and displays a 
checkmark next to the current type. You can choose a different 
button style from the pop-up menu.
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Purge Priority
Controls how Director removes the cast member from memory if 
memory is low.

Note If you set many cast members to have a purge priority of Last or Never, your 
movie may run out of memory.

Size
Displays the size of the cast member, in bytes.

Script...
Director opens a script window for the cast member, and displays the 
Lingo menu in the menu bar. For more information on creating and 
using cast member scripts, see the Using Lingo manual. The script 
remains attached to the cast member if the cast member is cut or 
copied and pasted.

Purge
priority

Description

3-Normal The selected cast member will be removed from 
memory as necessary. This is the default.

2-Next The selected cast member will be among the next to 
be removed from memory.

1-Last The selected cast member will be among the last to 
be removed from memory.

0-Never The selected cast member remains in memory and is 
never purged.
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Digital Video Cast Member Info

If you are using the Macintosh version of Director, this dialog box 
applies only to QuickTime cast members.

Length
The length of the digital video movie, in seconds.

Loop
If Loop is checked, the digital video movie loops from the end back 
to the beginning and continues to play.

Paused at Start
If checked, the digital video movie is paused when it first appears on 
the stage (while playing the Director movie).
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By default, a digital video movie starts playing the moment it first 
appears. If you check Paused at Start, you can later start the movie 
using the Lingo command:

set the movieRate of sprite n to R

where:

◆ n is the sprite number (within the current frame)

◆ R is a number representing the rate. For example, 0 = stop, 1 = 
normal speed, 2 = 2x speed, and -1 = reverse.

Video
If Video is checked, the digital video movie’s video portion plays. If 
unchecked, the video portion does not play. Uncheck this option and 
check the Sound option if you want to play the audio-only portion of 
a movie.

Sound
If Sound is checked, the digital video movie’s soundtrack plays. If you 
don’t have enough memory, you can leave this option unchecked so 
that Director does not load the movie’s sound into memory during 
playback.

Crop
If Crop is checked, the movie retains its original size if you resize its 
bounding rectangle, and its edges may get clipped. If Crop is not 
checked, the movie is scaled if you resize its bounding rectangle.

Center
Center is only available if Crop is checked. Use Center to 
automatically center the movie if you resize its bounding rectangle. If 
Center is not checked, the movie maintains its original position, 
relative to the upper left corner, if you resize its bounding rectangle.

Enable Preload into RAM
If checked, Director lets you preload the entire movie (or as much of 
the movie as can fit into available memory) using the preLoad or 
preLoadCast Lingo commands.
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If checked, Director loads the entire digital video movie into 
memory if enough memory is available. If there is not enough 
memory to load the entire movie, Director loads only what can fit 
into memory. If this option is unchecked, Director does not load the 
movie into memory and instead plays it from disk. This results in 
slower performance, since each frame must be retrieved from disk 
before it is played.

Direct to Stage
If Direct to Stage is checked, the digital video movie plays in front of 
any cast members on the stage, regardless of the channel that contains 
the movie. Inks are not visible on a movie that plays with this option. 
In general, use Direct to Stage when you want the best possible 
playback performance from a digital video movie and you don’t need 
ink effects or compositing. However, results may vary, so you may 
have to experiment. 

Note If the exported digital video movie plays before your transitions occur, turn off 
the digital video movie cast member’s Direct to Stage setting in the Cast 
Member Info dialog box.

Show Controller
This option is only available if Direct to Stage is checked. If this 
option is checked, a controller bar appears below the movie to allow 
the user to start, stop, and step through the movie.

Play Every Frame
This option is only available if Direct to Stage is checked. If checked, 
every frame of the digital video movie plays. The digital video 
movie’s soundtrack will not play, since the movie can’t play the 
sound track asynchronously while the video portion plays 
frame-by-frame. If not checked, the movie skips frames as necessary 
to keep up with a constant tempo.
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If Play Every Frame is checked, choose one of the following options:

◆ Play at Normal Rate

Each frame plays at its normal rate, and no frames are skipped.

◆ Play as Fast as Possible

The movie plays as fast as possible while still displaying each 
frame.

◆ Play at Fixed Rate.

Lets you play the movie using a specific frame rate. Use this 
option only for digital video movies that use the same frame rate 
for each frame of the movie.

Purge Priority
Controls how Director removes the cast member from memory if 
memory is low.

Note If you set many cast members to have a purge priority of Last or Never, your 
movie may run out of memory.

Memory Size
Size displays the size, in bytes, of the digital video movie’s description 
in memory. It does not indicate the file size of the digital video 
movie. Use the Get Info command in the Finder to determine the 
size of a digital video movie. 

Purge
priority

Description

3-Normal The selected cast member will be removed from 
memory as necessary. This is the default.

2-Next The selected cast member will be among the next to 
be removed from memory.

1-Last The selected cast member will be among the last to 
be removed from memory.

0-Never The selected cast member remains in memory and is 
never purged.
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File Name
Displays the name of the linked external file for the imported digital 
video cast member. Clicking the file name lets you choose a different 
file to link to.

Script...
Director opens a script window for the cast member, and displays the 
Lingo menu in the menu bar. For more information on creating and 
using cast member scripts, see the Using Lingo manual. The script 
remains attached to the cast member if the cast member is cut or 
copied and pasted.

Film Loop Cast Member Info

Displays information about the selected film loop cast member.

Crop
If checked, the film loop retains its original size if you resize its 
bounding rectangle, and its edges may get clipped. If Crop is not 
checked, the film loop is scaled if you resize its bounding rectangle. 

Center
This option is only available if the Crop option is checked. If 
checked, the film loop is automatically centered if you resize its 
bounding rectangle. If Center is not checked, the film loop maintains 
its original position, relative to the upper left corner, if you resize its 
bounding rectangle.
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Sound
If checked, sound is enabled during playback. If not checked, sound is 
disabled during playback.

Loop
If checked, the film loop returns from the last frame back to the 
beginning and continues to play. If this option is not checked, the 
film loop doesn’t loop, and the last frame remains on the stage when 
the film loop finishes playing.

Purge Priority
Controls how Director removes the cast member from memory if 
memory is low.

Note If you set many cast members to have a purge priority of Last or Never, your 
movie may run out of memory.

Size
Displays the size of the cast member, in bytes.

Script...
Director opens a script window for the cast member, and displays the 
Lingo menu in the menu bar. For more information on creating and 
using cast member scripts, see the Using Lingo manual. The script 
remains attached to the cast member if the cast member is cut or 
copied and pasted.

Purge
priority

Description

3-Normal The selected cast member will be removed from 
memory as necessary. This is the default.

2-Next The selected cast member will be among the next to 
be removed from memory.

1-Last The selected cast member will be among the last to 
be removed from memory.

0-Never The selected cast member remains in memory and is 
never purged.
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Linked Director Movie Cast Member Info

Displays information about an imported movie that is linked to its 
source file on disk.

Crop
If checked, the movie retains its original size if you resize its 
bounding rectangle, and its edges may get clipped. If Crop is not 
checked, the movie is scaled if you resize its bounding rectangle. 

Center 
This option is only available if Crop is checked. If checked, the 
movie is automatically centered if you resize its bounding rectangle. If 
Center is not checked, the movie maintains its original position, 
relative to the upper left corner, if you resize its bounding rectangle.

Sound
If checked, sound is enabled during playback. If not checked, sound is 
disabled during playback.

Loop
If checked, the movie returns from the last frame back to the 
beginning and continues to play. If this option is not checked, the 
movie doesn’t loop, and the last frame remains on the stage when the 
movie finishes playing.
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Enable Scripts 
If checked, Director activates the movie’s scripts when the movie is 
used in the score. If this option is not checked, Director ignores the 
movie’s scripts.

Size
Displays the size of the cast member, in bytes.

File Name
Displays the location of the external file associated with the linked 
movie. Clicking the filename lets you choose a different file to link 
to.

Script...
Director opens a script window for the cast member, and displays the 
Lingo menu in the menu bar. For more information on creating and 
using cast member scripts, see the Using Lingo manual. The script 
remains attached to the cast member if the cast member is cut or 
copied and pasted.
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Palette Cast Member Info

Cast Member
Enter or edit the name in the entry field. The name remains attached 
to the cast member if it is cut or copied and pasted. Director does not 
prevent you from creating duplicate cast member names, but you 
should avoid using them. If more than one cast member with the 
same name has a script attached to it, Lingo uses the script attached to 
the cast member with the lowest cast number. Use cast names instead 
of cast numbers to address cast members in a Lingo script, so that you 
don’t have to update your scripts if your cast members get 
re-numbered or sorted.

Purge Priority
Controls how Director removes the cast member from memory if 
memory is low.

Purge
priority

Description

3-Normal The selected cast member will be removed from 
memory as necessary. This is the default.

2-Next The selected cast member will be among the next to 
be removed from memory.

1-Last The selected cast member will be among the last to 
be removed from memory.

0-Never The selected cast member remains in memory and is 
never purged.
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PICT Cast Member Info

Cast Member
Enter or edit the name in the field. The name remains attached to the 
cast member if it is cut or copied and pasted. Director does not 
prevent you from creating duplicate cast member names, but you 
should avoid using them. If more than one cast member with the 
same name has a script attached to it, Lingo uses the script attached to 
the cast member with the lowest cast number. Use cast names instead 
of cast numbers to address cast members in a Lingo script, so that you 
don’t have to update your scripts if your cast members get 
re-numbered. 

Purge Priority
Controls how Director removes the PICT cast member from 
memory if memory is low.

Purge
priority

Description

3-Normal The selected cast member will be removed from 
memory as necessary. This is the default.

2-Next The selected cast member will be among the next to 
be removed from memory.

1-Last The selected cast member will be among the last to 
be removed from memory.

0-Never The selected cast member remains in memory and is 
never purged.
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Size
Displays the size of the cast member, in Kilobytes.

Script...
PICT cast members can have a Lingo script associated with them. To 
create or review the script, click the Script button in the dialog box. 
Director opens a script editor window for the cast member, and 
displays the Lingo menu in the menu bar. For more information on 
creating and using cast member scripts, see the Using Lingo manual. 
The script remains attached to the cast member if it is cut or copied 
and pasted.

Script Cast Member Info

Cast Member
Enter or edit the name in the field. The name remains attached to the 
cast member if it is cut or copied and pasted. Director does not 
prevent you from creating duplicate cast member names, but you 
should avoid using them. If more than one cast member with the 
same name has a script attached to it, Lingo uses the script attached to 
the cast member with the lowest cast number. Use cast names instead 
of cast numbers to address cast members in a Lingo script, so that you 
don’t have to update your scripts if your cast members get 
re-numbered. 

Size
Displays the size of the cast member, in bytes.
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Type
Displays the script type (movie or score) for the selected cast member, 
and lets you change it. A movie script’s handlers are global, and can 
be called from other scripts. A score script’s handlers are local, and 
cannot be called from other scripts. If you change a movie script into 
a score script, it appears in the script pop-up menu in the score.

Shape Cast Member Info

Shape
The Shape pop-up menu lists the shapes and displays a check mark 
next to the current shape. You can choose a different shape from the 
pop-up menu. 

Filled
If Filled is checked, the shape will be filled using the current fill 
pattern and colors as specified in the tools window.

Script...
Director opens a script window for the cast member, and displays the 
Lingo menu in the menu bar. For more information on creating and 
using cast member scripts, see the Using Lingo manual. The script 
remains attached to the cast member if the cast member is cut or 
copied and pasted.
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Sound Cast Member Info

Looped
If checked, the sound plays continuously. If not checked, the sound 
plays once, even if the movie loops. 

Note Director can loop mono or stereo sounds.

Purge Priority
Controls how Director removes the cast member from memory if 
memory is low.

Size
Displays the size of the cast member, in bytes.

Purge
priority

Description

3-Normal The selected cast member will be removed from 
memory as necessary. This is the default.

2-Next The selected cast member will be among the next to 
be removed from memory.

1-Last The selected cast member will be among the last to 
be removed from memory.

0-Never The selected cast member remains in memory and is 
never purged.
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File
If a cast member is an external sound file that is linked to its source 
file on disk, the Cast Member Info dialog box displays the location of 
the linked file. Clicking the file name lets you choose a different file 
to link to.

Play
Click the Play button to preview the sound at its pre-recorded 
sampling rate.

Text Cast Member Info

Style
Use the Style pop-up menu to choose a text display option for the 
text cast member.
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Editable Text
Allows the text cast member to be edited during movie playback. 
You can use this option instead of using the Lingo command set 
the editableText of sprite to true.

Note If you set a text cast member to be editable in the cast, it is always editable 
when used in the score. Director ignores the score’s Editable checkbox setting 
for the cast member.

Auto Tab
Causes the Tab key to advance to the next editable text field on the 
stage during playback. Note that the Editable Text checkbox must be 
checked, or the Lingo command set the editableText of 
sprite to true must be specified for this option to have any 
effect. 

Don’t Wrap
If checked, prevents text from moving to the next line. Text that 
extends beyond the right edge is truncated. You must use the Return 
key to generate a new line.

Style Description

Adjust to Fit Causes the text box to expand vertically when 
text is entered that extends beyond the current 
size of the box.

Scrolling Attaches a scroll bar to the right side of the text 
box. Useful for a large amount of text.

Fixed Causes the box to retain its original size. If text is 
entered that extends beyond the limits of the 
box, the text is not displayed.

Limit to Field Size Sets the field’s width to be fixed to the size of the 
field. Characters that don’t fit are ignored.
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Purge Priority
Controls how Director removes the cast member from memory if 
memory is low.

Note If you set many cast members to have a purge priority of Last or Never, your 
movie may run out of memory.

Size
Displays the size of the cast member, in bytes.

Script...
Director opens a script window for the cast member, and displays the 
Lingo menu in the menu bar. For more information on creating and 
using cast member scripts, see the Using Lingo manual. The script 
remains attached to the cast member if the cast member is cut or 
copied and pasted.

Purge
priority

Description

3-Normal The selected cast member will be removed from 
memory as necessary. This is the default.

2-Next The selected cast member will be among the next to 
be removed from memory.

1-Last The selected cast member will be among the last to 
be removed from memory.

0-Never The selected cast member remains in memory and is 
never purged.
Chapter 6422



Getting information on multiple cast members

You can select multiple cast members with Shift-click or 
Command-click to get information about the number, type, and total 
size of your selection, and to set the purge priority for the selected 
cast members when memory is low.

Cast Member Info for multiple cast members

Cast Member
Displays the number of cast members in the selection.

Type
When several cast members are selected, this is set to “Multiple.” If all 
the selected cast members are of the same type, this field instead 
displays their type.

Size
Displays the total size, in Kilobytes, of the selected cast members.
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Purge Priority
Controls how Director removes the cast members from memory if 
memory is low.

If all cast members have the same purge priority, the pop-up menu is 
blank.

Note If you set many cast members to have a purge priority of Last or Never, your 
movie may run out of memory.

Open Script...

Opens the script associated with the selected cast member. This is the 
same as clicking the Script button in the Cast Member Info dialog 
box.

In the cast window, select a cast member and click the Script button 
as a shortcut for choosing this command.

Purge
priority

Description

3-Normal The selected cast member will be removed from 
memory as necessary. This is the default.

2-Next The selected cast member will be among the next to 
be removed from memory.

1-Last The selected cast member will be among the last to 
be removed from memory.

0-Never The selected cast member remains in memory and is 
never purged.

Script button
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If you are editing a cast member in the paint, text, or digital video 
window, you can click the window’s Script button as a shortcut for 
choosing this command.

˛ Tip Command-’ is the keyboard shortcut for this command. Press Option while 
choosing Open Script to open the selected cast member’s script in a new script 
window.

Edit Cast Member

This command is only available if there is a selection in the cast 
window. It displays the appropriate editing window for the selected 
cast member. For example, if you select a bitmap cast member and 
choose this command, Director opens the paint window for the 
selected cast member. For cast members that don’t have editing 
windows (e.g., Shape, PICT, Sound, Movie, and Film Loop cast 
members) Director displays the cast member’s Cast Member Info 
dialog box.

˛ Tip Double-click a cast member in the cast window as a shortcut for choosing this 
command.

Launch External Editor...

Automatically launches an external application so that you can edit a 
linked bitmap, sound, or digital video cast member.

˛ Tip Command–, (comma) is the keyboard shortcut for this command.

You can only launch an external editor for a linked bitmap (PICT 
file), sound, or digital video cast member.

Select the cast member you want to edit in the cast window, and 
choose this command. If you select multiple cast members, only the 
first (lowest numbered) cast member in the selection is used.
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If an editor has yet not been specified for the type of cast member 
selected, or if the specified editor cannot be found, a dialog box 
appears so you can select the application.

Once you select an editor, Director stores its pathname in the 
Director 4.0 Preferences file, so that the location and name of the 
editor are remembered across sessions. 

Click Open to launch the new editor and open the selected cast 
member’s linked file.

The next time you choose Launch External Editor for a selected cast 
member of the same type, Director automatically launches the editor 
and opens the cast member’s linked file.

When you save your changes in the editor and return to Director, the 
edited cast member is reloaded and updated on the stage and in all 
authoring windows. 

Changing editors

To choose a new editor for all cast members of the same type, select a 
cast member of the appropriate type and press the Option key while 
choosing Launch External Editor.

Director will display the dialog box asking you to locate the new 
editor application. Clicking Open launches the selected editor.
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Record Sound...

This command lets you record short sounds and save them as cast 
members without leaving Director, using the standard Macintosh 
system sound-recording dialog box and a microphone.

This command is dimmed if your Macintosh does not have a sound 
driver installed.

To begin recording, click Record. Click Stop when you are finished 
recording. Click Save to add the sound to the cast window.

An easy way to add sounds to your movie is with Macromedia’s 
MacRecorder Sound System Pro. The MacRecorder is an audio 
digitizer like the Apple microphone.

Digitized sounds can be very memory intensive. You can decrease 
the sampling rate to save memory, but the quality of the sound will 
suffer. Experiment to find which sounds can be sampled at a lower 
rate without compromising the quality of the sound. For example, 
using a sound editing application such as SoundEdit Pro, you can 
reduce the sampling rate of spoken words and still understand them 
but sampling some types of music at that rate might not sound 
acceptable.
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Paste as PICT

This command lets you paste a PICT image into the cast and have it 
remain in PICT format. 

If you paste a PICT image into the cast using the Paste command in 
the Edit menu, Director converts it to a bitmap. If you want the 
artwork to remain in PICT format when you paste it into the cast, 
use Paste as PICT. 

Graphic cast members pasted to the cast window with this command 
do not appear in the paint window since the paint window only edits 
bitmapped images. 

You might want to use Paste as PICT for several reasons. PICT cast 
members may occupy less memory. Some PICT cast members, such 
as compound images consisting of lines, shapes, and text, will stretch 
and scale more smoothly than bitmapped cast members. PICT cast 
members also look better when printed on a laser printer. 

However, PICT cast members animate more slowly than bitmapped 
cast members, and they don’t support ink effects. When using color 
cycling or palette transitions, PICT cast members may yield 
unexpected results.

˛ Tip Command-Shift-Y is the keyboard shortcut for this command.

Convert to Bitmap

This command converts PICT cast members or QuickDraw text 
created in the text window or with the text tool in the Tool window 
to bitmapped cast members. The converted text or graphic can then 
be edited in the paint window. Once you convert PICT cast 
members or QuickDraw text to bitmapped graphics, you cannot 
undo the change. 

You can’t convert a QuickDraw shape to a bitmap.
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Using bitmapped text gives you more choices of inks to use on the 
text. Another advantage to using bitmapped text is that once created, 
the text is not dependent on the available fonts to be displayed. On 
the screen, QuickDraw and bitmapped text look identical. 

There is a trade-off in converting to bitmap. Bitmapped text and 
graphics animate faster, but they may take up more memory and disk 
space. They also have jagged edges when printed on a laser printer. 

˛ Tip You can also convert PICT cast members to bitmaps and reap some of the 
benefits of faster animation, but it usually takes more memory.

Transform Bitmap...

This command lets you change the size, color depth, and palette of 
one or more selected cast members. The palette you choose is applied 
to the cast members and cannot be undone. If you want to maintain 
the cast member’s original palette while temporarily applying a 
different palette, use the Cast Member Info command instead.

Note If you only want to change the size of the cast member on the stage, use the 
Sprite Info command in the Score menu.
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The dialog box displays the values for the current cast member 
selection. If more than one cast member is selected, a blank value 
indicates that some cast members in the selection have different 
values. To maintain a cast member’s original value, leave that value 
blank in the dialog box.

Size

◆ Scale

Use the Scale option to reduce or enlarge the cast member by a 
percentage. If multiple cast members are selected, you can scale 
them all relative to their original size. 

◆ Width, Height

Use the Width and Height fields to specify the horizontal and 
vertical dimensions of the cast member in pixels. If multiple cast 
members are selected, you can resize all the cast members to the 
dimensions you enter. 

Colors

◆ Color Depth

Your monitor and system software determine the set of color 
depth display modes available. A cast member’s color depth is 
determined by the monitor’s display mode at the time the cast 
member was created or imported. A movie’s color depth is 
determined by the cast member with the highest color depth.

You can change color depth to save memory and disk space 
when you are creating a color movie.

Black and white display mode is 1 bit. The higher the number of 
bits, the more color depth choices you have available. However, 
larger color depths require more memory, and may also increase 
the time necessary for an animation to redraw. Black and white 
cast members require less memory than 4-, 16-, or 256-color cast 
members. 
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After the cast member is reduced to black and white, you can still 
color the cast member. Just select the cast member and choose a 
color from the tools window foreground or background color 
pop-up palette. (Don’t use the paint window’s color palette to do 
this.) Keep in mind that when you change the color, you are only 
changing the color of the sprite on the stage. The actual cast 
member remains black and white. 

Another use for changing a cast member’s color depth is when 
colorizing black and white cast members. Their color depth must 
be increased before you can use the paint tools to colorize them.

You can set the color depth of a cast member to be greater than 
the color depth of either the movie or the monitor. There’s a 
performance penalty, however: if the cast member’s color depth 
is greater than the monitor’s, Director must remap the cast 
member every time it draws the cast member.

◆ Palette

The palettes listed in the pop-up menu are the default Director 
palettes, plus any additional ones found in the cast window. You 
can create a common palette that contains most of the colors your 
cast member needs. 

When you use the Transform Bitmap command, Director matches 
the colors of the cast member with similar colors in the new palette, 
regardless of the position of the original color in the palette. For 
example, if the original artwork is red and the only red available in 
the new palette is pink, the red is changed to pink.

If the movie is playing, the active palette is the one that is currently in 
use at any given time, as specified in the score. The active palette may 
be different from the palette used by the movie. See “What 
determines which palette is active” in Chapter 3 for more 
information.

A mapped palette is the palette to which a color bitmap cast member 
is linked. Usually, this is the palette that was active at the time the 
bitmap was created. To link a bitmap cast member to a different 
palette, use the Transform Bitmap command.
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Remapping

◆ Dither

Use Dither to improve the color or shading of the cast member. 
Director examines the palette and creates a blend from one color 
to another using the nearest matching colors.

◆ Remap to Closest Colors

When you create a cast member in a color paint application, it is 
created with a specific palette. If you want to use that cast 
member in a movie, but a different palette is set in the palette 
channel of the score, your cast member will not appear in the 
colors you intended. Use this option to remap the cast member 
to the colors in the current palette that are closest to the colors 
the cast member was originally created with.
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Importing cast members with different palettes

When importing cast members with palettes that are different from 
the currently active palette, a dialog box appears asking you if you 
want to remap the cast member to the current palette, or import the 
cast member and the cast member’s palette.

If you import the cast member and the palette, they will both be 
placed in the next available cast member positions in the cast 
window.

Remapping the cast member to the current palette causes the cast 
member to appear in the colors closest to those in the current palette. 
Importing the cast member’s palette ensures that it looks as it did 
when originally created.

Note Remapping cast members is a one-way street. If you remap a colorful cast 
member to a grayscale palette, then remap again to the cast member’s original 
color palette, the cast member may remain gray. The cast member always maps 
to the colors in the new palette that most closely resemble its current colors.
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Align Bitmaps

Align Bitmaps arranges cast members so that their registration points 
line up in the paint window. A registration point lets you align a 
series of cast members using a fixed reference point. When the 
registration points are aligned, you can use the left and right arrows in 
the paint window to flip through the cast members and preview a 
sequence of animated cast members. Align Bitmaps has no effect on 
sprite positions in the Score.

Cast to Time

Cast to Time is a quick way to create a cast member sequence in your 
movie. This command places selected cast members in the cast 
window sequentially into the score.

If you select a single cell in the score before choosing this command, 
the selected cast members are added to the score beginning at the 
selected cell. Any existing score data is replaced by the Cast to Time 
sequence. If you set an insertion point in the score before choosing 
this command, the Cast to Time sequence is inserted in Channel 1, 
beginning at the insertion point. If you select a range of score cells 
before choosing this command, the Cast to Time sequence that is 
inserted will only be as long as the number of selected cells in the 
score.

˛ Tip You can also place selected cast members across time in the score by holding 
down the Option key while dragging them from the cast.
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Duplicate Cast Member

The Duplicate Cast Member command duplicates the selected cast 
member and pastes the duplicate into the next available position in 
the cast window. Duplicate Cast Member can’t be used with a cast 
member that’s part of a shared cast.

˛ Tip Command-D is the keyboard shortcut for this command.

If the paint, text, digital video, or script window is open when you 
choose this command, the contents of the window changes to the 
new cast member. The name and registration point of the duplicate is 
the same as the name and registration point of the original cast 
member.

This is a quick way to create a series of cast members for 
frame-by-frame animation. Duplicate a cast member, change it 
slightly, duplicate the changed cast member, alter it some more, 
duplicate it again, and so on. 

˛ Tip If the cast window is front-most, you can select multiple cast members and use 
this command to duplicate the entire selection at the same time.
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Find Cast Members...

Find Cast Members permits you to quickly identify those cast 
members that are either unused in the current movie or are created 
with one of the palettes in the palette pop-up menu. You can also 
select cast members by name or type. Use this command to identify 
cast members to clear from your movie or candidates for remapping 
to another palette.

˛ Tip Command-; (semicolon) is the keyboard shortcut for this command.

The dialog box lists cast members in the current movie, including 
shared cast members.
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Find Cast Members

◆ whose type is

Choose a cast member type from the menu if you only want to 
find cast members of a specific type. (The default is All.)

◆ whose name begins with

Finds cast members whose name begins with the characters you 
enter.

◆ that use the palette

Finds cast members that use the chosen palette.

◆ that are not used in the score

Finds cast members that are not used in the score. Keep in mind, 
however, that a cast member that is not used in the score may still 
be used in a Lingo command.

View by

◆ Number

Sorts cast members by cast member number.

◆ Name

Sorts cast members alphabetically by name.

Selecting a cast member in the list and clicking Select (or 
double-clicking a cast member) closes the dialog box and selects the 
cast member in the cast. Clicking Select All closes the dialog box and 
selects all matching cast members in the cast.

Clicking Done closes the dialog box without affecting the selection in 
the cast window.

˛ Tip To quickly select cast members by name, begin typing the first few letters of the 
name, and the dialog box will automatically display a list of cast members 
whose name begins with the letters you type.
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Sort Cast Members...

This command lets you rearrange selected cast members in the cast 
and eliminate empty cast member positions in between non-empty 
ones. It’s particularly useful when you want to reorganize a selection 
of cast members or the entire cast in a compact format.

To rearrange the entire cast, first choose Select All from the Edit 
menu before choosing this command.

Director automatically updates the score with the new frame number 
for each repositioned cast member and the animation sequence is 
unaltered. 

Note Using this command will not affect shared cast members, since these cast 
members cannot be rearranged. To rearrange shared cast members, you must 
open the shared cast movie, called SHARED.DIR.

Because cast numbers may change when you use this command, cast number 
references in scripts may become invalid. If you use Sort Cast Members, you 
may have to go through your scripts to update them with the new cast 
numbers. Use cast names instead of cast numbers to address cast members in a 
Lingo script so that you don’t have to worry if your cast members get 
re-numbered.
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Sort Selection

◆ By Name

Sorts selected cast members alphabetically by name.

◆ By Type

Sorts selected cast members by type in the following order: 
bitmap, palette, button, text, sound, shape, PICT, digital video, 
film loop, movie, script.

◆ By Size

Sorts selected cast members by file size, in decreasing size order.

◆ By Order in Score

Sorts selected cast members in the order in which they appear in 
the score. If a cast member does not appear in the score it is 
placed after all the cast members that are referenced from the 
score.

◆ By Order in Cast

Sorts selected cast members in the order in which they appear in 
the cast. Empty cast members are placed at the end.

Note This option is equivalent to the Clean Up Selection command in previous 
versions of Director.
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Cast Window Options...

Displays a dialog box that lets you control cast window appearance. 
These preferences are stored in the Director 4.0 Preferences file.

Maximum Visible
Specifies the maximum number of cast members displayed in the cast 
window. Note that this option does not limit the actual number of 
cast members that can exist in the cast. If you have a small number of 
cast members, you can hide the remaining unused cast slots and make 
better use of the vertical scroll bar. The default is 1000.

Row Width
Determines how many thumbnails are displayed in each row in the 
cast window. Eight, Ten, and Twenty Thumbnails specify fixed-row 
widths that are independent of the window size; if the cast window is 
smaller horizontally than the width of the cast row, you must use the 
horizontal scroll bar to reveal the rest of the cast. The Fit to Window 
option automatically adjusts the number of cast members per row to 
fit the current width of the cast window. In this mode, the horizontal 
scroll bar is disabled, since the entire width of the cast is always in 
view. The default is Fit to Window.
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Thumbnail Size
The size of each cast thumbnail image displayed in the cast window. 
Thumbnails always maintain the standard 4:3 aspect ratio. The default 
is Medium.

Cast ID Style
Selects the display format of the cast member ID displayed below 
each cast thumbnail image in the cast window. The chosen format is 
also used in other windows, whenever a cast ID is displayed. The 
default is Number:Name.

Cast Type Icons
Controls how Director displays an icon in the lower right corner of 
each cast member, indicating the cast member’s type.

Thumbnail size Description

Small 44 x 33 pixels

Medium 56 x 42 pixels (default)

Large 80 x 60 pixels

Option Description

Number Displays cast number in decimal format.

Name Displays cast name, if one exists; otherwise 
displays cast number in decimal format.

A11 (Octal) Displays cast number in octal format, as used in 
previous versions of Director. Octal format is no 
longer supported in Lingo and should only be 
used when working with movies created using an 
earlier version of Director.

Number:Name Displays cast number (in decimal format) and cast 
name, separated by a colon (“:”)., i.e., 
“340:Snoopy”. If a name does not exist, just 
displays the cast number in decimal format. This 
is the default.
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Indicate Cast Members with Scripts
If checked, Director displays a script indicator in the lower left corner 
of each script cast member, to indicate that the cast member uses a 
script.

Script indicator

Cast type icon
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Score menu

The Score menu contains commands for editing the score and setting 
effects.

Sprite Info...

The Sprite Info command lets you change the size and location of a 
selected sprite on the stage. This command only affects the sprite’s 
appearance on the stage and does not alter the actual size of the cast 
member.

If you selected more than one sprite, this command lets you edit them 
as a group.

The size of a sprite on the stage is controlled by its parent cast 
member unless you change the sprite’s size using this command, or by 
manually resizing the sprite on the stage. Thereafter, any changes in 
the size of the parent cast member do not affect the size of the sprite 
on the stage.
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Size
These options let you change the sprite’s size.

◆ Scale

To scale the sprite’s appearance on the stage by a percentage, 
enter the percentage in the Scale % field. The sprite is scaled 
relative to its current size, not to the size of its parent cast 
member.

◆ Width, Height

Enter a specific width and height for the sprite, in pixels.

◆ Restore to Size of Cast Member

Returns the sprite to the size it was when you first moved it into 
the score or onto the stage.

Location
These options let you change the top left corner position of the sprite 
on the stage.

◆ From Left Edge of Stage

The value you enter represents the number of pixels the sprite is 
offset from the left edge of the stage.

◆ From Top Edge of Stage

The value you enter represents the number of pixels the sprite is 
offset from the top of the stage.

˛ Tip Command-K is the keyboard shortcut for this command.
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Delete Sprites

Delete Sprites removes selected artwork from the stage. Whatever is 
selected in the score window or on the stage is removed from your 
animation. Delete Sprites has no effect on the cast.

Delete Sprites is particularly useful when you want to clear sprites 
from the stage when the score window is closed or you have several 
windows open and want to avoid inadvertently deleting a cast 
member from the cast window.

˛ Tip Command-Delete is the keyboard shortcut for this command.

Set Sprite Blend...

Set Sprite Blend lets you specify the blend level for selected sprites in 
the score. This command allows you to apply a blend effect to sprites 
that use the blend, background transparent, mask, or matte ink. You 
can use this command to “fade” cast members in or out on the stage 
as they are animating.

You cannot apply a blend value to PICT sprites. You cannot apply a 
blend value to a digital video cast member if the Direct to Stage 
option is checked in the Cast Member Info dialog box.

Each sprite in the same frame can store its own blend value.

Use the score’s blend display option to see the blend values.
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Choosing a value sets the blend value as a percentage for the selected 
cells. 

To set blend values to fade cast members in or out:

1. Select the first cast members and assign them a starting 
blend value. 

2. Select the last cast members and assign them an ending 
blend value.

3. Select the entire range of cast members and choose the 
In-Between Special command from the Score menu. 
Make sure only the Blend checkbox is checked in the 
In-Between Special dialog box. 

4. Click OK.

˛ Tip Command-Option-B is the keyboard shortcut for this command.

Set Tempo...

The Set Tempo command lets you set a tempo or pause in your 
movie. The tempo setting controls the speed at which the playback 
head moves from frame to frame.

Select a cell in the tempo channel of the score window and choose 
Set Tempo from the Score menu. When you set a tempo, it also 
applies to all frames to the right of the tempo setting, until another 
tempo is encountered in the tempo channel.
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˛ Tip Double-clicking a cell in the tempo channel opens the Set Tempo dialog box.

Tempo
Use the scroll bar to set the movie’s tempo. This is the same as 
changing the tempo in the control panel.

Wait
Set the amount of delay in your movie using the scroll bar.

Wait for Mouse Click or Key
Lets you pause the playback head until the user clicks the mouse or 
presses a key. The cursor changes to a blinking mouse to indicate that 
the movie is paused. 

You might want to include some text on the screen telling users to 
click the mouse or press a key to continue.

Wait for Sound1 to Finish
Lets you pause the playback head until a sound in sound channel 1 
finishes playing.

Wait for Sound2 to Finish
Lets you pause the playback head until a sound in sound channel 2 
finishes playing.

Wait for QuickTime Movie to Finish in Channel:
Lets you pause the playback head until a QuickTime movie finishes 
playing. If you have several QuickTime movies playing, make sure 
you specify the channel of the longest playing movie when using this 
option.
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Using transitions

If you place tempo settings in the same frame as a transition, some 
tempo channel settings such as wait and sound playing become 
disabled. To avoid this, don’t place a transition in the same frame as 
your tempo settings. Instead, place the tempo settings in the frame 
immediately before or after the transition.

Set Palette...

The Set Palette command allows you to change palettes in a specific 
frame of the movie while your animation is playing. When you set a 
palette in the palette channel of the score, the color of the cast 
members in the movie will be determined by that palette, until 
another palette is encountered in the palette channel.

Palettes can be transitioned from one to another during an animation. 
A simple form of this occurs when you set two palettes in the palette 
channel of the score with the Set Palette command in the Score 
menu. When you play the movie, the cast members change from the 
colors of one palette to the other. In fact, everything on the screen 
will change color, including the Apple in the menu bar. 

The cast members’ new colors depend upon the position of the 
previous colors. For example, if one of your cast members is yellow, 
and yellow occupies the fifth color in your palette, the cast member 
will become whatever color is in the fifth position in the new palette.

To get a visual demonstration of color cycling or palette transitions, 
choose a range of frames in the score to cycle or transition colors in, 
and open the color palettes window while the movie plays. You can 
see the colors transition or cycle in the open color palettes window.

See “Working with palettes” in Chapter 3 for more information.
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˛ Tip Double-clicking a cell in the palette channel opens the Set Palette dialog box.

Color Cycling

This permits you to cycle a range of colors in a palette. For example, 
if a cast member’s color is the fifth color in the palette, and you 
specify a range of colors four, five, and six, the cast member will 
change colors when the movie is played, and it will cycle through 
colors four, five, and six. 

To select a range to cycle, drag across the colors to be cycled in the 
Set Palette dialog box. You can also click a color, and Shift-click 
another color to select the colors you click and all colors in between.

Palette
Lets you choose the palette used for the selected cells in the palette 
channel.

Speed
Lets you control how fast or slowly the palettes transition from one to 
another.

Cycles
Specifies the number of cycles per frame.
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Auto Reverse
If checked, this option causes the colors to cycle in one direction, 
then at the end of the cycle, reverse direction and cycle through the 
colors in the reverse order. Leaving this box unchecked causes the 
colors to cycle in one direction only. 

Over Time
If you want the cycling to occur over a number of frames, check this 
option.

Palette Transition

Transition makes a smooth transition from one palette to another. 
Instead of your cast member abruptly changing colors when you 
switch palettes, this option will gradually blend from one palette to 
the next.

Palette
Lets you choose the palette used for the selected cells in the palette 
channel.

Speed
Lets you control how fast or slowly the palettes transition from one to 
another.
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Normal
The screen doesn’t fade during the palette transition.

Fade to Black
Like other palette transitions, this can occur over time, or in between 
frames. This option makes the screen fade completely to black. A nice 
way to end a movie is to make the final frame a black cast member 
that covers the whole stage, and then fade to black over several frames 
before the last frame.

Fade to White
Like other palette transitions, this can occur over time, or in between 
frames. This option makes the screen fade completely to white. A 
nice way to end a movie is to make the final frame a white cast 
member that covers the whole stage, and then fade to white over 
several frames before the last frame.

Over Time
By default, the palette transition will take place between two frames. 
All movement will halt as the transition takes place. If you want the 
transition to occur over a number of frames, check this option. The 
range of cells you select before choosing Set Palette determines the 
length of the transition.

Note Color cycling does not work in 16–, 24–, and 32–bit environments. This is 
because color cycling requires either that palettes be in use or that a video card 
set to 256 colors is present.
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Set Transition...

To set a transition, select a cell in the transition channel of the score 
window, and choose Set Transition. The transition occurs when the 
playback head reaches that cell.

˛ Tip Double-clicking a cell in the transition channel opens the Set Transition dialog 
box.

Transition Applies to

◆ Stage Area

The transition takes place over the entire stage.

◆ Changing Area

The transition takes place over the changing area of the frame.

Duration
Indicates the approximate amount of time (in quarters of a second) of 
the entire transition.

Chunk Size
Indicates how much of the screen changes in each movement of the 
transition. The smaller the chunk size, the smoother the transition.
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˛ Tip To stop a transition during playback and advance the playback head to the 
next frame, press Command–Period.

Note To play a sound while a transition takes place, place the sound in the frame 
immediately before the transition.

If you are developing a movie for Macintosh and Windows computers, don't 
use the Dissolve Bits, Dissolve Bits Fast, Dissolve Pixels, Dissolve Pixels 
Fast, or Dissolve Patterns transitions. These transitions produce entirely 
different results on a Windows computer.

Palette transitions (including fade to black and fade to white) and bit and pixel 
dissolves do not work in 16–, 24–, and 32–bit environments. This is because 
these features require either that palettes be in use or that a video card set to 
256 colors is present.

Set Sound...

Lets you paste a sound into one of the sound channels in the score. 
Select one or more cells in one of the sound channels, and then 
choose this command. If the cast contains no sounds, or if you have 
not first made a selection in one of the sound channels in the score, 
this command is dimmed.
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The dialog box lists all sounds stored as cast members in the cast.

˛ Tip As a shortcut, you can select one or more cells in a sound channel, and then 
double-click the cast thumbnail in the upper left corner of the score to display 
this dialog box.

Choosing a sound from the list pastes the sound into the selected 
frames in the sound channel in the score. The Play button lets you 
preview the sound.

Insert Frame

Insert Frame adds a frame to your movie at the location of the 
playback head. With Insert Frame a copy of the current frame is 
added to the score. This can cause an apparent pause in the animation 
as two identical frames are played.

The new frame is inserted for all channels and adds a frame to the 
movie’s length. 

˛ Tip Command-] is the keyboard shortcut for this command.
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Delete Frame

Delete Frame deletes the frame at the location of the playback head, 
making the movie one frame shorter in length.

˛ Tip Command-[ is the keyboard shortcut for this command.

In-Between Linear

In-Between Linear is used when you want a sprite to move in a 
straight line across the stage, grow or shrink smoothly, or remain 
stationary for a number of frames. Director fills in the selected cells in 
the score with the sprite’s incremental motion between frames.

In-Between Linear interpolates the incremental positions of a sprite 
between key frames. Key frames are the locations of the sprite that are 
the starting and ending point for the sprite’s motion. If the starting 
and ending points are the same, the sprite remains stationary. If the 
starting and ending points are different, In-Between Linear generates 
all the intermediate steps between key frames. In-Between Linear also 
works with sprites that are stretched or squeezed.

˛ Tip Command-B is the keyboard shortcut for this command.
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In-Between Special...

Use In-Between Special when you want a sprite to move in a curved 
path, to accelerate or decelerate across the stage, or to in-between a 
film loop.

To make your sprite follows a curved path, you must set the sprite in 
at least three positions on the stage in different frames. As with the 
regular In-Between, select all the cells between the first and last 
position of the sprite, then choose this command.

˛ Tip Command-Shift-B is the keyboard shortcut for this command.

In-Between
You can independently tween individual parameters such as 
Location, Size, Foreground Color, Background Color, and Blend. 
Check the parameters that you want to tween.
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Acceleration
Ease-In and Ease-Out options can add realism to your animations by 
having sprites gradually build up to full speed, or decrease in speed as 
they come to a halt. 

◆ Accelerate over first n Frames (Ease-In)

Choose the number of frames over which you want to accelerate 
the sprite. If you choose to accelerate a sprite over the first eight 
frames, for example, a stationary sprite will ramp up to full speed 
over that many frames. To enter a number other than the choices 
in the pop-up menu, choose Other.

◆ Decelerate over last n Frames (Ease-Out)

Choose the number of frames over which you want to decelerate 
the sprite. For example, decelerating a sprite over eight frames 
will gradually bring the sprite to a halt by the eighth frame. To 
enter a number other than the choices in the pop-up menu, 
choose Other.

Path
If the beginning and ending points of the sprite are the same, the 
diagram in the dialog box will be circular, indicating that the sprite 
will travel in a circle when in-betweened. If the beginning and end 
points are not the same, the diagram describes a curved path, 
indicating that the sprite ends in a position different than the starting 
point. This diagram does not show the actual path of the sprite, just 
the type of curve it will follow.

The Inside/Outside slider controls the degree to which the sprite’s 
curved path follows the inside or outside boundaries of the path. If 
you drag the slider to the left, the sprite follows a curved path that is 
inside the sprite positions you set before choosing In-Between 
Special. If you move the slider to the center, the sprite will travel in 
straight lines between the points you set earlier. Dragging the slider all 
the way to the right causes the sprite to pass through the points you 
set as it travels a curved path. 
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◆ Circular

This option only affects sprites that begin and end in the same 
point. If checked, the sprite will circle around the stage, but it 
won’t pass through the starting point. The effect is to make a 
rounder circle. If this option is not checked, the sprite passes 
through the starting point during the animation.

◆ Preview Path

Lets you see the results of your choices by closing the 
In-Between Special dialog box and drawing a line on the stage 
indicating the path of the in-between. Click Preview Path to 
make sure your sprite is going where it’s supposed to.

Apply to Film Loop
If checked, you can in-between a series of sprites. For example, if you 
have a sequence of six sprites that make a walking person, you can 
store all six as a single sprite, called a film loop. Then, the film loop 
can be in-betweened as if it were a single sprite. Be sure that a film 
loop is selected in the cast window before choosing In-Between 
Special.

Space to Time...

Space to Time moves selected sprites in one frame to a single channel 
in the score so they play in a sequence of frames. 

The dialog box lets you specify the number of frames apart to spread 
sprites. Consecutive cells (1 frame apart) is the default.
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An example might be a bouncing ball. It’s difficult to lay out each 
position of the ball without comparing it to previous positions. With 
Space to Time, you can drag the ball from the cast window 
repeatedly to lay out your sequence, select the cells in the score that 
contain the sprites you just positioned on the stage, then choose 
Space to Time, and all the sprites shift from their vertical positions in 
one frame to horizontal positions in one channel. You might also find 
this a useful way to lay out sprites before using In-Between Special.

Space to Time shifts sprites from one frame to one channel across many frames

Paste Relative 

Use Paste Relative to paste a sequence of sprites at the point on the 
stage where a previous sequence ended. When you use this 
command, Director automatically adjusts the positions of cast 
members on the stage so that the first cast member in the pasted 
sequence follows the last cast member in the original sequence.
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For example, to animate a ball bouncing across the stage with a 
sequence of five sprites that describe one bounce, you can use Paste 
Relative to make the second sequence of sprites start where the first 
sequence ended. The effect is that the two sequences are chained, one 
after another, in one smooth, continuous motion. This works for any 
repetitive sequence of sprites.

Using Paste Relative to move a repetitive sequence of sprites across the stage

When selecting cells in a sequence to be pasted relative to the original 
sequence, make sure the same cast member is at the beginning and 
end of the sequence, and that you overlap the first cell in the copy 
with the last cell in the original sequence.

˛ Tip Command-Shift-V is the shortcut for this command.

Reverse Sequence

Reverses the order of selected cells in the score.

First sequence
Second sequence
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Switch Cast Members

The Switch Cast Members command replaces the cast member 
selected on the stage or in the score window with the cast member 
selected in the cast window. When you use Switch Cast Members, 
the registration point of the new cast member lines up with the 
registration point of the old cast member.

˛ Tip Command-E is the keyboard shortcut for this command.

Auto Animate

The Auto Animate command permits you to quickly create titles, bar 
charts, and text effects to add to your movies. Director adds the auto 
animate notation to the score window, so you can edit it.

If you select a single cell in the score, the entire auto animate 
sequence will be added to the score beginning at the selected cell. 
Any existing score data will be replaced by the sequence. If you set an 
insertion point, the auto animate sequence is inserted in channel 1, 
beginning at the insertion point. If you select a range of cells, the auto 
animate sequence that is inserted will occupy the number of cells in 
the selection. If you do not make a selection or set an insertion point, 
the auto animate sequence is placed at the end of the movie 
beginning in channel 1. 

Note For auto animate sequences that use more than one channel, if there isn’t 
enough room for all the channels to be placed in the score, they won’t be 
recorded in the movie.
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Banner...

Banner allows you to create an animated message that scrolls across 
the screen.

A typical banner effect

You can control the number of times the banner is displayed, the 
length of an initial delay, and the speed at which the effect occurs.

You can enter up to 255 characters in the text area. If you enter a 
name that is longer than 30 characters, Director only displays the first 
30 characters in the dialog box.

Text Style
Gives you complete control over the text font, size, style, 
transparency, and color of the banner text. 
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Animation Controls

◆ Speed 

Controls how fast the animation occurs, in this case how quickly 
the text moves across the screen.

◆ Initial Delay 

Controls the length of time before the effect starts.

Repeat
Controls how many times the effect is repeated.

Preview 
Displays the banner as it will appear in the presentation, including any 
background images. Use the Preview screen to adjust the location of 
the text. To set the location, click the mouse. Setting the starting 
location sets the position of the top of the text. Note that the starting 
location affects only the vertical dimension; wherever the starting 
location, the banner text travels from off the right side of the screen 
to off the left side of the screen.

Bar Chart...

Bar Chart allows you to create an animated bar chart.

A typical bar chart
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Title
Range

maximum

Vertical label

Range minimum
Bar label
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The title and labels of the bar chart appear first and are stationary; the 
bars grow into place through animation. Director allows you to 
control the scale of the chart, the height of the bars, the style of the 
bars, the speed of their growth, and the ending delay.

You can use up to six bars. The width of the bars is set automatically 
depending on the number of bars you are using. The actual length of 
the horizontal and vertical axes does not change, just the values on 
the scale. The height of the bars is proportional to the scale you set.

You can enter up to 255 characters in the Title text area and in the 
Vertical label text area. If you enter a name that is longer than 30 
characters, Director only displays the first 30 characters in the dialog 
box. 
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Chart Style

◆ Title Style, Label Style

These options give you complete control over the text font, size, 
style, transparency, and color of the title text and the label text.

◆ Bar Style

Provides several choices for different types of bars.

◆ Bar Labels

Enter a label that appears below each bar. You can enter up to 31 
characters for each label. If the labels are so long as to overlap, 
you can either use shorter labels or adjust the font, size, and style 
of the labels.

◆ Value 

Determines the height of each bar, in relation to the scale of the 
vertical axis. You can enter any positive values between 0 and 
32,000.

◆ Range

Determines the scale shown on the bar chart. The scale affects the 
height of the bars, which grow to a height proportional to the 
scale. You can set the maximum and minimum to any positive 
values between 0 and 32,000. 

Animation Controls

◆ Speed 

Controls how quickly the bars grow into place.

◆ Initial Delay 

Controls the length of time before the effect starts.

◆ Ending Delay 

Controls how long the completed bar chart is displayed.
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Preview 
Displays the bar chart as it will appear in the presentation, including 
any background images. Use the Preview screen to adjust the location 
of the bar chart. To set the location, click the mouse. Setting the 
starting location sets the position of the upper left corner of the chart. 
The upper left corner is determined by the top of the title text and 
the left edge of the vertical label text.

Bullet Chart...

Bullet Chart allows you to create an animated bulleted list.

A typical bulleted list

Typically, the title of the bulleted list appears first and is stationary; 
the items and their bullets travel into place through animation.
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You can determine the direction from which the bulleted items 
come. You can choose from several different bullets. You can 
animate the title as well as the bullets. You can have no animation at 
all, simply presenting a bulleted list. Or you can dispense with bullets 
altogether, presenting only a title and a list.

You can enter up to 255 characters in the Title text area and in each 
Bullet text area. If you enter a name that is longer than 30 characters, 
Director only displays the first 30 characters in the dialog box. 
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Text Formats

◆ Bullet Type

Provides choices for different types of bullets. Choices include a 
Dot, a Square, a Hand, a Check, and an Arrow. Three choices 
allow for animated bullets that move into place. These are the 
Flying Hand, the Animated Check, and the Flying arrow. You 
can also choose to have no bullets, or to have no bullets and the 
text and title centered.

◆ Line Spacing 

Controls the amount of space between items on the chart.

◆ Bullet Style, Title Style

Give you complete control over the text font, size, style, 
transparency, and color of the title text and the bullet text.

Animation Controls

◆ Motion 

Provides choices for how the bulleted items appear. The choices 
include from Right, Bottom, Left, Top, Upper Right, Lower 
Right, and so on. Choices also include Stationary (no 
movement), Wipe from Right, Wipe from Left, and Dissolve.

◆ Speed 

Controls how fast the animation occurs, in this case how quickly 
the bulleted items move into place.

◆ Initial Delay 

Controls the length of time before the effect starts.
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◆ Bullet Delay 

Controls the length of the pause between lines of text moving 
into place. A short Bullet Delay means that there is a very short 
pause between one line moving into place and the beginning of 
the next line’s movement.

◆ Ending Delay 

Controls how long the completed chart is displayed.

◆ Animate Title 

Causes the title text to also move into place. An animated title 
obeys the Motion, Speed, and Bullet delay settings.

Preview
Displays the bullet chart as it will appear in the presentation, 
including any background images. Use the Preview screen to adjust 
the location of the bullet chart. To set the location, you click with 
the mouse. Setting the starting location sets the position of the upper 
left corner of the title.
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Credits...

Credits allows you to create an animated credit list that scrolls up the 
screen. “Credits” comes from the motion picture practice of giving 
credit to everyone who worked on a movie in a scrolling list at the 
end.

A typical credits list
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You can control the number of times the credit list is repeated, the 
speed at which the effect occurs, the length of an initial delay, and the 
justification of the text (left, right, or center). 

Enter text in the text area, using the Return key to end a line of text 
and start a new line. There is no limit to the width of an individual 
line, except the practical limit of the screen width. Text that is too 
long to fit on one line of this dialog box wraps to the next line. Text 
appears in the preview as it will in the final slide.

You can enter up to 255 characters in the credit list.

Text Style 
Gives you control over the text font, size, style, transparency, and 
color of the credit text.

Justification 
Controls whether the credit text is justified flush left, flush right, or is 
centered.
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Animation Controls

◆ Speed 

Controls how quickly the text moves up the screen.

◆ Initial Delay 

Controls the length of time before the effect starts.

Repeat 
Controls how many times the effect is repeated.

Preview 
Displays the credit list as it will appear in the presentation, including 
any background images. Use the Preview screen to adjust the location 
of the text. To set the location, click the mouse. Setting the starting 
location sets the position of the center of the text. Note that the 
starting location affects only the horizontal dimension; wherever the 
starting location, the credit list travels from below the bottom of the 
screen to off the top of the screen.

Text Effects...

Text Effects allows you to create one of three animated effects on 
text. The effects include Sparkle, in which an animated highlight 
appears and disappears; Letter slide, in which the text is built up as 
letters slide one at a time; and Typewriter, in which the letters appear 
one at a time, as if typed.

A typical sparkle effect
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You can control the number of times the effect is repeated, the speed 
at which the effect occurs, the length of an initial delay, and the 
duration of the pause after the end of the effect. 

You can enter up to 255 characters in the text area. If you enter a 
name that is longer than 30 characters, Director only displays the first 
30 characters in the dialog box. 

Text Style 
Gives you complete control over the text font, size, style, 
transparency, and color of the text.

Animation Controls

◆ Effect 

Provides three choices for the effect you want. Choices include 
Sparkle, Letter Slide, and Typewriter.

◆ Speed 

Controls how quickly the text moves up the screen.

◆ Initial Delay

Controls the length of time before the effect starts.

◆ Ending Delay 

Controls how long the text is displayed after the effect is finished.
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Repeat 
Controls how many times the effect is repeated.

Preview 
Displays the text effect as it will appear in the presentation, including 
any background images. Use the Preview screen to adjust the location 
of the text. To set the location, you click with the mouse. Setting the 
starting location sets the position of the center of the text.

Zoom Text...

Zoom Text allows you to create an animated zoom effect. “Zoom” 
comes from the motion picture camera technique of changing 
smoothly from a long shot to a closeup (zoom in), or from a closeup 
to a long shot (zoom out).

A typical zoom text effect

Grows

Becomes
 full size

Starts small
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You can choose whether the text you enter grows from nothing to 
full size (zoom in), from full size to nothing (zoom out), or first 
zooms in and then zooms out. The text grows and diminishes 
through animation. Director allows you to control the number of 
times the effect is repeated, the speed at which the effect occurs, the 
length of an initial delay, and how long the full-size text remains on 
the screen.

You can enter up to 75 characters in the text area. If you enter a 
name that is longer than 30 characters, Director only displays the first 
30 characters in the dialog box. 

Text Style 
Gives you complete control over the text font, size, style, 
transparency, and color of the text.
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Animation Controls

◆ Zoom Type 

Determines whether the text zooms in, zooms out, or first zooms 
in and then zooms out.

◆ Speed 

Controls how fast the animation occurs, in this case how quickly 
the text grows from nothing into full size or diminishes from full 
size to nothing.

◆ Initial Delay 

Controls the length of time before the effect starts.

◆ Full-Size Duration

Controls how long the full-size text is displayed. Note that the 
text is full-sized at the beginning of a zoom out effect, in the 
middle of a zoom in and out effect, and at the end of a zoom in 
effect.

Repeat
Controls how many times the effect is repeated.

Preview 
Displays the zoom as it will appear in the presentation, including any 
background images. Use the Preview screen to adjust the location of 
the text. To set the location, you click with the mouse. Setting the 
starting location sets the position of the middle of the text.
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Score Window Options...

This command controls display options in the score window.
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Display Options

Colored Cells
If checked, you can choose a color for selected cells using the cell 
color selector on the left side of the Score window. If not checked, 
the cell color selector is hidden.

If you’ve already applied color to cells, unchecking this option hides 
cell colors but doesn’t remove them. Score window scrolling 
performance is faster if you hide cell colors. 

Magnified Cells
If checked, this option enlarges the cells in the score window for 
better viewing. You can perform all the regular score operations 
while the view is magnified.

Cell color selector
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Playback Head Follows Selection
This option toggles between two ways of selecting frames in the 
score. If checked, the playback head travels as you make a selection in 
the score window. You can see the selected frames on the stage as 
you select them. If not checked, your selection in the score window 
has no effect on the playback head and does not advance the movie as 
you make a selection. You might want to turn this option off if the 
score includes frames that take a long time to draw, such as frames 
with blend ink and anti-aliasing applied to them. (In earlier versions 
of Director, this setting was called Easy Select.)

˛ Tip You can temporarily switch this option to its opposite setting by pressing the 
Option key while making a selection in the score window.

Drag and Drop
This option allows you to turn off drag and drop in the score. 
Pressing the Spacebar while the score window is open temporarily 
overrides this setting.
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Extended Display Information

The Extended Display options let you choose the notation 
information that appears in the numbered sprite channels in the score 
if you choose the Extended display command from the score 
window’s Display pop-up menu.

◆ Cast Type, Movement, Anti-Alias, Blend displays the cast 
member type (text, PICT, or bitmap) and a directional arrow to 
indicate the cast member’s position with respect to the previous 
cast member in that channel. It also indicates whether a cast 
member has an anti-alias setting or a blend percentage applied
 to it.

◆ Cast Number displays the cast member position number from the 
cast window. If the cast member displays its name (as chosen in 
the Cast Window Options dialog box), then the first few letters 
of the cast member name are instead displayed.

◆ Ink Mode displays the type of ink applied to the cast member in 
that cell.

◆ Script Code displays the number of the script associated with that 
cell or a plus (+) sign if the script is a cast member script.

◆ X & Y Coordinates show the screen coordinates of the cast 
member.

◆ Change in X and Y Location indicates the change in X and Y 
coordinates relative to the previous cast member in that channel.
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Text menu

The Text menu controls the font, size, style, and alignment of text in 
the text, paint, markers, and cast windows, and on the stage.

To apply a font, size, or style to existing text in the text window, 
select the text before choosing a Font, Size, or Style command. If 
there is no selection in the text window, the font, size, or style you 
choose will be applied to future text entered in a text window.

In a text window, the Font, Size, or Style settings you choose can be 
applied on a per-character basis. The Alignment, Border, Margin, 
Box Shadow, or Text Shadow settings you choose are applied to the 
window’s entire contents.

In the paint window, you can only choose one font, size, style, and 
text shadow for the text you are typing. (The Alignment, Border, 
Margin, and Box Shadow commands are not available in the paint 
window.) You can choose them before typing, or after typing but 
before clicking another tool or repositioning the insertion point. If 
you want to change the bitmapped text in the paint window after 
clicking the mouse button, you must erase the previous type and 
create new type in the style you want.

In the markers window, you can only choose one font, size, and style 
for all text in the window.

In the cast window, the Font, Size, Style, Alignment, Border, 
Margin, Box Shadow, and Text Shadow commands are available if 
one or more text cast members are selected. You can use these 
commands to change the text attributes of all selected text cast 
members at once.

Note If you format text, delete it, and then type new text, the new text appears in 
the default format. Deleting all the text in a text field on the stage or in the 
text window deletes the formatting.
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The Text menu has eight submenus: Font, Size, Style, Alignment, 
Border, Margin, Box Shadow, and Text Shadow.

Submenu Purpose

Font Lets you choose any font that is installed in your 
System.

Size Controls the font size, in points. Point sizes that 
appear in outlined numbers are specifically 
designed for the currrently selected font and will 
look better than other font sizes.

Style Lets you choose a style for text.

Alignment Controls the alignment of text between the left 
and right borders of the text area. You can change 
the position of the right margin by dragging the 
right margin handle in a text window, or by 
dragging the handle of selected text on the stage.

Border Adds a box around QuickDraw text on the stage.

Margin Changes the distance between edges of the 
border and the text inside the border. Margins 
can only be used with QuickDraw text on the 
stage.

Box shadow Adds a drop shadow to the text box. Drop 
shadows can only be used with QuickDraw text 
on the stage.

Text shadow Adds a drop shadow to bitmapped or QuickDraw 
text. Drop shadow on text is a good way to 
ensure that your text will remain legible in color if 
you are planning to overlay text to videotape.
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Find/Change...

Find/Change lets you quickly search for and replace text in the text 
or script windows. All searches start at the insertion point and work 
forward. The Find/Change dialog box lets you enter the text you 
want to find in the text or script window and the text you want to 
replace it with.

Director stores the settings you specify in the Director 4.0 Preferences 
file (but does not save the text you enter in the Find or Change to 
fields).

Searching begins at the location of the insertion point. If you want to 
search from the beginning of the window, make sure the cursor is at 
the upper-left corner of the window before you begin the search.

Find:
Enter the text you want to find. Searching is not case-sensitive: 
ThisHandler, thisHandler, and THISHANDLER are all the same for 
search purposes. 

Change to:
Enter the replacement text.

Whole Words Only
Only finds occurrences of the search text as a separate word.
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Wrap–Around Search 
Specifies whether or not Director continues the search from the top 
of the window when it reaches the last line in the window. If this 
option is checked but Search All Cast Members is not checked, 
Director continues searching from the top of the current window 
after it reaches the bottom of the window. If both options are 
checked, Director searches all cast members of the same type (either 
text or script, depending on the window in which you initiated the 
search), beginning with the currently selected cast member, and 
wrapping around to the first cast member of that type if necessary.

Search All Cast Members
Specifies whether Director searches just the current cast member, or 
searches all cast members of the same type (either text or script, 
depending on the window in which you initiated the search). If 
checked, Director searches all cast members of the same type, 
beginning with the current cast member, and wrapping around to the 
first cast member if Wrap–Around Search is checked. If Search All 
Cast Members is not checked, Director only searches the current cast 
member’s text or script window.

Find 
Clicking Find closes the dialog box and finds the first occurrence of 
the specified text. The scope of the search depends on whether or not 
Search All Cast Members is checked. If a match is found, Director 
selects the text. If no match is found, Director beeps.

Change
Clicking Change closes the dialog box, finds the next occurrence of 
the specified text, starting from the insertion point, and replaces it 
with the specified text. The scope of the search depends on whether 
or not Search All Cast Members is checked. If no matching text is 
found, Director beeps.
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Change All
Clicking Change All closes the dialog box and replaces all 
occurrences of the specified text. Director first displays an alert 
informing you that this operation cannot be undone. If Search All 
Cast Members is checked, Director replaces all occurrences of the 
specified text for all cast members of the same type; otherwise, 
Director limits the operation to the current text or script window.

Cancel
Clicking Cancel closes the dialog box without performing a search or 
replace. However, any changes you made to the settings in the dialog 
box are saved in the Director 4.0 Preferences file.

˛ Tip Command-F is the keyboard shortcut for this command.

Find Again

Find Again finds the next occurrence of the text you entered in the 
Find: field in the Find/Change dialog box.

˛ Tip Command-G is the keyboard shortcut for this command.

Find Selection

Find Selection lets you find the next occurrence of the currently 
selected text in the text or script window.

˛ Tip Command-H is the keyboard shortcut for this command.
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Change Again

Change Again replaces the selected text and then searches for the 
next occurrence of the same text. You must choose this command 
again if you want to change the next occurrence of the selected text.

˛ Tip Command-T is the keyboard shortcut for this command.

Find Handler...

Find Handler lets you view the names of all handlers in the current 
script or movie. You can also use this command to open the script 
window that contains the selected handler.
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Find Handler
These buttons only appear if a script window is the active window. If 
any other window is active when you choose this command, all script 
handlers are listed.

◆ Current Script

Lists the handlers defined in the current script.

◆ All Scripts

Lists the handlers defined in all scripts.

View

◆ by Name lists handlers alphabetically, by name. 

◆ by Order lists handlers in the order in which they appear in their 
respective scripts. 

Handlers from different scripts are listed in the order in which the 
scripts appear in the cast window.

Selecting a handler and clicking Find opens the script window in 
which the handler is defined.

˛ Tip Command-: is the keyboard shortcut for this command.

Comment

Inserts the Lingo comment characters “--” at the beginning of the 
selected line(s).

˛ Tip Command-> is the shortcut for this command.
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Uncomment

Removes the Lingo comment characters “--” from the the beginning 
of the selected line(s).

˛ Tip Command-< is the shortcut for this command.

Recompile Script

Director saves any unsaved changes in the active script window, and 
then compiles the window’s script. This command is dimmed unless a 
script window is the active window.

˛ Tip Command-Shift-R is the keyboard shortcut for this command.

Recompile All Scripts

Recompiles all Lingo scripts and checks them for errors. If a script 
error is found, the appropriate script window opens and the error is 
selected.

If a script window is the active window, Director first saves any 
unsaved changes in the current script window and compiles its script 
before continuing.

˛ Tip Command-Option-R is the keyboard shortcut for this command.
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Palette menu

The Palette menu appears when the color palettes window is the 
active window. It contains commands for editing the current palette 
and for sorting its colors, and options for changing the colors in the 
palette. 

Duplicate Palette...

Duplicates the current palette, asks you to name it, and puts it in the 
next available position in the cast window. Director automatically 
duplicates a palette if you change any of the colors in one of the built-
in palettes. The duplicated palette is added to the list of available 
palettes in the color palettes window’s pop-up menu. A duplicated 
palette in the cast of a movie becomes part of that file and is always 
available in that movie until it is cut or cleared from the cast window. 

Reserve Colors...

Reserving colors in a palette is a way to isolate specific colors used in 
palette effects like color cycling. For example, if you are cycling 
colors and don’t want to inadvertently use the cycling colors on a 
non-cycling cast member, reserve the cycling colors to prevent them 
from being used.

Once reserved, colors are not available for use in the paint window or 
when Director automatically selects colors, such as in a gradient or 
when re-mapping a cast member. The only exceptions are gradients 
that use adjacent colors. They will use any reserved colors in the 
gradient’s color range. 
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To reserve colors, select them in the color palettes window and then 
choose this command.

Make sure Reserve Currently Selected Colors is chosen, then click 
OK. Director puts a check mark next to the Reserve Colors 
command, to indicate that colors are reserved. (If you later make all 
colors available by choosing All Colors Available, Director removes 
the check.)

Reserved colors appear striped in the color palettes window. The 
Select Reserved button also appears in the window when you’ve 
reserved colors to help you see which colors are reserved.

Click the Select Reserved button to display a black rectangle around 
each color that’s reserved.

Click to select 
reserved colors
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Invert Selection

When you choose Invert Selection after choosing a color or range of 
colors in the color palettes window, your selection is replaced by a 
new selection, which consists of all the colors that were not part of 
your original selection.

Set Color...

The Set Color command is dimmed unless you have a color selected 
in the color palettes window. When you choose this command, the 
Macintosh Color Picker appears. You can adjust the color of your 
selection in the color palettes window with the Color Picker. For 
information about using the Color Picker, see the manual that came 
with your Macintosh.

˛ Tip Double-clicking a color in the color palettes window is the shortcut for selecting 
a color and choosing this command.

Blend Colors

Creates a blend of the first and last color of a selected range in the 
palette, producing a smooth color transition from the first selected 
color to the last selected color. Use it to create blends of color for 
color cycling or smooth gradients.

˛ Tip Press the Command key while selecting colors with the pointer or hand tool to 
make a discontiguous selection. 
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Rotate Colors

Rotating selected colors displaces all the selected colors one square to 
the left. The leftmost color wraps around and appears at the last 
bottom right square. Each time you choose Rotate Colors, the 
selected colors shift by one more square. As the colors reach the left 
edge of the selection, they wrap around to the right edge and 
continue their journey. It is similar to the movement of color within 
a palette that you can see while colors cycle.

This is precisely what goes on when you use color cycling. If you are 
using a paint tool in the paint window with a cycling ink effect, the 
colors rotate through the palette as you draw. Another example of 
color cycling is in the Set Palette dialog box in the Score menu. You 
can select a range of colors to cycle as your movie plays. Any cast 
member that is the same color as one of the cycled colors will change 
as the colors rotate through the palette. 

Reverse Color Order

Reverses the order of the selected colors: the first color of the palette 
becomes the last. The colors, however, remain unchanged. If you 
reverse the palette that is associated with a cast member, it produces a 
negative image of the cast member. 
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Sort Colors...

The Sort Colors command allows you to sort the selected colors in 
the palette by Hue, Saturation, or Brightness.

When you click Sort, the colors will appear in the palette according 
to the sorting order selected. If you sort colors after drawing cast 
members, the cast members that use the selected colors will also 
change color as the colors are sorted.

Select Used Colors...

The Select Used Colors command highlights colors that are used by 
the bitmap cast member or cast members selected in the cast window. 
This command is useful when you want to cycle only the colors 
contained in one specific cast member, or when you need to find 
those colors you can cycle without affecting a cast member. You can 
also use the Invert Selection command, after you select the used 
colors, to select the colors that are not used by a cast member.
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Paint menu

The Paint menu appears when the paint window is open. It contains 
commands for editing artwork created or imported to the paint 
window. 

Show/Hide Paint Tools

The Hide Paint Tools command eliminates the tool palette from the 
paint window, leaving you with more room to create your cast 
members. After you choose Hide Paint Tools, this command changes 
to Show Paint Tools.

˛ Tip Command-Shift-J is the keyboard shortcut for this command.

Show/Hide Rulers 

The Show Rulers command displays vertical and horizontal rulers in 
the paint window. The default setting for the unit of measure is 
inches. You can change the scale to picas, centimeters, or pixels by 
clicking the upper left corner where the vertical and horizontal rulers 
meet. The zero point of the rulers can be moved to a new location by 
dragging from the corner of the rulers. The current position of the 
pointer is indicated by dotted lines in the rulers. After you choose 
Show Rulers, the command changes to Hide Rulers.

˛ Tip Command-Shift-K is the keyboard shortcut for this command.
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Zoom In 

Shows an enlargement of the artwork in the active easel. The 
enlargements can be 2, 4, and 8 times. Choose Zoom In from the 
Paint menu again to increase the magnification. 

When you zoom in, a smaller representation of the 100% size artwork 
appears in the upper right corner of the paint window. To return to 
normal size, click inside the smaller window or choose Zoom Out.

˛ Tip You can also magnify your artwork by double-clicking the pencil tool in the 
paint window’s tool palette, or by Command-clicking the area you want to 
enlarge with any of the paint tools. To move around in a zoomed view, press 
the Spacebar.

Command–+ (plus) is the shortcut for this command.

Zoom Out 

Reduces the zoom factor on the artwork if you are using an enlarged 
view (i.e., if you have chosen Zoom In). 

˛ Tip Command-clicking in the paint window, or pressing Command-– (minus) is a 
shortcut for choosing Zoom Out.
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Tiles... 

Tiles are a useful way to create patterns with more than two colors. 
Cast members in the paint window form the basis for creating a tile. 
When you choose a portion of a cast member to be made into a tile 
the cast member becomes a building block for a pattern created with 
a field of tiles. You can use tiles in the paint window or with the 
QuickDraw shapes in the tools window.

The Tiles dialog box lets you select the tile position, the cast member 
to make into a tile, what portion of the cast member to use for the 
tile, and the tile size.

The selection rectangle in the cast member box at the upper left of 
the Tiles dialog box determines which part of the cast member is used 
for the tile. Drag the rectangle to reposition it on a different part of 
the cast member or click a new spot in the cast member view to 
reposition the dotted rectangle.
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Select Tile to Edit
Click the tile you want to edit. An enlarged version of the tile is 
displayed in the dialog box.

Width, Height
Lists the available tile sizes in pixels. You can make a tile as small as 16 
by 16 pixels or as large as 128 by 128 pixels. As the size of the tile 
increases, more of the cast member is used for the tile.

This Tile Is
Controls which cast member is the basis for your tile. Click Built-In 
to indicate that the selected tile is one of the default tiles. Click the 
Cast Member radio button if you want to make a tile from a cast 
member in your movie. When you click the Cast Member radio 
button, left and right arrows appear that permit you to step through 
all the graphic cast members in your movie.

Creating tiles from a cast member

You can use tiles to make multi-colored patterns. There are eight 
default tiles that are always available for you to use, or you can create 
your own. The tiles you create are stored with the Director movie 
they were created in.

Once created, the tile appears in the patterns pop-up menu and can 
be used like any other pattern. The current foreground and 
background colors have no effect on the color of the tiles but 
switching palettes changes the color of the tiles.
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To create a tile:

1. Choose Tiles from the Paint menu.
The radio buttons determine whether the tile you select is built-
in or made from a cast member.

2. Click Cast Member.
This radio button is dimmed if all the cast members in the movie 
are 1-bit cast members. Tiles can only be made from cast 
members with color depths greater than 1 bit.

3. Click the left or right arrows to choose a cast member.
As you click the arrows, the cast members in the paint window 
appear in the left side of the Tiles dialog box.

4. Choose a size using the Width and Height pop-up menus.
As you choose a width and height for your tile, the dotted box in 
the left side of the Tiles dialog box changes shape to indicate the 
tile’s size. You can also drag the dotted box to make a tile from a 
different part of the cast member.

5. Click OK.
The tile you made is displayed in the bottom row of the pattern 
palette.

You can choose and use the tile just as you would select and use a 
pattern.
Chapter 6498



Patterns... 

Use the Patterns command to change the Custom paint patterns.

The patterns pop-up menu permits you to switch between Custom, 
Grays, Standard, and QuickDraw patterns. Only the Custom patterns 
are editable. 

To copy a built-in pattern to the custom set of patterns:

1. Choose one of the built-in sets of patterns from the pop-up 
menu.

2. Click Copy All.

3. Choose Custom from the pop-up menu.

4. Click Paste All.
The set of built-in patterns is pasted to the Custom pattern menu. 
You can now edit any one of the individual patterns.

The currently selected pattern is displayed at the left side of the dialog 
box. If you want to edit a different pattern, click the pattern in the 
pattern palette at the right side of the dialog box. Once you select the 
pattern you want to edit, you can click the pixels in the magnified 
view. Clicking a white pixel turns it black, and vice versa. The 
buttons below the editing area give you additional pattern editing 
abilities.
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You can “pick up” patterns from areas outside the Patterns dialog box 
by clicking outside the dialog box. The selected pattern changes to 
the pattern in the area you click.

The right and left arrows bounce the pattern one pixel to the right or 
to the left.

The up and down arrows bounce the pattern up or down one pixel.

The black and white square inverts the colors of the pattern (e.g., 
black becomes white and white becomes black).

If you want to edit the Grays, Standard, or QuickDraw patterns, you 
can swap entire sets of patterns in the patterns pop-up menu using the 
Copy All and Paste All buttons. When you have a set of custom 
patterns you like, click Copy All, and then click Cancel. Paste the 
patterns into the Scrapbook. Later, you can copy the patterns from 
the Scrapbook and use the Paste All button to install them again as 
custom patterns.

When you click Set the changes are reflected in the patterns pop-up 
palette in the tools and paint windows. Any custom patterns you 
create are stored in the Director 4.0 Preferences file.
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Brush Shapes...

The Brush Shapes dialog box lets you change the shape of the 
paintbrush. You can choose Brush Shapes from the Paint menu, or 
double-click the paintbrush in the paint window’s tool palette. The 
custom brushes you create are stored in the Director 4.0 Preferences 
file.

The brush shapes pop-up menu in the dialog box permits you to 
choose from the standard default brush shapes, or create your own 
brush shapes from the set of custom brush shapes. Only the custom 
brush shapes are editable.

Change a custom brush shape by clicking one of the brush shapes on 
the right. You can edit the current brush shape by clicking the 
magnified image of the brush shape. Clicking a blank pixel fills it and 
clicking a filled pixel makes it blank. 

Clicking outside the Brush Shapes dialog box picks up the shape on 
the screen at the point you click.

The right and left arrows move the brush shape one pixel to the right 
or to the left.

The up and down arrows move the brush shape up or down one 
pixel.

Click the black and white square to reverse the colors of the brush 
shape (e.g., black becomes white and white becomes black).
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You can store sets of custom brush shapes in the Scrapbook for future 
use. Click Copy All to copy the brush shapes you want to save, click 
Cancel, and then paste them into the Scrapbook. To use them again 
later, copy the brush shapes from the Scrapbook and use the Paste All 
button to paste them into the custom set of brush shapes.

Air Brushes...

The Air Brushes dialog box defines the size of the area the air brush 
covers, the size of the dots in the air brush’s spray, and the flow speed 
of the air brush’s paint. The three radio buttons at the top of the Air 
Brushes dialog box control whether the air brush sprays uniformly 
sized dots, randomly sized dots, or dots shaped like the currently 
selected paintbrush. 

˛ Tip Double-clicking the air brush in the paint window tool palette is a shortcut for 
choosing this command.
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◆ Normal

Click Normal if you want the drops sprayed by the air brush to 
be uniformly sized. 

◆ Speckle

Click Speckle to paint with randomly sized drops. 

◆ Brush Shape

Click Brush Shape to spray with drops shaped like the current 
paintbrush.

Size
To set the size of the air brush’s spray area, drag the Size scrollbar.

Dot Size
To set the size of the dots sprayed by the air brush, drag the Dot Size 
scrollbar.

Flow Speed
Controls how fast the air brush covers an area with paint. To change 
the flow, drag the Flow Speed scrollbar.
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Gradients...

The Gradient effect creates a blend of colors that you can use for 
backgrounds, highlights, shading, and special effects. Limited gradient 
effects can be created with a black and white monitor.

Background color chip
Foreground color chip

Gradient destination
color chip
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The foreground color and gradient destination color can be selected 
in the paint window with the gradient destination color chip or with 
the controls in the Gradients dialog box. When in the paint window, 
use the pop-up palette on the foreground color chip to select the 
foreground color. Pick the destination color with the pop-up palette 
at the right side of the gradient selection bar above the foreground 
and background color chips. The current foreground color is 
displayed at the left of the gradient destination color chip and the 
current destination color is displayed on the right side of the gradient 
destination color chip.

When you choose Gradients from the Paint menu you can set the 
foreground and destination colors as well as the pattern to use with 
your gradient. The Gradients dialog box also has several pop-up 
menus to control the style of your gradient fill. Each choice you 
make is immediately previewed in the Gradients dialog box.
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Direction
This pop-up menu determines the way the gradient fills an area in the 
paint window. The commands determine where the dark and light 
colors of your blend are located.

Option Example Description

Top to Bottom Puts the foreground color at the top and the 
destination color at the bottom.

Bottom to Top Puts the destination color at the top and the 
foreground color at the bottom.

Left to Right Puts the foreground color on the left and the 
destination color on the right.

Right to Left Puts the foreground color on the right and the 
destination color on the left.
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Directional Lets you determine the direction of the gradient. 
When you select this option, you will be able to set 
the direction of the gradient in the paint window with 
the paint tool used to fill the area. For example, if you 
use the paint bucket to gradient fill an area, a 
directional line appears as soon as you click the paint 
bucket in the area to be filled. Move the line without 
clicking the mouse button to establish the direction 
of the gradient. When the line is in the direction you 
want, click to fill the area with the gradient in the 
direction you specify. The length of the line has no 
effect.

Shape Burst Creates a gradient that starts at the edge of the area 
and moves toward the center following the contours 
of the area. You can use Shape Burst with all the fill 
tools, the paintbrush, and the paint bucket.

Sun Burst Starts filling at the edge of the artwork and moves in 
concentric circles to the center

Option Example Description
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Cycles 
Controls the number of times the gradient is created within one filled 
area, and whether or not the colors cycle through the palette in one 
direction only, or auto reverse at the end of one pass through the 
palette. Sharp cycles have a banded appearance, while smooth cycles 
go from foreground to destination, then back to foreground. 

Option Example Description

One Cycle Takes the gradient once through the range of colors 
you define.

Two Sharp Takes the gradient through the range of colors twice, 
from foreground to destination and from foreground 
to destination.

Two Smooth Takes the gradient from foreground to destination, 
then from destination to foreground.

Three Sharp Takes the gradient from foreground to destination 
three times.

Three Smooth Takes the gradient from foreground to destination, 
destination to foreground, foreground to destination.
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Method
The Method pop-up menu commands control whether the gradient 
is made with the pattern you select with the pattern chip pop-up 
palette in the paint window, or with a dithered pattern. You can 
clearly see the difference in methods when you have a pattern rather 
than a solid color selected.

Four Sharp Takes the gradient from foreground to destination 
four times.

Four Smooth Takes the gradient from foreground to destination, 
destination to foreground, foreground to destination, 
and destination to foreground.

Option Example Description
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Option Description

Pattern Best Colors Ignores the order of the colors in the palette 
and only uses colors that create a continuous 
blend of the foreground and destination colors.

Pattern Best Colors See 
Thru

Ignores the order of the colors in the palette 
and only uses those colors that create a 
continuous blend of the foreground and 
destination colors. White pixels in patterns 
created with this method are transparent.

Pattern Adjacent Colors Uses all the colors in the palette between the 
foreground and destination for the gradient.

Pattern Adjacent Colors 
See Thru

Uses all the colors in the palette between the 
foreground and destination for the gradient. 
White pixels in patterns created with this 
method are transparent.

Dither Best Colors Ignores the order of the colors in the palette 
and only uses colors that create a continuous 
blend from foreground to destination colors 
and blends them with a dithered pattern. 
Dithering is a technique of creating color with 
two or more colors of pixels interspersed 
together.

Dither Adjacent Colors Uses all colors between the foreground and 
destination colors and blends them with a 
dithered pattern.

Dither Two Colors Uses only the foreground and the destination 
colors and blends them with a dithered 
pattern.

Dither One Color Uses only the foreground color and fades it 
with a dithered pattern.

Standard Dither Ignores all colors between foreground and 
destination and adds several blended colors 
with a dithered pattern to create the gradient.

Multi Dither Ignores all the colors between foreground and 
destination and adds several blended colors 
with a randomized dithered pattern to create a 
smooth gradient. You can interrupt the 
drawing of this kind of dither by clicking 
anywhere in the dialog box.
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Spread
The commands in the Spread pop-up menu let you choose how to 
distribute colors between the foreground and the destination colors of 
the gradient.

Range
Range commands let you determine whether the full range of the 
gradient is created over the paint object, cast member, or the entire 
paint window. The options provide greater control over how the 
gradient is created relative to the cast member’s position on the stage 
or in the paint window.

Option Description

Equal Provides an even spacing of colors between 
the foreground and the destination colors.

More Foreground Increases the amount of the foreground color 
in the gradient.

More Middle Increases the amount of the middle color in 
the gradient.

More Destination Increases the amount of the destination color 
in the gradient.

Option Description

Paint Object Paints the full gradient as the fill or brush 
stroke of the object, regardless of the object’s 
location in the paint window.

Cast Member Paints the full gradient with respect to the size 
of the cast member.

Window Paints a full gradient only if the object is the 
length or width of the entire window, 
otherwise it paints a partial gradient 
corresponding to the object’s location in the 
window.
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Paint Window Options... 

The Paint Window Options command allows you to modify the 
settings of a number of tools and drawing methods in the paint 
window. All of the options you choose are saved in the Director 4.0 
Preferences file.

Display

◆ One Cast Member

Permits you to see one cast member at a time in the paint 
window.

◆ 50 Cast Members

Permits you to see multiple cast members at a time. Each cast 
member occupies an individual easel in the paint window. The 
easels can be resized by dragging the handle in the lower right 
corner of the easel. 
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Brushes

◆ Color Sticks to Brush Tools

If checked, the last color used with a tool stays selected the next 
time you use the paintbrush or air brush.

◆ Ink Effect Sticks to Tool 

If checked, the last ink used with a tool stays selected the next 
time you use the paintbrush or air brush.

◆ Smooth Cycle Brush 

Controls the way colors cycle when you draw with cycling ink. 
If checked, this option produces a cycle that goes from the 
foreground to the destination color and then destination to 
foreground. If not checked, colors cycle from foreground to 
destination, then repeat foreground to destination.
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Effects
These settings apply to the smooth, lighten, darken, and cycle effects.

◆ Use Best Colors

Use Best Colors ignores the order of the colors in the palette and 
produces a continuous blend of the foreground and destination 
colors. 

◆ Use Adjacent Colors

Use Adjacent Colors uses all the colors in the palette between the 
foreground and destination colors when using smooth, lighten, 
darken, or cycle effects.

◆ Lighten & Darken Rate 

Sets the rate at which artwork changes when you use the Darken 
or Lighten effect in the paint window or when you choose 
Darken or Lighten from the Effects menu. You may have to 
experiment to find the best setting.

◆ Blend Amount

Blend Amount sets the opacity of the selected color when using 
the Blend effect in the paint window. Use the scrollbar to vary 
the blend value between 0 and 100 percent.

Other Line Width
Other Line Width allows you to set a thicker line width than the 
widths available in the paint window. You can change the line’s 
width, as measured in pixels, with the scroll bar. The width you set 
will be the width that appears when you draw a line after selecting 
Other in the line width selector in the tool palette.
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Effects menu

The Effects menu is available when there is a selection in the paint 
window. It contains commands to transform your artwork in various 
ways. The full range of Effects menu commands is available to you 
when you use the selection rectangle to select the artwork. Not all 
the Effects menu commands are available to you when you select the 
artwork with the lasso.

Invert Colors

The Invert Colors command reverses the colors of the selected area in 
the paint window. To see what the reverse colors are, open the color 
palettes window, select all the colors in the palette, and choose 
Reverse Colors from the Palette menu. You’ll see that the effect is an 
upside-down mirror image of the palette. If you are working in black 
and white, Invert Colors changes black to white and vice versa.

Flip Horizontal

Turns the selected area in the paint window horizontally from right 
to left. 

Flip Vertical

Turns the selected area in the paint window vertically from top to 
bottom.
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Trace Edges 

Trace Edges creates an outline around the edges of the selected 
artwork. The outline is the same color as the selected line, if the line 
is a solid color. If the original line is multicolored, an outline is 
created for each section of the line. You can add multiple outlines by 
choosing Trace Edges or Repeat Effect repeatedly.

Fill

The Fill command fills a selected area with the current foreground 
color and pattern.

Darken

Reduces the brightness of the selected artwork. It is the same as 
decreasing the brightness in the color palettes window or in the 
Macintosh Color Picker.

Lighten

Increases the brightness of anything in the selection rectangle. It is 
equivalent to increasing the brightness in the color palettes window 
or in the Macintosh Color Picker.

Smooth

Softens the edges of the selected artwork by adding pixels of blended 
color to the artwork’s edges.
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Switch Colors 

Switch Colors changes each pixel that is the currently selected 
foreground color to the currently selected destination color.

Note This command only works for images whose color depth is 8 bits or less.

Rotate Left

Rotates the selected area in the paint window 90 degrees 
counterclockwise.

Rotate Right

Rotates the selected area in the paint window 90 degrees clockwise.

Free Rotate

Allows you to rotate the selected area in the paint window any 
number of degrees clockwise or counterclockwise. When you choose 
Free Rotate, handles appear at the corners of the selection rectangle. 
To rotate the artwork, drag any handle in the desired direction.

The Free Rotate command is one of four special effects you can apply 
to artwork selected with the selection rectangle in the paint window. 
The other special effects are Perspective, Slant, and Distort. When 
you choose one of the special effects after selecting the artwork, 
handles appear at each corner of the selection. Dragging the handle 
produces the desired effect.
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Perspective 

Perspective stretches the selected artwork to give it a perspective 
effect. When you choose Perspective, handles appear at the corners of 
the selection rectangle. Drag one or more handles to create the effect 
you want. For example, you can bring the two top handles closer 
together to create the illusion of linear perspective.

˛ Tip To make artwork appear to be vanishing into the distance, choose Perspective 
and move the handles on one side of your selection together and the handles on 
the opposite side of your selection apart.

Slant 

The Slant command skews the selected artwork. When you choose 
Slant, handles appear at the corners of the selection rectangle. 
Dragging a handle in the desired direction moves the opposing corner 
an equal amount in the same direction, maintaining a parallelogram 
shape.

Distort

When you choose Distort, handles appear at the corners of the 
selection rectangle. Each corner can be dragged in any direction 
independent of the other corners. When you release the mouse 
button, the selected artwork assumes the shape that you have created.
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Auto Distort... 

The Auto Distort command automatically generates in-between 
positions for any cast member that is free rotated, made into a 
perspective, slanted, distorted, or stretched. After artwork has been 
altered with one of these five effects, and before you deselect the 
artwork, choose Auto Distort, and type the number of in-between 
cast members in the Create New Cast Members field in the Auto 
Distort dialog box. The new cast members are placed in the next 
available cast member positions.

For a rotated bitmap image, Auto Distort uses the center of the image 
as the rotation point. Consequently, you will have to use the paint 
window’s registration tool to reset the registration point of each 
in-betweened cast member created by the Auto-Distort operation. 
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To reset the registration point:

1. Before you rotate the image, create a temporary dot in the 
image at the desired rotation point. 
Make this dot a unique color so you can change it to the proper 
color later. 

2. Select the image and rotate it using the appropriate rotate 
command on the Effects menu. 

3. Choose the Auto Distort command and specify the number 
of in-between cast members. 

4. Use the registration tool to click the colored dot within 
each cast member in the rotation sequence. 

5. Use the Switch Colors command to change the colored dot 
to the appropriate color.

˛ Tip Use the Auto Distort command in conjunction with Rotate Left, Rotate 
Right, Free Rotate, Perspective, Slant, or Distort to quickly create a number 
of cast members in between the artwork you selected and the artwork that has 
been changed. Auto Distort also works with artwork that is stretched or 
squeezed in the paint window.

Repeat Effect 

Repeats the last command chosen from the Effects menu for the 
selected area. It’s a shortcut for choosing that command again.

˛ Tip Command-Y is the keyboard shortcut for this command.
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The Lingo menu

The Lingo menu appears when the message or script windows 
become the active window. This menu displays the complete set of 
Lingo commands that you can use to create scripts for your movie. 

Use the Lingo menu to enter any Lingo command into a script. This 
saves you from typing the command and also eliminates typing errors. 
Simply choose the command you want from the appropriate 
submenu. The command is entered in the script at the insertion 
point. For a complete description of the Lingo menu, refer to the 
Using Lingo manual, or use the help pointer to display an explanation 
for a particular command.
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Appendix A

Director Shortcuts

In addition to the keyboard shortcuts listed in the menus, 
Director has many additional shortcuts.
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Menu shortcuts

Apple menu

File menu

Command Shortcut

Help Pointer Command-?, Command-/, or pressing
Shift-Option and clicking a menu command

Command Shortcut

New Command-N

Open Command-O

Close Window Command-W

Close All Windows Command-Option-W 
(or Option—Close Window)

Save Command-S

Save and Compact Command-Option-S

Save As Command-Shift-S

Import Command-J

Export Command-Shift-E

Movie Info Command-U

Preferences Command-Option-U

Print Command-Option-P

Quit Command-Q
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Edit menu

Command Shortcut

Undo Command-Z

Cut Command-X

Copy Command-C

Paste Command-V

Clear Delete

Select All Command-A

Play Command-P or Enter (toggles between Play 
and Stop) or keypad plus(+)

Shift-Enter clears the stage and plays

Stop Command-. or keypad Enter or 2, 5, 
or . (period)

Rewind Command-R or keypad 0

Step Backward Command-left arrow or keypad 1 or 4

Step Forward Command-right arrow or keypad 3 or 6

Disable Sounds Command-~ or Command-` or keypad 7

Loop Command-L or keypad 8

Selected Frames Only Command-\ or Command-|
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Window menu

Cast menu

Command Shortcut

Stage Command-1

Control Panel Command-2

Cast Command-3 or Command-up arrow

Score Command-4

Paint Command-5

Text Command-6

Tools Command-7

Color Palettes Command-8

Digital Video Command-9

Script Command-0

Message Command-M

Tweak Command-Shift-T

Markers Command-Shift-M

Command Shortcut

Cast Member Info Command-I

Open Script Command-tick mark (’)

Edit Cast Member Double-click or Command-down arrow

Launch External Editor Command-comma (,)

Reselect external editor 
and launch

Command-Option-comma (,)

Paste as PICT Command-Shift-Y

Duplicate Cast Member Command-D

Find Cast Members Command-semicolon (;)
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Score menu

Text menu

Command Shortcut

Sprite Info Command-K

Delete Sprites Command-Delete

Set Sprite Blend Command-Option-B

Paste Relative Command-Shift-V

Insert Frame Command-]

Delete Frame Command-[

In-Between Linear Command-B

In-Between Special Command-Shift-B

Switch Cast Members Command-E

Command Shortcut

Find/Change Command-F

Find Again Command-G

Find Selection Command-H

Change Again Command-T

Find Handler Command-colon (:)

Comment Command-greater than (>)

Uncomment Command-less than (<)

Recompile Script Command-Shift-R 

Recompile All Scripts Command-Option-R
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Paint menu

Effects menu

Command Shortcut 

Show/Hide Paint Tools Command-Shift-J

Show/Hide Rulers Command-Shift-K

Zoom In Command-+ (and Command-=)

Zoom Out Command-- (and Command-_)

Command Shortcut

Repeat Effect Command-Y
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Window shortcuts

Contents of stage

When there is a sprite selected on the stage, the arrow keys nudge. 
Exceptions (i.e., windows that grab the arrow keys first) are within a 
text selection in the paint, text,  markers, and script windows.

Action Shortcut

Open cast member 
editor

Double-click sprite

Inks pop-up Command-click

Toggle record light on 
and off

Option-click sprite

Real-time record Control-spacebar drag cast member

Display cast member 
info

Control-click sprite

Display sprite script Control-Option-click sprite

Change contents of 
stage to black

Keypad - (minus)

Invert everything on 
stage

Keypad /

Cursor display on/off Keypad =

Previous marker 
comment

Keypad: Option-1 or Option-4

Next marker comment Keypad: Option-3 or Option-6
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Cast window/Cast editor windows

Action Shortcut

Open cast member 
editor

Double-click a paint, text, palette or script cast 
member or Command-Shift-down arrow

Switch selected cast 
member with score 
selection

Option-double-click thumbnail

Display cast member 
info

Control-click cast thumbnail

Display cast member 
script 

Control-Option-click cast thumbnail

Open script in new 
window

Option-click Script button or 
Option-Open Script command

Place button Command-Shift-L (places in center of stage)

Center multiple cast 
members on stage over 
time

Command-Option--L 

Add button (new cast 
member)

Command-Shift-A 

Left arrow (previous cast 
member)

Command-Shift-left arrow

Right arrow (next cast 
member)

Command-Shift-right arrow

Scroll up or down one 
window

Page Up, Page Down

Scroll to top left of cast 
window

Home

Scroll to show last 
occupied cast member

End

Scroll to a cast member Type cast number. Press Return key to scroll 
immediately. Delete key deletes last digit 
typed.

Scroll to a selected cast 
member

Double-click cast number

Resize digital video 
window to larger size

Double-click zoom box
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Score window

Action Shortcut

Duplicate selection of 
cells

Option-drag

Open cast editor for 
selected sprite

Double-click cast thumbnail

Select entire range of a 
cast member

Double-click cell with a sprite in it

Select channel Double-click channel number

Select multiple channels Double-click channel number and drag up or 
down

Toggle record light Option-click channel number

Move playback head to 
end of movie

Tab

Move playback head to 
first frame

Option-Tab

Move playback head to 
beginning/end of 
selection

Command-Shift-left/right arrow

Open markers window Double-click any marker

Open appropriate Set 
dialog box

Double-click tempo, palette, or transition 
channel

Open Set Sound dialog 
box

Select one or more cells in a sound channel 
and then Command-double-click in the 
selected sound cells.l

Go to next marker 
comment (or jump 10 
frames)

Command-Option-right arrow

Previous marker 
comment (or back 10 
frames)

Command-Option-left arrow

Shuffle Backward Command-Shift-Up arrow

Shuffle Forward Command-Shift-Down arrow

Temporarily turn off/on 
drag and drop

Press Spacebar
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Paint window

Action Shortcut

Undo  ~

Next/previous cast 
member

Keypad left/right arrow keys

Turn selected tool into 
foreground eyedropper

Control key, while pressed

Turn selected tool into 
background eyedropper

Shift-Control key, while pressed

Turn selected tool into 
destination eyedropper

Control-Option key, while pressed

Turn selected tool into 
hand tool

Spacebar, while pressed

Nudge selection 
rectangle or lasso 
selection

Keypad arrows with selection rectangle or 
lasso 

Change airbrush size Keypad up/down arrows with airbrush 
selected

Change airbrush flow Keypad left/right arrows with airbrush selected

Change foreground 
color

Keypad up/down arrows, all other tools

Change background 
color

Shift-keypad up/down arrows, all other tools

Change destination 
color

Option-keypad up/down arrows, all other tools

Draw border with 
current pattern

Option-shape or line tools

Select background color Shift-eyedropper

Select destination color Option-eyedropper

Toggle between 
custom/grayscale 
patterns

Option-click pattern

Polygon lasso Option-lasso
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Duplicate selection Option-drag

Stretch Command-drag

Draw with background 
color

Option-pencil tool

Open Gradients dialog 
box and set ink to 
gradient

Double-click ellipse, paintbrush, rectangle, 
paint bucket, or polygon tool

Open Air Brushes dialog 
box

Double-click airbrush

Clear visible part of 
window

Double-click eraser

Open color palettes 
window

Double-click foreground, background, or 
destination color chip

Open Patterns dialog 
box

Double-click pattern chip

Open Brush Shapes 
dialog box

Double-click paintbrush

Open Paint Window 
Options

Double-click line width selector

Open Transform Bitmap 
dialog box

Double-click color resolution indicator

Toggle Zoom in/Zoom 
out

Command-click in window or double-click 
pencil tool

Action Shortcut
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Color palettes window

Markers window

Message window

Action Shortcut

Open Set Color dialog 
box

Double-click a color

Action Shortcut

Move cursor to next or 
previous comment

Command-Option-left/right arrow

Action Shortcut

Go to top/bottom of 
window

Command-up/down arrow

Delete contents of 
window

Command-Shift-Delete
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Glossary

AIFF An acronym for Audio Interchange File Format. A standard for 
exchanging sound information between applications.

anti-aliasing Removes or reduces edge distortions in an image by adding and 
subtracting pixels to enhance the appearance of the image.

background Objects that appear to be behind other objects on the stage. Objects 
in channels closer to the top of the score are said to be in the 
background, since they appear behind objects closer to the bottom of 
the score.

background color The background color is the secondary color that appears in a pattern 
and the gradient destination color for use with gradients. The 
background color is set using the background color chip in the paint 
window. 

bit depth The number of bits per pixel a video card is capable of displaying. 
Director supports 1-, 2-, 4-, 8-, 16-, 24-, and 32-bit color 
environments.

bounding box The rectangular border around the image of a sprite on the stage.

cast The cast is a multimedia database of graphics, film loops, sounds, text, 
palettes, scripts, buttons, shapes, movies, and digital video movies that 
are stored in the cast window.

cast member An individual graphic, text, film loop, movie, sound, palette, script, 
button, shape, or digital video movie stored in the cast window. 

cast member number The number that identifies a cast member in the cast window.

cell The smallest unit in the score window. Each cell contains 
information about one cast member at one point in time, called a 
sprite. See also sprite.

channel  A row in the score. Each channel holds one  sprite or one special 
effect. The score window has 48 channels for graphics, 5 effects 
channels for palettes, transitions, tempos, and sounds, and a script 
channel for creating Lingo scripts.
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color cycling A color effect that steps through a defined range of colors. When 
color cycling is applied to artwork, pixels that are the same color as 
the colors in the defined range change colors as the defined range 
cycles.

color depth The number of colors a cast member can display. 

color resolution Similar to color depth, color resolution refers to the number of colors 
a monitor can display at one time. Depending on the video display 
card you’re using, your monitor can display 1-bit color (black and 
white), 4-bit color (16 colors), 8-bit color (256 colors), 24-bit color 
(16.7 million colors), and 32-bit color (16.7 million colors and 8-bits 
of special effects).

common palette A palette that contains a representative sample of colors that permits 
artwork created with a variety of palettes to be displayed in colors that 
are as similar to the original colors as possible.

current frame The frame which is currently displayed on the stage. The current 
frame number is shown in the frame counter in the control panel. In 
the score, the playback head points to the current frame.

current palette The palette that controls the color of the artwork on the stage in the 
current frame.

digital video A generic term that refers to QuickTime on a Macintosh and Video 
for Windows on a PC.

dithering The process of changing a range of grey scales to patterns of black and 
white.

editable In the score, controls whether or not users can edit a text sprite on 
the stage during playback.

foreground Artwork that appears in front of other artwork on the stage is said to 
be in the foreground. In the score window, artwork in channels 
closer to the bottom of the score appears in front of artwork in 
channels closer to the top of the score.

foreground color In the paint window, the foreground color is the color that you paint 
with when the pattern is solid and the ink is Normal. The foreground 
color is set using the foreground color chip.
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frame A frame of animation is a snapshot of your movie. It includes the 
artwork and effects that appear in one column of the score. One 
movie might be hundreds or thousands of frames in length. The 
frames are numbered across the top of the score, starting at 1. Also see 
current frame.

film loop A sequence of cast members that you use as a single cast member. 
Like other cast members, a film loop resides in the cast window and 
can be treated as one cast member, even though it’s made of one or 
more sequences of cast members. You can in-between a film loop 
just as you would an individual cast member.

In-Between A feature of Macromedia Director which simplifies the animator’s 
task by filling in the frames between the beginning location and the 
end location of an animation sequence. In-Between is also used for 
extending held artwork, and sliding (and stretching) artwork between 
the points. This feature is available in the score menu.

inks Permit you to control the appearance of artwork. Inks can range from 
transparent to opaque. Inks also permit you to reverse white and 
black, create ghost images, change solid black regions to any pattern, 
and create other effects. Score window inks determine how artwork 
on the stage interacts with artwork in the foreground or background.

key frames Frames that mark key positions in an animated sequence. The 
positions of the cast members that determine the path of the in-
betweened cast members when animating with In-Between or In-
Between Special. The In-Between command fills the positions 
between the key frames with the in-between positions of the cast 
member.

mask An opaque image used to block the view in one area, but with holes 
that allow the image to be viewed in other areas. An example is a 
mask of a car with holes for the windows, which allows you to view 
the background through the windows.

matte An ink that allows artwork to appear without the white bounding 
box around it.

MIDI An interface for the synchronization and control of MIDI musical 
instruments and other devices. It is an acronym for Musical 
Instrument Digital Interface.
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moveable In the score, controls whether or not users can reposition a sprite on 
the stage during playback.

movie  A Macromedia Director animation. The terms file, document, 
movie and animation are loosely interchangeable. 

multiplane Traditional term for animation stand–based technology. The channels 
in the score can give you a 2 1/2 D effect by enabling artwork to 
move in front of and behind other artwork. This effect is called a 
multiplane effect.

PAL Phase Alteration Line System, the system of broadcast video display 
used in Europe.

palette A subset of all the possible colors that the Macintosh can display. 
Palettes are used to control the colors of artwork on the screen.

pixel Short for picture element, a pixel is one dot of a screen image. On the 
Macintosh it is 1/72 of an inch square.

playback head The small black square at the top of the score window that indicates 
the frame that is currently seen on the stage.

protected movie A movie in which Lingo source code and cast thumbnail images have 
been removed. This prevents the movie from being opened or 
edited, but does not affect the movie’s scripts. A protected movie’s 
icon looks like this:

A protected movie can only be run under Lingo control from a 
projector. You must use Lingo to “go to” or “play” the protected 
movie.

projector A play-only version of a Director movie, that can be played on any 
computer. To play a projector file, double-click it.

real-time recording Recording animation by dragging a selected cast member on the stage 
while pressing the Control and Spacebar keys.
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record light The indicator light that appears in a channel when a cast member is 
first dragged to the stage. When the record light is on, the cast 
member is recorded to the next frame when the movie is stepped 
forward.

registration point A fixed reference point used to align a series of cast members for 
animation.

RGB video A video signal or monitor that uses three separate signals for the red, 
green, and blue primary colors.

scene A sequence of action on stage. You can clear the stage of all action by 
selecting everything in the score and deleting it. This leaves the 
contents of the cast window unchanged.

score The contents of the 48 animation channels and 5 effects channels in 
the score window constitute a movie’s score. The score window is a 
notational editor for the movie, displaying animation information left 
to right over time.

trails In the score, controls whether or not a sprite leaves trails as it moves 
across the stage during playback.

sprite One instance of a cast member on the stage at one point in time. 
Changes you make to a sprite in the score or on the stage do not 
affect its parent cast member in the cast window.

stage The window in which animation appears. The contents of the stage 
at any point in time is determined by the current frame in the score.

step recording Lets you create frame-by-frame animation in a channel. To activate 
step recording in a channel, Option-click the channel number in the 
score where you want recording to occur.

synchronization The relative positioning of sound and pictures so that they are timed 
together.

tempo Controls the speed of animation. Director plays a movie at the tempo 
you’ve set until it encounters a new tempo in the tempo channel.

tile A multicolored pattern that’s a duplicate of a small rectangular section 
of an existing cast member.

transition A visual effect that occurs between two different frames. 
Glossary 539



tweak Tweak means to move a small distance. The tweak window permits 
you to move selected cast members on the stage a distance and 
direction you specify, measured in pixels.

tween From the word “between.” In traditional cel animation, “tweening” 
is the creation of artwork between key frames that changes shape and 
position (see also In-Between). 
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Index
SYMBOLS
+ (plus button). See Add button
+ (plus key), Play/Stop commands toggle, 391
+ (plus sign), indicating cast member scripts, 480
-- (double hyphen)

Lingo comment symbol, 487
no recorded frame duration symbol, 248, 249, 

396
... (dotted lines), trails feature symbol, 288
✔ (checkmark), open window symbol, 397

NUMERALS
0 option (script pop-up menu), 277
1-bit cast members

colorizing, 52, 55-56, 316, 322, 330
See also cast members

50 Cast Members option (Paint Window 
Options dialog box), 512

A
About Director command (Apple menu), 346-47
Accelerate over first n Frames (Ease-In) option 

(In-Between Special dialog box), 457
accelerating

animated sequences, 108-10, 457
film loops, 137
movies, 13
sprites, 457
See also performance (of movies)

Acceleration options (In-Between Special dialog 
box), 457

Accelerator, 13, 354
actions

shortcuts, 529-34
undoing, 389

active palette. See current palette

Actual display (control panel), 248-49
illustrated, 247, 248, 249
See also playback speed

Actual mode button, 248
Add All button (Create Projector dialog box), 

376
Add button (Create Projector dialog box), 376
Add button

adding cast members, 295, 300, 324, 336-37
illustrated, 295, 300, 323, 336

Add ink (score window), 279, 282
Add Pin ink (score window), 279, 282
Adjust Pre-4.0 Shared Cast References checkbox 

(Update Movies dialog box), 375
Adjust to Fit option (Text Cast Member Info 

dialog box), 421
advancing movies, 247
After Frame One option (load cast pop-up 

menu), 380
AIFF standard, defined, 535
air brush (paint window), 302, 307-8, 315, 316, 

502-3
illustrated, 301, 307

air brush pop-up menu (paint window), 308
illustrated, 308

Air Brushes command (Paint menu), 502-3
Air Brushes dialog box, 502-3

illustrated, 502
opening, 307, 502

Align Bitmaps command (Cast menu), 313, 434
aligning

cast members, 434
registration points, 434

Alignment settings (Text menu), 481
Alignment submenu (Text menu), 482
All Colors Available option (Reserve Colors 

dialog box), 490
All Scripts button (Find Handler dialog box), 487
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Allow Outdated Lingo checkbox (Movie Info 
dialog box), 379

Anim Scrapbook file, 351
Animate in Background checkbox (Preferences 

dialog box), 384
Animate in Background checkbox (Projector 

Options dialog box), 377
Animate Title checkbox (Bullet Chart auto 

animate dialog box), 469
animated sequences

accelerating/decelerating, 108-10, 457
incorporating into movies, 139, 158-60
linking, 102-3
moving to a single channel, 99-101, 115, 118, 

458-59
placing in the score, 101-2
selecting, 134
shifting, 124-25

animation channels. See sprite channels
animation compressor, compressing QuickTime 

movies, 371
Animation Controls fields (auto animate dialog 

boxes), 463-64, 465, 468-69, 472, 
473-74, 476

animations
auto animate effects, 86, 89, 461-76
basic techniques, 86-131
clearing, 391
creating, 19-20, 40, 62, 85-160

with Cast to Time, 101-2, 434
with Space to Time, 99-101

cutting and pasting, 130-31
distributing, 140
exporting as QuickTime movies, 140-46
frame-by-frame animation, 86, 312-13
in-betweening, 20, 86, 104-21, 156-57, 

456-58, 537, 540

animations (continued)
moving

between movies, 130-31
to the upper left corner of the stage, 142

operations (listed), 87-88
palette transitions and, 201, 450-51
real-time recording, 20, 86, 90-92, 135, 291, 

538
selecting locations for, 88
setting ending points, 106-8
setting starting points, 88
speed factors, 163
step-recording, 20, 93-98, 258, 261, 290, 539
text for, 328
types, 85
See also animated sequences; Auto Animate 

command (Score menu); auto animate 
effects; frame-by-frame animation; 
in-betweening; real-time recording; 
step-recording

Anti-Alias Text and Graphics checkbox (Movie 
Info dialog box), 379

anti-aliasing, 268, 285-86, 379, 535
Apple Events, and playing projectors, 377
Apple menu, 346

command shortcuts, 524
commands, 346-51
illustrated, 346

applications
for creating cast members, 22
launching, 10, 18, 425-26

Apply to Film Loop checkbox (In-Between 
Special dialog box), 458

arc tool (paint window), 302, 312
illustrated, 301, 312

arcs, drawing, 312
arrow (color palettes window)

illustrated, 332
showing the pointer, 333
Index542



arrow keys, 529
moving sprites using, 82

artwork
transferring into Director, 350
See also artwork (paint window)

artwork (paint window)
aligning and sizing, 295-96, 434
black and white, colorizing, 316
blurring, 317
darkening/lightening, 516
disguising, 315
distorting, 518-20
dragging, 306
effects, 515-20
erasing, 310, 315
filling enclosed areas, 307
magnifying the view, 309
masking, 315
painting, 307-9, 318
perspective, 518
revealing, 315
rotating, 517
selecting, 303-6
skewing, 518
smearing, 317
smoothing, 516
smudging, 317
spraying colors and patterns, 307-8
tracing edges around, 516
See also cast members, colors; drawing; Paint 

menu; paint tools
Auto Animate command (Score menu), 13, 19, 89, 

461-76
auto animate effects, 86, 89, 461-76

animation controls, 463-64, 465, 468-69, 472, 
473-74, 476

Banner, 462-63
Bar Chart, 463-66
Bullet Chart, 466-69
Credits, 470-72
Index
auto animate (continued)
customizing, 89-90
previewing, 463, 466, 469, 472, 474, 476
repeating, 463, 472, 474, 476
Text, 472-74
Zoom Text, 474-76

auto animate feature. See Auto Animate 
command (Score menu); auto animate 
effects

Auto Distort command (Effects menu), 19, 
45-47, 519-20

Auto Distort dialog box, 519-20
creating in-between cast members, 47, 519-20
illustrated, 519

Auto Hilite checkbox (Bitmap Cast Member Info 
dialog box), 404

Auto Hilite feature, for bitmap cast members, 404
Auto Reverse checkbox (Set Palette dialog 

box), 450
Auto Tab checkbox (Text Cast Member Info 

dialog box), 421
Auto Transform command (Director 3.1). See 

Auto Distort command (Effects menu)

B
Back button (help window), 349
background color, 299, 319, 535

blending, with the foreground color, 316
of the stage, changing, 249

background color chip (paint window), 319-20
illustrated, 293, 319

background color chip (tools window)
illustrated, 328
setting colors using, 329-30

background priority of sprites. See foreground 
priority of sprites

background sprites, illustrated, 105
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Background Transparent ink (score window), 
279, 281

backgrounds, 535
creating from cast members, 60-61
making transparent, 315

Banner auto animate dialog box, 462-63
Banner effect, 462-63
Bar Chart auto animate dialog box, 464-66

illustrated, 464
Bar Chart effect, 463-66

illustrated, 463
Bar Labels options (Bar Chart auto animate dialog 

box), 465
Bar Style field (Bar Chart auto animate dialog 

box), 465
Before Frame One option (load cast pop-up 

menu), 380
bit depth, 535. See also color depth
Bitmap Cast Member Info dialog box, 403-5
bitmap cast members, 403-5

Auto Hilite option, 404
color depth, 51, 404, 430-31
coloring, 40, 56-59
converting PICT cast members to, 428-29
creating, 22, 24-33, 295
erasing, 310, 404
naming, 403
registration points, 313, 434
rotated, 517, 519
See also 1-bit cast members; cast members

bitmapped graphics, 18
See also bitmap cast members

bitmapped text, 33, 34, 307
changing, 35, 307
converting QuickDraw text to, 34, 217, 219, 

428-29
creating, 23, 307
drop shadows, 482
registration points, 313, 434
See also text

Bkgnd Transparent ink (score window), 279, 281
black and white cast members

colorizing, 52, 55-56, 316, 322, 330
See also cast members

black and white interface, and performance, 384
Black and White User Interface checkbox 

(Preferences dialog box), 384
blank cells, filling in. See in-betweening
blank frames, adding, 124
Blend Amount option (Paint Window Options 

dialog box), 514
Blend Colors command (Palette menu), 491
blend display notation (in the score), 270
Blend ink (paint window), 56, 314, 316
Blend ink (score window), 279, 282
blend value, of sprites, 445-46
blending colors, 282, 316, 491
blurring artwork, 317
bold italic type as used in this manual, 3
Bookmarks button (help window), 349
bookmarks (in the help system), 349
Border settings (Text menu), 481
Border submenu (Text menu), 482
borders, 482

selecting, 330
See also bounding boxes

Bottom to Top option (Gradients dialog 
box), 506

bounding boxes, 280, 281, 535
eliminating, 151, 280

Box Shadow settings (Text menu), 481
Box Shadow submenu (Text menu), 482
branching (in movies). See interactivity
brightness (of colors), 334

color palettes window control 
(illustrated), 332

Color Picker controls, 195
sorting colors by, 493

Brush Shape option (Air Brushes dialog box), 503
Brush Shapes command (Paint menu), 501-2
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Brush Shapes dialog box, 501-2
illustrated, 501

brush shapes pop-up menu, 501
Brushes options (Paint Window Options dialog 

box), 513
Built In option (Tiles dialog box), 497
built-in patterns. See patterns
Bullet Chart auto animate dialog box, 467-69
Bullet Chart effect, 466-69

illustrated, 466
Bullet Delay slider (Bullet Chart auto animate 

dialog box), 469
Bullet Style button (Bullet Chart auto animate 

dialog box), 468
Bullet Type field (Bullet Chart auto animate dialog 

box), 468
Burn Scene command (Director 3.1), 14
Button Cast Member Info dialog box, 405-6
button cast members, 405-6

creating, 22, 217-21
See also cast members

Button tool (standard) (tools window), 329
illustrated, 215, 216

button tools (tools window), 329
illustrated, 328

buttons
creating, 22, 210, 215-16, 329
displaying types, 405
as hypertext links

creating, 217-21
creating text for, 217, 219
script scenarios, 226-39
script types, 222-25
typical scripts, 216, 218, 220-21

radio, 215-16
standard, 215-16
See also button cast members

by Name option (Find Handler dialog box), 487
Index
By Name option (Sort Cast Members dialog 
box), 439

By Order in Cast option (Sort Cast Members 
dialog box), 439

By Order in Score option (Sort Cast Members 
dialog box), 439

by Order option (Find Handler dialog box), 487
By Size option (Sort Cast Members dialog box), 

439
By Type option (Sort Cast Members dialog box), 

439

C
Cancel button (Find/Change dialog box), 485
cast, 250

cleaning up, 70-71
defined, 535
remapping, 433

to a single palette, 186-87, 379
sorting, 70-71, 438-39
See also cast members; shared casts

Cast and Score display (Director dialog box), 347
Cast command (Window menu), 398
cast display notation (in the score), 270
cast editor windows, action shortcuts, 530
Cast ID Style field (Cast Window Options dialog 

box), 441
cast member buttons, 253-54, 300, 336

illustrated, 293
Cast Member field (Bitmap Cast Member Info 

dialog box), 403
Cast Member field (Multiple Cast Member Info 

dialog box), 423
Cast Member field (Palette Cast Member Info 

dialog box), 415
Cast Member field (PICT Cast Member dialog 

box), 416
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Cast Member field (Script Cast Member Info 
dialog box), 417

Cast Member Info command (Cast menu), 
402-24

Cast Member Info dialog box, 402-24
for bitmap cast members, 403-5

illustrated, 403
for button cast members, 405-6

illustrated, 405
for digital video cast members, 13, 372, 

407-11
settings for cropping digital video movies, 

153, 408
illustrated, 407

displaying, 51, 254
for film loop cast members, 411-12

illustrated, 411
for linked Director movies, 413-14

illustrated, 413
for multiple cast members, 423-24

illustrated, 423
for palette cast members, 415

illustrated, 415
for PICT cast members, 416-17

illustrated, 416
renaming cast members, 43
for script cast members, 417-18

illustrated, 417
for shape cast members, 418

illustrated, 418
for sound cast members, 419-20

illustrated, 419
for text cast members, 420-22

illustrated, 420
cast member names, 64-65

in the cast window, 255
illustrated, 253

cast member numbers, 64
in the cast window, 255

illustrated, 253
defined, 535
Index546
Cast Member option (Gradients dialog box), 511
cast member position numbers, illustrated, 250
Cast Member option (Tiles dialog box), 497
cast member scripts, 223-24

go to frame "name", 231-32
play frame "name", 234-35
versus sprite scripts, 225, 231

cast member types, 22-23
as indicated in the score (illustrated), 269

cast members, 10, 17, 21, 76, 224, 338
adding, 10, 76, 78-80
aligning, 434
animating, 40, 62
anti-aliasing, 285-86, 379
button, 22
channels designated for (table), 262
clearing, 11, 68-69, 306
color depth, 48, 51, 430-31

changing, 40, 47, 51-55, 322
coloring, 40, 56-59, 402
copying, 306, 389, 390
creating, 22-39
creating a sequence of, 43-47
creating backgrounds from, 60-61
creating tiles from, 497-98
cutting, 389, 390
defined, 21, 535
deleting, 11, 68-69, 306
double-clicking, 251
dragging using the Option key, 78, 259-60, 

261-62, 434
duplicating, 43, 186, 435
editing, 17-18, 40-61, 264, 429-33
exporting as PICT files, 60-61, 368
and film loops, 134
finding, 65-68, 187, 436-37
graphic, 18
ID display format, 441
as identified in the score, 268, 270



cast members (continued)
identifying, 67-69, 250
illustrated, 16, 17
importing, 433
in-between, 44-47
lining up for animation, 312-13
linked, 11, 337, 357
as linked to palettes, 181
mapping to different palettes, 67
memory use display, 346, 347
moving within the cast window, 10, 253, 256
multiple, 78, 260, 423-24, 435
naming, 64-65, 403, 415, 416, 417
navigating to, 254
operations (listed), 41-42
orientation, changing, 46
palette, 260
with palettes, importing, 358, 433
pasting, 389, 390
PICT, 23
placing

in the score, 18, 80, 259, 260, 261-62, 434
on the stage, 18, 78-80, 224, 253, 257-60

positioning
in the paint window, 306
in the score, 19
on the stage, 19, 113-14

pre-loading into memory, 380
priority levels, 11
QuickTime, 11
referring to, 64
renaming, 43, 65
revealing, 31-33
scaling, 303, 306
scrolling to, 255
selecting, 10, 250
shape of, changing, 46
shared, 252, 438

See also shared casts
Index
cast members (continued)
sorting, 70-71, 438-39
sound, 23, 260
stationary, adding, 104-6
stretching or squeezing, 45, 111, 306
switching, 461

while step-recording, 97-98
transparent, 219-20
type icons (illustrated), 250, 251
types, 22-23, 269, 441
unused, finding and deleting, 11, 68-69
versus sprites, 78, 224
viewing, 437, 440
See also 1-bit cast members; animated 

sequences; bitmap cast members; black 
and white cast members; digital video 
movies; film loops; scripts; shapes; 
shared casts; sprites; text cast members

Cast menu, 402
command shortcuts, 526
commands, 402-42
illustrated, 402

Cast Number checkbox (Score Window Options 
dialog box), 480

Cast to Time command (Cast menu), 47, 434
cast type icons

display format, 441
illustrated, 250, 251

Cast Type Icons field (Cast Window Options 
dialog box), 441

Cast Type, Movement, Anti-Alias, Blend 
checkbox (Score Window Options 
dialog box), 480

cast window, 34, 62, 250-52, 398, 440-42
action shortcuts, 530
cast member buttons, 253-54
controlling appearance, 440-42
displaying the Cast Member Info dialog 

box, 402
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cast window  (continued)
features, 253-55
illustrated, 17
improvements in Director 4.0, 10
launching applications from, 10
moving cast members within, 253, 256
navigating in, 254
opening, 250, 398, 440
operations (listed), 63
and the paint window, 292
scrolling, 255
text settings, 481

Cast Window Options command (Cast 
menu), 440-42

Cast Window Options dialog box, 440-42
illustrated, 440

castmembers. See cast members
CD-ROM drives, optimizing movies for, 354
cell color selector, 276

displaying, 10
cell colors

selecting, 10, 276
showing/hiding, 276

cells (in the score), 79, 264, 535
clearing, 174
coloring, 10, 276, 478
cutting, copying, pasting, or clearing, 273
displaying, 267-71
filling in. See in-betweening
magnifying, 478
moving, 124-25, 273-74
reversing the order of, 460
selecting, 88, 271-73
switching between channels, 128-30

Center checkbox (Digital Video Cast Member 
Info dialog box), 408

Center checkbox (Film Loop Cast Member Info 
dialog box), 411

Center checkbox (Linked Director Movie Cast 
Member Info dialog box), 413

Center Stage on Screen checkbox (Projector 
Options dialog box), 378

centering
digital video movies, 408
film loops, 411
linked movies, 413
the stage, 378

Change Again command (Text menu), 486
Change All button (Find/Change dialog box), 

485
Change button (Find/Change dialog box), 484
change command. See Find/Change command 

(Text menu)
Change in X and Y Location checkbox (Score 

Window Options dialog box), 480
Change to field (Find/Change dialog box), 483
Changing Area option (Set Transition dialog 

box), 452
channels (in the score), 11, 264, 535

clearing, 84
as designated for cast members (table), 262
illustrated, 76, 264
selecting, 84
switching, for real-time recording, 92, 136
switching cells between, 128-30
turning on/off, 291

Chart Style options (Bar Chart auto animate 
dialog box), 465

Checkbox tool (tools window), 329
illustrated, 215, 216

checkboxes, creating, 215-16, 329
checkmark (✔), open window symbol, 397
circles

drawing, 310
in-betweening sprites in, 117-19, 456-58

Circular checkbox (In-Between Special dialog 
box), 458
Index548



Clean Up Selection command (Director 3.1). See 
Sort Cast Members command (Cast 
menu)

cleaning up the cast, 70-71
Clear command (Edit menu), 389, 391

avoiding unintended results, 389
clearing, 306, 389, 391

animations, 391
cells, 174
channels, 84
frame durations, 168, 249, 395-96
the score, 391
sequences of frames (sprites), 84
the stage, 539
unused cast members, 11, 68-69, 306
See also deleting

Clipboard ink (paint window), 314, 318
Clone command (Director 3.1). See Duplicate Cast 

Member command (Cast menu); 
Duplicate Palette command (Palette 
menu)

Close Window command (File menu), 353
closing the current window, 353
color chips

paint window, 293, 318-20
tools window, 328, 329-30
See also pattern chip

color cycling (color effect), 20, 162, 204-5, 448-51, 
492, 513, 536

applications, 199, 204
difficulties, 204
displaying, 205
See also cycling through colors (with color chips)

color depth, 47, 48, 536
of cast members, 40, 47-48, 51-55, 322, 430-31
changing, 49-50, 378
defined, 48, 536
Index
color depth  (continued)
and ink effects, 27
and memory, 40, 51
of monitors, 48-50, 378
of movies, 48-50, 352, 354, 355
of PICT cast members, 359
of QuickTime movies, 371

Color Depth command (Director 3.1). See 
Transform Bitmap dialog box

Color Depth field (Transform Bitmap dialog 
box), 430-31

color effects. See color cycling; palette transitions
color flashes, hiding

with fades, 199-200
with transitions, 184-85

color palettes. See palettes (color)
Color Palettes command (Window menu), 399
color palettes window, 179, 332, 399

action shortcuts, 533
illustrated, 332
opening, 251, 319, 399
operations (listed), 180
reserved colors, 490

Color Picker, 194-95, 334, 491
changing palette colors, 195-96, 491
illustrated, 194

color resolution. See color depth
color resolution indicator (paint window), 

illustrated, 293, 322
Color Sticks To Brush Tools option (Paint 

Window Options dialog box), 513
Colored Cells checkbox (Score Window Options 

dialog box), 478
coloring

bitmap cast members, 40, 56-59
cells, 10, 276, 478
shapes, 329
sprites, 52, 281-82, 329-30
text, 327, 329
See also Color Picker
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colorizing
1-bit cast members, 55-56

as sprites, 52, 329-30
black and white artwork, 316

colors, 298
adding to a common palette, 191-92
applying. See coloring
blending, 282, 316, 491
brightness, 195, 332, 334, 493
cell colors, 10, 276
changing, 40, 56-59, 194-96, 329-30
color resolution. See color depth
cycling through, 318, 319, 320, 449-50, 492
darkening, 317, 514, 516
destination, 299, 505-11
dithering, 54, 432, 510, 536
drawing shapes with, 308-9
editing, 334
foreground, 299, 318-19, 505, 536
hue, 195, 332, 334, 493
identifying, 58, 197-98, 313, 333
ink effects and, 283-84
inverting, 491, 515
lightening, 317, 514, 516
matching, 58, 313, 333
mathematics of, 283-84
remapping, 54-55, 432-33
reserved, 332, 489-90
reversing order, 492
reversing overlaps, 281, 315
rotating, 492
saturation, 195, 332, 334, 493
selecting, 491

used, 493
sorting, 493
spraying, 307-8
on the stage, identifying, 197-98
switching. See coloring
Index550
See also background color; color cycling; color 
depth; Color Picker; coloring; 
foreground color; gradient destination 
color; inks; palettes (color); patterns

Colors field (Bitmap Cast Member Info dialog 
box), 404

Colors options (Transform Bitmap dialog 
box), 430-31

commands, changes in Director 4.0, 14
Comment command (Text menu), 487
comment symbol, adding/deleting, 487-88
Comment window (Director 3.1). See markers 

window
comments

adding the comment symbol, 487
adding to frames, 213-14, 266, 342-43
adding to help topics, 348
editing, 343
illustrated, 214
removing the comment symbol, 488

common palettes, 181, 536
adding colors to, 191-92
assembling, 190-91
creating, 188-93
finding base palettes for, 189-90
remapping the cast to, 192-93, 379

compacting movies, 354, 371
compatibility of Macintosh and Windows 

movies, 8
compressing QuickTime movies, 371
Compressor options (QuickTime Export 

Options dialog box), 371
computer requirements, 4
constraining paint tools, 301
context sensitive help, 7, 350
continue command, 227-28
continue script, 227-28
continuing movies, script for, 227-28
Contract White Space option (for PICS files) 

(Import dialog box), 363



control panel, 10, 243, 397
buttons, 244-46
illustrated, 244, 247
indicators, 247-49
moving, 243
opening, 243, 397

Control Panel command (Window menu), 397
controls, creating, 215
Convert to Bitmap command (Cast menu), 428-29
converting movies, to Director 4.0 format, 8
Copy command (Edit menu), 390

avoiding unintended results, 389
Copy ink (score window), 279, 280, 281
copying, 389, 390

cast members, 306
frames, 150

Create button (Create Projector dialog box), 376
Create button (Import dialog box), 356
Create Projector command (File menu), 375-78
Create Projector dialog box, 207-8, 375-76

illustrated, 207, 375
creators (of movies), specifying, 379
Credits auto animate dialog box, 471-72
Credits button (Director dialog box), 347
Credits effect, 470-72

illustrated, 470
Crop checkbox (Digital Video Cast Member Info 

dialog box), 408
Crop checkbox (Film Loop Cast Member Info 

dialog box), 411
Crop checkbox (Linked Director Movie Cast 

Member Info dialog box), 413
cropping

digital video movies, 152-53, 408
film loops, 411
linked movies, 413

crosshair pointer, 36
cross-platform compatibility, 8
current file size display, 346, 347, 410
Index
current frame, 536
adding to the score, 454
current frame number, 536
jumping to, 274
printing, 386
tempo display, 247-48

current movie, choosing settings for, 378-81
current palette, 182, 183, 536

displaying, 249
duplicating, 489
editing, 489-93
factors determining, 182, 183, 333

Current Script button (Find Handler dialog 
box), 487

cursor disappearances, 222
cursor movement, simulating, 90
curved paths, in-betweening sprites in, 113-16, 

456-58
custom brush shapes, 501-2
custom palette, 299

changing pattern shades, 320
custom patterns. See patterns
Cut command (Edit menu), 390

avoiding unintended results, 389
cutting, 389, 390

frames, 122, 150
cutting and pasting

animations, 130-31
selected cells, 124-25, 273-74

Cycle ink (paint window), 299, 314, 316, 513, 
514

Cycles option (Set Palette dialog box), 449
Cycles pop-up menu (Gradients dialog 

box), 508-9
cycling through colors (in color chips), 318, 319, 

320, 449-50
See also color cycling (color effect)

cycling through inks (while drawing), 299, 316
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D
Darken command (Effects menu), 516
Darken ink (paint window), 314, 317, 514
Darkest ink (paint window), 56, 314, 316
Darkest ink (score window), 279, 282
Decelerate over last n Frames (Ease-Out) option 

(In-Between Special dialog box), 457
decelerating

animated sequences, 108-10, 457
film loops, 137
sprites, 457

Default Palette option (Movie Info dialog 
box), 380

default settings, modifying, 381-84
Delete Frame command (Score menu), 455
Delete key, clearing objects with, 391
Delete Sprites command (Score menu), 445
Delete Unused Cast command (Director 3.1), 14
deleting

comment symbol, 488
frames, 122, 455
sprites, 80, 445
text, 481
unused cast members, 11, 68-69, 306, 404, 

406
See also clearing

destination color, 299, 316, 505, 517
in gradients, 505-11
See also gradient destination color

destination color chip (paint window), 318
Destination options (Export dialog box), 367-68
dialog boxes, 10

getting help on, 7
See also individual dialog boxes by name

Dialogs Appear at Mouse Position checkbox 
(Preferences dialog box), 384

digital video
defined, 335, 536
versus QuickTime, 140

Digital Video Cast Member Info dialog 
box, 407-11

Digital Video command (Window menu), 400
digital video movies, 148, 151, 407-11

adding
to the cast, 337
to Director movies, 151-52

centering, 408
creating, 23, 336-37
cropping, 152-53, 408
cutting or copying frames from, 150
defining paths, 156
displaying, 149-50
displaying information about, 407-11
displaying size, 410
editing, 148-51
importing, 365
in-betweening, 156-57, 456-58
pasting frames into, 151
playing, 151-52, 154-57, 335, 408-10
preloading, 408-9
purging from memory, 410
selecting frames in, 150
software requirements, 4
See also cast members, QuickTime movies

digital video window, 140, 335, 400
buttons, 336
controls (illustrated), 149
displaying, 335
displaying the Cast Member Info dialog 

box, 402
duplicating, 401
illustrated, 149, 335
opening, 251, 335, 400
using multiple, 338
viewing new frames, 151
Index552



digitized sounds, 427. See also sounds
Direct to Stage checkbox (Digital Video Cast 

Member Info dialog box), 409
Direction pop-up menu (Gradients dialog box), 

506-7, 508-9
Directional option (Gradients dialog box), 507
Director shortcuts, 9, 523

menu (listed), 524-28
window (listed), 529-34

Disable Lingo command (Edit menu), 14, 395
Disable Sounds button (control panel), 245

illustrated, 244, 245
Disable Sounds command (Edit menu), 393
disabling

scripts, 291, 395
sounds, 245, 393

Display options (Paint Window Options dialog 
box), 512

Display options (Score Window Options dialog 
box), 478

Display pop-up menu (score window), 267
illustrated, 267

Dissolve Patterns transition, 453
Dissolve Pixels Fast transition, 453
Dissolve Pixels transition, 453
Distort command (Effects menu), 518, 520

See also Auto Distort command (Effects menu)
Dither Adjacent Colors option (Gradients dialog 

box), 510
Dither Best Colors option (Gradients dialog 

box), 510
Dither One Color option (Gradients dialog 

box), 510
Dither option (Transform Bitmap dialog box), 54, 

187, 193, 432
Dither Two Color option (Gradients dialog 

box), 510
dithering colors, 54, 432, 510, 536
Index
Don’t Wrap checkbox (Text Cast Member Info 
dialog box), 421

Dot Size slider (Air Brushes dialog box), 503
dotted lines (...), trails feature symbol, 288
double hyphen (--)

Lingo comment symbol, 487
no recorded frame duration symbol, 248, 249, 

396
double-clicking

cast members, 425
colors, 491
opening dialog boxes, 452, 454

down arrow, cycling through color chip 
colors, 320

Drag and Drop checkbox (Score Window 
Options dialog box), 479

dragging
artwork, 306
cast members to the stage, 78, 259-62, 260

See also placing cast members
selected cells, 124-25, 273-74

drawing, 303, 329, 330
arcs, 312
circles, 310
with colors or patterns, 307-9, 318
ellipses, 310
with inks, 307-9, 314-18, 318
lines, 311, 329
with the pencil, 309
pixels, 309
polygons, 311
rectangles, 310
See also artwork (paint window)

drawing area (paint window). See easel (paint 
window)

drop shadows
for bitmapped text, 482
for QuickDraw text, 482
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Duplicate Cast Member command (Cast 
menu), 435

Duplicate Palette command (Palette menu), 489
Duplicate Window command (Window 

menu), 401
duplicating

cast members, 43, 186, 434
palettes, 489
windows, 401

Duration option (Set Transition dialog box), 452

E
Ease-In option (In-Between Special dialog 

box), 457
easel (paint window), 294

displaying, 294
magnifying, 309

Ease-Out option (In-Between Special dialog 
box), 457

Easy Select command (Director 3.1), 14
See also Playback Head Follows Selection 

checkbox (Score Window Options 
dialog box)

Edit Cast Member command (Cast menu), 425
Edit menu, 389

command shortcuts, 525
commands, 389-96
illustrated, 389

Editable checkbox (score window), 289
editable feature (of sprites), 289, 536
Editable Text checkbox (Text Cast Member Info 

dialog box), 421
editing

cast members, 17-18, 40-61, 264, 429-33
colors, 334, 402
digital video cast members, 148-51
movies, incorporated animated sequences 

including (table), 160
palettes, 194-96, 489-93
text, 35, 39, 325-26, 421
Index554
editors, external, 425-26
Effect field (Text Effects auto animate dialog 

box), 473
effects channels, illustrated, 264
Effects menu, 515

availability, 292, 515
command shortcuts, 528
commands, 303, 515-20
effects (illustrated), 44
illustrated, 515

Effects options (Paint Window Options dialog 
box), 514

ellipse tool (paint window), 302, 310
illustrated, 301, 310

ellipses, drawing, 310
Enable Preload into RAM checkbox (Digital 

Video Cast Member Info dialog 
box), 408-9

Enable Scripts checkbox (Linked Director Movie 
Cast Member Info dialog box), 414

end command, 223
end points for animations, setting, 106-8
Ending Delay control, for auto animate effects, 

465, 469, 473
ending movies, script for, 237-38
ending scripts, command for, 223
Equal option (Gradients dialog box), 511
eraser (paint window), 302, 310

illustrated, 301, 310
erasing artwork, 310, 315
Est display (control panel), 248
Export button (Export dialog box), 368
Export command (File menu), 366-72
Export dialog box, 366-68

exporting animations as QuickTime movies, 
145, 369-72

exporting cast members as PICT files, 60-61, 
368

exporting frames, 366-68
illustrated, 366



exporting
cast members as PICT files, 60-61, 368
Director movies as QuickTime movies, 140-46, 

369-72
frame-differenced images, 368
frames, 366-68

as PICS images, 367, 368
Scrapbook files, 368

Extended Display Information options (Score 
Window Options dialog box), 480

extended display notation (in the score), 268-69
Extended Display Options command (Director 

3.1). See Score Window Options 
command (Score menu)

external editors, launching, 425-26
external files, links to, 376
external sounds, 372
Extras files (Director 4.0), 5
eyedropper (color palettes window), 333

identifying colors with, 197-98, 333
illustrated, 197, 332

eyedropper (paint window), 58, 302, 313
identifying colors with, 58, 313
illustrated, 58, 313

F
Fade to Black option (Set Palette dialog box), 451
Fade to White option (Set Palette dialog box), 451
fades

hiding palette changes with, 199-200
See also palette transitions

File menu, 352
command shortcuts, 524
commands, 352-88
illustrated, 352

File Name field (Bitmap Cast Member Info dialog 
box), 404
Index
File Name field (Digital Video Cast Member Info 
dialog box), 411

File Name field (Linked Director Movie Cast 
Member Info dialog box), 414

File Name field (Sound Cast Member Info dialog 
box), 420

File Size on Disk display (Director dialog 
box), 347

File Type pop-up menu (Export dialog box), 367
filenames

printing, 388
for QuickTime movies, 353

files
Anim Scrapbook, 351
current file size display, 346, 347
files listed in the Open directory dialog 

box, 352
installation, 5
links to external, 376
MacPaint, 360, 367
PICS, 363-64, 367, 368

files (continued) 
PICT, 22, 358-59, 367
previewing, 356
Scrapbook, 350, 351, 361-62

Fill command (Effects menu), 516
fill patterns. See patterns
Filled checkbox (Shape Cast Member Info dialog 

box), 418
fills, creating, 307, 516
Film Loop Cast Member Info dialog box, 411-12
film loops, 132, 139, 411-12, 458, 537

accelerating/decelerating, 137
alternatives to, 132
animating, 132
cast members and, 134
centering, 411
creating, 23, 133-34, 263
cropping, 411
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film loops (continued)
defining paths, 137
displaying information about, 411-12
displaying size, 412
importing movies as, 364
in-betweening, 136-37, 458
and inks, 132
looping, 412
multi-channel, 134
operations included in (table), 160
playing, 411-12
purging from memory, 412
real-time recording with, 135-36
and scripts, 132
switching, 138
versus QuickTime movies, 139
See also cast members

Find Again command (Text menu), 485
Find button (Find/Change dialog box), 484
Find Cast Members command (Cast menu), 67, 

436-37
Find Cast Members dialog box, 66, 67, 69, 

436-37
illustrated, 436

Find Cast Members options (Find Cast Members 
dialog box), 437

Find field (Find/Change dialog box), 483
Find Handler command (Text menu), 12, 486-87
Find Handler dialog box, 486-87

illustrated, 486
Find Handler options (Find Handler dialog box), 

487
Find Selection command (Text menu), 485
Find/Change command (Text menu), 483-85
Find/Change dialog box, 483-85

illustrated, 483
finding

a base palette for a common palette, 189-90
cast members, 65-68, 187, 436-37
and changing text, 483-85
Index556
Fixed option (Text Cast Member Info dialog 
box), 421

Flip Horizontal command (Effects menu), 515
Flip Vertical command (Effects menu), 515
Flow Speed slider (Air Brushes dialog box), 503
Font command (Text menu), 481
Font Mapping Table settings (Movie Info dialog 

box), 380-81
font mapping tables, 380-81
Font submenu (Text menu), 482
fonts

choosing, 37, 482
mapping, 380-81
size, 482
See also text

footers, printing, 388
foreground, defined, 536
foreground color, 299, 319, 505, 536

blending, with the background color, 316
in gradients, 505-11
setting, 318, 505
switching, to the gradient destination color, 

316, 508-9, 517
foreground color chip (paint window), 319, 505

illustrated, 293, 319
foreground color chip (tools window), 329-30

illustrated, 328
foreground priority (of sprites), 79, 126, 265

changing, 127-30, 275
formatting text, 37, 327
Forward button (help window), 349
Four Sharp option (Gradients dialog box), 508
Four Smooth option (Gradients dialog box), 508
frame counter (control panel), 247

illustrated, 247
frame counter (score window), 275



frame durations
clearing, 168, 249, 395-96
displaying, 247-49
finding long, 249
locking, 167-68, 249, 395
testing, 248
unlocking, 167-68, 395-96

frame numbers, going to, 247
Frame Printing Options (Stage Options dialog 

box), 388
Frame Rate options (QuickTime Export Options 

dialog box), 369-70
frame scripts, 12, 222, 225
frame-by-frame animation, 86

lining up cast members for, 312-13
See also step-recording

frame-differenced images, exporting frames as, 368
Frame-Differenced PICS checkbox (Export dialog 

box), 368
frames, 151, 265, 537

adding, 123-24, 362, 454
adding comments to, 213-14, 266, 342-43, 

487-88
converting Director to QuickTime, 370
copying, 150
cutting, 122, 150
deleting, 122, 455
displaying, while dragged, 274
exporting, 366-68
jumping to, 274
key, 106, 537
marking, 266
moving to specific frames, 247, 274

scripts for, 211-12, 229-32
pasting, 151
playing, script for, 234-35
playing selected frames only, 246, 394
previous, 248-49
printing, 385-88
Index
frames (continued)
returning from, scripts for, 233-36
selecting, 150, 479
sequences of, clearing, 84
setting tempos, transitions, and palette changes 

in, 165, 176, 452-53
setting the number between sprites, 100, 115, 

118
tempo display, 247-48
viewing new, in the digital video 

window, 151
See also cells (in the score); frame durations

Free Memory display (Director dialog box), 347
Free Rotate command (Effects menu), 517, 520
From Left Edge of Stage option (Sprite Info 

dialog box), 444
From Top Edge of Stage option (Sprite Info 

dialog box), 444
Full-Size Duration slider (Zoom Text auto 

animate dialog box), 476
Furniture + Philanthropy (sample movie), 210

G
Gaffer, 13
Ghost ink (paint window), 314, 315
Ghost ink (score window), 279, 281
go to frame "name" script, 231-32
go to the frame script, 229-30, 233-34
go to the frame statement, 229-30
going to specific frames, 247, 274

scripts for, 211-12, 229-32
gradient color selector (paint window), 

illustrated, 319
gradient destination color, 299, 505-11

setting, 318, 505-11
switching the foreground color to, 316, 

508-9, 517
gradient destination color chip (paint 

window), 318
illustrated, 293, 318
557



gradient fills. See gradients
Gradient ink (paint window), 29, 299, 314, 315
gradients, 28, 504-11

creating, 28-30, 315, 505-11
cycles options (illustrated), 508-9, 513
direction options (illustrated), 506-7
dithering colors in, 510
method options (table), 509-10
range options (table), 511
sharp/smooth cycles, 508-9, 513
spread options (table), 511

Gradients command (Paint menu), 504-11
Gradients dialog box, 505-11

creating gradients, 30, 505-11
illustrated, 505
opening, 303, 307, 310, 311, 505

graphic cast members, placing, in the score, 18
graphics. See artwork (paint window); drawing
Graphics compressor, compressing QuickTime 

movies with, 371
graphics display cards

and color depth, 48
and palette transitions, 453

Grays pattern, editing, 500
green bar (score window), 246, 394
guided tour, running, 16

H
hand tool (color palettes window), 333

illustrated, 332
selecting colors, 197

hand tool (paint window), 302, 306
illustrated, 301, 306

handlers
how listed, 12, 487
locating, 12, 486-87

hard disks, optimizing movies for slow hard 
disks, 354

hardware requirements, 4
headers, printing, 388
Height field (Preferences dialog box), 382
Height field (Sprite Info dialog box), 444
Height field (Tiles dialog box), 497
Help command (Apple menu), 7, 348-49
help contents window (help window), displaying, 

7, 348
help pointer, illustrated, 350
Help Pointer command (Apple menu), getting 

context-sensitive help, 348, 350
help screens, creating, 233
help system

context-sensitive help, 7, 350
help topics, 348-49
learning Lingo with, 238
navigating in, 348-49
searching for words in, 349
using bookmarks in, 349

help topics, 348-49
adding notes to, 348

help window, 348-49
displaying, 348
illustrated, 348

Hide Paint Tools command (Paint menu), 494
Hide Rulers command (Paint menu), 494
hiding

cell colors, 276
palette changes (color flashes), 184-85, 

199-200
the script pop-up menu, 278
the script preview button, 278

HSB color system, 194
hue (of colors), 334

color palettes window control (illustrated), 
332

Color Picker controls, 195
sorting colors by, 493
Index558



hypertext links
creating, 217-21
creating text for, 217, 219
script scenarios, 226-39
script types, 222-25
typical scripts, 216, 218, 220-21

I
Image Size settings (Stage Options dialog box), 387
Import All button (Import dialog box), 356
Import button (Import dialog box), 356
Import command (File menu), 355-65
Import dialog box

displaying files, 356, 360
illustrated, 356, 360, 361, 363
importing Director movies, 364
importing files, 356
importing PICS files, 363
importing PICT files, 359
importing QuickTime movies, 147
importing Scrapbook files, 361-62

Import dialog box (continued)
importing sounds, 360
linking to files, 357, 359, 360, 364
previewing images, 356

importing
cast members with palettes, 358, 433
digital video movies, 365
Director movies, 158, 364
MacPaint files, 360
PICS files, 363-64
PICT files, 22, 358-59
QuickTime movies, 147, 365
Scrapbook files, 350, 361-62
sounds, 360

in-between cast members, creating, 44-47, 519-20
Index
In-Between Linear command (Score menu), 104, 
455

adding stationary cast members, 104-6
adjusting the paths of sprites animated 

with, 121
moving sprites, 106-8, 455

In-Between options (In-Between Special dialog 
box), 456

In-Between Special command (Score menu), 
104, 456-58

adjusting the paths of sprites animated 
with, 121

in-betweening accelerated/decelerated 
animations, 108-10, 457

in-betweening sprites, 113-16, 117-19, 
456-58

in-betweening two or more aspects at once, 
111-12

In-Between Special dialog box, 456-58
applying previous settings, 116
illustrated, 456
in-betweening accelerated/decelerated 

animations, 109-10, 457
in-betweening sprites, 116, 119, 456-58
in-betweening two or more aspects at 

once, 112
in-betweening, 20, 86, 537, 540

with acceleration and deceleration, 108-10, 
457

cast members, 44-47, 519-20
commands, 104, 455-58, 519-20
digital video movies, 156-57
film loops, 136-37, 458
sprites, 106-8, 455

in circles, 117-19, 456-58
in curved paths, 113-16, 456-58

stretching or squeezing sprites, 110-11
two or more aspects at once, 111-12
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in-betweens
adjusting paths, 120-21
circular, 117-19, 456-58
curved, 101, 113-19, 456-58

Indicate Cast Members With Scripts checkbox 
(Cast Window Options dialog 
box), 442

Info button (cast window), 254
illustrated, 253

information, moving, in the score, 10
Initial Delay control, for auto animate effects, 

463, 465, 468, 472, 473, 476
ink display notation (in the score), 269
Ink Effect Sticks to Tool option (Paint Window 

Options dialog box), 27, 513
ink effects. See inks
Ink Effects (sample movie), playing, 26, 282
Ink Mode checkbox (Score Window Options 

dialog box), 480
ink pop-up menu (paint window), 314-18

illustrated, 28, 293, 314
ink pop-up menu (score window), 279-80

illustrated, 83, 279
inks, 537

color depth and, 27
film loops and, 132
learning, 26, 282
paint window, 25-27, 314-18

choosing, 27-28
cycling, 299, 316, 513
drawing shapes with, 308-9
effects (listed), 26-27
listed, 314
picking up, 318
QuickDraw anomalies, 316

inks (continued)
score window, 27, 37, 279

applying to sprites, 82-83, 279-80
changing, 280
default, 280
and jagged text, 282
listed, 281-82
and movie performance, 280
predicting effects, 283-84

Insert Frame command (Score menu), 454
insertion points

for animation, setting, 88
for text, setting, 325

Inside/Outside slider (In-Between Special dialog 
box), 457

installation files, 5
installing Director, 5-6
interactivity, 20, 209-39

 animated sequences including (table), 160
interface

black and white, 384
improvements in Director, 9

Invert Colors command (Effects menu), 515
Invert Selection command (Palette menu), 491, 

493
inverting colors, 491, 515

J
jagged text, inks producing, 282
Jump button (score window), 274
jump cuts, 175
Jump to Top button (score window), 275
Justification field (Credits auto animate dialog 

box), 471
Index560



K
kerning text, 34
key frames, 106, 455, 537
keyboard shortcuts, 9, 523-34
key-frame animation. See in-betweening
Keyword button (help window), 349
Keyword window (help window), 349
keywords, displaying help topics with, 349

L
Label Style button (Bar Chart auto animate dialog 

box), 465
Lasso option (selection rectangle pop-up menu) 

(paint window), 305
lasso (paint window), 302, 303-4

illustrated, 301, 303
lasso pop-up menu (paint window), 304

illustrated, 304
Launch External Editor command (Cast menu), 18, 

357, 425-26
launching applications, 10, 18, 425-26
layering of sprite channels, 126

changing, 127-30
See also foreground priority

Learning Director, 2
leaving movies, script for, 237-38
Left to Right option (Gradients dialog box), 506
Length field (Digital Video Cast Member Info 

dialog box), 407
Letter Style effect, 472-74
Lighten & Darken Rate option (Paint Window 

Options dialog box), 514
Lighten command (Effects menu), 516
Lighten ink (paint window), 314, 317, 514
Lightest ink (paint window), 56, 314, 316
Lightest ink (score window), 279, 282
Limit to Field Size option (Text Cast Member Info 

dialog box), 421
Index
Line Spacing slider (Bullet Chart auto animate 
dialog box), 468

line tool (paint window), 302, 311
illustrated, 301, 311

line tool (tools window), 329
illustrated, 328

line width selector (paint window), 321, 514
illustrated, 293, 321

line width selector (tools window), 330
illustrated, 328

line widths, selecting, 321, 330, 514
lines, drawing

in the paint window, 311
on the stage, 329

Lingo
disabling, 395
general enhancements, 12
learning, with on-line help, 238
new language elements, 13
new tools, 12
operations (listed), 239
See also Lingo commands; scripts; Using Lingo

Lingo commands
allowing outdated, 379
continue, 227-28
for the editable feature, 289
end, 223
entering, 521
go to the frame statement, 229-30
on exitFrame, 225
on mouseUp, 223
pause, 225, 226-29
quit, 237
for sounds, 170

Lingo Dictionary, 2
Lingo menu, 521

availability, 521
displaying, 405, 406, 411, 412, 414, 418, 422
illustrated, 521
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Lingo scripts. See scripts
Link to File checkbox (Import dialog box), 147, 

357, 359, 360, 364
linked cast members, 357

creating, 337
filing, 357
locating, 11, 357

Linked Director Movie Cast Member Info dialog 
box, 413-14

linked files. See linked cast members; linked 
movies; linking to files

linked movies, 412-13
centering, 413
cropping, 413
importing, 158, 364
looping, 413
operations included in (table), 160
playing, 413

linking to files, 357, 359, 360, 364, 376, 404, 411, 
414, 420

Load Cast settings (Movie Info dialog box), 380
Load from File button (Movie Info dialog 

box), 381
loading movies, 62
Location options (Sprite Info dialog box), 444
Lock button (control panel), 167-68, 249, 395

illustrated, 167, 249, 395
Lock Frame Durations command (Edit menu), 

395-96
locking the playback speed (frame durations), 

167-68, 249, 395
of part of a movie, 168-69

Loop button (control panel), 246
illustrated, 244, 246

Loop checkbox (Digital Video Cast Member Info 
dialog box), 407

Loop checkbox (Film Loop Cast Member Info 
dialog box), 412

Loop checkbox (Linked Director Movie Cast 
Member Info dialog box), 413

Loop command (Edit menu), 394
Looped checkbox (Cast Member Info dialog 

box), 171
Looped checkbox (Sound Cast Member Info 

dialog box), 419
looping

film loops, 412
linked movies, 413
movies, 246, 394, 407
sounds, 171, 372, 419

M
Macintosh Color Picker. See Color Picker
Macintosh system sound-recording dialog 

box, 427
MacPaint files

exporting files as, 367
importing, 360

MacRecorder Sound System Pro 
(Macromedia), 427

Macromedia Accelerator, 13, 354
MacroMind Player. See projectors
Magnified Cells checkbox (Score Window 

Options dialog box), 478
Magnify command (Director 3.1), 14
magnifying cells (in the score), 478
mapped palettes, 431
mapping fonts, 380-81
Margin settings (Text menu), 481
Margin submenu (Text menu), 482
margins for QuickDraw text, 482
marker labels, illustrated, 214
marker names, 212, 342-43
marker well, illustrated, 213
Index562



markers (score window), 266, 342
attaching comments to, 213-14, 266, 342-43, 

487
creating and labeling, 213
identifying, 212
illustrated, 266
labels (illustrated), 214
marker well (illustrated), 213
marking frames with, 266
moving the playback head to, 342
writing scripts for, 211-12

Markers command (Window menu), 401
markers window, 213-14, 342-43, 401

action shortcuts, 534
illustrated, 214, 342
opening, 342, 401
text settings, 481

marking frames, 266
Mask ink (score window), 279, 281
masking artwork, 315
masks

creating, 281
defined, 537

matching (identifying) colors, 58, 197-98, 313, 333
Matte ink (score window), 279, 280, 281, 537

memory use display, 346, 347
Mattes and Thumbs display (Director dialog box), 

347
Maximum Visible field (Cast Window Options 

dialog box), 440
measuring sprites, 142-43
memory

changing the amount reserved, 4
and color depth, 40, 51
management, 11
pre-loading cast members into, 380
removing purgeable items, 347, 404, 406, 410, 

412, 415, 416, 422, 424
Index
memory (continued)
requirements, 4
shared cast residence, 75
use and availability displays, 346-47

memory management, improvements in 
Director, 11

Memory Size field (Digital Video Cast Member 
Info dialog box), 410

menu bar, 242
menu shortcuts, listed, 524-28
menus, 9, 345-521

action shortcuts (listed), 524-28
window specific, 345
See also individual menus

Message command (Window menu), 400
message window, 340, 400

action shortcuts, 534
navigating in, 340
opening, 400

Method pop-up menu (Gradients dialog 
box), 509-10

microprocessor requirements, 4
MIDI (Musical Instrument Digital Interface), 

defined, 537
MM Player. See projectors
modifiers (of movies), specifying, 379
Monitor control panel, changing color depth, 50
monitors

color depth, 48, 49-50, 179, 378
requirements, 4
resizing the stage for, 382

More Destination option (Gradients dialog 
box), 511

More Foreground option (Gradients dialog 
box), 511

More Middle option (Gradients dialog box), 511
motion display notation (in the score), 270
Motion field (Bullet Chart auto animate dialog 

box), 468
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Move Down button (Create Projector dialog 
box), 376

Move Up button (Create Projector dialog 
box), 376

Moveable checkbox (score window), 288
moveable feature (of sprites), 288, 538
Movie Info command (File menu), 378-81
Movie Info dialog box, 378-81

choosing settings for the current movie, 
378-81

illustrated, 378
movie scripts, 12

conversion of text macro cast members to, 353
movies (Director)

accelerating, 13, 457
adding cast members, 10, 76, 78-80, 104-6
adding digital video movies, 151-52
adding frames, 123-24, 362, 454
adding stationary cast members, 104-6
advancing, 247
as cast members, incorporated animated 

sequences including (table), 160
choosing settings for, 378-81
color depth, 48-50
combining, 62
compacting, 354
compatibility of Macintosh and Windows 

versions, 8
continuing, script for, 227-28
converting to Director 4.0 format, 8
cutting frames from, 122
deleting frames from, 122, 455
editing, incorporated animated sequences 

including (table), 160
ending, script for, 237-38
exporting as QuickTime movies, 140-46, 367, 

369-72
importing, 158, 364
incorporating animated sequences into, 139, 

158-60
Index564
movies (Director) (continued)
information organization in Director 4.0, 11
leaving, script for, 237-38
loading, 62
looping, 246, 394, 407
making interactive, 20, 209-39
moving, incorporated animated sequences 

including (table), 160
moving animations between, 130-31
opening, 8, 352, 355
optimizing, 354
pausing, script for, 226-27, 229-30
performance. See performance (of movies)
playing. See playing, Director movies
from previous versions of Director, saving, 

353-54
printing, 385-88
protecting, 8, 373-74
quitting, script for, 237-38
reverting to the last saved version, 355
rewinding, 244, 247, 392
running, computer requirements for, 4
saving, 353-55
saving and naming, 355
segments, scripts for going to and returning 

from, 226-36
setting tempo, 446-48
size limit, 11
as sprites, incorporated animated sequences 

including (table), 160
stepping backward, 245, 247, 392
stepping forward, 245, 247, 393
stopping, 245, 392
tracing, 340
updating, 373-75
in windows

operations included in (table), 160
playing, 12, 158-59

See also animations; digital video movies; film 
loops; linked movies; performance (of 
movies); QuickTime movies



moving
animated sequences to a single channel, 99-101, 

115, 118, 458-59
animations

between movies, 130-31
to the upper left corner of the stage, 142

cast members within the cast window, 253, 256
cells, 124-25, 273-74
colors in palettes, 196-97
the control panel, 243
movies, incorporated animated sequences 

including (table), 160
to specific frames, 247, 274

scripts for, 211-12, 229-32
sprites, 82, 341, 443-44, 459-60, 540

with in-betweening, 106-8, 456-58
up/down in the score, 127-30, 275

See also placing cast members
Multi Dither option (Gradients dialog box), 510
multiplane effect, 538
multiple cast members, 78, 260, 423-24, 435
music. See sounds
Musical Instrument Digital Interface (MIDI), 

defined, 537

N
names, finding cast members by name, 67-68, 

436-37
naming

cast members, 64-65, 403, 415, 416, 417
shared casts, 72, 252

navigating
in the cast window, 254
in the help system, 348-49
in the message window, 340
in the score, 274-75

Navigator (sample movie), playing, 159
New command (File menu), 352
Index
new features in Director 4.0, 8-13
New option (script pop-up menu), 277
Next arrow (cast window), 254

illustrated, 253
next buttons, 210
No Shrink option (lasso pop-up menu) (paint 

window), 304
No Shrink option (selection rectangle pop-up 

menu) (paint window), 305
Noh Tale to Tell (sample movie), playing, 210
Normal ink (paint window), 314, 315
Normal option (Air Brushes dialog box), 503
Normal option (Set Palette dialog box), 451
Normal Size command (Director 3.1), 14
Not Copy ink (score window), 279, 281
Not Ghost ink (score window), 279, 281
Not Reverse ink (score window), 279, 281
Not Transparent ink (score window), 279, 281
notation in the score, 267-71
notes. See comments
Notes button (help window), 348
Now option (Preferences dialog box), 382

O
Obey Scripts command (Director 3.1). See 

Disable Lingo command (Edit menu)
on exitFrame handler, 225
on mouseUp handler, 223
One Cast Member option (Paint Window 

Options dialog box), 512
One Cycle option (Gradients dialog box), 508
online help. See help system
Open command (File menu), 352
Open directory dialog box, files listed, 352
Open Script command (Cast menu), 424-25
opening

the control panel, 243, 397
movies, 8, 352, 355
shared casts, from old versions of Director, 75
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optimizing movies, 354
Option-click procedures

activating step-recording, 290
changing pattern palette shades, 320
exporting Scrapbooks, 368
opening scripts, 425
recording animations, 95
selecting polygons, 303
toggling frame selection, 479

Option-drag procedures
constraining paint tools, 310, 311
copying cast members, 306
copying selections, 303
drawing shapes, 303
moving cell selections, 273-74
placing cast members in the score, 261-62, 434
placing cast members on the stage, 78, 259-60
scrolling in the paint window, 306

Options button (Create Projector dialog box), 
377

orientation (of cast members), changing, 46
Other Line Width slider (Paint Window Options 

dialog box), 514
Over Time checkbox (Set Palette dialog box), 

450, 451
Overview. See Auto Animate command (Score 

menu)

P
Page Setup command (File menu), 385
Page Setup options, 385
paint bucket (paint window), 302, 307

illustrated, 301, 307
Paint command (Window menu), 398
Paint menu, 494

availability, 292, 494
command shortcuts, 528
commands, 494-514
illustrated, 494
Index566
Paint Object option (Gradients dialog box), 511
paint tools (paint window), 301-13

clicking/dragging (table), 302
constraining, 301
effects, 515-20
illustrated, 293, 301
showing/hiding, 494
turning, into the hand tool, 306

paint window, 292-93, 398
action shortcuts, 532-33
adding cast members to movies from, 80
and the cast window, 292
creating cast members, 24-33
displaying the Cast Member Info dialog 

box, 402
effects, 515-20
features, 294-322
illustrated, 18, 24, 293, 294
importing Scrapbook files into, 361
opening, 251, 292, 398
operations (listed), 25
Paint menu commands, 494-514
paint tools, 301-13
patterns, 499-500
positioning cast members in, 306
rotating artwork in, 517
scrolling the view, 306
showing/hiding rulers, 494
text settings, 481
tool palette (illustrated), 293, 301
zooming in/out, 297, 301, 309, 495
See also artwork (paint window); bitmapped 

text; drawing; inks
Paint Window Options command (Paint 

menu), 512-14
Paint Window Options dialog box, 512-14

illustrated, 512
opening, 321, 512
selecting ink effects, 27, 513



paint window text. See bitmapped text
paintbrush (paint window), 302, 308-9, 317-18

air brushes, 307-8, 502-3
changing the shape of, 501-2
illustrated, 301, 308

paintbrush pop-up menu (paint window), 308-9
illustrated, 308

painting, 307-9, 318
See also artwork (paint window); Paint menu; 

paint tools
PAL system, defined, 538
Palette Cast Member Info dialog box, 415
palette cast members, 416

dragging, to the stage or score, 260
purging from memory, 415
See also cast members

palette changes, hiding
with fades, 199-200
with transitions, 184-85
See also palette transitions

palette channel
extended display notation, 268
illustrated, 76, 268
setting palettes, 448-51

palette effects. See color cycling; palette transitions
Palette menu, 489

availability, 332, 489
commands, 489-93
illustrated, 489

Palette option (Set Palette dialog box), 449, 450
Palette pop-up menu (Bitmap Cast Member Info 

dialog box), 403
Palette pop-up menu (Transform Bitmap dialog 

box), 430-31
palette settings, incorporated animated sequences 

including (table), 160
Index
palette transitions, 20, 162, 199, 201, 448, 450-51
in 16-, 24-, and 32-bit environments, 453
and animations, 201
displaying, 202
extending, 203
between frames, 201-2, 448
screen fades, 199-200
setting the speed, 202
See also transitions

palette window. See color palettes window
palettes (color), 67, 179, 181, 298, 489-93

active, 182, 183, 333, 536
availability, 179
built-in (listed), 333
change effects, 182, 333
changing, 183-84, 448-51
choices available, 184
current, 182, 183, 249, 333, 536
custom, 299
default, 183, 298, 380
and Director’s interface, 184
displaying, 249
duplicating, 489
editing, 194-96, 489-93
finding cast members by palette, 67-68
hiding changes, 184-85, 199-200
as linked to cast members, 181
mapped, 431
mapping cast members to, 67
moving colors in, 196-97
operations (listed), 180
palette transition, 20, 450-51
pattern, 299
problems, 181, 186
remapping the cast to a single palette, 186-87, 

379
repositioning colors on, 333
reserving colors in, 489-90
in the score, 332
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palettes (continued)
selecting colors, 191, 448
standard, 298
See also common palettes; palette channel; 

palette transitions
panel window. See control panel
Paste as PICT command (Cast menu), 22, 23, 428
Paste command (Edit menu), 390

avoiding unintended results, 389
Paste Relative command (Score menu), linking 

animated sequences, 102-3, 459-60
pasting, 389, 390

animated sequences together, 102-3
frames, 151
QuickTime movies, 337
sprites, 459-60
See also cutting and pasting

Path options (In-Between Special dialog 
box), 457-58

paths
of digital video movies, defining, 156
of film loops, defining, 137
of in-betweened sprites, 113-21, 456-58
See also circles; curved paths

Pattern Adjacent Colors option (Gradients dialog 
box), 510

Pattern Adjacent Colors See Thru option 
(Gradients dialog box), 510

Pattern Best Colors option (Gradients dialog 
box), 510

Pattern Best Colors See Thru option (Gradients 
dialog box), 510

pattern chip (paint window), 320
illustrated, 293, 320

pattern chip (tools window), 330
illustrated, 328

pattern palettes, 299
changing shades, 320

patterns, 298, 499-500
drawing arcs with, 312
drawing shapes with, 308-9
and gradients, 505, 509-11
picking up, 500
selecting, 330
spraying, 307-8
See also pattern chip; pattern palettes

Patterns command (Paint menu), 499-500
Patterns dialog box, 499-500

illustrated, 499
opening, 320, 499

pause command, 225, 226-30
pause script, 226-27, 229-30
Paused at Start checkbox (Digital Video Cast 

Member Info dialog box), 407-8
pausing movies, script for, 226-27, 229-30
pencil (paint window), 302, 309

illustrated, 301, 309
performance (of movies)

anti-aliasing and, 286, 379
color depth and, 51-52
inks and, 280
QuickDraw text and, 328
shared casts and, 62, 72
stretched cast members and, 81

Perspective command (Effects menu), 518, 520
Photo-JPEG compressor, compressing 

QuickTime movies with, 371
picking up patterns, 500
PICS files

display problems, 364
exporting files as, 367, 368
frame-differenced images, 368
importing, 363-64
saving files as, 368

PICT Cast Member Info dialog box, 416-17
Index568



PICT cast members, 416-17
color depth, 359
converting to bitmapped cast members, 428-29
creating, 23
editing, 359
purging from memory, 416
retaining PICT format when pasting, 428
See also cast members

PICT files
exporting cast members as, 60-61, 368
exporting files as, 60-61, 367, 368
importing, 22, 358-59
saving files as, 368

pixels
defined, 538
drawing, 309

Place button
illustrated, 253, 300
placing cast members, 253, 300

Place on Stage command (Director 3.1), 14
placing animated sequences in the score, 101-2
placing cast members

in the score, 18, 80, 259, 260, 261, 434
over time, 261-62, 434

on the stage, 18, 78-80, 224, 253, 257-58
canceling, 260
over time, 259-60

Play as Fast as Possible option (Digital Video Cast 
Member Info dialog box), 410

Play at Fixed Rate option (Digital Video Cast 
Member Info dialog box), 410

Play at Normal Rate option (Digital Video Cast 
Member Info dialog box), 410

Play button (control panel), 245
illustrated, 244, 245

Play button (Sound Cast Member Info dialog box), 
420

Play command (Edit menu), 391
play done script, 236
Index
Play Every Frame checkbox (Digital Video Cast 
Member Info dialog box), 409-10

Play Every Movie checkbox (Projector Options 
dialog box), 377

play frame "name" script, 234-35
play lists, 376

See also projectors
playback head (score window), 274, 538

holding back, 152, 154-55
moving

to markers, 342
to specific frames, 211-12, 229-32, 247, 

274
pausing, 447

Playback Head Follows Selection checkbox 
(Score Window Options dialog box), 
136-37, 156, 274, 479

playback speed
factors affecting, 163
locking, 167-68, 249, 395

for part of a movie, 168-69
unlocking, 167-69, 395-96
versus the tempo, 166-67
See also tempo

Player. See projectors
playing

digital video movies, 151-52, 154-57, 335
Director movies, 242, 245, 391

including selected frames only, 246, 394
inside other movies, 12, 158-59
as projectors, 208, 377

frames, script for, 234-35
projectors, 208, 377
QuickTime movies, 141

play-only versions (of Director movies). See 
projectors

plus button (+). See Add button
plus key (+), Play/Stop commands toggle, 391
plus sign (+), indicating cast member scripts, 480
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point size of fonts, 482
pointers, crosshair, 36
polygon tool (paint window), 302, 311

illustrated, 301, 311
polygons

drawing, 311
selecting, 303

positioning cast members
in the score, 19
on the stage, 19, 113-14

Preferences command (File menu), 381-84
Preferences dialog box, 381-84

changing color depth, 49
illustrated, 381
resizing the stage for exporting 

animations, 142-44
Preview button (auto animate dialog boxes), 463, 

466, 469, 472, 474, 476
Preview Path button (In-Between Special dialog 

box), 458
previewing

auto animate effects, 463, 466, 469, 472, 
474, 476

files, 356
paths, 458
sounds, 172, 420, 454

Previous arrow (cast window), 254
illustrated, 253

Previous button (help window), 348
previous buttons, 210
Print command (File menu), 385-88
Print File Name and Date in Header checkbox 

(Stage Options dialog box), 388
Print Options dialog box, 385-88

illustrated, 385
Print options (Print Options dialog box), 385-86
Print Page Footer checkbox (Stage Options 

dialog box), 388

Print Range options (Print Options dialog 
box), 386-88

printing
footers, 388
headers, 388
movies, 385-88

priority levels
for cast members, 11
for sprites. See foreground priority (of sprites)

Program files (Director 4.0), 5
projector icon, illustrated, 375
Projector options (Create Projector dialog 

box), 377-78
Projector Options dialog box, 377-78

creating projectors, 208, 375-78
illustrated, 208, 377

projectors, 11, 162, 206, 375-78, 538
and 68000 computers, 4
compatibility, on Macintosh and Windows 

computers, 11
creating, 206-8, 375-78
defined, 206, 538
playing, 208, 375, 377
RAM requirements, 4
system requirements, 4

Protect Movies checkbox (Update Movies dialog 
box), 374

protected movies, 8, 373-74, 538
icon (illustrated), 374, 538

Purge Memory button (About Director dialog 
box), 347

Purge Priority pop-up menu (Bitmap Cast 
Member Info dialog box), 404

Purge Priority pop-up menu (Button Cast 
Member Info dialog box), 405

Purge Priority pop-up menu (Digital Video Cast 
Member Info dialog box), 410

Purge Priority pop-up menu (Film Loop Cast 
Member Info dialog box), 412
Index570



Purge Priority pop-up menu (Multiple Cast 
Member Info dialog box), 424

Purge Priority pop-up menu (Palette Cast Member 
Info dialog box), 415

Purge Priority pop-up menu (PICT Cast Member 
dialog box), 416

Purge Priority pop-up menu (Sound Cast Member 
Info dialog box), 419

Purge Priority pop-up menu (Text Cast Member 
Info dialog box), 422

purging items from memory, 347, 404, 406, 410, 
412, 415, 416, 422, 424

Q
quality of QuickTime movies, 371
Quality slider (QuickTime Export Options dialog 

box), 371
Quick Time Options button (Export dialog 

box), 367
QuickDraw objects

changing, 18
pasting, as PICT images, 23
See also shapes

QuickDraw pattern, editing, 500
QuickDraw routines, ink anomalies, 316
QuickDraw shapes. See shapes
QuickDraw text, 33, 34, 323, 328

adding borders, 482
and animation, 328
appearance, 36
changing, 18
coloring, 327, 329
converting to bitmapped text, 34, 217, 219, 

428-29
creating, 23, 34, 35-38
drop shadows, 482
editing, 35, 39, 325-26
formatting, 37, 327
Index
margins, 482
resizing text width, 325-26
selecting, 325
See also text; text window

QuickTime versus digital video, 140
QuickTime Export Options dialog box, 369-72

exporting animations as QuickTime movies, 
146, 369-72

illustrated, 369
QuickTime movies, 11, 139, 147, 369-72

changing, 18, 148
compressing, 371
conversion of unlinked to linked, 353
exporting Director movies as, 140-46, 367, 

369-72
filenames, 353
importing, 147, 365
modifying transitions in, 146, 372
operations included in (table), 160
pasting, 337
playing, 141
quality setting, 371
scaling, 371
setting color depth, 371
tempo settings, 369-70
versus film loops, 139
See also cast members, digital video

QuickTime option (destination file type pop-up 
menu), 369

QuickTime window (Director 3.1). See digital 
video window

quit command, 237
Quit command (File menu), 388
quit script, 237-38
quitting Director, 388
quitting movies, script for, 237-38
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R
option tool (tools window), 329

illustrated, 215, 216
options, creating, 215-16, 329
RAM. See memory
Range fields (Bar Chart auto animate dialog 

box), 465
Range of Frames options (Export dialog 

box), 366-67
Range of Frames options (Print Options dialog 

box), 386
Range option (Import dialog box), 362, 363
Range pop-up menu (Gradients dialog box), 511
Real Time option (QuickTime Export Options 

dialog box), 370
real-time recording, 20, 86, 90-92, 135, 291, 538

activating, 291
controlling, 91
in different channels, 92, 136
with film loops, 135-36

real-time recording indicator (score window), 
illustrated, 92, 291

Recompile All Scripts command (Text 
menu), 488

Recompile Script command (Text menu), 488
recompiling scripts, 488
record lights, 539
Record Sound command (Cast menu), 427
recording animations, 88

with Cast to Time, 101-2, 434
with Space to Time, 99-101
See also real-time recording; step-recording

recording sounds, 427
rectangle tool (paint window), 302, 310

creating transparent cast members, 220
illustrated, 301, 310

rectangles, drawing, 310

registration points, 312-13, 362
aligning, 434
defined, 539
setting, 313, 520
and switching cast members, 461

registration tool (paint window), 302, 312-13
illustrated, 301, 312

Remap Palettes When Needed checkbox (Movie 
Info dialog box), 379

Remap to Closest Colors option (Transform 
Bitmap dialog box), 54-55, 187, 193, 
432

remapping
cast members, 433

to a single palette, 186-87, 192-93, 379
colors, 54-55, 432-33

Remapping options (Transform Bitmap dialog 
box), 432

renaming cast members, 43, 65
Repeat Effect command (Effects menu), 520
Repeat Selection command (Director 3.1). See 

Selected Frames Only command (Edit 
menu)

Repeat slider (auto animate dialog boxes), 463, 
472, 474, 476

repeating
auto animate effects, 463, 472, 474, 476
sounds, 173-74

Reserve Colors command (Palette menu), 
489-90

Reserve Colors dialog box, 490
illustrated, 490

Reserve Currently Selected Colors option 
(Reserve Colors dialog box), 490

reserved colors, selecting, 332, 489-90
reserving colors in palettes, 489-90
resize handle (text window), 325-26
Resize Stage checkbox (Projector Options dialog 

box), 377
Index572



resizing
sprites, 242, 443-44
the stage, 142-44, 377, 382
text width, 325-26

Restore to Size of Cast Member option (Sprite Info 
dialog box), 444

retriggering sounds, 173-74
returning from frames, scripts for, 233-36
Reveal ink (paint window), 25, 31-33, 314, 315
revealing

cast members, 31-33
sprites, 281

Reverse Color Order command (Palette 
menu), 492

Reverse ink (paint window), 314, 315
Reverse ink (score window), 279, 281
Reverse Sequence command (Score menu), 460
Revert command (File menu), 355
Rewind button (control panel), 244

illustrated, 244
Rewind command (Edit menu), 392
rewinding movies, 244, 247, 392
RGB color system, 194
RGB video, defined, 539
Right to Left option (Gradients dialog box), 506
Rotate Colors command (Palette menu), 492
Rotate Left command (Effects menu), 517, 520
Rotate Right command (Effects menu), 517, 520
rotating colors, 492
Row Width field (Cast Window Options dialog 

box), 440
rulers (paint window), 295-96

showing/hiding, 494
running

the guided tour, 16
movies, computer requirements, 4
Index
S
Sample Movies folder, 5
saturation (of colors), 334

color palettes window control 
(illustrated), 332

Color Picker controls, 195
sorting colors by, 493

Save and Compact command (File menu), 11, 
354

Save As command (File menu), 355
Save command (File menu), 353-54
Save Settings options (Preferences dialog 

box), 382
Save to File button (Movie Info dialog box), 381
saving movies, 353-55
Scale option (Sprite Info dialog box), 444
Scale options (QuickTime Export Options dialog 

box), 371
scaling cast members, 303, 306
scaling exported QuickTime movies, 371
scenes, defined, 539
score, 10, 76, 263-66, 539

adding sounds to, 9, 171-72
adding transitions to, 176-78
changing, 76
clearing, 391
defined, 539
displaying, 267-71, 477-80
displaying specific parts of, 214
illustrated, 16, 76
memory use display, 346, 347
moving animated sequences to a single 

channel, 99-101, 115, 118, 458-59
moving information in, 10
navigating in, 274-75
notation, 267-71
operations (listed), 77
order of sprites in, 79, 126, 265

changing, 127-30, 275
placing animated sequences in, 101-2
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score (continued)
placing cast members in, 18, 80, 259, 260, 

261, 434
over time, 261-62, 434

positioning cast members, 19
scrolling, 275
sprite information, incorporated animated 

sequences including (table), 160
sprite information in, 79, 268, 270, 443-44
transferring, to new movies, 350
using palettes, 332
See also cells (in the score); channels (in the 

score); markers (score window); score 
scripts; score window

score cells. See cells (in the score)
Score command (Window menu), 398
Score menu, 443

command shortcuts, 527
commands, 443-80
illustrated, 443

score scripts
applying, 277
frame, 222, 225
sprite, 222, 224-25, 231-32, 234-35

score window, 398, 539
action shortcuts, 531
controlling display options, 477-80
editing cast members from, 264
features, 265-71, 274-91
opening, 264, 398
See also inks; score

Score Window Options command (Score 
menu), 477-80

Score Window Options dialog box, 477-80
illustrated, 477

Scrapbook, 350
Index574
Scrapbook files
building, 351
displaying, in the paint window, 361
exporting, 368
importing, 350, 361-62
managing, 368
saving files as, 368

Scrapbook FKey, building Scrapbook files, 351
screen, determining the appearance of cast 

members on, 19
Screen Buffer display (Director dialog box), 347
screen items, getting help on, 7
screen savers, excluding from QuickTime 

movies, 146
Script button (Bitmap Cast Member Info dialog 

box), 405
Script button (Button Cast Member Info dialog 

box), 406
Script button (cast window), 254, 424

illustrated, 253
Script button (Digital Video Cast Member Info 

dialog box), 411
Script button (Film Loop Cast Member Info 

dialog box), 412
Script button (Linked Director Movie Cast 

Member Info dialog box), 414
Script button (Shape Cast Member Info dialog 

box), 418
Script button (Text Cast Member Info dialog 

box), 422
Script Cast Member Info dialog box, 417-18
script cast members. See scripts
script channel, 264

illustrated, 76, 264
jumping to, 275

Script Code checkbox (Score Window Options 
dialog box), 480

Script command (Window menu), 400
script display notation (in the score), 271



Script Editor window. See script window
Script field (PICT Cast Member dialog box), 417
script indicator icons, 224, 252, 442
script pop-up menu (score window), 277

hiding, 278
illustrated, 227, 277

script preview button (score window), 278
illustrated, 278

script scenarios, 226-39
script windows, 278, 339, 400

displaying the Cast Member Info dialog box, 402
duplicating, 401
opening, 220, 251, 254
save feature, 339
See also scripts

scripts, 12, 222-25, 278, 417-18
associating with cast members, 405, 406, 411, 

412, 414, 417, 418
for buttons, 216, 217-39
cast member, 223-24, 225, 231-32, 234-35
checking for errors, 488
commonly used, 226-39
continue, 227-28
for continuing movies, 227-28
creating, 23, 277, 339
disabling, 291, 395
displaying size, 417
displaying type, 418
ending, 223
for ending movies, 237-38
film loops and, 132
frame, 222, 225
go to frame "name", 231-32
go to the frame, 229-30, 233-34
for going to specific frames, 211-12, 229-32
as identified in the score, 271
for leaving movies, 237-38
locating handlers in, 12, 486-87
for markers, 211-12
Index
scripts (continued)
movie scripts, 12, 353
opening, 251, 254, 278, 339, 400, 405, 406, 

411, 412, 414, 418, 422, 424-25
pause, 226-27, 229-30
and the pause command, 229
for pausing movies, 226-27, 229-30
play done, 236
play frame "name", 234-35
for playing frames, 234-35
quit, 237-38
for quitting movies, 237-38
recompiling, 488
removing, 277
for returning from frames, 233-36
script display notation, 271
script indicator icons, 224, 252, 442
script scenarios, 226-39
sprite, 222, 224-25, 231-32, 234-35
testing, 340
writing, 210, 222-39
See also cast members; script channel; script 

windows
scrolling

the cast window, 255
the paint window, 306
the score, 275

Scrolling option (Text Cast Member Info dialog 
box), 421

scrolling text fields, creating hypertext links 
in, 217

Search All Cast Members checkbox (Find/
Change dialog box), 484

Search button (help window), 349
See Thru Lasso option (selection rectangle 

pop-up menu) (paint window), 305
See Thru option (lasso pop-up menu) (paint 

window), 304
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segments (of movies)
scripts for going to and returning from, 

226-36
See also frames

Select All command (Edit menu), 391
Select Cast command (Director 3.1). See Find 

Cast Members command (Cast menu)
Select Tile to Edit options (Tiles dialog box), 497
Select Used Colors command (Palette 

menu), 493
Select Used Colors in Bitmap dialog box, 

illustrated, 189
Selected Frames Only button (control panel), 246

illustrated, 244, 246
Selected Frames Only command (Edit 

menu), 394
selecting

all selectable items, 391
animated sequences, 134
artwork, 303-6
cast members, 10, 250
cells, 271-73

for animation, 88
channels, 84
colors, 491, 493
frames, 150, 479
polygons, 303
sequences of sprites, 82
text, 325

selection rectangle (paint window), 302, 305-6
illustrated, 301, 305

selection rectangle pop-up menu (paint 
window), 305

illustrated, 305
Set Blend Value command (Director 3.1). See Set 

Sprite Blend command (Score menu)
Set Color command (Palette menu), 491
Set Palette command (Score menu), 448-51
Index576
Set Palette dialog box, 183-84, 449-51
cycling colors, 204-5, 448-51
hiding palette changes, 200, 202
illustrated, 183, 200, 202, 203, 204, 449
opening, 183, 449
palette transitions, 203, 450-51

Set Sound command (Score menu), 453-54
Set Sound dialog box, 172, 454

illustrated, 172, 454
Set Sprite Blend command (Score menu), 445-46
Set Sprite Blend dialog box, 445-46

illustrated, 445
Set Tempo command (Score menu), 446-48
Set Tempo dialog box, 155, 165-66, 446-48

illustrated, 165, 447
opening, 165

Set Transition command (Score menu), 452-53
Set Transition dialog box, 177-78, 452-53

hiding color flashes, 185
illustrated, 177, 185, 452
opening, 452

shades. See gradients
shape (of cast members), changing, 46
Shape Burst option (Gradients dialog box), 507
Shape Cast Member Info dialog box, 418
shape cast members. See shapes
Shape pop-up menu (Shape Cast Member Info 

dialog box), 418
shape tools (paint window), 310-12

drawing with, 303
shape tools (tools window), 329

illustrated, 328
shapes, 23, 328, 418

changing, 329, 331
coloring, 329
drawing, 303, 329, 330
filling, 418, 516
positioning, 330
registration points, 313, 434, 520
See also cast members



shared cast members
identifying, 252
sorting, 438
See also shared casts

shared cast movies. See shared casts
shared casts, 62, 72, 74

cleaning up, 70
compatibility on Macintosh and Windows 

computers, 9
creating, 72-75
illustrated, 73, 74
naming, 72, 252
from old versions of Director, opening, 75
residence in memory, 75
for sounds, 172
See also shared cast members

SHARED.DIR shared cast movie, 9, 72, 438
sharp cycles, in gradients, 508-9
Shift-drag procedures

constraining paint tools, 301, 310, 311
drawing shapes, 303, 306, 330
moving objects, 303

shortcuts. See Director shortcuts
Show Controller checkbox (Digital Video Cast 

Member Info dialog box), 409
Show Paint Tools command (Paint menu), 494
Show Rulers command (Paint menu), 494
Shrink option (lasso pop-up menu) (paint window), 

304
Shrink option (selection rectangle pop-up menu) 

(paint window), 305
Shuffle Backward button (score window)

illustrated, 129
switching cells between channels, 128-29, 275

Shuffle Backward command (Director 3.1), 15
Shuffle Forward button (score window)

illustrated, 129
switching cells between channels, 128-29, 275

Shuffle Forward command (Director 3.1), 15
Index
Size command (Text menu), 481
Size field (Bitmap Cast Member Info dialog 

box), 404
Size field (Film Loop Cast Member Info dialog 

box), 412
Size field (Linked Director Movie Cast Member 

Info dialog box), 414
Size field (Multiple Cast Member Info dialog 

box), 423
Size field (PICT Cast Member dialog box), 417
Size field (Script Cast Member Info dialog 

box), 417
Size field (Sound Cast Member Info dialog 

box), 419
Size field (Text Cast Member Info dialog 

box), 422
Size field (Transform Bitmap dialog box), 430
Size options (Sprite Info dialog box), 444
Size slider (Air Brushes dialog box), 503
Size submenu (Text menu), 482
Slant command (Effects menu), 518, 520
Smear ink (paint window), 314, 317
smearing artwork, 317
Smooth command (Effects menu), 516
Smooth Cycle Brush option (Paint Window 

Options dialog box), 513
smooth cycles, in gradients, 508-9
Smooth ink (paint window), 314, 317, 514
Smudge ink (paint window), 314, 317
smudging artwork, 317
software requirements, 4
Sort Cast Members command (Cast menu), 

438-39
Sort Cast Members dialog box, 71, 438-39

illustrated, 438
Sort Colors command (Palette menu), 493
Sort Colors dialog box, 493

illustrated, 493
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Sort Selection options (Sort Cast Members dialog 
box), 439

sorting
the cast, 70-71, 438-39
colors, 493

Sound Cast Member Info dialog box, 419-20
sound cast members, 419-20

creating, 23
displaying size, 419
dragging, to the stage or score, 260
looping, 419
previewing, 420
See also cast members; sounds

Sound Channel checkboxes (QuickTime Export 
Options dialog box), 372

sound channels, 265
extended display notation, 269
illustrated, 76, 171, 269
management of, 11
pasting sounds into, 453-54

Sound checkbox (Digital Video Cast Member 
Info dialog box), 408

Sound checkbox (Film Loop Cast Member Info 
dialog box), 412

Sound checkbox (Linked Director Movie Cast 
Member Info dialog box), 413

sound effects, 162
sound files, changing, 18
Sound menu. See Set Sound command (Score 

menu); sounds
SoundEdit Pro, editing digital sounds with, 427
sound-recording dialog box, 427

illustrated, 427
sounds, 170

adding to the score, 9, 171-72, 453-54
AIFF standard, 535
digitized, 427
disabling, 245, 393
during transitions, 453
Index578
sounds (continued)
exporting with QuickTime movies, 372
external, 372
importing, 360
incorporated animated sequences including 

(table), 160
Lingo commands, 170
looped, 171, 372, 419
operations (listed), 170
pasting into sound channels, 453-54
previewing, 172, 420, 454
recording, 427
repeating, 173-74
shared casts for, 172
stereo, 360
tailoring movies to, 172
See also sound cast members; sound channel

Sounds file. See Set Sound command (Score 
menu); sounds

Space to Time command (Score menu), moving 
cast members to a single channel, 
99-101, 115, 118, 458-59

Space to Time dialog box, 100, 458-59
illustrated, 458
setting the number of frames between sprites, 

100, 115, 118
Spacebar, using to turn paint tools into the hand 

tool, 306
Sparkle effect, 472-74
Speckle option (Air Brushes dialog box), 503
Speed control, for auto animate effects, 463, 465, 

468, 472, 473, 476
Speed option (Set Palette dialog box), 449, 450
spraying paint, 307-8
Spread ink (paint window), 314, 318
Spread pop-up menu (Gradients dialog box), 511
sprite channels, 126

extended display notation, 268
foreground priority, 79, 126, 265

changing, 127-30, 275
illustrated, 76, 264



Sprite Info command (Score menu), 429, 443-44
Sprite Info dialog box, 443-44

illustrated, 443
measuring sprites, 142-43, 443-44

sprite information (in the score), 79, 268, 270
incorporated animated sequences including 

(table), 160
sprite scripts, 12, 222, 224-25

go to frame "name", 231-32
play frame "name", 234-35
versus cast member scripts, 225, 231

sprites, 78, 224, 264, 539
accelerating, 457
anti-aliasing, 285-86, 379
applying inks to, 82-83, 279-80
attributes, 279-89
background (illustrated), 105
blend value, 445-46
coloring, 52, 281-82, 329-30
creating, 78-80
defined, 52
as displayed in the score, 79, 268, 270
editable feature, 289, 536
foreground priority, 79, 126, 265

changing, 127-30, 275
in-betweening, 113-19, 256-58, 456-58
measuring, 142-43
monitoring while recording, 93
moveable feature, 288, 538
moving, 82, 341, 443-44, 459-60, 540

with in-betweening, 106-8, 455
up/down in the score, 127-30, 275

pasting, 459-60
removing, 80, 445
resizing, 242, 443-44
revealing, 281
Index
sprites (continued)
sequences of

changing, 81-82
clearing, 84
selecting, 82

setting the number of frames between, 100, 
115, 118

stretching or squeezing, 80-81
animating, 110
with in-betweening, 110-11

versus cast members, 78, 224
See also animated sequences; animations; 

in-betweens; sprite channels
squeezing

cast members, 45, 111, 306
sprites, 80-81

animating, 110
with in-betweening, 110-11

stage, 78, 242, 397, 539
action shortcuts, 529
bringing/sending to the front/back, 242
centering, 378
changing, 76
changing the background color, 249
clearing, 539
creating text, 35-37
drawing lines on, 329
drawing shapes on, 329
identifying colors on, 197-98
illustrated, 16
moving movies across, incorporated animated 

sequences including (table), 160
operations (listed), 77
placing cast members on, 18, 78-80, 224, 253, 

257-58
over time, 259-60

positioning cast members on, 19, 113-14
resizing, 382

for exporting animations, 142-44, 377
resizing sprites on, 242, 443-44
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Stage Area option (Set Transition dialog box), 
452

Stage command (Window menu), 242, 397
Stage Options dialog box, 387-88

illustrated, 387
Stage Size settings (Preferences dialog box), 382
standard buttons, creating, 215-16
Standard Dither option (Gradients dialog box), 

510
Standard pattern, editing, 500
starting Director, 6
starting points (for animations), setting, 88, 111
stationary cast members, adding, 104-6
Step Backward button (control panel), 245

illustrated, 244, 245
Step Backward command (Edit menu), 392
Step Forward button (control panel), 245

illustrated, 244, 245
Step Forward command (Edit menu), 393
stepping movies backward, 245, 247, 392
stepping movies forward, 245, 247, 393
step-recording, 20, 93-96, 290, 539

activating, 258, 261, 290
stopping, 95, 96
switching cast members while, 97-98
See also frame-by-frame animation

step-recording indicator (score window), 93, 95
illustrated, 93, 290

stereo sounds, importing, 360
Stop button (control panel), 245

illustrated, 244, 245
Stop command (Edit menu), 392
stopping movies, 245, 392
stretching

cast members, 45, 111, 306
sprites, 80-81

animating, 110
with in-betweening, 110-11

Style command (Text menu), 481

Style pop-up menu (Button Cast Member Info 
dialog box), 405

Style pop-up menu (Text Cast Member Info 
dialog box), 420-21

Style submenu (Text menu), 482
Subtract ink (score window), 279, 282
Subtract Pin ink (score window), 279, 282
Sum display (control panel), 248
Sun Burst option (Gradients dialog box), 507
Switch Cast Members command (Score 

menu), 461
Switch Colors command (Effects menu), 56-58, 

299, 517
Switch ink (paint window), 56-57, 59, 299, 314, 

316
Switch Monitor’s Color Depth to Match Movie’s 

option (Projector Options dialog 
box), 378

Switch Monitor’s Color Depth to Match Movie’s 
option (Preferences dialog box), 49

synchronization, defined, 539
system requirements, 4

T
Tab key, editing text, 421
tempo, 163, 247-48, 446-48, 539

entering/changing, 247
versus playback speed, 166-67
See also playback speed; tempo channel; tempo 

settings
tempo channel

extended display notation, 268
illustrated, 76, 154, 268

tempo display (control panel), 247-48
illustrated, 247

tempo mode button (control panel), 247
illustrated, 247

Tempo option (Set Tempo dialog box), 447
Index580



tempo settings, 162, 163, 165, 446-48
adding, 152, 154-55, 164-66
incorporated animated sequences including 

(table), 160
and interactivity, 210
operations (listed), 164
for QuickTime movies, 369-70
slowing real-time recording, 91, 135
and transitions, 448
See also tempo

Tempo Settings option (QuickTime Export 
Options dialog box), 369-70

testing
frame durations, 248
scripts, 340

text, 481-88
banner text, 462
borders, 482
changing, 18, 483-86
creating, 33-39
deleting, 481
editing, 35, 39, 325-26, 421
finding and changing, 483-85
jagged, 282
justifying, 471
kerning, 34
paint window. See bitmapped text
preventing wrapping, 421
styles, 482
in text cast members. See QuickDraw text
text effects, 472-74
underlined, active window symbol, 397
zooming, 474-76
See also bitmapped text; fonts; QuickDraw text; 

text cast members; text window; text 
window text; tools window text

text blocks, creating hypertext links out of, 217-21
text boxes, 36
Text Cast Member Info dialog box, 420-22
Index
text cast members, 420-22
changing attributes, 250
creating, 23, 34, 35-38, 324
creating hypertext links out of, 217-21
displaying size, 422
double-clicking, 323
editable feature, 289
editing, 421
placing, in the score, 18
purging from memory, 422
updating process, 323
See also cast members; text

Text command (Window menu), 399
Text effects, 472-74
Text Effects auto animate dialog box, 473-74
Text Formats options (Bullet Chart auto animate 

dialog box), 468
text macro cast members, conversion to movie 

scripts, 353
Text menu, 481-88

command shortcuts, 527
commands, 323, 481-88
illustrated, 481
submenus (table), 482

Text Shadow settings (Text menu), 481
Text Shadow submenu (Text menu), 482
Text Style button (auto animate dialog boxes), 

462, 471, 473, 475
text tool (paint window), 33, 307

illustrated, 301, 307
text tool (tools window), 33, 328

illustrated, 328
text width, resizing, 325-26
text window, 323-24, 399

bringing, to the front, 323
buttons, 324
creating a second view, 326
creating text, 38
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text window (continued)
displaying the Cast Member Info dialog box, 

402
duplicating, 401
illustrated, 33, 323
opening, 251, 323, 399
titles, 323
See also text; text window text

text window text, 34, 323
appearance, 38
creating, 38
formatting, 327
selecting and editing, 325-26
See also QuickDraw text

That Are Not Used in the Score option (Find 
Cast Members dialog box), 69, 437

That Use the Palette option (Find Cast Members 
dialog box), 437

This Tile Is option (Tiles dialog box), 497
Three Sharp option (Gradients dialog box), 508
Three Smooth option (Gradients dialog box), 508
thumbnail images, 251, 252, 357, 440-41

displaying size, 441
memory use display, 346, 347

Thumbnail size field (Cast Window Options 
dialog box), 441

tiles, 496-98
creating, 497-98
defined, 299, 539

Tiles command (Paint menu), 496-98
Tiles dialog box, 496-98

illustrated, 496
Tips & Tricks, 2
Title Style button (Bar Chart auto animate dialog 

box), 465
Title Style button (Bullet Chart auto animate 

dialog box), 468
tool palette (paint window), illustrated, 293, 301
Tool window. See tools window

tools
augmenting, 22
button, 328, 329
paint, 301-13
shape (paint window), 303, 310-12
shape (tools window), 328, 329

Tools command (Window menu), 399
tools window, 328-31, 399

creating text, 35-37
illustrated, 18, 33, 328
opening, 399

tools window text, 34, 328
creating, 35-37, 328
See also QuickDraw text

Top to Bottom option (Gradients dialog 
box), 506

Topics button (help window), 348
Total Memory display (Director dialog box), 346
Total Used display (Director dialog box), 346
Trace Edges command (Effects menu), 516
Trace feature (message window), 340
tracing movies, 340
Trails checkbox (score window), 287-88
trails feature (score window), 287-88, 539

illustrated, 287
Transform Bitmap command (Cast menu), 

429-33
changing palettes, 67

Transform Bitmap dialog box, 429-33
changing cast member color depth, 53-54, 

322, 430-31
illustrated, 53, 187, 429
remapping the cast to a single palette, 186-87, 

193
Transform Sprite command (Director 3.1). See 

Sprite Info command (Score menu)
Transition Applies to options (Set Transition 

dialog box), 452
Index582



transition channel
extended display notation, 269
illustrated, 76, 176, 269

transitions, 20, 162, 175, 452-53
adding, to the score, 176-78
Changing Area setting, 452
Chunk Size setting, 372, 452
defined, 539
Duration setting, 372
exporting in QuickTime movies or PICS files, 

178, 372
hiding palette changes with, 184-85
incorporated animated sequences including 

(table), 160
operations (listed), 175
palette, 20, 450-51
platform variations, 177
playing sounds during, 453
in QuickTime movies, modifying, 146, 372
selecting, 177-78

transitions (continued) 
setting, 452-53
Stage Area setting, 452
stopping, 453
and tempo settings, 448
See also palette transitions; transition channel

transparent cast members, creating, 219-20
Transparent ink (paint window), 314, 315
Transparent ink (score window), 279, 281
Tutorial Movies folder, 5
Tweak command (Window menu), 401
tweak window, 82, 341, 401, 540

illustrated, 341
opening, 401

tweaking, defined, 540
tweening. See in-betweening
Two Sharp option (Gradients dialog box), 508
Two Smooth option (Gradients dialog box), 508
Index
Type field (Multiple Cast Member Info dialog 
box), 423

Type field (Script Cast Member Info dialog 
box), 418

Type pop-up menu (Import dialog box), 356
Typewriter effect, 472-74

U
Uncomment command (Text menu), 488
underlined text, active window symbol, 397
Undo command (Edit menu), 389
undoing actions, 389
unlocking the playback speed (frame durations), 

167-68, 395-96
of part of a movie, 169

up arrow, using to cycle through color chip 
colors, 320

Update Movies command (File menu), 373-75
protecting movies, 8, 373-74
reformatting movies, 8, 373-74

Update Movies dialog box, 373-75
illustrated, 373

Use Adjacent Colors option (Paint Window 
Options dialog box), 514

Use Best Colors option (Paint Window Options 
dialog box), 514

Used by Program display (About Director dialog 
box), 347

used colors, selecting, 493
User Info settings (Movie Info dialog box), 379
Using Director, contents summary, 3
Using Lingo, 2
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V
Value options (Bar Chart auto animate dialog 

box), 465
VGA (Video Graphics Array) palette, 333
video cards, and palette transitions, 453
Video checkbox (Digital Video Cast Member 

Info dialog box), 408
Video compressor, using to compress QuickTime 

movies, 371
View by Name option (Find Cast Members 

dialog box), 437
View by Number option (Find Cast Members 

dialog box), 437
View options (Find Handler dialog box), 487

W
Wait for Mouse Click or Key option (Set Tempo 

dialog box), 447
Wait for QuickTime Movie to Finish in 

Channel _ option (Set Tempo dialog 
box), 447

Wait for Sound1 to Finish option (Set Tempo 
dialog box), 447

Wait for Sound2 to Finish option (Set Tempo 
dialog box), 447

Wait option (Set Tempo dialog box), 447
When Needed option (load cast pop-up 

menu), 380
When Quitting option (Preferences dialog box), 

382
Whole Words Only checkbox (Find/Change 

dialog box), 483
Whose Name Begins with option (Find Cast 

Members dialog box), 437
Whose Type is Option (Find Cast Members 

dialog box), 437
Width field (Preferences dialog box), 382
Width field (Sprite Info dialog box), 444

Width field (Tiles dialog box), 497
Window menu, 397

command shortcuts, 526
commands, 397-401
illustrated, 397
open windows list, 397

Window option (Gradients dialog box), 511
window shortcuts, listed, 529-34
windows, 241-343

action shortcuts (listed), 529-34
bringing to front, 397
bringing/sending the stage in front/behind, 

242
duplicating, 401
help window, 348-49
hiding, 242, 397
movies in, 12, 158-59

operations included in (table), 160
open, as listed in the Window menu, 397
playing Director movies in, 12, 158-59
showing all open, 242
tweak window, 82, 341, 540
See also cast window; color palettes window; 

digital video window; markers window; 
message window; paint window; score 
window; script window; stage; text 
window; tools window

Within Range of Frames options (Export dialog 
box), 367

Within Range of Frames options (Print Options 
dialog box), 386

words, creating hypertext links out of, 219-21
working area display, 346-47
Wrap-Around Search checkbox (Find/Change 

dialog box), 484
writing scripts, 210, 222-39
Index584



X
X & Y Coordinates checkbox (Score Window 

Options dialog box), 480

Z
Zoom In command (Paint menu), 297, 495
Zoom Out command (Paint menu), 297, 495
Zoom Text auto animate dialog box, 475-76

illustrated, 475
Zoom Text effect, 474-76
Zoom Type field (Zoom Text auto animate dialog 

box), 476
zooming in/out, 474-76

in the paint window, 297, 301, 309, 495
Index
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